This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are “commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement between you and Oracle.

If this document is in public or private pre-General Availability status:

This documentation is in pre-General Availability status and is intended for demonstration and preliminary use only. It may not be specific to the hardware on which you are using the software. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to this documentation and will not be responsible for any loss, costs, or damages incurred due to the use of this documentation.

If this document is in private pre-General Availability status:

The information contained in this document is for informational sharing purposes only and should be considered in your capacity as a customer advisory board member or pursuant to your pre-General Availability trial agreement only. It is not a commitment to deliver any material, code, or functionality, and
should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through help links. All such sample code is provided "as is" and "as available", for use only with an authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's particular usage pattern requires a higher limit or threshold, then the Customer should procure a subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally available. To use such features, Customer acknowledges and agrees that such beta features are subject to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will use the beta feature carefully and will not use it in any way which might result in any loss, corruption or unauthorized access of or to its or any third party's property or information. Customer must promptly report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability of such beta features and may substantially modify or cease providing such beta features without entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the performance of the Service resulting from the use of beta features. Oracle's standard service levels, warranties and related commitments regarding the Service shall not apply to beta features and they may not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the date that Oracle at its sole option makes a beta feature generally available to its customers and partners as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document.
Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click [here](#) to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
# Table of Contents

**OVERVIEW** .......................................................................................................................... 1
Integration and Synchronization ................................................................................................. 2
Standards, Guidelines and Recommendations ........................................................................... 4
User Interface ............................................................................................................................ 7
Icons ........................................................................................................................................ 11
Best Practices for using an NSPOS register ............................................................................. 12
Backward Compatibility for NSPOS upgrades ......................................................................... 13
Contacting NSPOS Customer Support ..................................................................................... 14
NSPOS Documentation Resources ........................................................................................... 15

**ENVIRONMENT – REQUIRED** .......................................................................................... 17
NSPOS System Requirements .................................................................................................... 17
Benchmarks for Data Transfers and System Limits .................................................................... 20
Subsidiaries, Locations, Taxes ................................................................................................... 23
  Work with Subsidiaries ............................................................................................................ 23
  Work with Locations ............................................................................................................... 25
  Map Sales Tax Locations by Group or Code ............................................................................ 26
  Tax Rounding Discrepancies – Set up Discount Items to Prevent .......................................... 29
Set up a Register ....................................................................................................................... 30
  Prerequisites for NSPOS ......................................................................................................... 31
  Add an RA-Workstation Record in NetSuite .......................................................................... 33
  Install the Microsoft SQL Server application ......................................................................... 34
  Stage a Register ...................................................................................................................... 50
  Inactivating a Register ........................................................................................................... 59
  Set up a Self-sell Kiosk ............................................................................................................ 59
  NSPOS Workstations Provisioning for Mass Staging .............................................................. 61
  Store Server Architecture ...................................................................................................... 64
  Use Workstation Groups to customize Features for Select Registers ................................... 65
Customize the User Interface and Security in NSPOS .............................................................. 66
  Customize Button Bars .......................................................................................................... 67
  Set Button Security ................................................................................................................. 69
  Set Page Security ..................................................................................................................... 70
  Customize the on-screen Keyboard ......................................................................................... 71
  Set up Item Hotkeys ............................................................................................................... 71
  Customize a Prompt for Receipt ............................................................................................. 74
  Capture Signatures on a Tap Screen Tablet ............................................................................ 76

**Codes and Comments** ......................................................................................................... 77
Reason Codes ............................................................................................................................ 77
Require Entering a Comment with Sale ....................................................................................... 79
Work with Customer Records .................................................................................................. 80
Work with the Default Anonymous Customer ......................................................................... 83

**ENVIRONMENT – OPTIONAL** .......................................................................................... 85
Payment Gateways .................................................................................................................... 85
  Shift4 UTG ............................................................................................................................... 85
  Worldpay ................................................................................................................................ 91
  FreedomPay ............................................................................................................................ 94
  PC-EFTPOS ........................................................................................................................... 99
Money Management .................................................................................................................. 103
  Tenders and Payment Methods ............................................................................................. 103
  Transaction Payment Records in NetSuite ERP .................................................................... 108
  Tender Workflows ................................................................................................................ 113
  Tracking Money Movement through NetSuite ERP records ............................................... 114
  Cash Till Management in NSPOS .......................................................................................... 120
  Flags and Settings ................................................................................................................ 123
OVERVIEW

Applies to: NetSuite Point of Sale (NSPOS)

Watch a Related Video

Use this document as a guide to administrating NetSuite Point of Sale (NSPOS). The guide includes steps for common tasks and instructions for making basic changes, such as modifying the buttons that are available to store managers and the cashiers that run your registers.

NSPOS integrates with NetSuite ERP to manage your items, pricing, subsidiaries and store setups. This guide covers user and administration tasks performed in NetSuite ERP and in the NSPOS application. Some topics include links to the NetSuite Help for more information.

NetSuite Point of Sale

NetSuite Point of Sale (NSPOS or NetSuite POS) is the in-store register component of the Commerce web stores product line. Designed for midsize retailers, NSPOS provides an efficient and customizable interface for handling sales transactions and working with customer and item information. It is a high-performance, full-featured solution that can scale to meet demands as retailers increase their sales volume and expand to new locations.

NSPOS works on many register types, and provides a quick and accurate check-out process. Because it is highly customizable, the workflow and appearance can be modified to meet the business requirements of most store locations. It can work with peripheral equipment such as barcode scanners, a mouse and keyboard, or the sales associate can use on-screen features such as dynamic item lookup, a tap screen interface and a virtual keyboard. Most setups include a receipt printer and a credit card swipe device.

Important: The Commerce web stores line includes another point of sale solution – SuiteCommerce InStore (SCIS). NSPOS runs primarily on desktop cash register setups. SCIS processes transactions using touchscreen tablets or other portable devices. For SCIS documentation, see the SuiteCommerce InStore User Guide under NetSuite Help > User Guides.

NetSuite Point of Sale is available in the United States, Australia, Canada, England, and New Zealand.

- Integration and Synchronization
  - Integration with NetSuite ERP
  - Integration Users
  - Synchronization Downloads
  - Synchronization Uploads
  - Synchronization Periods
  - Synchronization Optimization for Custom Fields in Item Records
  - Stale Partner Processing for Disconnected Registers
  - Third-Party Payment Gateways

- Standards, Guidelines and Recommendations
  - Payment Application Data Security Standards (PA-DSS)
  - Recommendations for mass Item and Customer updates
  - Planning efficient rollouts for new Stores and Registers
  - The File Cabinet in NetSuite ERP
Integration and Synchronization

Integration with NetSuite ERP

NSPOS integrates with the NetSuite application to provide Enterprise Resource Planning (ERP) tools for managing your items, pricing, and other aspects of your business. This occurs through a periodic synchronization process that includes a cloud-based replication server.

Because NSPOS receives and sends information periodically rather than in real-time, internet outages do not prevent your sales associates from making sales transactions. Synchronization resumes when your internet connection is restored.

Integration Users

Each NetSuite account for NSPOS includes at least one integration user dedicated to handling the synchronization connection between NetSuite ERP and the replication server. Integration users are configured during your initial implementation. On occasion, heavy traffic across a single integration user can lead to performance issues.

To maintain performance during peak periods, you can have up to three integration users set up for your account. Each integration user requires a separate NetSuite license.

We support token-based authentication (TBA) for integration accounts. TBA is only required for one integration user account. The TBA-integration setup does not require you to enter a token when you log into NetSuite ERP or NSPOS. However, the Token-based Authentication box must be checked on the Enable Features page.

Synchronization Downloads

Sales associates use item, price and promotion data saved to the register when they scan items for sales and make other transactions. This data originates in NetSuite and is pushed to the registers in frequent synchronization downloads. Also called a down sync, these downloads ensure your registers have the most current information available. Downloaded content includes:

- Item information
- Pricing
- Promotions
- Customer information
- Employee information
- POS register configuration data

This periodic synchronization method provides a level of independence for each register. An NSPOS register can easily operate in “offline” mode if an internet connection becomes temporarily unavailable. It is an advantage over POS applications that require uninterrupted communications with a host server.
**Synchronization Uploads**

Transactions and other entries made at registers periodically upload to NetSuite. Also called an **up sync**, these updates adjust inventory levels for item movement in and out of your stores, log payments, and modify customer information and history. Information uploaded from the POS register includes:

- Items sold / returned
- Payment amounts, including taxes
- Payment types
- Customer information

**Synchronization Periods**

Synchronization between NetSuite and your POS registers occurs periodically, with the default intervals being:

- NetSuite to POS every 15 minutes
- POS to NetSuite every 5 minutes

Note that these times are approximate. Synchronization intervals usually begin on time and complete within a few minutes. However, processing can be influenced by things such as the volume of data transferred or your connection speed. If you do not see your data immediately, try checking back later. For more information, see [Benchmarks for Data Transfers and System Limits](#).

⚠️ **Important:** Very large item updates made in NetSuite can impact the synchronization process, delaying updates across the network. For this reason, we recommend against performing mass item updates in NetSuite during store business hours.

**Synchronization Optimization for Custom Fields in Item Records**

To ensure offline capabilities for each register, synchronizations between NetSuite ERP and NSPOS include most of the fields associated with the NetSuite ERP Item record. Item records can include custom fields set up by a retailer to handle unique requirements. However, having many custom fields replicated to each register can slow performance during synchronization.

Because some custom fields will be set up for a limited purpose and period, NSPOS performs clean up processes at the server level during each synchronization. The clean up validates whether the fields scheduled for replication have been marked deleted in NetSuite ERP. If yes, the deprecated fields are removed from the replication and deleted from the local NSPOS register database. Clean up is also processed for fields that remain active in NetSuite ERP but were removed from the list for download to NSPOS.

**Stale Partner Processing for Disconnected Registers**

When a register is disconnected from the server network, synchronization updates for that register are unable to complete. Disconnections are usually caused by registers being manually powered down (turned off) or entering hibernation. We refer to disconnected registers as **stale partners**.

When NetSuite detects that a register is disconnected, it holds all new transactions, price changes and customer information for download to that partner later. This works well in the short term, but over time
the data volume will grow with each held update. If very large amounts of data are held in the normal synchronization queue, it can impact overall server performance.

To protect server performance and manage large volumes of held register data, NSPOS uses a function called Stale Partner Processing. After a defined period of inactivity, we route updates meant for the register away from the normal queue and hold them in a separate queue for possible download later.

If a partner is reactivated (the register is turned back on), the data required to bring it up to date is downloaded automatically from the stale queue. The register then begins receiving normal updates.

Depending on how long a register has been stale (turned off), it can take time for updates to download. The following guidelines can help ensure success when bringing a register back online:

- It is best to restart a register at least 24-48 hours before it is needed. NetSuite recommends allowing 48 hours.
- Do not restart many registers at the same time. Multiple large downloads could impact server performance.
- If a register has been turned off for an extended period, restaging the register can be the fastest method for bringing it up to date. Staging generally takes less time than waiting for very large downloads to complete.
  - If a register's location changes to a different store, you must restage it.
  - If a register's RA-Workstation record was set to Inactive, you must restage it.

⚠️ **Important:** Before restaging a register workstation that was set to Inactive in NetSuite ERP, clear the Inactive box on the NetSuite RA-Workstation record, Save and then wait 15 minutes for the active status to sync between the server and the workstation.

**Third-Party Payment Gateways**

Each POS register connects to a payment gateway. These are third-party applications selected by retail businesses to handle credit or debit card authorizations and other payment types that require special handling. When you or the customer swipes a credit card as payment, your POS connects with the payment gateway and sends the credit card, purchase amount and other information. The gateway processes the payment and returns an authorization code stating that the payment is accepted or rejected.

The capabilities of different gateway services vary in how they are set up and the features they provide. Work with your NetSuite Account Manager or Professional Services representative to determine which service meets your business needs. For information about setting up gateways, see Payment Gateways.

**Standards, Guidelines and Recommendations**

**Payment Application Data Security Standards (PA-DSS)**

NSPOS is a PA-DSS validated application. The Payment Application Data Security Standard (PA-DSS) guide describes the Payment Card Industry (PCI) initiative and lists recommendations for using NSPOS in a PCI DSS compliant environment.

The guide includes details about installing and configuring a compliant system, best practices for maintaining compliance, and a list of operating systems (OS) validated for use on your NSPOS registers/terminals.
Important: See the Payment Application Data Security Standard (PA-DSS) guide appropriate to your NSPOS version in the NetSuite Help > User Guides.

Recommendations for mass Item and Customer updates

We recommend against performing mass item and customer updates during business hours when transactions are occurring on your registers. NSPOS integrates with NetSuite ERP to provide Enterprise Resource Planning (ERP) tools for managing your items, customers and other aspects of your business. You can update items and customers in NetSuite manually or through CSV imports.

Updates in NetSuite periodically download to your POS registers to ensure all information is synchronized and current. NSPOS performs synchronization uploads to NetSuite of sales and other transactions that occur at the register. This is distributed to other registers in your store through the replication server.

Important: Item and customer updates of over 60,000 records can impact synchronization across the network. If mass updates must occur during business hours, we recommend limiting each update to 60,000 records or less.

Planning efficient rollouts for new Stores and Registers

When opening one or more new stores, it is important to consider the time needed to prepare the registers with current information from your NetSuite ERP setup. This consideration also applies to registers that were previously active but have been turned off for a long time.

When a register is staged, all information fully loaded and up to date. After staging, registers receive only the information needed to keep them current. When a register is turned off, NetSuite holds all new transactions, price changes and customer information for download to the register later.

If a register is turned off for an extended period and then turned back on, the size of the update can be large and take a while to download. This might delay a register from being ready when you need it.

Important: Excessive download times can delay registers from being ready to accept sales transactions and can affect overall server performance. This delay can be critical in the event of a new store opening.

To ensure your new registers are ready for business, NetSuite recommends the following:

1. Stage registers **24-48 hours before first use**. If no major ERP updates will occur after staging, this time can be longer without a significant impact on performance.

2. If a store rollout requires new item and customer information, if possible, be sure to add or import the information to NetSuite ERP **before** staging new registers. Then the new information will be included during the staging process.

3. To reduce the impact to existing registers, large item and customer changes in NetSuite ERP should be performed in small increments. A good guideline is **limiting changes to 60,000 records** or less per day, performed outside of business hours.

   If you are not certain how to limit the number of records or if this guideline does not fit your rollout schedule, please contact NSPOS Customer Support for assistance.

4. For registers that have been turned off for a long time, **restaging a register can be the fastest method** for bringing it up to date. Staging is generally quicker than waiting for large downloads to complete.
The File Cabinet in NetSuite ERP

NSPOS uses the NetSuite ERP File Cabinet > File System folder to manage many system-wide configurations. An example of File Cabinet configuration is the template that determines the look of your printed receipts. Customers with advanced knowledge about the application can make some File Cabinet customizations themselves by signing into NetSuite and going to Documents > Files > File Cabinet > NSPOS.

Making File Cabinet changes directly in NetSuite is fast and provides for easy replication across all registers. NetSuite performs a check for file changes one time each hour. NetSuite recommends that you back up any file you will change to your local hard drive. Then upload only the final version. Keep the backup copy until you are certain the change works as expected.

Due to the complexities and risks associated with making File Cabinet modifications, we do not describe specific customization steps in this guide.

Warning: Moving or modifying files in the File Cabinet can seriously affect NSPOS performance or cause it to cease functioning completely. If you are not certain about making a change, please contact NSPOS Customer Support first.

As a security measure, you should strictly limit File Cabinet access to only your administrator and others that have a need for such access. Not restricting access could enable others to inadvertently or maliciously interrupt NSPOS operations, including causing a complete denial of service at the point of sale.

Important: Do not make modifications to the File Cabinet shortly before or during an upgrade to a new release. Any modifications you make during that time might be lost.

Restrictions for File Cabinet access

By default for NSPOS 2018.1.2 and greater, access is available to members of the NSPOS File System Access Group only. This group is comprised of Administrators and others with a “full access” role. Administrators can grant or remove access for individual users by adjusting their NetSuite ERP role.

To review who has access to the File Cabinet:

This procedure displays the results of a saved search that is refreshed one time every 24 hours. If you change a user’s Role to add or remove administrator privileges, and want to verify the change, clicking Save forces the search to update.

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Relationships > Groups.
3. Click **Edit** for **NSPOS File System Access**.
4. Review the list.
5. If your task is complete, click **Cancel**.
6. If you want to update the search to include changes made today, click **Save** and then click **Edit** to view the refreshed list.

![Groups Table]

**To adjust a user's Role:**

Use this procedure to add or remove administrator privileges. An administrator Role is generally required to access the File Cabinet in NetSuite ERP.

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Employees > Employees.
3. Locate the user by their **Name** or other criteria.
4. Click **Edit**.
5. Click the **Access** subtab.
6. Under **Roles**, select the desired Role.
7. Click **Save**.

**User Interface**

NSPOS pages include key areas for working with transactions, performing tasks such as signing on and monitoring network connectivity, and for entering information and performing searches.

- **Journal Window**
- **Journal Modes**
- **Status Bar**
- **Forms**

**Journal Window**

The Journal displays all information about the current transaction. It is your main workspace. Items added to a transaction list as separate lines in sequential order, with the first item shown at the top and the current item at the bottom. The transaction summary in the lower section lists details about the total transaction, including the tax rate, subtotal and amount due.

This image shows a typical transaction in progress. Your layout may vary.
1. **Status Bar** — Shows details about the current session, including your sign-on name or type, workstation ID, number of transactions for the day, and whether your register is connected to the server. You can also view the current operating or register mode in the upper left corner. See Status Bar for more information.

2. **Customer Information** — Displays the selected customer’s name, phone number and address. Double-click or tap the customer to display their recent sales and returns history.

3. **Transaction Activity** — Shows the last item scanned, the quantity, price, any discounts or promotions applied, the tax category, POS ID (usually the UPC), and the Item ID. The Item ID lists the item name and the stock keeping unit (SKU).

4. **Main Button Bar** (bottom) and **Side Button Bar** (right) — Tap a button on the Main Bar to display its options or menu sub-pages in the Side Bar. Tap a Side Bar option to perform the task. Buttons may open windows for entering information, finding things such as customers or items, or for choosing from lists. NSPOS is highly customizable; your manager or system administrator may define buttons to perform functions not covered in this guide.

5. **Pending Operation** — Shown as a green circle with a number, this is the count of tasks pending for that button. Tap the button to see the list. The example shown here is the number of on hold or suspended sales transactions ready to resume.

6. **Transaction Summary** — Displays summary details about transaction, including the subtotal, discounts and taxes, ID of the person ringing up the transaction and the number of items purchased. Details update as each item is added and when payments take place.

7. **Amt Due** — Shows the total payment due. Tap to select a payment type and complete the transaction. If making a return, this displays a Change button with the money to be returned to the customer shown in brackets.

### Journal Modes

The Journal display changes as you progress through a transaction.

- As you work, the current line is in **Summary** mode, displaying basic information about the item, coupon, customer, payment or other entry. Only the most recent entry appears in Summary mode.
- When you add items or payments to the transaction, previous lines in the Journal switch to Compact mode to save space. Compact mode displays only the most important information about the entry. Tap a line shown in Compact mode to display it in Summary mode.

- Page mode appears when you double-click or tap an entry. This comprehensive mode displays all available information about the entry, including sales history for customers or product details for items. Single-click or tap an entry in Page mode to return to Summary mode.

Some actions apply to the selected line only. This line always displays in Summary mode. For example, to void a previously entered item, tap that item's line. The line displays in Summary mode, indicating it is selected. Then tap the Void Line button.

A red security shield icon appears on a button if you, the signed-on user, do not have sufficient permission to perform a task. The task can still be accessed if a manager or someone with similar privileges is available to enter their credentials and allow the override. The security level on any button can be changed by your system administrator.

**Tip:** If you cannot find a button or its associated function, look it up by pressing Ctrl+F12. This opens the Function List window where you can search for the function by name or click/tap into function categories. You can also click/tap the Mode icon in the Status Bar to access the list.

### Status Bar

Located above the Journal, the Status Bar displays information about your NSPOS register status and provides options for signing on or off, clocking in or out, and exiting the application. You can also monitor your register's connectivity to your network.

1. **Menu** — Use this to toggle the on-screen Keyboard, display the Function List, display the system Message Window (system administrator only) or to exit NSPOS.
2. **Mode Display** — Shows the current register mode. For example, Closed Mode or Sales Mode.
3. **Operator Name** — Depending on your setup, this displays the name or ID of the signed-on user or the signed-on user type. You can tap the Operator Name to sign on or off and clock in or out.
4. **Workstation ID** — Shows the workstation or register ID.
5. **Transaction Number** — Displays the day’s transaction count. In addition to sales transactions, this number includes control transactions such as the count of users that have signed on and the number of canceled transactions.
6. **Time** — Displays the time at your location.
7. **System Notifications** — Indicates there are messages and alerts waiting to be read. Blue icons are system information and red icons are errors or similar problems. Tap to view the messages.
8. **Sever Status** — Shows the status of the NetSuite server connection. If the register is not connected to the internet through the server, item and customer searches may be limited and certain payment types may be unavailable. A green check mark indicates the workstation is connected and fully ready to make transactions. A red icon indicates connectivity issues.

### Forms

NSPOS includes pop-up forms for searching, selecting and entering information. For example, you look up items and find or add customers using forms.
Forms can include optional and required fields, as well as fields that are **display only**. NSPOS alerts you when a required field is incomplete or contains an invalid entry.

Forms display icons that guide you through completing the form. Some provide helpful hints on the information to be entered, while others perform tasks or identify required fields.

- Tap the **Browse** icon to search for information or valid entries. These searches open a separate window.

  Located directly on the form, enter text in **Search** fields to find items, customers, or other information based on the type of form.
  
  Search results display automatically after entering three characters. Searches are not case sensitive, and match any part of a word.
  
  For example, use **Find Item** search for a specific item.
  
  1. In **Sales Mode**, with or without a current transaction, tap **Find Item**.
  2. In the search field, enter part of the item name. Exact, likely and near matches appear in the list. This is helpful when you are unsure of an item name or spelling.
  3. If folders display, tap a folder to view the items inside.
  4. Tap an item to add it to the transaction.

**Required** fields display an arrow. These fields must contain a valid entry and cannot be left blank.

**Text** fields for entering notes, comments or other information.

Tap **Done** to save your changes or tap **Cancel** to go back.

Sometimes, when a window has options for multiple choices, your actions do not take effect until you tap the **Done** button.
Similar to Done and Cancel, tap the green check mark to enter a value or the red X to cancel.

Show and Hide the on-screen keyboard. Use this for entering search criteria and text when you do not have an attached keyboard.

Scroll bars visible along the bottom or side of the window indicate that the form includes more options or fields. Scroll to view the entire form.

**Icons**

Use this as a guide to the icons and symbols that display in NSPOS.

A red **security shield** icon on a button indicates it is inaccessible. This displays either when the current user doesn't have sufficient access to perform a task or the application requires an additional sign in to confirm an action, such as shutting down a register.

If the user doesn't have sufficient access, the function can still be run if a manager or administrator is available to enter their credentials. The security level on any function can be changed by an administrator.

A green circular **count** icon appears on a button to indicate there are pending jobs associated with the button. The number in the circle shows how many jobs are pending.

The **register functions** icon appears in the top left corner of the screen, in the Status Bar. Tap the icon to open register functions such as **Toggle Keyboard, Function List, Message Window, and Exit**.

Appearing as a set of binoculars, the **browse** icon shows that the field can be used to search, such as to find a customer. A small browse icon next to a form field means you can search for information to complete the field.
Tap the **show keyboard** icon to open the on-screen keyboard.

Tap the **hide keyboard** icon to close the on-screen keyboard.

The **refresh** icon appears on Find Windows next to the search field. Tap this icon to clear the search field and begin a new search.

Tap a **check mark** icon to accept the text entered. You can also press the Enter key.

Tap the round **cancel** icon to cancel a search. You can also press the Esc key.

A red **blocked** icon indicates that a setting is disabled. Tap the icon to enable and enter a value. The icon will change to a white enter-value icon.

**Note:** Even if a value is visible in a blocked (grayed out) text field, that value will not be applied as long as the setting has a blocked icon.

This icon also appears in the status bar to alert you to a system warning message. Tap the icon to read the message.

The white **enter value** icon indicates that a setting is enabled, and the data input type is text. Enter the desired setting in the text field immediately below it. Tap the icon to disable it. It is replaced by a red **blocked** icon with the text field shaded gray.

**Best Practices for using an NSPOS register**

The following are tips and guidelines for using your NetSuite Point of Sale (NSPOS) register.

**Keep the register powered on**

Your register (the personal computer or workstation) and the network synchronize every 15 minutes. Leave the register **powered on** to allow updates.

- You can turn off the monitor to save electricity.
- Turn off Windows® hibernation features. Depending on your Windows version, go to Start Menu > Help and Support. Search for “hibernation” to display the steps. Select Never.
Using the register

- To print a receipt for a past sale or other transaction, touch **Reprint Receipt**. Click **Yes** to print the last receipt or **No** to search for transactions by day, week or date.
- Or press **Ctrl+F12** and search for **Reprint**.
- To troubleshoot hand-held barcode scanners:
  - Is it dirty? Clean lenses with a soft cloth or airbrush.
  - Keep the hand-held scanner in its focus range. Do not scan too close or too far away from the barcode. Orient the scanner with the bar code, not at an angle.
  - When outside, avoid scanning in direct sunlight. Bright lights can affect results.
- If the register does not appear on the monitor, look at the Task Bar to see if it is running, but minimized. Touch the icon to expand.
- If the POS application is not running, start it by tapping the **NetSuite Point of Sale** icon on your desktop.
- Limit the applications running. Email, spreadsheets, and other programs can decrease performance. We recommend running only NSPOS during business hours.
- Be cautious opening email attachments or files from USB drives. Be sure your anti-virus software is up to date.

Working offline and handling errors

NSPOS can run on a register even if your internet connection or server is down. Because registers update by syncing with the server via the network, being offline for a long time can slow performance after the connection is restored and updates are occurring.

If your register goes offline:

- Continue making transactions as usual.
- If possible, use a connected register instead.
- Gift Card and Gift Certificates cannot be sold or taken as payment.
- Details for certain types of Returns and other transaction history may not be available.

If errors display:

- Most error messages alert you to the corrective steps.
- If you cannot correct an error, write down the error code and message. Contact your manager or NSPOS Customer Support.
- If the register freezes, you may need to restart the computer.

Backward Compatibility for NSPOS upgrades

NSPOS includes an upgrade feature called Backward Compatibility. With this feature, we can upgrade a server to the latest release and then let you upgrade each register when it is convenient to your business. Registers on the previous release will continue communicating with the upgraded server until time is available to make the change.
Backward Compatibility can help avoid downtimes that might occur if all registers in a store are upgraded at the same time. Note that compatibility can be extended to the current and previous major releases only, such as 2019.2 to 2019.1.

To start with Backward Compatibility

Work with your account manager or NSPOS Customer Support to have your server upgraded to the latest targeted release. After that, upgrade your registers to the new release on your time line.

Doing a self upgrade requires that you restage your registers. We recommend starting the process with only a few registers. See Stage a Register.

**Note:** To ensure all of your registers receive an upgrade, we will alert you through prompts in NSPOS (Closed mode) and NetSuite ERP (RA-Workstation record) that a new release is available for the register. In the event that another release is coming soon, the prompts to upgrade to the current version will include a do-by date.

Features are specific to registers on a release

Features made available through a new release will not appear on registers running the previous release. For example, if a register is upgraded to 20XX.2, and the release includes a new “promotions” feature, that feature will not be available on backward compatible registers running 20XX.1.

In addition, NSPOS settings configured for a feature on the current release will not work on registers running the previous release.

Contacting NSPOS Customer Support

Individual support is available to NetSuite Point of Sale (NSPOS) customers via telephone or by issuing a case. Before reaching out, NSPOS Customer Support asks that customers enter their concerns in the SuiteAnswers search field first to see if an answer is already available.

**To contact Customer Support:**

1. Log into NetSuite.
2. From the **Support** tab, click **Go to SuiteAnswers**.
3. Select from the options in the right pane to contact Support.

## NSPOS Documentation Resources

This topic provides descriptions and links to NetSuite Point of Sale (NSPOS) documentation resources. Use these resources to learn about using NSPOS, configuring NSPOS to meet the needs of your retail business, and troubleshooting NSPOS to solve common problems. You can review materials online or download a PDF to your computer or register.

### Videos

Our videos deliver a convenient method for understanding and using NSPOS. Housed in the NetSuite Help Center, in the Oracle Learning Library and on YouTube. Each video is brief and concise. Watch our videos to get the information you require in a relaxed learning environment.

**Watch a Related Video**

⚠️ **Tip:** Log into **NetSuite ERP** before clicking a link.

<table>
<thead>
<tr>
<th>Documentation Resource</th>
<th>What it provides</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NSPOS Release Notes</strong></td>
<td>NSPOS release notes list the customer-facing updates included in each release. We modify these release notes on occasion to provide our customers with additional information.</td>
</tr>
<tr>
<td>- Release 2018.2</td>
<td></td>
</tr>
<tr>
<td>- Release 2018.1</td>
<td></td>
</tr>
<tr>
<td><strong>PA-DSS Implementation Guide</strong></td>
<td>NSPOS is a PA-DSS validated application. The Payment Application Data Security Standard (PADSS) guide describes the Payment Card Industry (PCI) initiative and lists recommendations for using NSPOS in a PCI DSS compliant environment. The guide includes:</td>
</tr>
<tr>
<td>- PA-DSS 3.2 Implementation Guide - NSPOS 2018.2</td>
<td></td>
</tr>
<tr>
<td>- PA-DSS 3.2 Implementation Guide - NSPOS 2018.1</td>
<td></td>
</tr>
<tr>
<td><strong>NSPOS Register Verification Checklist</strong></td>
<td>This document lists steps for verifying the basic functionality of NSPOS terminals/registers in stores or other locations.</td>
</tr>
<tr>
<td></td>
<td>Customers or other representatives should perform verifications as part of the user acceptance testing (UAT) process and after deployment of an upgrade.</td>
</tr>
<tr>
<td></td>
<td>Each section will help to identify issues prior to a store recommencing customer transactions.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Important:</strong> We recommend testing at least one terminal (register) in every store.</td>
</tr>
<tr>
<td><strong>NSPOS Security Guide</strong></td>
<td>This guide provides security guidelines and information for installing and using NSPOS. It contains both direct information and links to other NSPOS-related documentation</td>
</tr>
</tbody>
</table>

---

**NSPOS Administrator Guide**
<table>
<thead>
<tr>
<th>NSPOS Help Center Videos</th>
<th>Our videos deliver a convenient method for understanding and using NSPOS. Housed on the Oracle Learning Library, each video is brief and concise. Watch our videos to get the information you require in a relaxed learning environment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>▪ NetSuite SuiteCommerce NSPOS Overview</td>
<td></td>
</tr>
<tr>
<td>▪ NetSuite SuiteCommerce: NSPOS Basic Transactions</td>
<td></td>
</tr>
<tr>
<td>▪ NetSuite SuiteCommerce: Customizing the NSPOS User Interface</td>
<td></td>
</tr>
<tr>
<td>▪ NetSuite SuiteCommerce: NSPOS Documentation Resources</td>
<td></td>
</tr>
<tr>
<td>▪ NetSuite SuiteCommerce: NSPOS Cancel and Void</td>
<td></td>
</tr>
<tr>
<td>▪ NetSuite SuiteCommerce: NSPOS Suspend and Resume</td>
<td></td>
</tr>
<tr>
<td>Also available from the NetSuite ERP application:</td>
<td>Some NPSOS-related tasks are common across different NetSuite</td>
</tr>
<tr>
<td>▪ Help Center</td>
<td>▪ Your general ledger.</td>
</tr>
<tr>
<td>▪ SuiteAnswers</td>
<td>▪ Item and price updates.</td>
</tr>
<tr>
<td></td>
<td>▪ Other areas not specific to working with your registers.</td>
</tr>
</tbody>
</table>
This chapter provides information on system requirements and configurations needed for a successful NetSuite Point of Sale (NSPOS) environment. It includes step-by-step procedures for staging and customizing registers in your stores.

- NSPOS System Requirements
- Benchmarks for Data Transfers and System Limits
- Subsidiaries, Locations, Taxes
- Set up a Register
- Customize the User Interface and Security in NSPOS
- Codes and Comments
- Work with Customer Records
- Work with the Default Anonymous Customer

NSPOS System Requirements

- Operating Systems and Components
- Microsoft SQL Server versions
- Register Workstation Specifications
  - Recommended Register Hardware Specs with MS SQL Server 2008 R2 EE
  - Recommended Register Hardware Specs with MS SQL Server 2016 SP 2 EE
- Store Server Architecture Specifications
  - Minimum Server with POS Hardware Specifications
  - Recommended Server with POS Hardware Specifications
- Supported OPOS Peripheral Types

Operating Systems and Components

For a list of supported operating systems and information about NetSuite Point of Sale (NSPOS) application components, see the Application Summary section of the Payment Application Data Security Standard (PA-DSS). Select the standard appropriate to your NSPOS release.

You can find our PA-DSS publications in the ORACLE | NetSuite Help Center > User Guides tab. Log into NetSuite first.

NetSuite POS is a PA-DSS validated application. The PA-DSS describes the Payment Card Industry (PCI) initiative and lists recommendations for using NetSuite POS in a PCI DSS compliant environment.

- Register Workstation Specifications
- Store Server Architecture Specifications
Microsoft SQL Server versions

NSPOS requires having a Microsoft SQL Server application on each workstation. NSPOS 2018.2.x can use Microsoft SQL Server 2016. Microsoft will deprecate support for Microsoft SQL Server 2008, including Release 2 Express Edition Service Pack 3, on July 9, 2019.

However, Microsoft SQL Server 2016 does not function on Windows 7, Windows Embedded POSReady 7, Windows Vista, Windows Server 2008 R2 or other, earlier operating systems. Also note that the SQL Server application requires at least 6GB free for the server setup.

For information about Microsoft's July 9, 2019 deprecation, you can visit the MS SQL Server 2008 R2 site.

Register Workstation Specifications

These specifications apply to Standalone or POSClient registers in your stores. These workstations provide normal register functions for sales and other transactions.

- Recommended Register Hardware Specs with MS SQL Server 2016 SP 2 EE
- Recommended Register Hardware Specs with MS SQL Server 2008 R2 EE

Recommended Register Hardware Specs with MS SQL Server 2008 R2 EE

This topic covers the current register specifications if:

- You are on NSPOS 2018.1 or greater
- You plan to install Microsoft® SQL Server 2008 R2 Express Edition with Service Pack 3 installed as the SQL Server on each register.

If your current hardware meets the minimums recommended prior to NPSOS 2018.1, you can continue using NSPOS with release 2018.1 or greater. However, for the long term we recommend updating your hardware to the new specifications.

- Processor speed: 2.2 GHz (2.8 GHz recommended)
- Processor type: Intel Dual-Core / Core i3 (or AMD equivalent) or above
- Operating system: Windows 64 bit, required to address RAM above 4 GB
  - Windows Embedded POSReady 7 (MS SQL Server R2 EE SP3 only)
  - Windows 7 Professional (MS SQL Server R2 EE SP3 only)
  - Windows 8.1
  - Windows 10
- RAM: At least 4 GB (6-8 GB recommended)
- Hard disk drive (HDD) or solid state drive (SSD): 30 GB free space or above

Note: Configurations that only meet the minimum requirements might experience slower processing times during periods of high-volume traffic.

Recommended Register Hardware Specs with MS SQL Server 2016 SP 2 EE

This topic covers the current register specifications if you plan to install Microsoft® SQL Server 2008 R2 Express Edition with Service Pack 3 installed as the SQL Server on each register.
NSPOS System Requirements

**Note:** MS SQL Server 2016 is applicable to NSPOS release 2018.2.0 or greater only.

**Important:** MS SQL Server 2016 will not function on Windows 7, Windows Vista, Windows Server 2008 R2 or other earlier operating systems.

- **Processor**
  - 64-bit processors only
  - Minimum speed of 1.4GHz (2.0GHz recommended)

- **RAM dedicated to MS SQL Server 2016**
  - 512MB minimum for Express editions (2GB recommended)
  - 1GB minimum for all other versions (4GB recommended)

- **Operating System**
  - Windows Server 2016
  - Windows Server 2012 R2
  - Windows Server 2012
  - Windows 10
  - Windows 8.1
  - Windows 8

- **Disk space**
  - Minimum of 6GB free for the server setup. This free space does not include the space required for the NSPOS databases.

### Store Server Architecture Specifications

These specifications apply to **Server with POS** workstations. In addition to providing normal register functions for sales and other transactions, these workstations act as the database server for POSClient registers. See **Store Server Architecture** for more information.

The following are for a Server with POS register connected with **five** POSClient registers. Setups not meeting the minimum requirements might experience performance issues.

**Note:** MS SQL Server 2016 is applicable to NSPOS release 2018.2.0 or greater only.

**Important:** MS SQL Server 2016 will not function on Windows 7, Windows Vista, Windows Server 2008 R2 or other earlier operating systems.

### Minimum Server with POS Hardware Specifications

- **Processor speed:** 3.2 GHz (2 cores 4 threads)
- **Processor type:** Intel Dual-Core / Core i3 (or AMD equivalent) or above
- **Operating system:** Windows 64 bit
  - Windows Embedded POSReady 7
  - Windows 7 Professional
  - Windows 8.1
  - Windows 10
RAM: At least 6 GB (8 GB recommended)
Solid state drive (SSD): 30 GB free space or above

Recommended Server with POS Hardware Specifications
- Processor speed: 3.2 GHz (4 cores 4 threads)
- Processor type: Intel Dual-Core / Core i5 (or AMD equivalent) or above
- Operating system: Windows 64 bit
  - Windows Embedded POSReady 7
  - Windows 7 Professional
  - Windows 8.1
  - Windows 10
- RAM: At least 8 GB (16 GB recommended)
- Solid state drive (SSD): 30 GB free space or above

Supported OPOS Peripheral Types
NetSuite POS supports the following OLE for Retail Point of Sale (OPOS) compatible devices. You should confirm support for specific device models with your hardware provider.
- POS Printers
- Bar Code Scanners
- PIN Pads
- Signature Capture Devices
- Magnetic Stripe Readers (MSRs)
- Line Displays
- Cash Drawers

Benchmarks for Data Transfers and System Limits
The benchmark statistics presented in this topic are from tests run on a NetSuite Point of Sale (NSPOS) 2017.1.x environment.

The numbers represent the benchmark data-transfer rates for synchronizing information between NSPOS register terminals and NetSuite ERP. The topic includes scenarios for improving data throughput and provides system limitations for activities such as staging new registers. Transfers occur through a cloud-based replication server typical to the servers assigned to customers.
- Upsync Transfers from NetSuite POS to NetSuite ERP
  - Sending data from POS Terminals to the Replication Server
  - Processing backlogged data from a Terminal to the Replication Server
  - Sending data from the Replication Server to NetSuite ERP
- Downsnp Transfers from NetSuite ERP to NetSuite POS
- Replicating Partner Limit
- Workstation Staging / Provisioning Limits
Upsync Transfers from NetSuite POS to NetSuite ERP

These transfers from the POS use two steps:

- Sending data from POS Terminals to the replication server
- Sending data from the replication server to NetSuite ERP

Sending data from POS Terminals to the Replication Server

There should be almost no delay in getting data from POS terminals to the replication server. Transfers occur in near real-time. You can expect delays if a register is processing transactions offline (without replication server connectivity) and at some point is connected back.

Processing backlogged data from a Terminal to the Replication Server

If a register is processing transactions offline (without replication server connectivity) and at some point is reconnected, the delay in getting data from a terminal to the replication server depends linearly on the number of transactions.

For example, if a customer has 100 terminals processing transactions that went offline for 3 days, and there are 10,000 transactions a day from all terminals distributed equally, then the statistics for catching up and becoming current on the replication server are:

- 30,000 transactions total
- 300 transactions per terminal
- On average, all transaction data should be available on the replication server in 3.5 hours.

Important: These numbers are valid for a normal workload. If a mass update is performed in NetSuite ERP, it can significantly slow down the transfer of data from the POS terminals to the replication server. This is because replication server > terminal transfers have a higher priority than terminal > replication server transfers.

Sending data from the Replication Server to NetSuite ERP

The replication server sends data to NetSuite ERP via NetSuite SOAP Web Services. The transfer speed may differ based on the number of user accounts dedicated for integration with NetSuite POS (integration accounts) and the availability of SuiteCloud Plus (SC+) licenses for those integration accounts.

A maximum of three integration accounts can be used, either with no SC+ licenses or up to three SC+ licenses (one per account). A customer with three integration accounts that have no SC+ license is limited to three parallel connections to and from NS ERP. SC+ configurations can be adapted to improve bandwidth by increasing the number of connections. Each SC+ license adds up to 10 parallel connections.

Bandwidth depends on number of available connections and the average item count per transaction. The following chart lists the average bandwidth defined as the number of transactions per hour.

<table>
<thead>
<tr>
<th>Number of connections</th>
<th>Average item count per transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>650</td>
</tr>
<tr>
<td>5</td>
<td>3200</td>
</tr>
</tbody>
</table>
Benchmarks for Data Transfers and System Limits

<table>
<thead>
<tr>
<th>10</th>
<th>6600</th>
<th>6900</th>
<th>6000</th>
<th>4500</th>
<th>2200</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>10800</td>
<td>10000</td>
<td>7200</td>
<td>5200</td>
<td>2400</td>
</tr>
</tbody>
</table>

20 dedicated connections to NetSuite ERP will usually provide the best performance, but some customers will have different requirements. Note that not all integration accounts / SC+ connections can be used for upsync. Free slots must be available for downsync and real-time services such as Sales Orders and returns.

The default optimal configuration is 20 upsync, 5 downsync connections. This can be achieved with three SC+ licenses.

SC+ License Setup

After you purchase an SC+ License, it must be configured on the server. Contact NSPOS Customer Support to request the configuration.

Downsync Transfers from NetSuite ERP to NetSuite POS

These transfers also use two steps:

- Downloading data from NetSuite ERP to the replication server
- Distributing data from the replication server to POS Terminals

The current average bandwidth per hour is:

- 15,000 records from NetSuite ERP to the replication server
- 15,000 records from the replication server to POS Terminals

**Warning:** You should **not** perform mass record updates during business hours. Creating or importing large numbers of records while your stores are open can impact the synchronization process on your registers, reducing performance at checkout.

**Important:** You should limit Item and customer updates to **60,000 records or less per 24-hour period.** Updates greater than 60,000 records a day can impact synchronization across your network.

**Note:** SC+ license availability has no impact if only one type of records, such as items, is downloaded from NetSuite ERP at the same time. This is because the task only uses one job. If more than one independent record type is downloaded at the same time – such as items and customers – and an SC+ is available, records are downloaded in parallel.

Location / Terminal Influence on Downsync

Downsync bandwidth is strongly influenced by the number of locations / terminals. The downsync numbers listed here are valid for up to 100 locations / 200 terminals. The more locations, the smaller the bandwidth. The dependency is not linear.

Replicating Partner Limit

We support up to 1200 replicating partners on one standard implementation. Replicating partners are **Standalone** terminals and **Server with POS** terminals providing database services to other registers.
Workstation Staging / Provisioning Limits

The following limits apply to staging and mass staging registers. For details on the two staging types and the processes used for each, see Set up a Register.

On-demand, single register staging

On-demand staging is initiated from a register's RA-Workstation record. The process uses an installation URL to download a staging package to the register represented by the record.

Limitations:
- You can stage up to 5 registers in parallel (at the same time).
- Installation URLs are valid for 24 hours only.

Scheduled, mass register staging

Scheduled staging is performed from the NSPOS Workstations Provisioning for Mass Staging tool. Use this tool to create multiple provisioning URLs and their accompanying staging packages from a single NetSuite ERP page.

Limitations:
- You can stage up to 30 registers in parallel.
- Installation URLs are valid through the period defined by Provisioning Start and End dates.
  The default period is four days, maximum period is seven days.

Subsidiaries, Locations, Taxes

Use this NetSuite Point of Sale (NSPOS) chapter to work with your Subsidiaries, your store or outlet Locations, and the tax configurations associated with your Locations.

- Work with Subsidiaries
- Work with Locations
- Map Sales Tax Locations by Group or Code
- Define tax schedules for Items
- Tax Rounding Discrepancies – Set up Discount Items to Prevent
- Considerations for Returns after Tax Adjustments to Discounts
- Errors when No Tax is Available

Work with Subsidiaries

Subsidiaries in NetSuite Point of Sale (NSPOS) provide a means for managing data across a hierarchical structure of separate legal entities. Retailers commonly set up subsidiaries based on business divisions, geographical territories, or areas of item availability. How you use and organize subsidiaries depends on your unique business needs.

⚠️ Important: Customers can return items between locations, but not across different subsidiaries.

Subsidiaries are structured as levels that roll up to a top-level parent subsidiary. The parent level is the highest subsidiary in your account; all other subsidiaries are below the parent in the hierarchy.
Subsidiaries are associated with NetSuite OneWorld accounts. For more information about subsidiaries, search for Subsidiaries in OneWorld in the NetSuite Help Center.

**Note:** Some NSPOS retailers do not use a NetSuite OneWorld setup. These retailers will not have subsidiaries and will not see the options for working with them.

### Adding and editing Subsidiaries

Use the steps in this section to add and edit subsidiaries for your NSPOS environment. The procedure covers the basic fields only. For a complete list of options and additional help, see the help topics Creating Subsidiary Records and Editing Subsidiary Records.

**To work with Subsidiaries:**

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Subsidiaries.
3. To create a Subsidiary, click **New Subsidiary**.
   - To work with an existing Subsidiary, review the list and click **View** or **Edit**.
4. Complete the fields required for NSPOS.
   - **Name** – Enter alphanumeric characters for the name of the subsidiary.
   - From the **Subsubsidiary of** field, select the subsidiary level above your new subsidiary. This level is often the parent level.

   **Important:** You cannot change the **Subsubsidiary of** choice after you save the subsidiary record.

5. Click **Save**.

   ![Subsidiary form](image)

   - Select the **State/Province** associated with the subsidiary's headquarters, main office, or other point of reference.
   - Select the **Country** associated with the subsidiary.
   - Select the **Language** associated with the subsidiary.
   - Select the **Currency** used for store locations in the subsidiary.

Other fields on this page are optional. The requirements can vary based on your business and accounting needs. For example, you might be required to complete other fields or some fields might not appear, such as **Country** and **Language**.

5. Click **Save**.
Important: If you add a subsidiary, you must authorize your Integration Role to work with it. This requirement applies to NSPOS 2018.2.0 and greater.

To authorize your NSPOS Integration Role to a new Subsidiary:

1. Log in to NetSuite ERP as an administrator.
2. Go to Setup > Users/Roles > Manage Roles.
3. Search or scroll down to find NSPOS Integration.
4. Click Edit.
5. In the Selected Subsidiaries list, select all subsidiaries. (Hold the Shift or Ctrl key.) This action will include your new subsidiary.
6. Click Save.

Work with Locations

Locations are your stores, outlets, warehouses, or any other type facility in which you operate NetSuite Point of Sale (NSPOS) register workstations.

Use the steps in this section to add and edit Locations for NSPOS. The procedure takes place in NetSuite ERP and includes the basic fields only. Not all options listed here may appear for your implementation. For a complete list of options available on the Location record, see the help topic Creating Locations.

Important: To allow for tax updates, the Address, including the country, must be set for each location.

To work with Locations:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Locations.
3. To create a Location, click New Location.
   To work with an existing Location, review the list and click View or Edit.

4. Complete the fields required for NSPOS.
   - Name – Enter the name of the Location.
   - Subsidiary – Select the Location's subsidiary or, if none, the parent company. Ensure your choice is correct.
- **RA - Store Size Unit** – (optional) If your account is configured for physical Store Size, select the unit of measurement used to list the size.
- **RA - Store Size** – (optional) If your account is configured for physical Store Size, enter the size of the store.
- **RA-Prices Include Tax** – Select if items sold at this location include sales tax in the price.
- **RA–Location Type** – Select the type of location, such as Retail Store.
- **RA-Default Customer** – If different from your default, select the anonymous customer to be used in the event a customer does not provide information when making a sales or other transaction.
  If left blank, anonymous transactions at this Location are automatically assigned to your company default.
- **RA-Currency** – (optional, but recommended) Set the currency type used in the location. Required if Location sells NetSuite Gift Cards/Certificates.
- **POS-Price Level** – (optional) If applicable, select a price level at the Location to be used instead of the standard base price. For example, if the Location uses outlet store or online pricing. See Add a Price or Price Levels to an Item.
- **Override Tax Item** – (optional) Select when taxes calculate at the Location using a non-inventory sale item.
  This setting replaces standard tax groups. Commonly used for areas and industries with restrictive tax rules, such as certain states and countries or sales of clothing items with alternate taxes.
- **Address** subtab – Click Edit, complete the fields, click OK.

**Important:** To allow for tax updates, set the Address > Country.

- **Tax Configuration** subtab – See Map Sales Tax Locations by Group or Code To define taxes for a Location.

5. Click Save.

Map Sales Tax Locations by Group or Code

In NetSuite Point of Sale (NSPOS), we calculate sales tax and value added tax (VAT) through custom RA-TaxSchedule records you create in NetSuite. This enables setting tax rates by location and assigning rates to item records. It is helpful for products that may be taxable in one jurisdiction, but have a different tax status in another.

Note that tax groups and codes, RA-TaxSchedules, and location records are all closely linked. You can set up tax groups or codes for locations within an RA-TaxSchedule definition, or you can set these up from a location record. Tax codes are helpful for doing business in countries and other jurisdictions that require codes instead of groups.
Availability varies by country. Some implementations may require assistance from NetSuite Professional Services.

⚠️ **Important:** To allow for tax updates, the store Location > Address > Country must be set for each location.

⚠️ **Important:** To prevent tax issues with item returns after setting up new tax groups or codes, NetSuite recommends that you do not delete or inactivate old tax groups or codes.

When a shopper returns an item for a refund, NetSuite ERP uses the tax group or code in place during the original sale to process the refund transaction. If the group or code is not available, NetSuite ERP considers the transaction to be invalid and rejects the transaction import from the server.

The transaction becomes “stuck” on the server, with the send / rejection cycle repeating each night. Keep all previous tax groups and codes active until you are certain that no future transactions will require them.

**Note:** Due to complexities with implementing the Canadian goods and services tax (GST), NetSuite Professional Services must configure all Canadian sales tax setups.

### To create a new RA-TaxSchedule:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-TaxSchedule row.
4. Click New Record.
5. Complete the fields at the top.
   - **Name** – Name for your new schedule.
   - **Receipt Text** – Two-character code identifying the category of goods related to the tax schedule. For example, enter GR for groceries.
   - **Description** – Brief description of the schedule. Include any special considerations up to 255 characters.
6. For each location that should use the new schedule, select the **Tax Code/Group**.
   You can search by entering the first portion of the Tax Code or Group name. You can also click the down arrows and choose List.

   ✔️ **Tip:** If a Tax Group and a Tax Code share the same name, the first entry in the list is the Tax Group.

7. Click Save.

**Note:** If you have many locations and make a large number of changes at one time, NetSuite will periodically prompt you to save your work.

### To verify tax groups by country:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Accounting > Tax Groups.
3. Click the **Country** column to order the list.
4. Check the **Tax Groups** associated with that country.
5. Verify the **Tax Groups** and rates associated with each country as needed. To view details, click the tax group **Name**.

**To verify tax codes by country:**

1. Log in to NetSuite as an administrator.
2. Go to Setup > Accounting > Tax Codes.
3. Click the **Country** column to order the list.
4. Verify the **Tax Codes** and rates associated with each country as needed. To view details, click the tax code **Name**.

**To define taxes for a new location:**

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Locations.
3. Click **New Location**.
4. Complete the required fields.
5. Click the **Tax Configuration** subtab.
6. Under **Tax Schedules Configuration**, select the **Tax Code/Group** to use for each type of tax schedule or category.

<table>
<thead>
<tr>
<th>Address</th>
<th>System Notes</th>
<th>Tax Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INTERNAL ID</strong></td>
<td><strong>NAME</strong></td>
<td><strong>TAX CODE/GROUP</strong></td>
</tr>
<tr>
<td>1</td>
<td>Taxable</td>
<td>TS-1</td>
</tr>
<tr>
<td>2</td>
<td>Non-Taxable</td>
<td>TS5-1</td>
</tr>
<tr>
<td>3</td>
<td>Services • Taxable</td>
<td>TS-3</td>
</tr>
</tbody>
</table>

You can search by entering the first portion of the Tax Code or Group name. You can also click the down arrows and choose **List**.

**Tip:** If a Tax Group and a Tax Code share the same name, the first entry in the list is the Tax Group.

7. Under **Default Zero Tax Item** field, select the **Tax Code/Group** to use when no tax should be calculated. For example, select the tax group to use when a calculation error occurs or when a purchase is made by a tax-exempt organization.

**Warning:** Tax groups and tax codes should be assigned on a country-specific basis.

**Important:** RA-TaxSchedule record changes synchronize to NSPOS daily. Assigning new or modified RA-TaxSchedules or rates to items or locations must occur after the daily synchronization.

**Define tax schedules for Items**

Tax schedules are item categories that are subject to taxation rules. You can define item categories like Services and Groceries if items must be taxed using different rules at a location. This is important for ensuring you meet your country requirements.
Each item must have an assigned tax schedule that determines the tax rate to be applied to the item based on the location where the purchase is made. Set up the tax schedule and the tax codes/groups first, and then apply the tax schedule to the item in the item record.

**To set up a tax schedule for an item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click **Edit** for the desired item.
4. Click the **Accounting** subtab.
5. Under **Tax/Tariff**, select the **Tax Schedule**.
6. Click **Save**.

**Important:** RA-TaxSchedule record changes synchronize to NSPOS daily. Assigning new or modified RA-TaxSchedules or rates to items or locations must occur after the daily synchronization.

**Tax Rounding Discrepancies – Set up Discount Items to Prevent**

Discrepancies caused by rounding differences can occur when tax is applied to the transaction total in NetSuite Point of Sale (NSPOS), but calculated against line items in NetSuite ERP. The invoiced amount shown in NetSuite ERP can be different by a small fraction (approximately $0.01) from the amount received at the register in NSPOS.

NSPOS includes a script that in most instances will resolve these errors. The script uses posting and nonposting Discount Items in NetSuite to automatically adjust tax-rounding discrepancies. When a rounding discrepancy causes an invoice in NetSuite to be higher or lower than the payment received, the script adjusts the invoice amount up or down to match the payment. This adjustment allows NetSuite ERP to show the invoice as closed (paid in full).

For example, if a payment was received at $10.64, but tax-rounding discrepancies caused the invoice to show $10.65, the invoice is adjusted down by -0.01 to $10.64.

Each **Discount Item includes a Rate that limits the adjustment amount allowed.** A common limit is 0.05, but your Accounting department must determine what limit is acceptable for your business processes. If an invoice discrepancy is more than the limit, the discrepancy must be handled manually in NetSuite ERP.

**To implement the script, you must:**

A. Determine the adjustment limit Rate. For example, adjust by 0.05 or less.

B. Set up two Discount Items:
   - Posting rounding difference
   - Nonposting rounding difference

**To set up Discount Items to adjust tax-rounding discrepancies:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items > New.
3. Under **Item Type**, click **Discount**.
4. For **Item Name/Number**, enter **Posting rounding difference**.
The item name **must** match exactly, including upper and lower case.

5. For **Rate**, enter the adjustment limit. For example, **0.05**.
   This is the maximum an invoice can be adjusted up or down. Do not enter a currency symbol.

6. Click **Save**.

7. Repeat using the **Item Name/Number** of **Nonposting rounding difference**.

**Please note that this script does not cover every scenario.** For example, rounding discrepancies can still occur when an item is returned/exchanged for a different item and the price difference creates a refund to the customer. Discrepancies can occur for transactions at locations that include taxes in each item's price. Either of these situations may require manual adjustment to eliminate differences between the two connected systems.

### Considerations for Returns after Tax Adjustments to Discounts

Usually the tax rate applied to a discount will be the same as the tax rate applied to the items sold. However, an administrator can make adjustments to tax rates associated with different parts of a transaction.

If a shopper returns an item purchased at a discount, and the tax for the discount was changed after the purchase, the refund amount will show the original taxes paid. This variance from the original and current discount tax rate could result in a difference between amounts logged for the transaction in NSPOS and the amount listed in NetSuite ERP.

Because NetSuite ERP does not prevent an administrator from making tax changes, the NetSuite customer is responsible for discrepancies in refund amounts caused by changing the tax rate applied to discounts.

**Important:** The NetSuite customer is responsible for discrepancies in refund amounts caused by changing the tax rate applied to discounts.

### Errors when No Tax is Available

In rare instances, an error situation can occur because an item was sold without a tax being applied. It is caused by a register having no tax configuration or by no tax-schedule information being available for the item. It does not apply to tax exempt (zero tax) sales.

Having no tax information for a transaction means that the transaction cannot upload to NetSuite ERP. Some point of sale systems might try to correct the upload by applying a default tax.

However, if the item is part of a validated return, the default tax recorded in the database would not match what the customer actually paid. The customer could be refunded more money than they paid.

To prevent this scenario, NSPOS will not sell any items without a tax schedule being available. The cashier will see an error when selling or attempting a validated return of such items, blocking the transaction from proceeding.

If your business policy permits it, a cashier can process the return as non-validated. Non-validated returns do not require information from the original purchase.

### Set up a Register

Use this section to add or reactivate NetSuite Point of Sale (POS OR NSPOS) registers in your stores. The first task describes configuring an RA-Workstation record for a register. This record establishes the register in NetSuite ERP and is necessary for enabling item, price and other synchronization. The second task guides you through staging the register to load and activate the NSPOS application.
Also included are procedures for using mass staging to provision multiple registers at one time. This provisioning tool is helpful for large projects, such as new store rollouts. Then we describe using Store Server Architecture to optimize your connection and database functions by assigning server and client roles to registers in your stores.

- Prerequisites for NSPOS
- Add an RA-Workstation Record in NetSuite
- Install MS SQL Server 2016 Service Pack 2 Express Edition
- Install MS SQL Server 2008 R2 Express Edition
- Stage a Register

Other setup tasks:
- Inactivating a Register
- Set up a Self-serve Kiosk

For large staging tasks and configurations:
- NSPOS Workstations Provisioning for Mass Staging
- Store Server Architecture
- Use Workstation Groups to customize Features for Select Registers

Prerequisites for NSPOS

The following are prerequisites that must be installed on each register workstation prior to staging. If you are upgrading from an earlier release, these are likely already installed. However, you should verify your setups.

If you have questions about a third-party installation, please contact the support department associated with the company that provides the application. NetSuite Customer Support is also available to guide you.

You should perform the installations in phases to ensure you always have working registers available.

- Microsoft® SQL Server 2008 R2 Express Edition with Service Pack 3 installed

  Note: The required SQL server is the Express edition.

- Microsoft Point of Service for .NET v1.14
- Microsoft .NET Framework 4.6.2
  For Windows 10, Microsoft .NET Framework 4.6.2 is included and installed automatically in the Windows 10 Anniversary Update.
- OPOS 1.14 for some devices.
  OPOS v1.14 is not required for peripheral hardware devices from the following manufacturers. It might be required for devices from other manufacturers. Please consult your hardware installation guides.
    - Epson®
    - Hewlett Packard (HP)®
    - Logic Controls®
    - Star Micronics®
    - Toshiba®
Ensure Token-based Authentication is enabled in NetSuite ERP

Token-based Authentication (TBA) is an industry standard for improving system security. NetSuite supports this authentication type for accessing NetSuite from client applications. TBA enables secure access without the need for SOAP web services or Restlets to hold user credentials.

We support token-based authentication for your integration user accounts. Each NetSuite account for NSPOS includes one to three integration users dedicated to handling synchronization between NetSuite ERP and your replication server.

Integration users are different from your standard users that log into NetSuite via the online user interface. TBA does not apply to access through the user interface. The feature does not require you to enter a token when you log into NetSuite ERP or NSPOS.

TBA for NSPOS requires that the Token-based Authentication box is checked on the Enable Features page.

**Note:** If this feature is already enabled, you do not need to change the setting.

**Important:** If the Token-based Authentication feature is not enabled, any bundle upgrades you perform can fail.

To enable Token-based Authentication in NetSuite ERP:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Enable Features (under Setup Tasks).
3. Click the SuiteCloud subtab.
4. Scroll to the Manage Authentication section and check the Token-based Authentication box.
5. Click I Agree on the SuiteCloud Terms of Service page.
6. Click Save.

Peripheral hardware

**HP, Logic Controls, Star Micronics and Toshiba:** We have tested these peripherals after installing the software required for NSPOS 2017.1. If you have the latest drivers installed, no further driver setup should be required. However, we recommend that you install the latest peripheral drivers and test all peripherals after installing the required software.

**Epson printers:** The recommended OPOS driver is Epson OPOS ADK v2.80 or later.
To verify which Epson OPOS driver is installed:

1. Click the Windows® Start button.
2. Open the Control Panel.
3. Click Programs or Programs and Features.
4. Review the list for the following drivers:
   - Epson OPOS ADK v2.70 or below
   - Epson OPOS ADK for .NET, any version
5. If either of these drivers is installed, replace it with Epson OPOS ADK v2.80 or later. Be aware that replacing the driver will reset your device configurations.

Device manufacturers not listed: Install the latest peripheral drivers and test all peripherals after installing the required software.

Add an RA-Workstation Record in NetSuite

The NetSuite Point of Sale (NSPOS) RA-Workstation record establishes a register in NetSuite ERP, enabling the exchange of information to occur through data synchronization. It defines the register's location, ID, payment gateway for credit or debit tenders and other important information. This record must be in place before you can stage a register.

Note: If you will stage the register immediately after creating the RA-Workstation record, NSPOS recommends using Internet Explorer®.

Warning: You cannot change the Location setting after saving the workstation record.

To prevent system issues, administrators cannot change the Location setting on the RA-Workstation record after creating the record in NetSuite. If you must move a register to another store, first create a new RA-Workstation record with the desired Location and inactivate or delete the old workstation record. Then stage the register for the new Location.

To add a register RA-Workstation record:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Review the list to ensure the register's record does not already exist.
5. Click New RA-Workstation.
6. Set Custom Form to RAPOS Workstation Form.
7. Complete the required fields:
   - Name – Enter a descriptive name that will assist you in identifying the register in the RA-Workstation list.
   - Location – Select the store in which the register will be used.
   - Lane Number – Enter the register's lane assignment in the store.
   - Till Count – Enter the number of physical till (cash) drawers the register is capable of supporting. If the register has no till drawers, enter 1.
Set up a Register

- **Workstation Type** – Select Sales for a register that defaults to your standard setup. Or, if pre-configured, select a named RA-WorkstationGroup for a custom register subset Type. NetSuite POS does not support Mobile setups.

**Note:** For information on using RA-WorkstationGroup records for a Workstation Type, see Use Workstation Groups to customize Features for Select Registers.

- **Payment Provider** – Select the provider to be used for credit and debit card payment processing.

For providers that require configuration to enable their payment gateway in NetSuite POS, this opens the Payment Provider section. For the steps to set up Shift4, Vantiv (MPS) or FreedomPay, see Payment Gateways.

- **Provisioning section** – Leave blank until you are ready to install NetSuite POS on the register. See Stage a Register.

8. **Complete optional fields as desired:**

   - **Inactive** – Leave the check box blank. Use this option only to take an existing register offline from the synchronization process.
   - **Manufacturer Name** – Enter the register brand.
   - **Model** – Enter the register model.

9. Click **Save**.

Install the Microsoft SQL Server application

Each register requires having a Microsoft SQL Server installed. You have two choices:

- Microsoft® SQL Server® 2016 Service Pack 2 Express
- Microsoft® SQL Server 2008 R2 Express Edition with Service Pack 3 installed

We began supporting **Microsoft SQL Server 2016** in NSPOS release 2018.2.0.

- Install MS SQL Server 2016 Service Pack 2 Express Edition
- Install MS SQL Server 2008 R2 Express Edition

**Important:** Before installing MS SQL Server 2008 R2, please read about the MS SQL Server 2008 R2 Deprecation Timeline.

MS SQL Server 2008 R2 Deprecation Timeline

Microsoft will deprecate or has deprecated support for MS SQL Server 2008 R2 on July 9, 2019. The deprecation means that regular security updates from Microsoft will end for MS SQL Server 2008 R2. Microsoft might offer extended security-update plans for these versions. You can contact Microsoft for more information.

Install MS SQL Server 2016 Service Pack 2 Express Edition

Installing and configuring one of the Microsoft SQL Server applications listed in this guide is a requirement for NetSuite Point of Sale (NSPOS) registers.

Follow the steps in this chapter to install and configure the Microsoft® (MS) SQL Server® 2016 Service Pack 2 Express Edition. The contents include the prerequisites, steps for a new installation, and steps for upgrading from MS SQL Server 2008 R2 Express Edition SP3.
Set up a Register

■ MS SQL Server 2016 with SP2 Express System Requirements
■ New Install – MS SQL Server 2016 with SP2 Express
■ Upgrade – MS SQL Server 2016 with SP2 Express

Also important is the section to Configure your MS SQL Server for CLR Integration with NSPOS.

MS SQL Server 2016 with SP2 Express System Requirements

You must meet these requirements for each register on which you install MS SQL Server 2016.

■ Processor
  □ 64-bit processors only
  □ Minimum speed of 1.4GHz (2.0GHz recommended)
■ RAM dedicated to MS SQL Server 2016
  □ 512MB minimum for Express editions (2GB recommended)
  □ 1GB minimum for all other versions (4GB recommended)
■ Operating System
  □ Windows Server 2016
  □ Windows Server 2012 R2
  □ Windows Server 2012
  □ Windows 10
  □ Windows 8.1
  □ Windows 8
■ Disk space
  □ Minimum of 6GB free for the server setup. This free space does not include the space required for the NSPOS databases.

**Important:** MS SQL Server 2016 Service Pack 2 Express will not function on Windows 7, Windows Vista, Windows Server 2008 R2 or other earlier operating systems.

New Install – MS SQL Server 2016 with SP2 Express

Follow the steps in this topic to install the Microsoft® (MS) SQL Server database application as a new installation on your NetSuite Point of Sale (NSPOS) registers.

Application Prerequisites

■ MS Windows 8.1 or higher (64 bit) operating system
■ MS .NET Framework 4.6.2 or higher

**Download the MS SQL Server Installer files:**

   The site will show the **Download** link for Microsoft® SQL Server® 2016 Service Pack 2 Express
2. Select the **Language** and click **Download**.  
This action downloads the initial installer file.

3. If prompted to **Run** or **Save**, choose **Save**.  
Depending on your browser, the file will be saved to the **Downloads** folder designated in your browser settings or you might be prompted to choose a location.

4. Locate the initial file: **SQLServer2016-SSEI-Expr.exe**.

![Image of SQLServer2016-SSEI-Expr.exe]

5. Double-click the .exe file to begin preparing the application installer file download.

6. From the window that displays, select the **Download Media** option.

![Image of Download Media option]

7. Select the preferred **Language**.

8. Select the **Express Core** option.

![Image of Express Core selection]

9. Click **Download**.

10. If prompted to **Run** or **Save**, choose **Save**.  
Depending on your browser, the file will be saved to the **Downloads** folder designated in your browser settings or you might be prompted to choose a location.

**Install the MS SQL Server Application:**

1. Locate the downloaded application installer file: **SQLEXPR_x64_ENU.exe**.
2. Double-click the .exe file to begin extracting the application installer files.

3. Choose a directory for the installation files and click OK. You will need to locate the setup.exe file in that directory.

4. Double-click setup.exe from the extracted files.

5. For Installation Type, choose:
   - New SQL Server stand-alone installation or add features to an existing installation

6. Accept the License Terms and Privacy Statement.

7. Click Next.

8. The NSPOS team recommends checking the Use Microsoft Update to check for updates option.

9. Click Next.

10. Click Next to accept the default feature choices.
11. Select the **Default instance** option.
12. Verify that the **Instance ID** is **MSSQLSERVER**, not SQLExpress. Change the ID if needed.

13. Click **Next**.
14. For **Service Accounts**, leave the **Account Name** choices at their defaults.
15. Click the **Collation** tab and verify that the **Database Engine Collation** is set to **SQL_Latin1_General_CP1_CI_AS**. If not, change it to this setting.

16. Click **Next**.

17. On the **Server Configuration** tab, choose **Mixed Mode**.
18. For each Password field, enter a password that meets your company's policy for password strength and complexity.

19. Verify that the account you are using to perform the installation is listed in the Specify SQL Server administrators area.
   If not, click Add Current User.

20. Click Next.

21. Complete the installation.

22. Click Close.

**Note:** If required, the SQL Server Management Studio needs to be installed separately using the Install SQL Server Management Tools option in the SQL Server Installation Center.

For more information, visit the official SQL Server Management Studio website.

### Next Steps

After installing the MS SQL Server, you must do a final configuration. See Configure your MS SQL Server for CLR Integration with NSPOS.

### Upgrade – MS SQL Server 2016 with SP2 Express

Follow the steps in this topic to upgrade your NetSuite Point of Sale (NSPOS) register Microsoft® (MS) SQL Server database application from MS SQL Server 2008 to 2016.
From either:

- MS SQL Server 2008 R2 (SP3) Express Edition (64 bit)
- MS SQL Server 2008 R2 RTM Express Edition with Advanced Services (64 bit)

To:

- MS SQL Server 2016 (SP2) Express Edition (64 bit)

Application Prerequisites

- MS Windows 8.1 or higher (64 bit) operating system
- MS .NET Framework 4.6.2 or higher
- MS SQL Server 2008 R2 (SP3) Express Edition (64 bit) or MS SQL Server 2008 R2 RTM Express Edition with Advanced Services (64 bit)

Identify your current Express version

To ensure you download the Express version currently on the register, you can either:

- Review the Server Properties within the SQL Server Management Studio
- Run the sqlcmd command in a command line window.

1. Open a Command line (cmd.exe).
2. Enter the following commands, pressing Return after each line.
   sqlcmd
   select @@version;
   Go

   The command window displays the Express version installed.
3. Press Ctrl + C to quit sqlcmd.
4. Exit the Command line window.

Download the MS SQL Server Installer:

   The site will show the Download link for Microsoft® SQL Server® 2016 Service Pack 2 Express

2. Select the Language and click Download.
   This action downloads the initial installer file.
3. If prompted to Run or Save, choose Save.
   Depending on your browser, the file will be saved to the Downloads folder designated in your browser settings or you might be prompted to choose a location.
5. Double-click the .exe file to begin preparing the application installer file download.
6. From the window that displays, select the Download Media option.
7. Select the preferred **Language**.

8. Select the **Express Core** option.

9. Click **Download**.

10. If prompted to **Run** or **Save**, choose **Save**.

    Depending on your browser, the file will be saved to the **Downloads** folder designated in your browser settings or you might be prompted to choose a location.

**Install the MS SQL Server Application:**

1. Locate the downloaded application installer file: **SQLEXPR_x64_ENU.exe**.

2. Double-click the **.exe** file to begin extracting the installation files.

3. Choose a directory for the installation files and click **OK**.

    You will need to locate the **setup.exe** file in that directory.

4. Double-click **setup.exe** from the extracted files.

5. For **Installation Type**, choose:

    - **Upgrade from a previous version of SQL Server**

6. Accept the **License Terms** and **Privacy Statement**.

7. Click **Next**.
8. The NSPOS team recommends checking the **Use Microsoft Update to check for updates** option.
9. Click **Next**.
10. Verify that the **Instance to upgrade** is **MSSQLSERVER**, not SQLExpress. Change the ID if needed.

11. Click **Next**.
12. For **Service Accounts**, leave the **Account Name** choice at the default.

   **Note:** The window might look different or not appear at all depending on your original MS SQL Server version.

13. Click **Next**.
14. Leave the **Full-text Upgrade** option at the **Import** default.
15. Click Next.
16. Follow the on-screen steps to complete the installation.
17. Click Close.

### Note:
The 2008 R2 version of SQL Server Management Studio can still be used with SQL Server 2016. If required, the current version can be installed using the Install SQL Server Management Tools option in the SQL Server Installation Center. For more information, visit the official SQL Server Management Studio website.

**Next Steps**

After installing the MS SQL Server, you must do a final configuration. See Configure your MS SQL Server for CLR Integration with NSPOS.

**Configure your MS SQL Server for CLR Integration with NSPOS**

Follow the steps in this topic to configure your NetSuite Point of Sale (NSPOS) SQL Server 2016 for CLR integration.

The Common Language Runtime (CLR) integration feature for MS SQL servers is disabled by default. You must enable it to use the NSPOS objects that are implemented using CLR integration.

**To configure the SQL Server:**

1. Open a Command line (cmd.exe).
2. Enter `sqlcmd` and press **Return**.

![Command Prompt](image)

3. Enter the following commands, pressing **Return** after each line.

   ```sql
   sp_configure 'show advanced options', 1;
   GO
   RECONFIGURE;
   GO
   sp_configure 'clr enabled', 1;
   GO
   RECONFIGURE;
   GO
   ``

4. Press **Ctrl + C** to quit `sqlcmd`.

5. Exit the **Command line** window.

### Install MS SQL Server 2008 R2 Express Edition

Installing and configuring Microsoft® SQL Server® 2008 R2 Express Edition SP3 or the newer MS SQL Server 2016 Service Pack 2 Express Edition version is a prerequisite for each of your NetSuite Point of Sale (NSPOS) registers.

Follow the steps in this chapter to install and configure the Microsoft® (MS) SQL Server® 2008 R2 Express Edition on your NetSuite Point of Sale (NSPOS) registers.

**Warning:** Microsoft will depreciate MS SQL Server 2008 in July 2019. If your NSPOS release is 2018.2.0 or later, you should Install MS SQL Server 2016 Service Pack 2 Express Edition instead.

**Important:** If not already done, you should install Microsoft .NET Framework 4.6.2 before installing the SQL Server. This framework application is automatically included and installed in the Windows® 10 Anniversary Update or greater.

The procedures cover the following tasks:

1. Download the SQL Server installation file and the Service Pack (SP3) file
2. Install the SQL Server with Service Pack 2 (SP2)
3. Install Service Pack 3 (SP3)
4. Use the SQL Server Configuration Manager
5. Configure the SQL Server Management Studio
Important: The setup includes performing a double-click and right-click. You should perform these steps using a mouse.

Note: Due to updates by Microsoft, the download links or setup steps might vary.

Download the SQL Server installation file and the SP3 file:
As of this writing, the Microsoft site does not include a direct link to download the SQL Server with Service Pack 3 (SP3) included. Instead, you will install the SQL Server with SP2 and then apply SP3.

1. Go to Microsoft SQL Server 2008 R2 SP2 - Express Edition and download the SQL Server with SP2.
   - For 64-bit systems (recommended), download: SQLEXPRADV_x64_ENU.exe
   - For 32-bit systems, download: SQLEXPRADV_x86_ENU.exe
2. Go to Microsoft SQL Server 2008 R2 Service Pack 3 and download SP3. This Service Pack includes support for the 2008 R2 Express Edition.
   - For 64-bit systems (recommended), download: SQLServer2008R2SP3-KB2979597-x64-ENU.exe
   - For 32-bit systems, download: SQLServer2008R2SP3-KB2979597-x86-ENU.exe
3. Install the SQL Server download first using the following steps. Then install SP3.

Install the SQL Server with Service Pack 2 (SP2):

1. Open SQLEXPRADV_x64_ENU.exe.
   - Or, for 32-bit systems, open SQLEXPRADV_x86_ENU.exe.
2. Begin the guided setup for SQL 2008 R2.
3. For the Installation Type, choose New installation or add features to an existing installation.

4. Check I accept the license terms.
5. Do not check Send feature usage data.
6. Click Next.
7. Click Select All to choose all Features.
8. Clear the option for SQL Server Replication, so that it is no longer checked.
9. Click **Next**.
10. Choose the **Default Instance**.
    The **Instance ID** should be **MSSQLSERVER**, not SQLExpress.

11. Click **Next**.
12. In the **Account Name** column, for **Service Accounts**, leave the accounts at the defaults:
    - **SQL SVR DB Engine**: NT AUTHORITY\NETWORK SERVICE
    - **SQL SVR Reporting Services**: NT AUTHORITY\NETWORK SERVICE
13. Click the **Collation** tab and verify that **Database Engine Collation** is set to **SQL_Latin1_General_CP1_CI_AS**. If not, change it to this setting.
14. Click **Next**.
15. On the **Account Provisioning** tab, choose **Mixed Mode**.
16. For each **Password** field, enter a password that meets your company's policy for password strength and complexity.
17. For **Specify SQL Server administrators**, verify that the account you are using to perform the installation is listed in the **Specify SQL Server administrators** area.
    If not, click **Add Current User**.
18. Click **Next**.
19. Choose **Install, but do not configure report server**.

20. Click **Next**.
21. Leave the **Send Windows and SQL Server Error Reports**... option clear.
    Instead, click **Next**.
22. Click **Close**.
23. If needed, click the **X** to exit the installation window.

**Install Service Pack 3 (SP3):**

1. Open **SQLServer2008R2SP3-KB2979597-x64-ENU.exe**.
   Or, for 32-bit systems, open **SQLServer2008R2SP3-KB2979597-x86-ENU.exe**.
2. When prompted, click **Next**.
3. Check **I accept the license terms**.
4. Do not check **Send feature usage data**.
5. Click **Next**.
6. Do not change the default **Instances**.
Set up a Register

The only instance checked should be MSSQLSERVER.

7. Click Next.
8. If prompted, close any applications that might prevent the installation.
9. Click Next.
10. Click Update.

Note: This update will take awhile to install.

11. Click Close when the update is complete.

Use the SQL Server Configuration Manager:

1. Start the SQL Server Configuration Manager.
   For example, go to Start > All Programs > Microsoft SQL Server 2008 R2 > Configuration Tools >
   SQL Server Configuration Manager.
2. If prompted, click Yes to allow configuration.
3. In the left pane, double-click SQL Server Network Configuration.
4. In the left pane, click Protocols for MSSQLSERVER.
5. In the right pane, right-click TCP/IP to enable the setting.
6. Click OK
7. Click File > Exit to close the SQL Server Configuration Manager.

Configure the SQL Server Management Studio:

1. Start the SQL Server Management Studio.
   For example, go to Start > All Programs > Microsoft SQL Server 2008 R2 > SQL Server Management
   Studio.
2. For the Server Name, enter localhost.
   Leave all other options at their default.
3. Click Connect.
4. Right-click the parent folder localhost (SQL Server...) and select Facets.
5. In the Facet list, select Surface Area Configuration.

   ![Facet Configuration.png](attachment:image)

6. Set ClrIntegrationEnabled to True.
7. Click OK.
8. Right-click the parent folder localhost (SQL Server...) and select Restart.
9. Click Yes to restart the MSSQLSERVER service.
   ▪ If prompted by User Account Control to allow changes, click Yes.
If prompted **Are you sure you want to restart the MSSQLSERVER service on XXX?**, click **Yes**.

10. After the MSSQLSERVER service restarts, click **File > Exit**.

## Stage a Register

Use the steps in this section to bring a NetSuite POS register online in your store. The process installs the latest NetSuite POS application package from the replication server and, depending on the Provisioning Type, will load current item, pricing, customer and other information.

In NetSuite terminology, staging is also called **Partner Provisioning**. Use staging to:

- Set up a new register.
- Bring disconnected registers up to date.
- Correct issues where a release upgrade was unsuccessful.

The initial process can begin from the register's RA-Workstation record or from the Installation URL generated from the NSPOS Workstations Provisioning for Mass Staging tool.

The **RA-Workstation** record for the register must already exist. See Add an RA-Workstation Record in NetSuite.

**Note:** If the install should fail due to a lost internet connection or other reason, you can repeat these staging steps.

**Important:** Staging POSClient registers requires a **skilled knowledge of system and network configurations**. You might need assistance from your store's system or network administrator.

### Guidelines and Important Information

When opening one or more new stores, it is important to consider the time needed to prepare the registers with current information from your NetSuite ERP setup. NetSuite recommends that you ensure all registers are ready **24-48 hours** prior to being used to process sales transactions. This time consideration also applies to registers that were previously active but have been turned off for a long time.

**Staging is an effective method for preparing registers in a short amount of time.** When a register is staged, all information is fully loaded and up to date. After staging, registers receive only the information needed to keep them current.

**Staging is an option for restoring a register that was offline and not in use.** When a register is turned off, NetSuite holds all new transactions, price changes and customer information for download to the register later. **If a register is turned off for an extended period**, the size of the update can be large and take extra time to download. This might delay a register from being ready when you need it. Staging is generally faster than waiting for large downloads to complete.
Preparing items and prices for new locations is a factor to consider. If new item setups require mass updates to NetSuite ERP, it is better to perform the updates before staging your registers.

To ensure your new registers are ready for business, NetSuite recommends the following:

1. Stage registers **24-48 hours before first use**. If no major changes to NetSuite ERP data will occur before using the register, the time between staging and first use can be longer without a significant impact on performance.

2. If a store rollout requires new item and customer information, if possible, be sure to add or import the information to NetSuite ERP **before** staging new registers. Then the new information will be included during the staging process.

3. To reduce the impact to existing registers, large item and customer changes in NetSuite ERP should be performed in small increments. A good guideline is **limiting changes to 60,000 records or less per day**, performed outside of business hours.

   If you are not certain how to limit the number of records or if this guideline does not fit your rollout schedule, please contact NetSuite Customer Support for assistance.

**Important:** You should use Internet Explorer® to stage or restage registers. Using a different browser can produce undesired results.

**Important:** If a register was inactivated in NetSuite ERP, you must clear the Inactive check box and re-provision the register.

Open the Installation URL

Use these steps to get and open the register's Installation URL. You can get the URL from the register's RA-Workstation record or you can get it from the NSPOS Workstations Provisioning for Mass Staging tool. The mass staging tool provides URLs from a CSV provisioning export or from an online list in NetSuite ERP.

**Note:** NetSuite POS strongly recommends using Internet Explorer® to stage registers. Using a different browser can produce undesired results.

To open the URL from the RA-Workstation record:

1. On the register to be staged, open Internet Explorer®.
2. Log in to NetSuite as an administrator.
3. Go to Customization > Lists, Records & Fields > Record Types.
4. Locate the RA-Workstation row and click List.
5. Locate the RA-Workstation record for the register and click View.
6. In the Provisioning section, review the Provisioning Status. It should be Not Provisioned or To be Provisioned.
   - If the section includes values for Provisioning Days, Start and End, the Installation URL is already available from the NSPOS Workstations Provisioning for Mass Staging tool.
   - If the Status is Provisioned, the register is already staged. If the register was disconnected for a long period or should be restaged for other reasons, continue with the following steps. Otherwise, no further action is required.
7. Click Edit.
8. Check the Provision box.
9. Select the Provisioning Type.
Set up a Register

- **Standalone** – Select this type if your environment does not use Store Server Architecture or if the register is the only workstation at the location.
- **Server With POS** – Used for store server environments. Select this type to stage the register as a server terminal.
- **POSClient** – Used for store server environments. Select this type to stage the register as a client terminal that relies on the assigned server for database functions.

10. Click **Save**. The **Provision** box will clear.

11. Click the **Installation URL**.

12. Follow the steps under **Install the NetSuite POS application within 24 hours**. If you are delayed, you must create a new Installation URL using the previous steps.

![Note:](image)

**Note:** For staging a register over a remote connection, you copy the Installation URL and paste it into the register's Internet Explorer ® address bar.

**To open the URL from the NSPOS Workstations Provisioning for Mass Staging tool:**

**Online**

1. Using **Internet Explorer®**, log into NetSuite from the register to be staged.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Click **New NSPOS Workstations Provisioning**.
4. Click the register's **Installation URL** to download the staging package and begin the installation.

**Export**

Open the CSV export on the register and click the URL to download the staging package. We strongly recommend using **Internet Explorer®**.

![Tip:](image)

**Tip:** You can email the CSV export to the personnel who will stage registers at each location.

**Install the NetSuite POS application**

Follow these steps after beginning the download from the Installation URL.

**Important:** Staging must be performed from a Windows **Administrator** account.

**To install the application:**

If you used Internet Explorer ® as recommended, the application opens automatically.

1. Click **Run** and **Yes** as required to begin the installation. The application is safe for your register.
2. When the **NetSuite Partner Staging Tool** opens, click **Next**.

3. The options for completing the **Connection Properties** form depend on the type of register you are staging.

   **Standalone** registers use a traditional direct connection to the replication server. For **Store Server Architecture** setups, **POSClient** registers connect to a **Server With POS** register database. Only the server register connects to the replication server for database synchronization.
Set up a Register

Server Name

- **Standalone** or **Server With POS** – Enter `localhost`.

⚠ **Important**: SQL Port (1433) – To set up a **Server With POS**, you must use and allow the standard SQL Port (1433) for remote TCP/IP connections. Otherwise, client registers will be unable to connect to the database. Also remote connections should be allowed for the SQL Server itself. Remote connections are enabled by default.

- **POSClient** – Click the down arrow and select the **Server With POS** ID to which the register will connect.

⚠ **Important**: **NetSuite ERP setup** – The **POSClient** must already be assigned to its **Server With POS** in NetSuite ERP. You can do this from the POSClient's RA-Workstation record or the NSPOS Workstations Provisioning record. Otherwise, the server will not appear in the list.

⚠ **Important**: **Network configuration** – Your network setup might affect whether the **Server With POS** appears in the list. If you cannot see the server, enter the server's **IP address** or **SQL Server instance network address**.

Log on to the server

You can use either authentication option – **Use Windows Authentication** or **Use SQL Server Authentication** – for all register types. However, you should review the following:

- **Standalone** or **Server With POS** – Because all processes are running on the same equipment, the default **Use Windows Authentication** should provide the required access.

- **POSClient** – Determining the correct option requires skilled knowledge of your network configuration.

- **Use Windows Authentication**:
  - Choose this option only if **Active Directory** is configured for your store network.
  - Each Windows user accessing NSPOS must have rights to connect to the database. If Windows authentication is not working, you can provide SQL server credentials upon being prompted by NSPOS.
important: the user under which the auto updater service is running (typically NT Authority\SYSTEM) must be able to authenticate via active directory. This configuration is the default. You can verify the setup in your system services list.

- use SQL server authentication – use this option if the windows authentication method will not meet your needs due to the access rights or configurations required to make it function correctly.

note: credentials provided during staging are used for staging purposes only. Each windows user might be prompted to enter credentials to access the database upon the first start up of NSPOS. The credentials required might be windows credentials and SQL server credentials.

test connection
- leave all other fields at the default.
- click test connection to verify your configuration is working.

If the connection fails, please review the connection properties steps again before contacting NetSuite customer support.

4. click OK.

Note: if you are restaging an existing register, the drop database dialog displays. Click yes to delete the current databases.

If you are restaging a register due to a technical issue, the register may hold transactions that did not replicate to the server. If so, the staging tool will refuse to delete the databases and staging will halt. Please contact NetSuite customer support for assistance.

5. Wait for the package downloads to complete. This may take from a few minutes to approximately one hour.
6. Click **Next** when the **NetSuite Point of Sale Setup Wizard** opens.

7. If desired, under **Custom Setup**, select optional extension features.

    NetSuite POS includes optional features that you can use to customize your installation. To set up a staged register with the same options as your other registers, you can review the **Extensions** folder setup on an existing register. See the steps that follow.

    ![Custom Setup](net_suite_point_of_sale_setup.png)

    **Important:** Some payment gateway setups require you to install their extension.
   
   **Shift4** – If using an Ingenico device, install the Ingenico extension.
   
   **Worldpay** (was YESpay) – Install the Worldpay extension.
   
   **PC-EFTPOS** – Install the EFTPOS extension.

8. Click **Next** and **Install** as prompted.

9. Click **Finish** when the installation completes.
The application and database configurations are now installed on the register.

10. Click the NetSuite POS shortcut installed on your desktop to ensure the register starts as expected.

To view optional extensions installed on another register:

1. Go to an existing register.
2. Open the NSPOS installation folder. For example: C:\Program Files\NetSuite\NetSuite Point of Sale\Extensions.
3. Review the .nspos filenames to identify the installed extensions.
4. If needed, work with NetSuite Customer Support to determine which extensions are required for your business processes.

Secure the Default Operator

Each register installation creates a default operator user 9999 on the new register with the default password Admin123. You should secure this user account by disabling the 9999 operator's role or resetting the password. This adjustment to the default operator is part of the NSPOS Payment Application Data Security Standard (PADSS).

**Warning:** After setting up a new register, you should secure the default operator by disabling the operator's role or changing the default password.

To disable the Default Operator:

Change the 9999 operator's Role to Disabled.

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F12 on the keyboard to open the Function List.
3. Enter edit operator in the search field.
4. Tap Edit Operator.
5. Search for operator 9999.
6. Tap the 9999 record.
7. Tap the Operator Role browse icon.
8. Select **Disabled**.
9. Tap **Done**.

⚠️ **Important:** After disabling the default operator’s role, you should verify that the change occurred. Do either of the following tasks.

**Repeat the first steps to change the operators role:**

Repeat steps 1 – 6. Verify that the **Operator Role** is **Disabled**.

**Try to log in as the default operator:**

Try to log in using the default operator name and password. You should not be able to log in, and see the following:

![Invalid user or password. Please try again.](image)

**To reset the Default Operator password:**

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press `Ctrl+F12` on the keyboard to open the Function List.
3. Enter `edit operator` in the search field.
4. Tap **Edit Operator**.
5. Search for operator **9999**.
6. Tap the **9999** record.
7. Tap **Set Password**.
8. Enter the new **Password**.
9. Enter the password again to **Confirm**.
10. Tap **Change**.

⚠️ **Important:** After resetting the password, you should verify that the default password is no longer valid. Perform the following task.

**Try to log in using the default password:**

Login to NSPOS using the default operator account **9999** and default password **Admin123**. You should see the following:
Inactivating a Register

You can inactivate an NSPOS register by checking the Inactive box on the RA-Workstation record in NetSuite ERP. This action removes it from synchronization updates. However, it also removes all data about the register from your replication server.

If a register is inactivated, it cannot be reactivated. If reactivation is desired, the workstation must be set up as a new register.

**Warning:** If a register is set to Inactive in NetSuite ERP, it cannot be reactivated. Instead, the register must be set up as a new register.

Set up a Self-serve Kiosk

An administrator can set up a workstation to function as an NSPOS kiosk register. This kiosk setup can serve two purposes:
It can let shoppers scan or enter items and tender out a purchase without the need for interaction with a cashier.

It can prevent a cashier from accessing the operating system or other applications besides NSPOS.

Most kiosk options use the account features available in Windows in combination with running NSPOS maximized in the workstation display. The administrator creates a “kiosk user” that limits operations to the NSPOS application. All other applications and most Windows functions are locked out. NSPOS can be set to launch automatically when the kiosk user logs to Windows. A shopper using the kiosk workstation cannot do anything outside of NSPOS.

The administrator or other authorized user can exit NSPOS and the kiosk account by pressing Ctrl+Alt+Del and logging in with a different account.

In general, users should follow these security recommendations:

- If a workstation includes an attached keyboard, try to prevent access to the Windows key. A shopper or cashier pressing that key can lock out the application by mistake.
- Consider setting the workstation startup features to automatically log in to the kiosk account and open NSPOS. This setup can prevent register downtime in the event the workstation undergoes a restart.
- Keep the authorized user or administrator account password strong so that a malicious shopper cannot bring up a log in page and access other features.

The kiosk setup procedures vary based on the Windows operating system running on the workstation. The following links contain helpful information for several operating systems, but you can find other sources by performing a search on the internet.

- Setup up a single-app kiosk: https://docs.microsoft.com/en-us/windows/configuration/kiosk-single-app
  Applies to: Windows 10 Professional, Enterprise or Education
  Applies to: Windows 8.1
- How to turn a Windows 7 PC into a Kiosk: http://jaredheinrichs.com/how-to-turn-a-windows-7-pc-into-a-kiosk.html
  Applies to: Windows 7 Professional

### Setting up a kiosk in Windows 10 Professional, Enterprise or Education:

Multiple methods are available for setting up a kiosk on a Windows 10 workstation. Methods include using the Assigned Access option, PowerShell, the Kiosk Wizard in Windows Configuration Designer, or using Microsoft Intune or other mobile device management (MDM) provider.

The following high-level steps use the **Assigned Access** option in Windows local settings. For more information, go to the Microsoft site Set up a single-app kiosk.

1. Create a local user account for the kiosk log in.
2. Go to Start > Settings > Accounts > Other people.
3. Select **Set up assigned access**.
4. Choose the kiosk account you created.
5. Choose **NetSuite Point of Sale** for the application.
6. Close the **Settings** window.
   The kiosk settings will be applied the next time a user signs into the kiosk account.

**Note:** To remove assigned access, choose **Turn off assigned access and sign out of the selected account**.

---

### NSPOS Workstations Provisioning for Mass Staging

Staging a new register involves several manual steps, including logging into NetSuite ERP and generating a provisioning URL for downloading the workstation-staging package. When provisioning a register from the **RA-Workstation** record, the provisioning URL generated from the record must be used within 24 hours.

To assist with setting up multiple registers, NSPOS provides a mass staging tool called **NSPOS Workstations Provisioning**. You can use this tool to create multiple provisioning URLs and their accompanying staging packages from a single NetSuite ERP page. The provisioning tool provides planning features and additional time in which to use each URL.

The workstations provisioning tool is designed for large retailers with many workstations, but any size retailer can use this tool to optimize the staging of multiple registers. In addition to preparing for mass staging, you can use the tool to view the current provisioning status of registers across all locations.

### System and Time Period Limitations

Due to the large impact on resources from preparing and installing packages, there are system limits to staging multiple registers at the same time. See **Workstation Staging / Provisioning Limits** in the Benchmarks chapter for information.

Workstation provisioning creates time-sensitive data bundled in packages that use valuable storage space. You must use each package URL within the period defined by its **Provisioning Start** and **Provisioning End** dates. The default period is four days, after which you must generate a new provisioning URL. The maximum period is seven days. To keep POS data current, the application regenerates packages every 24 hours.

**Note:** For details on workstation terms used in this topic, such as Server, ServerPOS, Standalone, and POSClient, see **Store Server Architecture**.

### Scheduling Staging Events

Use the NSPOS Workstations Provisioning page to plan and implement rolling out your new or restaged registers.

The page is split into three areas:

- **Defaults** – Set the default **Start Date** for new provisioning and the default number of **Days** to use the URLs.
  The **Start Date** defaults to today’s date. We recommend that you keep the default **Days** at 4.
- **Filters** – Find the registers you want by selecting from the lists and clicking the **Filter** button.
Provisioning – Use this section to schedule staging for the registers found in your filter results.

To Schedule Workstations for Provisioning:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the NSPOS Workstations Provisioning row and click List.
5. Use the Filters section to locate the desired registers. Click Filter to display the results.

The Status list is:

- **Not Provisioned** – Workstation is not staged and does not have a provisioning URL or staging package available.
- **To Be Provisioned** – Provisioning URL and staging package are ready for download. The record changes to this status when you check Provision on the RA-Workstation record.
- **In Provisioning** – Workstation provisioning package is being downloaded or preparing to be downloaded to register.
- **Provisioned** – Workstation is provisioned, meaning that it has been staged.

Note: All registers to be provisioned must have an RA-Workstation record already set up. For the steps to set up the record, see Add an RA-Workstation Record in NetSuite in the NetSuite Point of Sale Administrator Guide. Log into NetSuite first.
Set up a Register

- **Provision Planned** – The **Provisioning Start** date is set for URL and package generation. The record changes to this status when you check **Plan Provisioning**.

6. Check **Plan Provisioning** to schedule staging for the register.

**Warning:** If you select to re-provision one or more workstations that were previously provisioned, you must stage them within the time frame selected. If registers are offline or not re-staged, some replication data used to keep the workstations current might be lost.

7. Select the **Provisioning Type**.
   - **Server With POS** – Used for Store Server environments. Select this type to stage the register as a server terminal.
   - **POSClient** – Used for Store Server environments. Select this type to stage the register as a client terminal that relies on the assigned server for database functions.
   - **Standalone** – Select this type if your environment does not use Store Server architecture or if the register is the only workstation at the location.

8. Use the following as a guide to reviewing or completing the other fields:
   - **Name** – Register name as set up on the RA-Workstation record.
   - **Location** – Store location.
   - **Provisioning Status** – Current status of the register.
   - **Workstation Type** – Shows Sales for a register that defaults to your standard setup or, if pre-configured, will show the register's RA-WorkstationGroup that defines its custom register type.
   - **Provisioning Start** – Date the provisioning package will be generated for installation.
   - **Provisioning Days** – Number of days in which the provisioning URL must be used. We recommend four days (default) or less.
   - **Provisioning End** – Date by which the provisioning URL must be used. After this date, you will be required to generate a new URL.
   - **Installation URL** – Optionally click the link from the register to download the installation package. See **Applying Staging URLs to Registers**.

9. Click **Save & Export**.

   A CSV export listing the staging URLs downloads automatically to your browser's download folder. Save the export to use for staging each register.

<table>
<thead>
<tr>
<th>#</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>Installation URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>118</td>
<td>MP - 1</td>
<td>United States Location : Boston Store 1</td>
<td>Not Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>2</td>
<td>119</td>
<td>MP - 2</td>
<td>United States Location : Boston Store 1</td>
<td>Not Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>3</td>
<td>120</td>
<td>MP - 3</td>
<td>United States Location : Boston Store 1</td>
<td>Not Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>4</td>
<td>121</td>
<td>MP - 4</td>
<td>United States Location : Boston Store 1</td>
<td>Not Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>5</td>
<td>122</td>
<td>MP - 5</td>
<td>United States Location : OKC Store 4</td>
<td>To Be Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>6</td>
<td>123</td>
<td>MP - 6</td>
<td>United States Location : OKC Store 4</td>
<td>To Be Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>7</td>
<td>124</td>
<td>MP - 7</td>
<td>United States Location : OKC Store 4</td>
<td>To Be Provisioned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>8</td>
<td>125</td>
<td>MP - 8</td>
<td>United States Location : OKC Store 4</td>
<td>Provision Planned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
<tr>
<td>9</td>
<td>126</td>
<td>MP - 9</td>
<td>United States Location : OKC Store 4</td>
<td>Provision Planned</td>
<td>Provisioning Status</td>
<td>Provisioning Start</td>
<td>Provisioning End</td>
</tr>
</tbody>
</table>

**Note:** Dates use the time zone set up for your replication server, with the workstation package prepared at midnight on the Provisioning Start date. This time might not correspond to the time zones used at your register locations.

**Applying Staging URLs to Registers**

To use the Installation URLs, choose the method that best fits your needs:
Online

1. Using Internet Explorer®, log into NetSuite from the register to be staged.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Click New NSPOS Workstations Provisioning.
4. Click the register’s Installation URL to download the staging package and begin the installation.

Export – Open the CSV export on the register and click the URL to download the staging package.

Tip: You can email the CSV export to the personnel who will stage registers at each location.

Note: We strongly recommend using Internet Explorer® to stage registers. Using a different browser can produce undesired results.

For the steps to install staging packages, see Stage a Register.

Prior to using workstations provisioning for the first time, we recommend contacting NSPOS Customer Support to discuss your provisioning plan.

Store Server Architecture

The standard environment for registers in an NSPOS network is to communicate with and receive database updates from NetSuite ERP through direct connections to the replication server. Growing a business by adding many registers can impact replication server performance.

To assure performance for our larger retailers, NSPOS includes a Store Server Architecture option. Under this model, we define some registers in a store as server terminals that act as database hubs. These servers receive database updates from the replication server. Then we set other registers in the same store to be POSClient terminals that rely on the data held in the server terminals. The server terminals can act both as registers and databases, handling the information required for the POSClient terminals to process transactions. The terminal options are:

- **Standalone** – Regular workstation.
- **Server with POS** – Server terminal that is also available as a POS workstation.
- **POSClient** – POS workstation dependent on a server terminal for database functions and most communications. If a server terminal is shut down, its POSClient terminals will no longer function due to the lack of a database.

The Store Server approach significantly lowers the requirements for replication server performance. We can support more registers and provide better overall functioning using the same replication server instance.

Note: Although the server terminals handle most of the communication with the replication server, POSClient terminals still depend on replication server connectivity for displaying reports, or processing returns and real-time sales orders.

Important: Because a Server with POS terminal might be temporarily shut down for maintenance or repair, you should have two server terminals running in every location using Store Server Architecture.

The default setup is to assign all registers as standalone terminals. If you want to configure your registers to use Store Server Architecture, you can restage your terminals using the NSPOS Workstations Provisioning for Mass Staging tool.
Store Server fields on the RA-Workstation Record

Each register's RA-Workstation record in NetSuite ERP includes a Provisioning section on the NetSuite RA-Workstation record. The Provisioning Type lists the workstation's provisioned role.

If the role is POSClient, the section lists the workstation's server under a Database Owner Workstation field. Click the link to open the server's record.

If you need to reassign a POSClient to a different server, you must reprovision the workstation.

Use Workstation Groups to customize Features for Select Registers

You can assign subsets of your total NetSuite POS registers to unique groups and then modify those groups to use different logos, button layouts, or other features unique to a portion of your business. For example, you can use one logo for your large retail locations and use another for your smaller outlets. Other uses are setting up unique tender rules and permissions to areas within the application.

To configure your registers to use a workstation group, first create an RA-WorkstationGroup record in NetSuite. Then edit the desired register RA-Workstation records to select the group using the Workstation Type list. You only need to modify workstation records that will use the group.

Next, modify the layout or other features from a single register that is assigned to the group. The changes will replicate to all other registers in the group. You will need to exit and restart NetSuite POS on each grouped register for the changes to take effect.
To set up a Workstation Group:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-WorkstationGroup row and click List.
4. Review the list to ensure the group you want to create does not already exist.
6. Enter a Name for the new group.
7. If desired, enter a User Note Title and Memo that describes how the group will be used. Click Add.
8. Click Save.

To assign a Group to individual Registers:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. For the first register to assign, click Edit.
5. For Workstation Type, select the desired workstation group.
6. Click Save.
7. Repeat as needed for the remaining registers to be grouped.

For general Customization of Registers within a Group:

1. Sign on to a NetSuite POS register assigned to the group.
2. Touch Ctrl+F10.
3. Touch Group Settings.
4. Make changes as desired.
5. Touch Done.

For information on customizing layouts and other features, see Customize the User Interface and Security in NSPOS.

Customize the User Interface and Security in NSPOS

Watch a Related Video

Use this section to set up custom button bars, work with security settings for pages and forms, and set up other NetSuite Point of Sale (NSPOS) customizations for your registers.

- Customize Button Bars
- Set Button Security
- Set Page Security
- Customize the on-screen Keyboard
- Set up Item Hotkeys
- Customize a Prompt for Receipt
- Capture Signatures on a Tap Screen Tablet
Customize Button Bars

Watch a Related Video

The main button bar in NetSuite POS is located at the bottom of the journal. These buttons change what appears in the side button bar on the right. As sales associates work, each choice on the main bar or side bar can display a new button bar, form or journal entry.

The NSPOS layout is very flexible. You can customize any button or button bar to fit your business needs. You can change the button placement, color and size. You can add or remove buttons or even entire button bars. Any function available in NSPOS can be mapped to a button. To provide more control over specific processes, you can set levels such as requiring manager permission to accept returns without a receipt. (See Set Button Security.)

In the following example, the administrator uses colors to highlight a few frequently-used buttons. These make it easy for a sales associate to locate the buttons, even during the busiest shopping hours. Some business prefer to make all discount buttons green and buttons that void lines or cancel transactions red. Another option is to create buttons for ringing up items that do not have barcodes, such as produce and self-serve beverages.

By default, button bars are arranged as:

- Main button bar – 11 buttons per page, with pages corresponding to modes, such as Sales Mode or Closed Mode.
Side button bar – 11 buttons per main bar button. Tapping a main button opens a unique set of side bar buttons. Like main bars, side bar sets are called pages.

For each button, you can adjust its width and height. By reducing a button’s size, you can stack buttons to display two in a single position. This means that instead of having only 11 buttons on a page, you can have up to 22.

**Note:** For testing, at maximum button size, each page can display 11 buttons on each bar. Adding another button at maximum size may hide one of the existing buttons. For testing, ensure all buttons display and review how resizing the window affects the layout.

### To Customize the Button Bars:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press **Ctrl+F12** on the keyboard to open the Function List.
3. Enter **Button Edit** in the search field.
4. Tap **Button Edit**.
5. Tap **Main** (bottom) or **Side** and then tap **Pages**.
6. Tap a **Button Page**. For example, tap Discounts.
7. Tap **Activate** so that you can see the changes immediately.
8. Tap **Buttons**
9. Select a button and customize using the options below:
   - Tap **New** to create a new button.
   - Tap **Delete** to remove a button.
   - Set the **Caption** field to the name you want for the button.
   - Set the **Style** to change the button’s color.
   - Set the **Function** for the button by tapping **Browse** to search. Select the function and tap **Done**.
   - Tap **Edit Function** to change advanced configuration settings for the function.
   - **(Optional)** In the **HotKey** field, enter a key users can press to quickly access a function. For example, the default hotkey to sign off is F11.
   - **(Optional)** Set the **Target** page. This defaults to None. If you specify a page, when the user taps the button, NetSuite POS will go to that page when the function completes.
   - Check **Go Back** to display a green arrow on the Back button.
   - Adjust the position of the button in a grid by setting its **Column** number and **Row** number.
   - Adjust the size of the button by setting its **Width** and **Height** in blocks or units.
10. Close the window when your setup is complete.

### Example Button Setup for Edit Operator function:

Some retailers want a button that administrators can use to quickly reset an operator’s password. This button can appear on the “Closed” page that displays prior to signing on. Use this example to set up that button and other buttons.

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press **Ctrl+F12** on the keyboard to open the Function List.
3. Enter **Button Edit** in the search field.
4. Tap **Button Edit**.
5. Tap Main for the bottom bar and then tap Pages.
6. Tap the Closed button set. This button bar displays when no operator is signed on.
7. Tap Activate so that you can see the changes immediately.
8. Tap Buttons
   The buttons currently set up for the Closed set display on the left.
9. Tap New to create a new button.
10. Search for the words Edit Operator.
11. Tap the Edit Operator function.
12. Enter a name for the button in the Caption field or leave it at the default.
13. Choose a color from the Style list.
14. Set the placement for your button by changing the Column and Row fields.
15. If you want to make your button smaller or larger, adjust the Width and Height.
16. Close the Button Edit form when your setup is complete.

Set Button Security

As an administrator, you can customize the individual NetSuite POS features that each group can access by editing the Resource ID set up for a button function. A Resource ID is the code identifying a resource level. By default, the levels are:

<table>
<thead>
<tr>
<th>Operator Role / Group</th>
<th>Operator Role / Group ID</th>
<th>Resource ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Associate, Cashier, xPOS Access</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>Specialist</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>Opener / Closer</td>
<td>500</td>
<td>9050</td>
</tr>
<tr>
<td>Manager</td>
<td>700</td>
<td>9070</td>
</tr>
<tr>
<td>System Administrator</td>
<td>900</td>
<td>9090</td>
</tr>
</tbody>
</table>

To set Button Security:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F12 on the keyboard to open the Function List.
3. Enter Button Edit in the search field.
4. Tap Button Edit.
5. Tap Main (bottom) or Side and then tap Pages.
6. Tap a Button Page and then tap Buttons.
7. Select the button.
8. For the button **Function**, tap the edit icon.

9. Tap **Yes** to proceed.

10. Enter the desired **Resource ID** or tap the **Browse** button to search for it.

![Edit Function "Sales Order Fulfillment" dialog box](image)

**Note:** If the Resource ID shows a red icon and a gray field, tap the red icon to switch to edit mode.

11. Tap **Done** and close the window as needed.

### Set Page Security

As an administrator, you can customize the set of NetSuite POS features that each group can access by editing the **Resource ID** set up for a **button page**. A Resource ID is the code identifying a resource level. By default, the levels are:

<table>
<thead>
<tr>
<th>Operator Role / Group</th>
<th>Operator Role / Group ID</th>
<th>Resource ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Associate, Cashier, xPOS Access</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>Specialist</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>Opener / Closer</td>
<td>500</td>
<td>9050</td>
</tr>
<tr>
<td>Manager</td>
<td>700</td>
<td>9070</td>
</tr>
<tr>
<td>System Administrator</td>
<td>900</td>
<td>9090</td>
</tr>
</tbody>
</table>

**To set Page-level Security:**

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press **Ctrl+F12** on the keyboard to open the Function List.
3. Enter **Button Edit** in the search field.
4. Tap **Button Edit**.
5. Tap **Main** (bottom) or **Side** and then tap **Pages**.
6. Tap a **Button Page**.
7. Enter the desired **Resource ID** or tap the **Browse** button to search for it.
8. Changes are saved automatically. You can close the window.

**Customize the on-screen Keyboard**

In NetSuite POS, users can enter text and numbers with a traditional keyboard or through the on-screen keyboard. Options to customize the on-screen keyboard are limited, but you can set the width, the height, and whether to allow displaying the keyboard.

**To customize the on-screen Keyboard:**

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press **Ctrl+F10** to open the Universal Settings window.
3. Enter **keyboard** in the search field.
4. Set keyboard options as desired:
   - **Height** – How tall to display the keyboard in pixels.
   - **Width** – How wide to display the keyboard in pixels.
   - **Show on Startup** – Display the keyboard when NetSuite POS starts. This is useful for entering sign-on information without a keyboard attached to the register.
   - **Use On-Screen Keyboard** – Clear the check box to disable the option to display the keyboard.

**Set up Item Hotkeys**

Item hotkeys are buttons or groups of buttons that add items to the Journal when tapped. Set up hotkeys in NetSuite POS as a quick method for sales associates to ring up store specials, common items or hard-to-scan items. You find the Item ID first and then set it up as a hotkey.

**Find the Item ID:**

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. In **Sales Mode**, tap **Find Item** and look up the item to associate with the hotkey. You can just start typing and press **Enter**.
3. Make a note of the **Item ID**. This ID is not the Item ID that displays during sales transactions. Instead, it is the internal Item ID as shown in this screen shot.
4. Tap **Cancel** to close the Find window.
Create the item hotkey:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F12 on the keyboard to open the Function List.
3. Enter Button Edit in the search field.
4. Tap Button Edit.
5. Tap the Side set of buttons in the Button Bar list.
6. Tap Pages.

7. Tap the Item Hotkeys set of buttons in the Button Page list.
8. Tap Buttons in the lower-right corner.
10. In the Select a Function window, tap Create Function.
11. Tap Yes for Edit a function by name. Do you want to proceed?
12. In the Function Name field, enter a descriptive name for the function.
13. For Caption for Buttons, enter the text to appear on the button.
14. For Resource ID, tap the red blocked icon. It changes to the enter value icon.
15. Enter the security level required to use hotkey. Only enter the lowest level required:
   - 2 – Sales Associates, Specialists
   - 9050 – Openers/Closers
   - 9070 – Managers
   - 9090 – System Administrators
16. In the Message field, enter RunDefaultAction.
17. For Parameter, tap the red blocked icon. It changes to the enter value icon.
18. In the Parameter field, enter the Item ID. For example, ITM101669.
19. Tap Done.

20. In the Item Hotkeys on Side window, add formatting if desired. See Customize Button Bars for options.
21. If you want to test the hotkey, tap outside the Button Configuration window. Then tap Item Hotkeys and tap the new button in the side bar. You do not need to close the setup window to test.

22. When your setup is complete, tap X in the upper right to close the Button Configuration window.

Customize a Prompt for Receipt

You can set up a prompt that asks the cashier at the end of a transaction if the customer wants a receipt. You determine the content of the prompt and whether it will appear on all workstations, selected workstation groups only, or selected workstations only.

First you enter the receipt flag identifier and prompt text, and then you configure which workstations will use the prompt.

To configure the Receipt Prompt flag and text:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F12.
3. Search for and tap Configure Receipts.
4. Search for Retail.
5. If not done, check Enabled.
6. For Required Flag, enter: Receipts: Ask for Receipt
   
   Tip: Enter or copy/paste the flag text exactly as it appears here.
7. For Prompt, enter the desired text. For example: Does customer want a receipt? or Print receipt?
8. Tap Done.

To configure where the Receipt Prompt appears:

To configure all workstations to display the prompt, sign into any workstation. If you only want to configure a single workstation group or individual workstation, you will need to sign into a workstation within that group or into the desired workstation.

1. Sign in to the applicable NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F10 to open the Universal Settings.
3. Choose the area to display the prompt:
   - For all workstations, stay on the Universal Settings page.
   - For the current workstation group, tap Group Settings.
   - For the current workstation only, tap Workstation Settings.
   
   Note: Workstation Settings displays “Local Settings.”
4. Search for Receipts.
5. Check Ask for Receipt.
   
   If needed, tap the red blocked icon ❌ to allow editing.
6. Tap Done.
## Customize the User Interface and Security in NSPOS

**Note:** If you chose Group Settings or Workstation Settings, configure the receipt settings flag for each workstation group or individual workstation desired.

### Capture Signatures on a Tap Screen Tablet

If you are using a tablet as your NetSuite POS terminal, you can now also use it as a signature capture device.

**Note:** In order for signature capture to function, it needs to be selected as an installed option from the NetSuite POS application installer package.

**To enable signature capture on tablet devices:**

1. On the NetSuite Point of Sale Setup screen, select Tap Signature Capture.

   **Note:** Users can enable the capture signature feature at a later date, by re-opening the installer package and selecting Change.

2. Go to Universal Settings (Ctrl+F10) on the register and check the Require Signature box.

3. Complete the Signature Required Over: field, if transactions over a certain amount require a signature.
Contact NetSuite Customer Support if you want assistance with configuring this feature.

**Codes and Comments**

Use this section to set up the reason codes displayed and logged for various types of NetSuite POS transactions. Reason codes explain why a specific action was taken at the sales terminal or register.

- **Reason Codes**
- **Require Entering a Comment with Sale**

Also included are the steps to require that the cashier manually add a comment to an item transaction, such as a serial number or a comment about an item's physical condition.

**Reason Codes**

You can create and manage the reason codes displayed and logged for various types of NetSuite POS transactions by updating the codes in NetSuite. Reason codes explain why a specific action was taken at the sales terminal or register. For example, if a customer returns an item, you may want to tag the return transaction with an explanation of why they are returning the item – whether it was damaged, unwanted, or did not fit. Creating reason codes allows the flexibility to implement business rules effectively.

Reason codes are managed as sets of individual reasons that are grouped together by the activity that calls for them.

**Note:** For Tax Exempt transactions, sales associates must select a Reason Code to describe the exemption. If no Reason Code is available, the Tax Exempt button will not function. Please ensure that one or more Reason Codes are set up for Tax Exempt.

<table>
<thead>
<tr>
<th>Reason Group Code</th>
<th>Reason Group Name</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD</td>
<td>Adjustment Reasons</td>
<td>Reasons for conducting an inventory adjustment at the POS, such as theft or damage.</td>
</tr>
<tr>
<td>AR</td>
<td>Dollar Discount</td>
<td>Reasons for applying a manual price discount.</td>
</tr>
<tr>
<td>Code</td>
<td>Reason</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CA</td>
<td>Cash Reasons</td>
<td>Reasons for using cash.</td>
</tr>
<tr>
<td>CK</td>
<td>Check Reasons</td>
<td>Reasons for using a bank check.</td>
</tr>
<tr>
<td>CM</td>
<td>Comment</td>
<td>Reasons for using a comment.</td>
</tr>
<tr>
<td>CR</td>
<td>Cash Receipts</td>
<td>Codes associated with entries on a cash receipt.</td>
</tr>
<tr>
<td>CT</td>
<td>Cancel Transaction</td>
<td>Reasons for canceling a transaction.</td>
</tr>
<tr>
<td>DB</td>
<td>Disbursements</td>
<td>Defines the nature of the disbursement.</td>
</tr>
<tr>
<td>DS</td>
<td>Discount</td>
<td>Reasons for exceeding the authorized threshold limiting a discount amount.</td>
</tr>
<tr>
<td>FR</td>
<td>Funds Received</td>
<td>Defines the source of funds received.</td>
</tr>
<tr>
<td>IN</td>
<td>Internal</td>
<td>Internal reason codes required by NetSuite POS.</td>
</tr>
<tr>
<td>NP</td>
<td>Price Override</td>
<td>Reasons for a price override.</td>
</tr>
<tr>
<td>NS</td>
<td>No Sale</td>
<td>Reasons for a no sale transaction.</td>
</tr>
<tr>
<td>PR</td>
<td>Percent Discount</td>
<td>Reasons for applying a manual percentage off discount.</td>
</tr>
<tr>
<td>RC</td>
<td>Rental Condition</td>
<td>Rental condition returns.</td>
</tr>
<tr>
<td>RR</td>
<td>Rental Returns</td>
<td>Rental return codes.</td>
</tr>
<tr>
<td>SG</td>
<td>Operator Sign On/Off</td>
<td>Codes associated with abnormal sign on/off.</td>
</tr>
<tr>
<td>SR</td>
<td>Sale Return</td>
<td>Reasons for returning a sale (except validated returns).</td>
</tr>
<tr>
<td>TC</td>
<td>Time Punch Correction</td>
<td>Reasons for time punch corrections.</td>
</tr>
<tr>
<td>TE</td>
<td>Tax Exempt</td>
<td>Reasons for providing tax exemption to customers such as resellers.</td>
</tr>
<tr>
<td>TL</td>
<td>Till Activity</td>
<td>Codes associated with till activities such as drawer loans and pickups.</td>
</tr>
<tr>
<td>TM</td>
<td>Time Punch</td>
<td>Reasons for a manual time punch.</td>
</tr>
<tr>
<td>TP</td>
<td>Tender Pickup</td>
<td>Reasons for a tender pickup.</td>
</tr>
<tr>
<td>VD</td>
<td>Void</td>
<td>Reasons for voiding a transaction.</td>
</tr>
<tr>
<td>VR</td>
<td>Validated Return</td>
<td>Reasons for returning a sale (validated returns).</td>
</tr>
</tbody>
</table>

NetSuite is populated with all existing reason codes used in NetSuite POS. NetSuite stores reason codes as RA-Reason Code records.

**To create a new reason code:**

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records & Fields > Record Types.
3. Locate the RA-Reason Code row.
4. Click New Record.
5. In the Name field, enter the reason exactly as you would like it to appear in the sales terminal. For example, enter Window Washing for a service-related till disbursement.
6. In the RAPOS Code field, enter a unique four-character code.
### Codes and Comments

**Note:** NetSuite suggests using the first two letters of the **Reason Code Group** followed by a two letter abbreviation of the **Name** field.

**Warning:** Each **RAPOS Code** must be **unique**. Duplicate codes can result in incomplete entries in your Paid In / Paid Out records.

7. In the **Reason Code Group** field, select the group that represents the POS usage context, such as Disbursements.
8. Add instructions in the **Description** field.
9. Click **Save**.

New reason codes are available after the next sync between NetSuite and NetSuite POS.

**Note:** After being created, reason codes cannot be deleted as they may be linked to existing transactions. Check the **Inactive** box to prevent a reason code from appearing at the POS in the future.

### Require Entering a Comment with Sale

Sometimes when ringing up a transaction, you need to manually add information relevant to an item, such as a serial number or a comment about an item’s physical condition. The Comment Required box in NetSuite POS provides this functionality. Any comments added to a transaction appear in the NetSuite POS Journal and print on the sales receipt.

**To require a comment during a sale:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click **Edit** for the desired item.
4. Under the **Custom** subtab, check the **Comment Required** box.
    - The **Comment Message** field becomes active.
5. In the **Comment Message** field, enter the required message prompt to appear above the input field on the operator's POS terminal. For example, “Enter Serial Number”. The maximum message length is 40 characters.
6. Click **Save**. Allow time for the updated record to sync to NetSuite POS registers.

**To enter a comment during a sale:**

1. On a NetSuite POS register, add the product to a transaction. An **Item Info Required** window appears. Note that the prompt text you entered above is used as a field label.

![Item Info Required window](image)

2. Enter text and tap **Done**.

**Note:** The maximum length of comment is 255 characters, although all characters may not display in the NetSuite POS Journal. The comment is added as a line under the associated transaction line item. This comment is also printed on the customer’s sales receipt.

**Note:** If this window has any other fields present, all fields must be completed before you can tap **Done**.

The following image shows how a comment appears in the Journal.

![Comment in Journal](image)

**Work with Customer Records**

Every customer making a purchase is a potential repeat customer. Having purchase history and details easily available through a customer record can help you provide an interactive, personal experience for your shoppers.

This topic covers a few areas for working with customers in NetSuite Point of Sale (NSOPS). It includes fields in NetSuite ERP that are specific to NSPOS as well as working with the default anonymous customer. The default customer handles situations where the actual customer declines to provide information about themselves.

NSPOS synchronizes customer information via the replication server with NetSuite ERP. You can add and update customers at the register or in NetSuite. For NetSuite ERP records, you can add a large number of customers through a mass update.

- Working with a Customer Record in NetSuite ERP
- Working with a Customer Record in NSPOS
- Work with the Default Anonymous Customer
- Flags to Require Customer Information
Work with Customer Records

For more information about working with Customer records in NetSuite ERP, see the help topic Customers in the NetSuite ERP Help Center.

Working with a Customer Record in NetSuite ERP

Use these topics to work with Customer records online. Customer records synchronize with each register’s database.

To find and update a Customer record in NS ERP:

1. Log into NetSuite ERP.
2. Go to Lists > Relationships > Customers > Search.
3. Enter search criteria. A quick method is to enter any portion of the customer’s name in the Name/ID field.
4. Click Submit.
5. Locate the customer and click Edit (to update) or View.
   For more information, see the help topic Customers in the NetSuite ERP Help Center.
6. If editing, make your changes and click Save.
   The information will synchronize with your registers shortly.

Do not download option

The Customer record includes a Do not download to POS option. Checking this box prevents a customer’s information from synchronizing to your registers. It is useful for business processes that are restricted to online tasks not available in stores.

However, customers with this option checked should not be used for sales orders.

![Customer record with Do not download to POS option](image.png)

⚠️ Important: Do not create a sales order in NetSuite ERP for Customer records marked Do not download to POS. The sales order could cause an error from synchronizing to your registers without the required customer information.

To add a Customer record in NS ERP:

1. Log into NetSuite ERP.
2. Go to Lists > Relationships > Customers > New.
3. Under **Custom Form**, leave the choice at the default **Standard Customer Form**.
4. Add the information available about the customer.
   For more information, see the help topic **Customers** in the NetSuite ERP Help Center.
5. Click **Save**.
   The information will synchronize with your registers shortly.

## Working with a Customer Record in NSPOS

**Watch a Related Video**

Use these topics to work with Customer records from a register. Customer records in NSPOS synchronize with your account in NetSuite ERP.

### To find and update a Customer from an NSPOS register:

1. Tap **Find Customer**.
2. Search for the customer by drilling into alphabetized folders or by entering the first few letters of the customer's first or last name.
   Search results display after entering three characters. Searches do not require pressing any additional buttons, are not case sensitive, and match any part of a name. If you do not have a keyboard, tap the green **Show Keyboard** button.

   **Note:** NetSuite limits the search to customers in the same subsidiary as the store. Subsidiaries are different divisions or companies under a corporate parent.

3. Tap the customer's name.

   **Tip:** To view the customer's past five transactions, tap the customer's name again. Tap anywhere in the Journal to return.

4. Tap **Edit Customer**.
5. Make changes as desired and tap **Done**.
   The information will synchronize with NetSuite ERP shortly.

   **Note:** If the customer is not making a purchase or other transaction, you can clear the name from the Journal by tapping **Find Customer > No Customer**.

### To add a new Customer from an NSPOS register:

   **Note:** Search for the customer before adding them. This step helps to prevent duplicate entries.

1. Tap **Find Customer**.
2. Tap **Create Customer**.
3. Enter required and optional information.
   a. **Required** fields display an arrow.
   b. If the customer belongs to an **Organization** or **Customer Group** already set up in your system, select it. These are pre-defined by your system administrator. You cannot add an organization or group.
4. Tap Done.
The information will synchronize with NetSuite ERP shortly.

Note: If the customer is not making a purchase or other transaction, you can clear the name from the Journal by tapping Find Customer > No Customer.

Work with the Default Anonymous Customer

A benefit of NetSuite POS is that it can log your customers' transaction histories. This history allows sales associates to recommend additional items during a sale, and is helpful for customer inquiries about past purchases. For marketing staff, histories are a source for targeted campaigns and promotions. However, customers might decline to provide their name and other personal information when making a transaction. If customers decline, the transactions are assigned to a default customer in NetSuite. This default is also called the anonymous customer.

Default by Location record

NSPOS uses the RA-Default Customer listed on each Location record in NetSuite ERP to assign anonymous transactions by store. For Location records without a default customer, an automated job run periodically completes the transaction assignments. If you want to control how you track and analyze anonymous transactions, you should set the default on each store's Location record.

Note: For retailers new to NetSuite POS, each Location record must have a default customer assignment as part of the implementation process. For retailers upgrading from a previous release, the automated job assigns anonymous transactions for Locations without an assignment.

To set the default customer for a Location:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Locations.
3. Click Edit for the desired Location.
4. Select the RA-Default Customer.
5. Click Save.
6. Repeat for other specific, unassigned Location records as desired.

Do not change the Default Customer Sequence Number

Each default customer has its own sequence number. It is very important that you do not change this number. If the sequence number is not in the correct format and order, you will experience job scheduler errors that can impact your processing.

Warning: Do not change the default customer sequence number.

Flags to Require Customer Information

Universal flags set at the point of sale (POS) level determine whether selecting a customer is required to complete a transaction. This prevents assigning transactions to a default customer. You should only check one flag.
CustomerRequired – A customer-search popup displays when adding the first item to the journal. The sales associate cannot complete a transaction without manually selecting a customer.

RequireCustomer – A customer-search popup displays when selecting a tender. The sales associate cannot complete a transaction without manually selecting a customer.

To set a preference for requiring a customer choice:

1. Log into NSPOS as an administrator.
2. Press Ctrl+F10 to open the Universal Settings menu.
3. Search for the phrase CustomerRequired or RequireCustomer, depending on your store’s preference.
   - The CustomerRequired flag prompts for a customer when the cashier scans the first item.
   - The RequireCustomer flag displays the prompt at the end of the transaction, when the cashier taps Amt Due.
4. Check the CustomerRequired or RequireCustomer box. Only check one box.

   ! Important: Do not check both options.

5. Tap Done to save your changes
6. You must exit and restart NSPOS on each register for the change to take effect on that register.
ENVIRONMENT – OPTIONAL

Applies to: NetSuite Point of Sale (NSPOS)

Use this chapter to configure optional settings for the interaction between the NetSuite ERP application and NetSuite Point of Sale (NSPOS).

- Payment Gateways
- Money Management
- Flags and Settings

**Warning:** These topics describe making changes to the NSPOS default setup. Be aware that changes can impact custom configurations previously made to your business setup. NetSuite recommends that only experienced administrator personnel make setting adjustments.

Payment Gateways

This chapter describes setting up credit and debit card payment gateways in NetSuite ERP for NetSuite Point of Sale (NSPOS).

Each NSPOS register is connected to a payment gateway. Payment gateways are third-party applications selected by retail businesses to handle credit or debit card authorizations and other payment types that require special handling. When a cashier or the customer swipes a card as payment, your POS connects with the payment gateway and sends the card number, purchase amount and other information. The gateway processes the payment and returns an authorization stating the payment is accepted.

The capabilities of different gateway services vary in how they are set up and the features they provide. Work with your NetSuite Account Manager or Professional Services representative to determine which service meets your business needs.

- Shift4 UTG
- Worldpay
  - Worldpay (Vantiv)
  - Worldpay (YESpay)
- FreedomPay
- PC-EFTPOS
  - zipPay Integration through PC-EFTPOS

Shift4 UTG

NetSuite's integration with the Shift4 UTG (Universal Transaction Gateway) payment gateway can provide EMV and other functionally for your NSPOS setup.

To begin your setup with Shift4, visit their site at [www.shift4.com](http://www.shift4.com). Then review and follow the sections in this topic.

- Shift4 UTG controlled devices
  - Shift4 and EMV Receipt Requirements
- NSPOS controlled devices for Shift4
End of Day Report
Line Item display for Shift4 UTG PIN Pads
Credit or Debit Card default setting for Shift4 UTG PIN pads

We offer two methods for integrating Shift4 with your system. Use the “Shift4 UTG controlled devices” method to include EMV support.

Shift4 UTG (Universal Transaction Gateway) controlled devices
- Provides EMV support
NSPOS controlled devices
- Does not support EMV

Shift4 UTG controlled devices
Because this setup supports EMV, we strongly recommend using Shift4 controlled devices for your Shift4 setup. United States regulations for EMV liability requirements went into effect October 1, 2015.

Important: Before starting, you must have the following ready for each RA-Workstation on which you want to configure and use the Shift4 gateway.

Terminal ID: This is the serial number found on the register credit card PIN pad or swipe device. It is usually an 8-digit number. On many devices, this ID displays during the initial power-up.

URL: This is the URL/IP address of the server running UTG.

Client GUID: Contact NetSuite Customer Support and request the Client GUID value to enter in the steps below. This value will be the same for all RA-Workstation records.

Authentication Token: Each RA-Workstation record requires a unique Authentication Token. This can be obtained from the Shift4 Portal. Shift4 will provide you with the information needed to access their portal, and they are available to help you with this process.

To set up Shift4 UTG controlled devices:
This requires an update to each RA-Workstation on which you want to configure and use the Shift4 gateway.

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Click Edit for the first workstation to update.
5. For Payment Provider, select Shift4.
6. In the Shift4 section, check Use New UTG. This indicates that you are using Shift4 controlled devices.
7. Complete the following fields:
   - Terminal ID – Enter the serial number found on the register credit card PIN pad or swipe device. It is usually an 8-digit number.
   - URL – Enter the URL/IP address of the server running UTG.
   - Client GUID – Enter the value provided by NetSuite Customer Support.
   - Authentication Token – Enter the token value generated from the Shift4 portal. Each token must be unique to each RA-Workstation record.
8. Click Save.
9. Repeat for the next workstation.

![Payment Gateway Information](image)

**Important:** After configuring your RA-Workstation records, verify that your Tender in NSPOS is configured to use EMV. If you are not certain how to do this, please contact NetSuite Professional Services.

**Important:** During register staging, if using an Ingenico device with Shift4, you must also select to install the Ingenico extension. See Stage a Register.

**Note:** Before your cashiers can user Shift4 at the workstation, the set up must first perform a synchronization download from NetSuite. This takes approximately 15 minutes.

### Shift4 and EMV Receipt Requirements

**Warning:** NetSuite Professional Services must update your receipts to match EMV requirements.

Shift4's EMV standards include requirements for the information printed on merchant and customer receipts. EMV requirements can vary across payment processors, but in most instances receipts must include:

- Merchant name, address and telephone number
- Invoice number
- Date and time
- Amount
- Last 4 digits of the credit or debit card number
- Card type using full spelling
- Authorization code
- The words Merchant Copy or Customer Copy

### NSPOS controlled devices for Shift4

**Important:** Using NSPOS controlled devices for Shift4 will not work for NSPOS 2018.2.0 or greater.

**Warning:** On January 1, 2019, NetSuite Point of Sale discontinued support of Shift4 gateway setups using "NSPOS controlled devices".

This setup provides backward compatibility for customers originally configured for NSPOS prior to 2015.2.0. **It does not support EMV.** Because United States regulations require EMV as of October
1, 2015, NetSuite strongly recommends that all new and existing customers perform the Shift4 UTG controlled devices setup.

**Important:** Although this integration method is similar to versions prior to NSPOS 2015.2.0, you must have the following ready for each RA-Workstation on which you want to configure and use the Shift4 gateway.

- **Merchant ID:** Shift4 will provide this ID.
- **URL:** This is the URL/IP address of the server running UTG.
- **Client GUID:** Contact NetSuite Customer Support and request the Client GUID value to enter in the steps below. This value will be the same for all RA-Workstation records.
- **Authentication Token:** Each RA-Workstation record requires a unique Authentication Token. This can be obtained from the Shift4 Portal. Shift4 will provide you with the information needed to access their portal, and they are available to help you with this process.

**To set up NSPOS controlled devices:**

This requires an update to each RA-Workstation on which you want to configure and use the Shift4 gateway.

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the **RA-Workstation** row and click **List**.
4. Click **Edit** for the first workstation to update.
5. For **Payment Provider**, select **Shift4**.
6. Complete the following fields:
   - **Merchant ID** – Enter the ID provided by Shift4.
   - **URL** – Enter the URL/IP address of the server running UTG.
   - **Client GUID** – Enter the value provided by NetSuite Customer Support.
   - **Authentication Token** – Enter the token value generated from the Shift4 portal. Each token must be unique to each RA-Workstation record.
7. Click **Save**.
8. Repeat for the next workstation.

**Important:** In the Shift4 section, do **not** check **Use New UTG**. Leave this box clear.

**Important:** During staging and setup of your registers, you must select to install the Ingenico extension. This is only applicable to Shift4 setups using NSPOS controlled devices.
Important: For clients new to NSPOS, after configuring your RA-Workstation records, verify that your Tender in NSPOS is configured properly. If you are not certain how to do this, please contact NetSuite Professional Services.

Important: During register staging, if using an Ingenico device with Shift4, you must also select to install the Ingenico extension. See Stage a Register.

Note: Before your cashiers can use Shift4 at the workstation, the set up must first perform a synchronization download from NetSuite. This takes approximately 15 minutes.

End of Day Report
NSPOS includes a report for verifying transaction amounts processed on registers through the payment gateway over a period of time. Called the End of Day report, it is designed to closely match the end of day report available from Shift4. Use this report to compare the results from similar reports provided by your gateway.

Administrators may want to configure this report function as a button for easy access by your store managers. The function is called End-of-Day Report and is available from every register. Be sure to include any access restrictions that you believe are appropriate.

To run an End of Day Report:
1. In Sales Mode, complete all sales transactions.
2. From the Main button bar, tap Manager Functions and/or tap Reports.
4. To adjust criteria, choose from the fields at the top and tap View Report.
5. To print or save and export the report, choose from the options at the top.
6. Tap X in the upper right to return to the Journal window.

Line Item display for Shift4 UTG PIN Pads
You can display items as they are processed for a sales transaction on Shift4 UTG PIN pads. This option is disabled by default. Enabling Shift4 line item display on one register will populate registers across your network during the next synchronization cycle.

Important: Performance issues from Shift4 UTG may impact the item-display refresh rate. This can cause a lag between a physical scan and the item appearing on the PIN pad. The issue is being worked by Shift4, and affects the PIN pad item display only.

To enable Shift4 Line Item Display:
1. Log in to any NSPOS register as an administrator.
2. Go to Universal Settings (Ctrl+F10).
4. Enter the desired values using the table below as a guide.
5. Tap Done.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response timeout</td>
<td>Time POS waits for a response from UTG.</td>
<td>Milliseconds</td>
<td>120000</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Value</td>
<td>Default Value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>UTG PIN pad refresh interval</td>
<td>Interval to prevent PIN pad from moving to idle state due to no journal changes. This prevents the display from going idle while a transaction is delayed, but in progress.</td>
<td>Milliseconds</td>
<td>10000</td>
</tr>
<tr>
<td>UTG PIN pad update changes interval</td>
<td>Periodically check for journal changes and update on PIN pad display. Changes include items added and quantities updated. No update if no changes.</td>
<td>Milliseconds</td>
<td>1000</td>
</tr>
<tr>
<td>UTG PinPad Line Item width</td>
<td>Line width supported by PIN pad. Refer to PIN pad documentation.</td>
<td>Number of characters</td>
<td>30</td>
</tr>
<tr>
<td>UTG PinPad max lines</td>
<td>Maximum number of line items supported by PIN pad, including last line with tax and total amount. If set to a number greater than supported by your PIN pad, the display may not work as intended. Refer to your PIN pad documentation for the maximum lines allowed.</td>
<td>Number of lines</td>
<td>10</td>
</tr>
<tr>
<td>UTG PinPad line item display enabled</td>
<td>Enable PIN pad to display line items.</td>
<td>Check to enable, clear to disable</td>
<td>Cleared</td>
</tr>
</tbody>
</table>
Credit or Debit Card default setting for Shift4 UTG PIN pads

You can set the default card type accepted at your Shift4 UTG PIN pad – credit, debit or both. The default is both (blank), with the PIN pad prompting the customer to select the card type. Setting the default card type on one register will populate registers across your network during the next synchronization cycle.

To set the default card type:

1. Log in to any NSPOS register as an administrator.
2. Go to Universal Settings (Ctrl+F10).
4. Enter the Default card type.
5. Tap Done.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default card type</td>
<td>Default card type for all transactions. If card type is not specified, PIN pad prompts user to select Debit or Credit. If card type is specified, PIN pad will not prompt user to select. Instead the default is assumed.</td>
<td>CC – All cards are credit cards. DB – All cards are debit cards. (blank) – PIN Pad prompts user to select Debit or Credit.</td>
<td>(blank) – No value entered</td>
</tr>
</tbody>
</table>

**Worldpay**

NetSuite Point of Sale (NSPOS) comes with support for two Worldpay payment gateway services. This section covers how to set up those services.

- Worldpay (Vantiv)
- Worldpay (YESpay)

**Worldpay (Vantiv)**

NSPOS includes support for gateway services provided by Worldpay (Vantiv).

For information about starting with Worldpay, visit their site at [www.worldpay.com](http://www.worldpay.com). Worldpay will provide installation instructions for the client terminal setup on your registers. You must configure your RA-Workstation records in NetSuite ERP to accept Worldpay (Vantiv).

**Note:** Mercury Payment Systems (MPS) changed its name to Vantiv Integrated Payments. Vantiv is now a part of Worldpay.

EMV support by Worldpay (Vantiv) is enabled by integration with a dsiEMVUS client using a time-stream settlement method. Also known as auto-close, this method is a time-initiated settlement that closes the batch process automatically.

**Supported Transaction Types**

**Credit:**
Payment Gateways

- EMVParamDownload
- EMVSale
- EMVReturn
- EMWVoidSale/Return
- EMVVoiceAuth
- EMVVoidSale
- EMVVoidReturn

Settlement Method:
- Time-Stream

Functionality:
- dsiEMVUS™ (requires DataCap Systems In-Store NETePay®)
- Mercury E2E
- Mercury Tokenization, MToken™

How it works
The Datacap dsiEMVUS uses a locally installed Windows ActiveX control – dsiEMVX – that serves as the application interface between the POS, the EMV device, and Datacap's US EMV-certified in-store NETePay. The dsiEMVX:
- Directly controls an EMV device through a PC port (Serial/RS232 or USB using a Virtual COM port) to manage all PIN pad interactions.
- Uses XML-formatted requests and responses for transaction processing. It makes all non-sensitive request and response XML data available for POS payment logs.

When the POS initiates an EMV transaction, the dsiEMVUS takes control of the PIN pad device. The chip card and card reader negotiate to determine debit or credit, the verification method and other parameters. The chip card generates the authorization ARQC, sending it to dsiEMVUS which in turn passes it to the Worldpay (Vantiv) processor. Worldpay (Vantiv) connects with the card issuer and returns a final authorization through dsiEMVUS to the device and POS.

Supported Devices
PIN pads supported in the Worldpay (Vantiv) initial EMV release are Datacap Systems dsiEMVUS, the VeriFone VX805 enabled with End-to-End Encryption (E2EE), and the Ingenico ISC250. To check if another device is supported for dsiEMVUS, please contact your Worldpay (Vantiv) representative.

To set up the Worldpay (Vantiv) EMV payment gateway:

**Note:** Although the setup options in NetSuite might show Mercury Payment Systems, your setup will automatically apply to the new company name – Worldpay (Vantiv).

**Important:** This requires an update to each RA-Workstation on which you want to configure and use the Worldpay (Vantiv) gateway.

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Click Edit for the first workstation to update.
5. For Payment Provider, select Mercury Payment Systems.
6. In the Payment provider info section, complete the following fields:
- **Merchant** – Enter the Merchant ID (MID) provided by Worldpay (Vantiv). The Merchant ID identifies the account both internally and externally for your POS configuration and for transmitting banking information and deposits. It includes a range of attributes that parallel the POS system's functionality.

  **Warning:** If the Worldpay (Vantiv) system value is not synchronized with the value at the POS, processing can become unavailable at the merchant location. For example, if the POS is processing using E2EE, then the Merchant ID must be E2EE. Otherwise, processing can fail.

- **Terminal ID** – Called the SecureDeviceID by Worldpay (Vantiv), this is the device identifier. The supported values are:
  - VX805 device: **EMV_VX805_MERCURY**
  - Ingenico ISC250 device: **EMV_ISC250_MERCURY**

7. In the **Mercury Payment System** section, enter:
   - **XSERVERS** – Called the IP/Hostname by Worldpay (Vantiv), enter the IP address of the computer where NETePay was installed.
   - **EMV Enabled** – Check this box.
   - **COM Port** – The COM port to which the PIN pad is connected.

8. Click **Save**.
9. Repeat for the next workstation.

---

**Important:** After configuring your RA-Workstation records, verify that your Tender in NSPOS is configured to use EMV. If you are not certain how to do this, please contact NetSuite Professional Services.

**Note:** Before your cashiers can use Worldpay (Vantiv) at the workstation, the setup must first perform a synchronization download from NetSuite. This takes approximately 15 minutes.

The last step is to download the software and set up your devices for EMV by following the Worldpay (Vantiv) documentation. If you are not sure how to proceed, please contact your Worldpay (Vantiv) representative.

**Worldpay (Vantiv) and EMV Receipt Requirements**

**Warning:** NetSuite Professional Services must update your receipts to match EMV requirements. EMV standards include requirements for the information printed on merchant and customer receipts.

In addition to standard authorization receipt data (MerchantID, TerminalID, Clerk ID, TranCode, masked card data, CardType, Date/Time, Invoice, Reference, Amount and Total), the following EMV-specific data is required to appear on the receipt:
Payment Gateways

- Entry Method (how card information was obtained)
- Application Label
- AID – Application Identifier
- TVR – Terminal Verification Results
- IAD – Issuer Application Data
- TSI – Transaction Status Indicator
- ARC – Application Response Code
- CVM – Card Holder Verification Method

Worldpay (YESpay)

NSPOS includes support for gateway services provided by Worldpay (YESpay).

For information about starting with Worldpay, visit their site at www.worldpay.com. Worldpay will provide installation instructions for the client terminal setup on your registers. You must configure your RA-Workstation records in NetSuite ERP to accept Worldpay (YESpay).

To configure Worldpay (YESpay) in NetSuite ERP:

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Click Edit for the first workstation to update.
5. For Payment Provider, select Worldpay Payment Provider. No further setup is required on this record.
6. Click Save.
7. Repeat for the next workstation.

Important: During register staging, you must also select to install the Worldpay extension. See Stage a Register.

FreedomPay

NetSuite Point of Sale (NSPOS) includes EMV credit and debit card support for the Freedom Pay gateway provider. The support includes an optional FreedomPay Token Tender setup to allow future charges.
To begin your setup with FreedomPay, visit their site at www.freedompay.com. Then review and follow the sections in this topic.

- Automatic in-store refunds to a credit or debit card
- Floor-limit Overrides in Offline Mode
- FreedomPay Token Tender

The FreedomPay integration requires a small server application that is installed on each register. The FreedomPay server application manages connectivity with NSPOS registers to process payments through the PIN pad. The setup also requires updating RA-Workstation records in NetSuite ERP.

**To configure FreedomPay in NetSuite ERP:**

The integration requires an update to each RA-Workstation record assigned to registers that will use the FreedomPay gateway. FreedomPay will provide you with the **Merchant number** and **Terminal ID**.

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the **RA-Workstation** row and click **List**.
4. Click **Edit** for the first workstation to update.
5. For **Payment Provider**, select **FreedomPay**.
6. Enter the **Merchant** number.
7. Enter the **Terminal ID**.
8. Optionally enter the FreedomPay **FCCAddress**.
   - This field is the IP address of the computer where the FreedomPay FCC application is installed, plus the port where it is listening. The value is usually the localhost IP 127.0.0.1 + port 1011, entered as 127.0.0.1:1011. If not entered manually, we default to 127.0.0.1:1011.
9. Click **Save**.
10. Repeat for the next workstation.

The NSPOS FreedomPay integration includes a validated return option for automatic refunds to a card holder’s account. The credit or debit card to be automatically refunded is the card used to make

**Automatic in-store refunds to a credit or debit card**

The credit or debit card to be automatically refunded is the card used to make
the purchase. Under this option, customers making a return at a register using FreedomPay are not required to have the original card available to swipe or give to the cashier. FreedomPay uses the purchase Transaction ID and FreedomPay reference ID to process the refund.

1. Cashier scans the purchase receipt or looks up the transaction to be refunded.
2. Cashier is prompted “Do you want to put money to same card CARD TYPE, CARD NUMBER?”
   YES/NO.
3. If YES, refund is applied to the purchase card without the customer having to swipe the card.

**Automatic refunds are only available in the store where the purchase was made**

The swipe-free refund depends on the original FreedomPay reference ID from the purchase still being on any register in the store. If a register was restaged after the purchase was made, the automatic refund cannot be performed from that register. However, other registers in the store can be used.

**Floor-limit Overrides in Offline Mode**

This topic applies to NSPOS 2018.1.2 and greater.

Freedompay includes the option to set floor limits for offline transaction processing. A floor limit is a set amount that the Freedompay will accept automatically in offline mode without additional authorization. If the amount of an offline transaction is greater than the defined floor limit, Freedompay provides a voice-authorization method for overriding the floor limit. For more information, review the FreedomPay documentation or contact FreedomPay support.

NSPOS supports FreedomPay's voice-authorization override method for offline floor limits by prompting the cashier or store manager to call FreedomPay for an authorization code. The code is sent to the FreedomPay client for processing and recorded with the transaction.

NSPOS includes the option to set tender floor limits for credit card purchases. Floor limits help control fraud by setting a limit amount, for example $500, on credit card tenders. In order to proceed with tendering a credit card purchase that exceeds the floor limit, the cashier must receive store manager approval. Credit card tenders below the floor limit do not require manager approval.

In the event a register is offline due to loss of an internet connection, our integration with FreedomPay ensures that floor limit restrictions and authorizations can occur.

If a register is offline and the purchase to be tendered via credit card will exceed the floor limit, NSPOS will prompt with a message to call FreedomPay for an authorization code. Before tendering out the
transaction, the cashier or manager must enter the code in NSPOS. The code is sent to the FreedomPay client and recorded with the transaction.

**For more details about FreedomPay**

For more details about FreedomPay, including PIN pad device compatibility and pricing, visit their website at [http://corporate.freedompay.com](http://corporate.freedompay.com). FreedomPay will provide instructions for installing their payment application on your registers.

**FreedomPay Token Tender**

The NSPOS integration with the FreedomPay payment gateway includes a token feature to permit a future charge against a credit card. Tokens are created from the register and stored in NetSuite ERP.

A typical example of token usage is in rental transactions. The rental agreement might state that if the property is not returned on time, is lost or becomes damaged, then the renter is liable for an extra fee. The fee is held in the form of a FreedomPay token that can authorize a future credit card transaction.

Using a token provides the retailer with security similar to requiring a rental deposit, but does not place an immediate financial burden on the renter.

![Payment Method](image)

**Enabling FreedomPay Tokens**

Besides the standard gateway setup for your workstations in NetSuite ERP, enabling the token feature requires linking the **Token Create** function to a new tender button on your NSPOS registers.

**To enable creating tokens from your registers:**

1. Sign in to any NSPOS register as an administrator (9090 level operator).
2. Press **Ctrl+F12** on the keyboard to open the Function List.
3. Enter **Button Edit** in the search field.
4. Tap **Button Edit**.
5. Tap **Side** and **Pages**.
6. Tap the **Tender** row in the **Button Page** list.
7. Tap **Activate** so that you can see the changes immediately.
8. Tap **Buttons**.
9. Tap **New**.
10. Search for the function by entering **Token Create**.
11. Tap the **Token Create** function.

12. If desired, enter a different button name in the **Caption** field, such as **FreedomPay Token**. Otherwise the button defaults to **Token Create**.
13. Choose a color from the **Style** list.

14. If desired, adjust where your button appears in the tender list by changing the **Column** and **Row** fields. (Otherwise, it appears last in the list.)

15. If you want to make your button smaller or larger, adjust the **Width** and **Height**.

   **Tip:** For a button size that matches your default tender buttons, set the **Width** to 2.

16. Close the **Button Edit** form when your setup is complete.

**Important:** Repeat these steps for one register in each Workstation Group.

---

**PC-EFTPOS**

NetSuite Point of Sale (NSPOS) includes support for the Australian payment gateway PC-EFTPOS.

For information about PC-EFTPOS, visit their site at [www.pceftpos.com](http://www.pceftpos.com). They will provide installation instructions for setting up their gateway on your registers. You must configure your RA-Workstation records to accept PC-EFTPOS and select the Continuous Sequenceflag in NSPOS.

**Note:** Using the PC-EFTPOS gateway requires that you have the EFTPOS extension installed. You can install the extension during your initial register setup or you can install it from the Windows Control Panel.

For most Windows versions, go to **Start > Control Panel > Programs and Features > NetSuite Point of Sale > Change.** (Do not uninstall NetSuite Point of Sale.)

Also see [zipPay Integration through PC-EFTPOS](#).

**To configure PC-EFTPOS in NetSuite ERP:**

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Click Edit for the first workstation to update.
5. For Payment Provider, select EFTPOS.
   No further setup is required for this record.

6. Click Save.
7. Repeat for the next workstation.

**Important:** During register staging, you must also select to install the EFTPOS extension. See Stage a Register.

Select the Continuous Sequence flag in NSPOS

This ensures that sequence numbers are continuous and do not reset each day.

1. Sign in to any NSPOS register as an administrator (9090 level operator).
2. Press Ctrl+F10 to open the Universal Settings window.
3. Search for Continuous Sequence.
4. Check the box for Continuous Sequence.
5. Tap Done.
6. Tap Sign Off and then tap Exit.
7. Restart the NSPOS application on the register.

zipPay Integration through PC-EFTPOS

zipPay is payment method customers can use to tender payment for a transaction. zipPay is based in Australia. It sends the consumer a code via their mobile device that is entered at the point of sale. The code authorizes payment to the retailer.

NSPOS 2018.1 or greater uses our integration with the PC-EFTPOS payment gateway to enable zipPay tender transactions. zipPay supports sales transactions and return transactions for NSPOS. Consumers must have a zipPay account and the application at hand on their mobile devices to tender payment. With the exception of a prompt that requests the code from the customer, the transaction process flows similar to any other tender payment.
Retailers choosing to include zipPay as a tender option must update each register's RA-Workstation record in NetSuite ERP to set EFTPOS as the Payment Provider. EFTPOS is an abbreviation for PC-EFTPOS.

**Note:** zipPay is only available through the PC-EFTPOS payment gateway. You cannot have more than one payment gateway per register.

### Refunds for zipPay Transactions

Refunds for returned items purchased through zipPay transactions are handled similar to other refunds. The following restrictions apply:

- The cashier must locate the zipPay transaction ID to process a refund. The ID can be found in the NSPOS transaction history or on the customer's receipt.
- Refunds for zipPay transactions can be applied to the customer's zipPay account or refunded as cash.
- Refunds from items purchased using other tenders, such as credit cards, cannot be applied to a zipPay account.
- Refunds for zipPay transactions cannot exceed the original sale total.

### Setting up zipPay for your Registers

Follow these steps to set up zipPay in your tender list. The NSPOS zipPay function and button setup only needs to be applied to one register in each workstation group. These steps assume you have already configured the PC-EFTPOS gateway in NetSuite ERP and set the Continuous Sequence flag.

1. Add the zipPay function and button on your registers.
2. Install the zipPay extension in NSPOS. (Contact your zipPay representative.)

**Tip:** Function and button changes for one register appear on all registers in its workstation group.

### To add the zipPay function and button on your registers:

1. Sign on to a NSPOS register as an administrator.
2. Tap Manager Functions > System Configuration > Button Edit.
   Or press Ctrl+F12, search for and tap Button Edit.
3. Tap the Side button bar option and tap Pages.
4. Tap the Tender row in the Button Page list.
5. Tap Activate so that you can see the changes immediately.
6. Tap **Buttons**.
7. Tap **New** and then **Create Function**.

![Select a Function](image)

8. Tap **Yes**.
9. For **Function Name**, enter **zipPay**.
10. For **Function Group**, click the search icon and tap **Tender**.
11. Tap **Done**.
12. For **Caption for Buttons**, enter **zipPay**.
13. If desired, adjust the **Resource ID**.
   The **Resource ID** sets the permission level required to use the button. The default is 2 for sales associates and cashiers. Manager-level access is 9070.
15. For **Parameter**, enter **Tender:CCEM Provider:0 AuthorizationOption:ZIPPAY**

![Create New Function](image)

**Tip:** You can copy and paste these values from the PDF or Help Center topic.

16. Tap **Done**.
17. Choose a color from the **Style** list.
18. Set the placement for your button by changing the **Column** and **Row** fields.
19. If you want to make your button smaller or larger, adjust the Width and Height.

Tip: Because you tapped Activate earlier, you can see the changes behind the edit form.

20. Close the Button Edit form when your setup is complete.

Important: Repeat all steps for one register in each Workstation Group.

Install the zipPay extension

1. Contact your zipPay representative for instructions.

Money Management

This chapter covers the NetSuite Point of Sale (NSPOS) and NetSuite ERP (NS ERP) setup and tasks for managing tenders and cash flow in your retail business.

Overview

Running a retail chain involves handling and tracking the flow of money into and leaving each retail location. Retailers track money held at the:

- Point of Sale (POS) register or terminal till (cash drawer)
- Store safe or other back office repository
- Bank or other financial institution

The integration with NetSuite ERP General Ledger and account-charting tools provide methods for assigning the accounts to which your financial operations will post.

The integration updates your accounts through synchronizations from the register – via your replication server – to your NetSuite ERP implementation. As a result, you have the ability to track every money movement that occurred in every retail location, including cash drawer disbursements for services like window cleaning.

- Tenders and Payment Methods
- Transaction Payment Records in NetSuite ERP
- Tender Workflows
- Tracking Money Movement through NetSuite ERP records
- Cash Till Management in NSPOS

Tenders and Payment Methods

The payment types accepted by your NSPOS registers are called “tender types.” Each tender type must be configured to track the different types of payments your stores handle. The following are common tender types:

- Cash
- Check
- Credit Card and Debit Cards
- Gift Card and Gift Certificates

A Payment Method determines how NetSuite ERP and NSPOS handles cash and other tender transactions. Setting up or editing a Payment Method and tenders is done in three sets of steps:
1. Set up a Payment Method in NetSuite ERP

First, ensure that your NetSuite ERP default view is set to Show Internal IDs. This is a one-time setup.

To set your default View for Internal IDs:

1. Log into NetSuite as an administrator.
2. Go to Home > Set Preferences > General tab.
3. Under Defaults, ensure that Show Internal IDs is checked.
4. Click Save.

Then set up your Payment Methods. You will do this once for each tender type handled in your stores.

**Note:** The most common tenders were set up during your implementation. These steps are most helpful for creating additional tender types.

To set up a new Payment Method:

1. Log into NetSuite as an administrator.
2. Go to Setup > Accounting > Accounting Lists.
3. Filter the list by Payment Method to see what tenders are in place now. Determine what additional methods you need to handle your tenders.
4. Click **New**. Select **Payment Method** if listed as a choice.

5. Enter a name for your **Payment Method**. When reviewing accounting activity, you will use the name to identify transactions paid via that method (tender).

The name should describe the tender or tender-method that will be associated with the tender button on the register. Because basic tender types were set up during your implementation, custom payment methods usually handle special circumstances only.

You might set up a method and button for a credit card brand that requires special handling, naming it `SPCLCC` for "Special Credit Card." Or, if the method will handle credit card payments made through a separate, non-integrated gateway, you might name it `EXTCCGATEWAY` for "External Credit Card Gateway."

6. If you want deposits from this method to go to a specific account, select **Deposit to Account** and choose the account.

7. Click **Save**. The Accounting List updates with your new method.

8. Note the **Internal ID** for your method. You will enter the ID in the next set of steps.

---

### Important:

Note the **Internal ID** for your new payment method. This ID is required for the register button setup.

9. Click **Home** or **Log Out** as desired.

---

2. **Create a new Tender in NSPOS**

Tenders in NSPOS provide a method for the cashier to accept different forms of payment. They also provide information about the payment to NetSuite ERP, allowing the retailer to track sales and money flow by tender type. The common tenders were set up during your implementation. Use the steps in this section to set up or modify custom tenders that fit your unique business needs.
To create a new Tender:

1. Sign in to an NSPOS register as an administrator (9090 level operator).
2. Press Ctrl+F12 and search for Edit Tenders.
3. Tap Edit Tenders.

4. Tap Create Tender.
5. Complete the required fields as follows:
   - **Tender code** – Enter up to four characters that describe the tender type. Common examples are DB for debit card, CC for credit card, CASH for currency.
   - **Warning:** Do not delete or modify an existing Tender Code. Do not duplicate a Tender Code.
   - **Tender Name** – How the tender will appear on the NSPOS register, on receipts, on the Sales Audit Report and in the memo field of Invoice records where tender is used as payment. For example, Gift Card.
   - **Tender Class** – Choose the class that best describes the tender.
   - **NetSuite ID** – Internal ID from the NetSuite ERP payment method.
   - If the tender is for credit cards or gift cards/certificates, you must check **Require Authorization**.
6. Tap Done. The tender will now appear with the other NSPOS tenders.

3. Map the Tender to a Button in NSPOS

Once you create a tender, you can assign it to one or more buttons. Buttons are shared by all other workstations within the same workstation group. Before modifying buttons, please make sure the...
changes should apply to all workstations (registers) in the workstation group. If any workstations have different requirements, you should create a new workstation group to handle them.

**To add a Tender Button:**

1. Sign in to a NSPOS register as an administrator (9090 level operator).
2. Tap Manager Functions > System Configuration > Button Edit.  
   Or press **CTRL+F12** and search for **Button Edit**.
3. Tap **Side** in the **Button Bar** list.
4. Tap **Pages**.
5. Tap the **Tender row** in the **Button Page** list.
6. Tap **Activate** to display your changes immediately.
7. Tap **Buttons**.

8. Tap **New** and then **Create Function**.

9. Tap **Yes** to edit a function by name.
10. Enter values for the following fields:
    - **Function Name** – Descriptive name for the tender function. Use alphanumeric characters only, with no spaces. For example, enter **Function_enabling_XYZ_card_tender**.
    - **Function Groups** – Tender.
■ **Caption for Buttons** – Text to display on cashier’s button in Journal tender sidebar. For example, enter *XYZ Card*.

■ **Resource ID** – Security level required to use the tender button. If a role lower than the one set here attempts to use the button, a higher, authorized role must enter their credentials for the task to proceed.
  - 2 – Sales Associates, Specialist, Cashier
  - 9050 – Openers/Closers
  - 9070 – Managers
  - 9090 – System Administrators


■ **Parameter** – Enter the word *Tender:* and the **Tender Code** entered in the previous NSPOS steps.
  
  For example, enter *Tender:DB*.

11. Tap **Done**. You can customize the button size and position using the Column, Row, Width, Height and Style fields.

12. Close the form when your button setup is complete.

### Transaction Payment Records in NetSuite ERP

After the cashier completes a transaction on NSPOS, the server submits the transaction to NetSuite ERP for validation and upload. After it is accepted and received, NetSuite ERP creates payment records for the transaction.

- Invoice record
- Payment record
- Customer Refund record
- Credit Memo record
- Customer Deposit record

The payment records created depend on the NSPOS transaction type and the actions taken by the cashier.

<table>
<thead>
<tr>
<th>NSPOS Transaction</th>
<th>NetSuite ERP (NS ERP) records</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Basic sales transaction | ■ Invoice  
 ■ Payment | Only a single tender used as payment.  
  
  **Note:** NS ERP does not create a payment record when a gift card or gift certificate is used. Because the card or certificate was purchased previously (with a corresponding payment record), the card or certificate tender information for the current transaction is located in the invoice record. |
| Split-tender sales transaction | ■ Invoice  
 ■ Payment 1  
 ■ Payment 2 | Each tender creates a separate payment record.  
 If one payment was a gift card or certificate, NS ERP does not create a payment record for that tender. |
| Split-tender sales transaction with change given in different tender | ■ Invoice  
 ■ Payment 1 | When provided in a different tender, the overpayment returned to the customer as change creates a refund record. |
<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Items</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic return transaction</td>
<td>Payment 2</td>
<td>NSPOS must be configured to return different change using thresholds set for each tender accepted by your business.</td>
</tr>
<tr>
<td></td>
<td>Customer Refund</td>
<td></td>
</tr>
<tr>
<td>Return transaction, equal exchange</td>
<td>Invoice</td>
<td>If customer is refunded using multiple, different tenders, NS ERP creates a customer refund record for each tender used.</td>
</tr>
<tr>
<td></td>
<td>Credit Memo</td>
<td>Value of items sold during the return transaction are equal to the value of items returned. No money is transferred between customer and retailer.</td>
</tr>
<tr>
<td></td>
<td>Customer Refund</td>
<td></td>
</tr>
<tr>
<td>Return transaction, balance due from customer</td>
<td>Invoice</td>
<td>Value of items sold during the return transaction are greater than the value of items returned. Payment is collected from customer.</td>
</tr>
<tr>
<td></td>
<td>Credit Memo</td>
<td>If payment received in split tender, one payment record is created for each tender.</td>
</tr>
<tr>
<td></td>
<td>Payment</td>
<td></td>
</tr>
<tr>
<td>Return transaction, balance due from retailer</td>
<td>Invoice</td>
<td>Value of items sold during the return transaction are less than the value of items returned. Change is given to customer.</td>
</tr>
<tr>
<td></td>
<td>Credit Memo</td>
<td>If change given in split tender, one customer refund record is created for each tender.</td>
</tr>
<tr>
<td></td>
<td>Customer Refund</td>
<td></td>
</tr>
<tr>
<td>Create sales order transaction</td>
<td>Invoice</td>
<td>The initial payment for a sales order is the deposit transaction. Customers might make multiple payments against a sales order before final invoicing. Each payment creates a Customer Deposit record.</td>
</tr>
<tr>
<td></td>
<td>Customer Deposit</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** NetSuite ERP does not create Customer Deposit records from sales order payments tendered as a Gift Card or Gift Certificate. This tender type is not supported for sales order deposits.

| Invoice sales order transaction                       | Invoice                              | The final payment on a sales order is the invoice transaction. If split tender, one payment record is created for each tender.         |
|                                                      | Payment                             |                                                                                                                                 |

**Invoice record**

An invoice is a record of the sale of items or services to a customer. Invoicing is requesting payment for those items or services. Each invoice consists of line-items and the amount for which those line items were sold.

The sum of all sales amounts on an invoice equals the total amount the customer paid or will pay. NetSuite ERP tracks outstanding invoices in an account called Accounts Receivable.

![Invoice](image)

**To view Invoice records:**

Administrators and others with NetSuite ERP access can review invoices by following these steps.

1. Log in to NetSuite ERP.
2. Go to Transaction > Sales > Create Invoices > List.
3. Click View to review invoice details.

The following are key fields for reviewing NSPOS transactions in Invoice records:

- **Invoice #** – Document number automatically generated for the invoice portion of the transaction.
- **Customer:Project** – Name of customer assigned to the NSPOS transaction. If the cashier did not select a customer, this field lists the anonymous **Default Customer** set on the store's NS ERP Location record.
- **Currency** – Currency used at the store's location, where the transaction took place.
- **Date** – Date the transaction occurred on the NSPOS register.
- **Location** – Store location, where transaction occurred on the NSPOS register.
- **Source** – For NSPOS this will list **Web Services**.
- **Items** – All items purchased in the transaction, including quantities, prices and tax rates.

### Payment record

The Payment record lists a payment made in response to an invoice, such as payment for an NSPOS transaction. Payment is applied to decrease or eliminate the amount due. Payment records can also be used to track income for taxes and performance indicators.

To view Payment records:

Administrators and others with NetSuite ERP access can review payments by following these steps.

1. Log in to NetSuite ERP.
2. Go to Transaction > Sales > Create Invoices > List.
3. Expand the Filters and select a Type of Payment.
4. Click View to review payment details.

The following are key fields for reviewing NSPOS transactions in Payment records:

- **Payment #** – Document number automatically generated for the payment portion of the transaction.
- **Customer** – Name of customer assigned to the NSPOS transaction. If the cashier did not select a customer, this field lists the anonymous **Default Customer** set on the store's NS ERP Location record.
- **Currency** – Currency used at the store's location, where the transaction took place.
- **Date** – Date the transaction occurred on the NSPOS register.
- **Location** – Store location, where transaction occurred on the NSPOS register.
- **Payment method** – Payment method sent from NSPOS, depending on the tender type used.

### Customer Refund record

Customer refunds are payments to the customer, either from a customer return or if change is given to the customer in a tender that is different from the purchase payment. Different tender payments for change are usually provided as cash.
To view Customer Refund records:
Administrators and others with NetSuite ERP access can review refunds by following these steps.

1. Log in to NetSuite ERP.
2. Go to Transaction > Sales > Create Invoices > List.
3. Expand the Filters and select a Type of Customer Refund.
4. Click View to review refund details.

The following are key fields for reviewing NSPOS transactions in Refund records:

- **Transaction number** – Document number automatically generated for the refund portion of the transaction.
- **Customer** – Name of customer assigned to the NSPOS transaction. If the cashier did not select a customer, this field lists the anonymous Default Customer set on the store’s NS ERP Location record.
- **Currency** – Currency used at the store’s location, where the transaction took place.
- **Date** – Date the transaction occurred on the NSPOS register.
- **Location** – Store location, where transaction occurred on the NSPOS register.
- **Refund Method** – Refund method sent from NSPOS. The method reported depends on the tender used. The method might include multiple lines.
- **Refund Amount** – Total amount that was provided to the customer.

**Credit Memo record**

A credit memo is created when a credit is issued to a customer, typically as the result of a return. For validated returns made on NSPOS, credit memos are applied to an Invoice record in NetSuite ERP.

Credit Memo records from NSPOS transactions include a Created From link to the original Invoice. Click the link to display information about the purchase.

This link connecting validated-return refunds to the original purchase gives visibility into buying patterns when not all items from a purchase were returned. It can help with balancing cash in vs. cash out and is
an aid to preventing fraud at the cashier level. For example, you can view when a return was an attempt to get cash in exchange for a gift card purchase.

**To view Credit Memo records:**

Administrators and others with NetSuite ERP access can review memos by following these steps.

1. Log in to NetSuite ERP.
2. Go to Transaction > Sales > Create Invoices > List.
3. Expand the **Filters** and select a **Type** of Credit Memo.
4. Click **View** to review memo details.

The following are key fields for reviewing NSPOS transactions in Memo records:

- **Credit #** – Document number automatically generated for the memo portion of the transaction.
- **Customer** – Name of customer assigned to the NSPOS transaction. If the cashier did not select a customer, this field lists the anonymous **Default Customer** set on the store's NS ERP **Location** record.
- **Date** – Date the transaction occurred on the NSPOS register.
- **Amount Used** – Total price of returned items.
- **Memo** – Describes the credit issued to the customer, dependent of the tender used.
- **Items** – All returned items as listed in the **Item** subtab.

**Customer Deposit record**

Customer deposits are when a customer makes a payment against a purchase prior to the final invoicing. Deposits appear as liabilities in the General Ledger until they are applied to an invoice.

**To view Customer Deposit records:**

Administrators and others with NetSuite ERP access can review deposits by following these steps.

1. Log in to NetSuite ERP.
2. Go to Transaction > Sales > Create Invoices > List.
3. Expand the **Filters** and select a **Type** of Customer Deposit.
4. Click **View** to review deposit details.

The following are key fields for reviewing NSPOS transactions in Deposit records:

- **Deposit #** – Document number automatically generated for the transaction.
- **Customer** – Name of customer assigned to the NSPOS transaction. If the cashier did not select a customer, this field lists the anonymous **Default Customer** set on the store's NS ERP **Location** record.
- **Currency** – Currency used at the store's location, where the transaction took place.
- **Date** – Date the transaction occurred on the NSPOS register.
- **Payment Amount** – Amount received from the customer.
- **Payment Method** – Payment method sent from NSPOS. The method reported depends on the tender used. The method might include multiple lines.

**Tender Workflows**

This section describes the tender-processing flow for transaction made on NSPOS.

**Credit and Debit Card processing flow**

1. NSPOS sends an authorization request to its integrated payment gateway. Payment gateway returns a response of authorized or declined.
   A payment gateway might include other steps specific to the gateway's requirements and the issuing bank.
2. NSPOS prints a receipt corresponding to the gateway's response of authorized or declined.
3. If payment is approved, data covering the transaction and payment are sent to NetSuite ERP.

**Cash processing flow**

1. NSPOS processes the transaction using the cash payment and prints the receipt.
2. Data covering the transaction and payment are sent to NetSuite ERP.
Gift Card and Certificate processing flow

1. NSPOS processes transaction using the gift card or certificate payment.
   a. NSPOS queries NetSuite ERP to determine whether the balance on the card or certificate is sufficient to complete the sale.
   b. NetSuite ERP returns the balance to NSPOS.
2. NSPOS prints a receipt corresponding to the balance check of sufficient or insufficient funds.
3. If funds are sufficient, data covering the transaction and payment are sent to NetSuite ERP.

Tracking Money Movement through NetSuite ERP records

All transactions that involve money received or paid out by a NetSuite Point of Sale (NSPOS) register post to your NetSuite ERP account via the next synchronization. The accounts assigned to your corporate Chart of Accounts to which these transactions post are, by default, global accounts. Accounts are not generally specific to individual store locations.

Using the set of custom records set up for your NetSuite ERP account, you can configure which General Ledger accounts will be credited and debited for each transaction. Payment Methods are useful for determining the target accounts.

NSPOS includes functions that you can use to keep track of money moved from one point in your operations to another. For example, you can track the movement of money between registers, the back office, and your bank. You can also track:

- Money added to a register cash drawer for use as change
- Excess money removed from a cash drawer and placed in a safe
- Money moved from a safe and deposited in a bank
- Discrepancies between expected (book value) and actual end of day drawer counts
- Money used for small expenses paid out of a cash drawer, such as buying stamps, cleaning products or services.

Note that the defaults set up for your implementation might not assign tracked transactions to the General Ledger accounts desired for your auditing. You have the option to assign transactions to other accounts.

For NSPOS, NetSuite ERP uses RA-Money Management Action records to specify the accounts to which money movements are assigned. Each record determines the accounts to debit and credit based on the type of action taken. You can create and modify these records to meet your requirements.
Once in place and synchronized with your registers, these records create the General Ledger entries you will use to manage accounting duties and drill down into detailed snapshots of your cash-flow operations.

**Working with RA-Money Management Action records**

Use the steps and descriptions in this section to plan for and configure RA-Money Management Action records for use with your NetSuite ERP General Ledger.

1. Create an Accounting Plan
2. Use your Accounting Plan to set up the NetSuite ERP records

### 1. Create an Accounting Plan

As your first step, you should make a general accounting plan that lists the money-movement types you want to track. The plan should include where to record these movements in your NetSuite ERP General Ledger.

**Note:** Be sure to work with your Accounting teams when creating a plan.

Reviewing a blank RA-Money Management Action record from your NetSuite ERP account will help you understand what values you will need to input.

**To view a new RA-Money Management Action record:**

1. Log into NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the **RA-Money Management Action** row.
4. Click **List**.
5. Click **New RA-Money Management Action**.

**Note:** Click **Edit** or **View** on an existing record to review what is in place now.

Two lists to review:

- **Type** – The type corresponds to the NSPOS button used by the cashier to perform the task.
- **Reason** – This field can hold any value you want to describe why an action was taken.

You might not have any reasons in the list now. Accounting reasons are created using the **RA-Funds Rec/Disb Reason** record. See **RA-Funds Rec/Disb Reason Codes**.
To determine what values to select for each accounting scenario, you can create a five-column table to use as a template. Complete the table using the following questions:

- What money movement action do I want to track in NSPOS?
- What are the reasons the action would be performed?
- Which account should be debited from the money disbursed or received?
- Which account should be credited from the money disbursed or received?

If the accounts you want to use do not exist in your Chart of Accounts, create them before continuing to the next section.

**Note:** Sometimes you will have matching records representing a funds disbursement for some expense and then a funds receipt to track any change returned.

You only need to create Reason Codes for **Funds Disbursement** and **Funds Receipt** types.

**Example money movement record plan**

<table>
<thead>
<tr>
<th>Cashier Action Type</th>
<th>Reason Code</th>
<th>Two-character Code for NSPOS</th>
<th>Debit Account</th>
<th>Credit Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawer Drop</td>
<td>N/A</td>
<td>DD (Drawer Drop)</td>
<td>1092 – Cash On Hand</td>
<td>1095 – Cash in Tills</td>
</tr>
<tr>
<td>Funds Disbursement</td>
<td>Supplies</td>
<td>DS (Disburse for Supplies)</td>
<td>6230 – Supplies Expense</td>
<td>1092 – Cash On Hand</td>
</tr>
<tr>
<td>Funds Disbursement</td>
<td>Miscellaneous</td>
<td>DM (Disburse for Miscellaneous)</td>
<td>6130 – Miscellaneous Expense</td>
<td>1092 – Cash On Hand</td>
</tr>
<tr>
<td>Funds Receipt</td>
<td>Supplies</td>
<td>RS (Receipt for Supplies)</td>
<td>1092 – Cash On Hand</td>
<td>6230 – Supplies Expense</td>
</tr>
<tr>
<td>Funds Receipt</td>
<td>Miscellaneous</td>
<td>RM (Receipt for Miscellaneous)</td>
<td>1092 – Cash On Hand</td>
<td>6130 – Miscellaneous Expense</td>
</tr>
</tbody>
</table>

* This code can be any two alphanumeric characters. Each code must be unique, meaning do not duplicate a code. To keep them manageable, codes should reflect the action being performed, such as DD for Drawer Drop. You will enter these codes when setting up your RA-Funds Rec/Disb Reason records. NSPOS uses the codes for record processing.

### 2. Use your Accounting Plan to set up the NetSuite ERP records

After mapping the accounting scenarios you want to set up into a table, you are ready to create the NetSuite ERP action records. You will use three record types to implement your plan:

- **RA-Funds Rec/Disb Reason Codes** provide the codes that describe why an action at the register was taken.
- **RA-Money Management Actions** determine how actions at the POS are recorded in the General Ledger/Journal Entry.
- **RA-Payment Method Account Flows** (optional) records track money flow in the General Ledger as funds move between holding accounts and deposit accounts. The record is most applicable for tracking cash movement.
RA-Funds Rec/Disb Reason Codes

Before setting up your Money Management Action records, prepare your Reason Codes so that they are available to select. Reason Codes describe why you have performed a specific action in NSPOS.

For example, you can set up a disbursement code describing payment for cleaning windows in your stores. The action by itself – a drawer disbursement – does not provide visibility into why the disbursement took place. A Reason Code assigned to the action provides the needed information.

You do not need Reason Codes for actions like sales transactions because it is clear that one or more items were sold.

Note: These RA-Funds Rec/Disb Reason Codes are different from the codes used with returns or cancelling a transaction.

You will create a separate record for each unique Reason Code in your plan. If a code such as “Supplies” is used more than once in your accounting plan, you only need to create one record for that code. A single code can be assigned to multiple Money Management Action records.

To set up RA-Funds Rec/Disb Reason records:

1. Log into NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Funds Rec/Disb Reason row.
4. Click List.
5. Review the list of existing codes.
6. Click New RA-Funds Rec/Disb Reason.
7. For Name, enter the text to appear on the cashier’s POS Reason selection list and in your General Ledger records.
8. For Type, select Receipt or Disbursement, depending on the Action Type in your planning table.
   If your plan uses the same reason code for both receipts and disbursements, create two separate records, one with Receipt selected and one with Disbursement selected. To help track which reason code is associated with which action, you can append this information to the Name field.
9. For the RAPOS Code, enter the two-character Code for NSPOS from your plan.
10. For Account, select the Debit Account or Credit Account from your plan that corresponds to the Receipt or Disbursement Type selected.
11. Click Save.
12. Repeat the steps for all Reason Codes and Debit or Credit Accounts in your plan.

RA-Money Management Actions

After you set up your Reason Codes, you will create a RA-Money Management Action record for each Cashier Action Type in your plan.

Money management actions describe how till management actions done at the register are logged to your General Ledger. The records determine the accounts to debit or credit based on the type of action and – using a Reason Code – why the action is performed.

Common uses are tracking drawer counts, drops and loans. You can also track disbursements such as money paid to third parties for cleaning services, charity contributions, or receipt paper purchases. The key is deciding what actions should be specifically called-out in your General Ledger.
**To set up RA-Money Management Action records:**

1. Log into NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Money Management Action row.
4. Click List.
5. Review the list of existing Action records.
7. Leave the Custom Form at Standard RA-Money Management Action Form. Unless you have changes in place to customize the form. Then you will select the applicable custom form.
8. For Type, select Funds Receipt or Funds Disbursement, depending on the Action Type in your planning table.
9. To apply the accounting action to a specific store, select it in the Location field. Leave empty to apply the action to all Locations.
10. For Reason, Debit Account and Credit Account, select the values from your accounting plan.

   **Note:** A Debit or Credit Account field might automatically list the account information you entered in a Reason Code record. Change this as needed for the account you are setting up.

11. Click Save.
12. Repeat the steps for all Action Types in your plan.

**RA-Payment Method Account Flows**

After your RA-Money Management Action records are set up, you have the option to create an RA-Payment Method Account Flow record for each Payment Method. This optional record tracks the flow of money between different accounts.

   **Note:** Some retailers use NetSuite ERP as a “back office” processing system only, and use other accounting applications to manage the flow of money. Setting up RA-Payment Method Account Flow records is not a requirement if they are not applicable to your processes.

Three account types are available for each flow record and associated method:

- **Un-Deposited Account** – The account used to hold cash or other tender funds prior to depositing those funds in the bank. Because the payment gateway automatically deposits credit and debit card payments, this account is not used for credit or debit card tenders.
- **Depository Account** – The account used to deposit and withdraw funds received.
- **Over/Short Account** – Income statement account to hold overages or shortages. These variances are the differences between actual amounts received and expected amounts received.

**Determining the account types for tracking your flow**

Depending on how you track the flow of money now (or want to begin tracking it), you can select all account types for one record, but only select one or two for others. The choices vary based on your business type, accounting rules and any requirements set by your country or other regulatory jurisdiction.

Cash is usually held prior to making a bank deposit, so most cash-flow tracking will include an Un-Deposited (holding) Account. Since payments tendered with credit or debit cards often move directly to
Depository Accounts, holding accounts are usually not relevant for those transactions. Depository and Over/Short (variance) Accounts are applicable to both cash and credit/debit cards.

If different locations have different requirements, you can set up separate Account Flow records for those locations. Other locations will default to the Account Flow records that do not specify a location.

<table>
<thead>
<tr>
<th>INTERNAL ID</th>
<th>LOCATION</th>
<th>PAYMENT METHOD</th>
<th>UN-DEPOSITED ACCOUNT</th>
<th>DEPOSITORY ACCOUNT</th>
<th>OVER/SHORT ACCOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dover</td>
<td>Cash</td>
<td>Undeposited Funds</td>
<td>Acc. Dep-Automotive Equip.</td>
<td>Estimates</td>
</tr>
<tr>
<td>4</td>
<td>Dover</td>
<td>Demo Credit Card</td>
<td>Acc. Dep-Automotive Equip.</td>
<td>Estimates</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Mobile</td>
<td>Cash</td>
<td>Undeposited Funds</td>
<td>Acc. Dep-Building</td>
<td>Estimates</td>
</tr>
<tr>
<td>5</td>
<td>Mobile</td>
<td>Demo Credit Card</td>
<td>Acc. Dep-Building</td>
<td>Estimates</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Pensacola</td>
<td>Cash</td>
<td>Undeposited Funds</td>
<td>Acc. Dep-Furniture &amp; Fixtures</td>
<td>Estimates</td>
</tr>
<tr>
<td>6</td>
<td>Cash</td>
<td></td>
<td>Deposits</td>
<td>Gain (loss) on Sale of Assets</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Demo Credit Card</td>
<td></td>
<td>Deposits</td>
<td>Gain (loss) on Sale of Assets</td>
<td></td>
</tr>
</tbody>
</table>

Be sure to review the options with your Accounting or Finance Departments before beginning the setup.

To set up RA-Payment Method Account Flow records:

1. Log into NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Payment Method Account Flow row.
4. Click List.
5. Review the list of existing Account Flow records to verify that the flow is not yet in place or only needs editing.
7. To apply the Account Flow to a specific store, select it in the Location field. Leave clear to default the payment-method flow to all non-specified Locations.
8. For the Payment Method, select Cash (or other method if not for cash flow).
9. For the three Account (type) fields, select the accounts identified by your Accounting or Finance Departments.
   If you will not use one of the account types, leave the list at the default.
10. Click Save.
11. Repeat the steps for other Payment Methods as desired.

After completing the record setups, allow time for the updates to synchronize with your NSPOS registers. You can confirm if the updates have synced by viewing the Reason Codes displayed on the register after tapping an associated function. For example, tap Other Functions > Funds Receipt and view the Reasons offered.
NetSuite ERP will now automatically update your General Ledger entries from NSPOS transactions using the records you created.

Cash Till Management in NSPOS

This topic guides you through performing NetSuite Point of Sale (NSPOS) till management tasks throughout a business day.

The physical portion of a till is also called a cash drawer, and is the drawer or cabinet in which cash payments are placed and change is removed. Most till management tasks are manual, such as entering the cash put into and removed from the drawer. These tasks are important for recording deposit amounts and determining any overages or shortages.

A business day represents the time from when a retail store starts its operations to when operations end, as a continuous session. NSPOS uses start of day and end of day tasks to separate till activities into separate business days. The day does not have to match a calendar date or time range. If more than one cashier shift uses a register during a business day, then each cashier can be responsible for opening and closing the till for their shift within that day.

Typical Till Business Day

A business day starts with an authorized cashier or manager signing on to the terminal and entering the beginning till count. The beginning count records the denominations and amounts placed in the till as a float to provide change for the day's sales operations.

The cashier is then ready to ring up sales, process returns and perform other transactions. If the cashier runs short of the cash denominations needed to make change, they can get added funds through a drawer loan. If they have more cash in their till than allowed by store guidelines, they can make a drawer drop.

When the store closes to the public, the cashier or manager initiates the end of business day tasks by counting and settling the till. Any any cash overages or shortages are noted for further investigation. The cashier or manager then signs off and the business day is over.

- Start of Day – Enter Beginning Till Count
- During the Day – Make a Drawer Drop
- During the Day – Make a Drawer Loan
- During the Day – Make a Disbursement
- End of Day – Count and Settle Till

**Important:** Depending on your store's rules and requirements, these tasks may be available only to store managers, shift managers, or other operators with high-level roles.

**Note:** Because NSPOS is highly customizable, your store's procedures may vary.

Start of Day – Enter Beginning Till Count

Before starting any cash sales activity on an NSPOS register, the store manager or cashier will count and enter the beginning currency denominations placed in each register. This money is a float for making change throughout the day. Accurate reporting for identifying overages or shortages depends on ensuring beginning values are accurate.

A beginning till count is generated every time the physical till tray is inserted or removed from a till cash drawer.
To enter the beginning till count:

1. In Sales Mode, ensure no sales transaction is present in the Journal.
2. Tap Manager Functions.
   - If you do not see Manager Functions, press Ctrl+F12 and search for Start of Day.
3. Tap Start of Day.
4. In the Count Till window, enter the count for each coin and bill denomination.
   - **Note:** Use the tab key to quickly move between fields.
5. Review the total Cash Amount on the right.
6. Tap Done when complete.
   - The till is ready for the opening shift. Because NSPOS assigns the till to the shift, different cashiers can sign on and sign off to NSPOS using this till during the shift.

During the Day – Make a Drawer Drop

Also called a tender pickup, perform this to remove excess cash from an NSPOS till during a shift or business day. Besides keeping the drawer organized and manageable, making drawer drops reduces the risk of having large amounts of cash in registers throughout your store.

To make a drawer drop:

1. In Sales Mode, complete all sales transactions.
2. Tap Manager Functions.
   - If you do not see Manager Functions, press Ctrl+F12 and search for Drawer Drop.
3. Tap Drawer Drop.
   - The cash drawer opens and the Tender Pickup window appears.
4. Remove cash as needed, entering the count for each coin and bill denomination removed.
   - **Note:** Use the tab key to quickly move between fields.
5. Review the total Cash Amount on the right.
6. Tap Done.
7. If prompted, select a Pickup Reason Code.
8. If applicable to the drop, complete the optional Bank Deposit form that appears.

During the Day – Make a Drawer Loan

When a cashier runs short of change during their shift, your cash office or back office can make a drawer loan to their NSPOS till. A drawer loan is also called a tender loan. Loans to a drawer are reconciled using your company’s internal methods.

To make a drawer loan:

1. In Sales Mode, complete all sales transactions.
2. Tap Manager Functions.
   - If you do not see Manager Functions, press Ctrl+F12 and search for Drawer Loan.
3. Tap **Drawer Loan**. The cash drawer opens and the **Till Count** window appears.

If you do not see **Drawer Loan**, press **Ctrl+F12** and search for **Drawer Loan**.

4. Add the loaned cash, entering the count for each coin and bill denomination put into the till.

   **Note:** Use the tab key to quickly move between fields.

5. Review the total **Cash Amount** on the right.
6. Tap **Done**.

### During the Day – Make a Disbursement

Depending on your store's setup, you may also have the option to disburse cash from a till for small expenditures such as petty cash purchases of supplies or services.

Disbursements are typically performed for immediate needs vital to your store's operation, such as purchasing receipt paper or paying a cleaning service. Disbursements might also occur for expenses such as charitable donations. If the disbursement option is installed, you can select a Reason Code for tracking purposes.

**To make a disbursement:**

1. In **Sales Mode**, complete all sales transactions.
2. Tap **Other Functions**.
3. Tap **Disbursement**.
4. If prompted, sign in with your authorized credentials.
5. Find and select a **Reason Code**.
6. Remove the cash to disburse.
7. Enter the **Cash Disbursement Amount**.
8. Tap **Enter**.
9. Choose whether to print a receipt.
10. If printed, place the receipt in the location listed in your store's procedures, such as the cash drawer.

### End of Day – Count and Settle Till

Perform these steps to count and settle each till at the end of a shift. This creates a NetSuite business day of register transactions and provides the totals that determine any overage or shortage.

**Important:** By default, the End of Day process cancels and clears all suspended customer transactions.

Because your NSPOS administrator can customize the End of Day process with a variety of options, your store procedures might vary. For example, your administrator can set registers to not automatically cancel suspended transactions.

**Note:** Transactions from NSPOS sync to NetSuite ERP throughout the day, not just at End of Day.

**To count and settle a till:**

1. In **Sales Mode**, complete all sales transactions.
2. Tap Manager Functions.
   If you do not see Manager Functions, press Ctrl+F12 and search for End of Day.
3. Tap End of Day.
4. Tap Yes for Proceed with the End of Day Process?
5. Depending on your setup, you may be prompted to select a Count Till ID for this or other workstations.
   This ends the shift and closes the till.

   **Note:** Signing in again will open a new till.

7. Choose whether to Print a Till Count Worksheet?
   This worksheet provides a convenient form on which to enter your count. It prints as a receipt on the receipt printer. The cash drawer opens and the Count Till window appears.
8. Enter the count for each coin and bill denomination.

   **Note:** Use the tab key to quickly move between fields.
9. Tap Done when complete.
10. Choose whether to Print the Actual Till Counts?
    This report lists counted values for the till.
11. If prompted, choose whether to Recount Till? to confirm the count.
    The Sales Audit Report runs and appears when the count is complete. The cashier is signed off from NSPOS.

**Review End of Day in NetSuite ERP**

Follow these steps to review your end of day settlements in the NetSuite application. This task may not be available to all users.

To review End of Day settlements:

1. Log in to NetSuite ERP.
2. Go to Transactions > Financial > Make Journal Entries > List.
3. Locate the desired entries by Date, Account or other column.
4. Tap View.

**Flags and Settings**

Follow these steps to view and edit flags and settings for NSPOS, including universal settings and settings for groups, workstations, stores, permissions and preferences.

- A flag is any setting with a Boolean value, such as a check box that is either checked or blank or a field set to true or false, or 1 or 0. Changing a flag enables or disables an option.
- A setting is any customizable field value, such as a default amount or a maximum or minimum limit. Changing a setting lets you configure your NSPOS installation to match business rules in place for your stores.
Warning: This topic describes making changes to the NSPOS default setup. Be aware that changes can impact custom configurations previously made for your business. NetSuite recommends that only experienced administrator personnel make setting adjustments.

- Flag List
- Setting List

How changes replicate across your network

Updates made from a single POS register replicate everywhere across your network in the next synchronization cycle. Some changes will not apply until you restart the workstation or register. Although you may not receive a prompt to restart, it is good practice to always exit and restart the application after making changes.

The type of flag or setting determines where changes will apply.

- Universal Settings – Apply everywhere on your network.
- Store Settings – Apply only to registers in the selected store.
- Group Settings – Apply only to registers of the same Workstation Type. The Workstation Type is a field in NetSuite under RA-Workstation records.
- Workstation Settings – Apply only to the selected register.

To view and edit a flag or setting:

1. Sign in to any NSPOS register as an administrator (9090 level operator).
2. Press Ctrl+F10 to open the Universal Settings window.
3. To adjust Settings for:
   - Your entire system (Universal Setting), continue to the next numbered step.
   - All operators and registers in a particular store, tap Store Settings
   - All operators and registers in a particular group, tap Group Settings
   - The current workstation, tap Workstation Settings.
4. In the search field, enter any part of a flag or setting name. The current configuration displays.
5. If desired, edit the flag or setting.
   - For field settings, tap the red and white icons near the field labels to enable or disable.
   - For check box flags, tap the blue triangle and red icons to disable or enable.
6. Tap Done when complete.
7. If you made changes, tap Sign Off and then tap Exit. Restart the application.

Flag List

A flag in NSPOS is any setting with a Boolean value, such as a check box that is either checked or blank, a field set to true or false or 1 or 0, or an option that is enabled or disabled. Flag shown with a colon(;) list the setting group and then the flag name.

- Flag – The flag name.
<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment: Ask About Effect</td>
<td>Asks the user if the adjustment affects the inventory negatively or positively.</td>
</tr>
<tr>
<td>Anonymous Customer: Job Enabled</td>
<td>Enable automated job runs that assign anonymous default customers to NetSuite ERP Location records with no default selected. Job also replaces anonymous customers when history reaches 100,000 transactions. Default is job enabled.</td>
</tr>
<tr>
<td>Application Startup: Synchronize Date and Time</td>
<td>Automatically adjust the local system time based on the time-zone settings for the store.</td>
</tr>
<tr>
<td>Application Startup: Use Startup Folder</td>
<td>Process scripts in the System Startup folder when the Application has loaded.</td>
</tr>
<tr>
<td>ApplyRetailPriceModifiers</td>
<td>Use new NSPOS external business logic in RA_BestDiscount.</td>
</tr>
<tr>
<td>Audio Alerts: Get Entry</td>
<td>Play an audio alert when the user’s attention is requested by GetEntry.</td>
</tr>
<tr>
<td>Audio Alerts: Item Price Entry</td>
<td>Play an audio alert when an item requires price entry.</td>
</tr>
<tr>
<td>Audio Alerts: Notification</td>
<td>Play a sound when a notification appears.</td>
</tr>
<tr>
<td>Audio Alerts: Popup Notification</td>
<td>Play a sound when a popup notification appears.</td>
</tr>
<tr>
<td>Audio Alerts: Request Credentials</td>
<td>Play an audio alert when user credentials are requested.</td>
</tr>
<tr>
<td>Audio Alerts: User Input</td>
<td>Play an audio alert when user input is requested.</td>
</tr>
<tr>
<td>Authorization: Use Preferred Location</td>
<td>An Operator’s location will be used as a hint, not a rule when signing on.</td>
</tr>
<tr>
<td>Buy/Trade: Allow Invalid Customer Data</td>
<td>Tells the buy/trade process to allow purchases from customers in bad seller groups.</td>
</tr>
<tr>
<td>Buy/Trade: Hide Conversion Details</td>
<td>Hide details regarding the cash/trade conversion and related clearing adjustments in the Journal.</td>
</tr>
<tr>
<td>CashBack</td>
<td>Indicates that the customer should be prompted for a cash back amount when using a debit card.</td>
</tr>
<tr>
<td>CATLineDisplay</td>
<td>Use the customer activated terminal as a line display.</td>
</tr>
<tr>
<td>Clear Operator: Skip Sign On</td>
<td>Will not require initial sign on when loading NSPOS and will only sign off after a transaction.</td>
</tr>
<tr>
<td>ClearOperator</td>
<td>The Operator is cleared after each transaction (excluding Sign On/Off transactions).</td>
</tr>
<tr>
<td>ConfirmPayment</td>
<td>Confirm the customer activated terminal payment amount</td>
</tr>
<tr>
<td>Consignment: Allow Invalid Customer Data</td>
<td>Tells the consignment process to allow completing the transaction even when customer data is invalid.</td>
</tr>
<tr>
<td>Consignment: Real-time Credit Memos</td>
<td>Applies credit to a consignors account whenever their item is sold in a transaction.</td>
</tr>
<tr>
<td>Coupon: Ignore Family</td>
<td>Family Code will not be evaluated when applying a coupon.</td>
</tr>
<tr>
<td>Coupon: Ignore Manufacturer</td>
<td>Manufacturer will not be evaluated when applying a coupon.</td>
</tr>
<tr>
<td>CreateCardholderCustomer</td>
<td>Create a customer from the cardholder name.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Customer Account: Allow Non-Same Day Cash</td>
<td>Allow customers to receive cash payments for balances on house accounts indefinitely.</td>
</tr>
<tr>
<td>Customer Edit: Allow Employee Affiliation</td>
<td>Customers can be affiliated with an employee, and share their discount status.</td>
</tr>
<tr>
<td>Customer Edit: Allow Organization Affiliation</td>
<td>Customers can be affiliated with an organization, and share their tax status.</td>
</tr>
<tr>
<td>Customer Edit: Alternate Phone Numbers</td>
<td>Enable alternate phone numbers for Customers, such as Work, Mobile, and Fax.</td>
</tr>
<tr>
<td>Customer Edit: Always Show Identification Types</td>
<td>Always display the Identification Type selection area, even if there is only one option.</td>
</tr>
<tr>
<td>Customer Edit: Charge Account Limit</td>
<td>Display the Charge Account Limit for a customer.</td>
</tr>
<tr>
<td>Customer Edit: Customer Group</td>
<td>Show the Customer Group field on the edit form.</td>
</tr>
<tr>
<td>Customer Edit: Hide ID Fields</td>
<td>Hide the Identification related prompts.</td>
</tr>
<tr>
<td>Customer Edit: Hide Nationality</td>
<td>Do not display the Nationality field on the Customer Edit form.</td>
</tr>
<tr>
<td>Customer Edit: Hide Over 18</td>
<td>Hide the ‘Customer is Over 18’ prompt.</td>
</tr>
<tr>
<td>Customer Edit: Hide Picture</td>
<td>Hide the customer Picture prompt.</td>
</tr>
<tr>
<td>Customer Edit: Require Area Code</td>
<td>Require a three digit area code for all phone numbers.</td>
</tr>
<tr>
<td>Customer Edit: Require City</td>
<td>Require the Customer City for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Email</td>
<td>Require the Customer Email for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Identification</td>
<td>Require the Customer Identification for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Image</td>
<td>Require the Customer Image for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Middle Name</td>
<td>Require the Customer Middle Name for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Nationality</td>
<td>Require the Customer Nationality for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Notes</td>
<td>Require the Customer Notes for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Phone</td>
<td>Require the Customer Phone for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Postal Code</td>
<td>Require the Customer Postal Code for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Prefix</td>
<td>Require the Customer Prefix for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require State</td>
<td>Require the Customer State for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Street Address</td>
<td>Require the Customer Street Address for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Require Suffix</td>
<td>Require the Customer Suffix for all new Customers.</td>
</tr>
<tr>
<td>Customer Edit: Validate New Customer</td>
<td>New Customers will be validated using the Validate New Customer express file, if present.</td>
</tr>
<tr>
<td>Customer Find: Full Width Layout</td>
<td>Display customers using the Full Width layout in the Find Results window.</td>
</tr>
<tr>
<td>Customer Find: Use Alternate Style</td>
<td>Customer Find Results will be displayed using the RA.Find.CustomerFindResult class.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer History: Include Default History</td>
<td>Use the built-in Customer History data for all Customers.</td>
</tr>
<tr>
<td>CustomerNationality</td>
<td>Displays a Nationality section on Customer Add and Edit forms.</td>
</tr>
<tr>
<td>CustomerRequired</td>
<td>Requires a customer to begin a sale.</td>
</tr>
<tr>
<td>CustomerSubLocation</td>
<td>Displays a Sub Location (Hotel) section on Customer Add and Edit forms.</td>
</tr>
<tr>
<td>Debit Card: No refund</td>
<td>When a debit card refund is attempted, show message “Please use credit card or cash tender to process this refund.”</td>
</tr>
<tr>
<td>Debit Card: Use legacy key serial number</td>
<td>When a key serial number is 20 bytes and starts with FFFF, remove the FFFF.</td>
</tr>
<tr>
<td>DebugPrinter</td>
<td>Text should be displayed on-screen rather than sent to a printer.</td>
</tr>
<tr>
<td>DeveloperMode</td>
<td>Allow the use of Execute and Full Screen toggle.</td>
</tr>
<tr>
<td>DisbursementGetCustomer</td>
<td>Requires a Customer for Disbursement transactions.</td>
</tr>
<tr>
<td>Discount: Discount promoted items</td>
<td>If checked (enabled), allow sales associates to manually discount an item included in a promotion without displaying an alert.</td>
</tr>
<tr>
<td></td>
<td>If the box is clear (disabled), allow the manual discount but display an alert. A manager or administrator authorization may be required.</td>
</tr>
<tr>
<td></td>
<td>Default is checked.</td>
</tr>
<tr>
<td>Discount: Promote discount items</td>
<td>If checked (enabled), allow an item that received a manual discount to be included in a promotion.</td>
</tr>
<tr>
<td></td>
<td>If the box is clear (disabled), items receiving a manual discount cannot also receive a promotional discount.</td>
</tr>
<tr>
<td></td>
<td>Default is clear (disabled).</td>
</tr>
<tr>
<td>Discount: Limit to price override and one discount</td>
<td>Limit discounts that can be applied to a price override and one discount.</td>
</tr>
<tr>
<td>Discount: All Discounts Require Reason</td>
<td>All manual discount types will prompt for a reason code.</td>
</tr>
<tr>
<td>Discount: Display Mode on Transaction</td>
<td>Display posting and non-posting status of discounts.</td>
</tr>
<tr>
<td>Discount: Price Override Requires Reason</td>
<td>Require a reason code for manual price overrides.</td>
</tr>
<tr>
<td>Discount: Set Item Status to Discount Reason</td>
<td>Display the Reason as the item Status.</td>
</tr>
<tr>
<td>Do Not Prompt for Rental Rate</td>
<td>Always use the same value for Rental Rate, and do not prompt the operator to supply a value.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DontAssumeDecimal</td>
<td>Causes GetNumeric to never assume a decimal place in all cases.</td>
</tr>
<tr>
<td>Edit Item: Allow Price Change</td>
<td>Allow the price of an item to be modified after it has been received.</td>
</tr>
<tr>
<td>EditItemHideTax</td>
<td>Hide the tax configuration section on Item Add and Edit forms.</td>
</tr>
<tr>
<td>End Of Day: Cancel Suspended</td>
<td>Cancel suspended transactions as a part of the end of day process.</td>
</tr>
<tr>
<td>End Of Day: Perform Till Count</td>
<td>Perform a till count as part of the end of day process.</td>
</tr>
<tr>
<td>End Of Day: Print Receipt</td>
<td>Prints an end of day receipt during the end of day process.</td>
</tr>
<tr>
<td>End Of Day: Print Reports</td>
<td>Prints reports found in the End Of Day: Report List setting during the end</td>
</tr>
<tr>
<td></td>
<td>of day process.</td>
</tr>
<tr>
<td>End of Day: Process Unattended</td>
<td>Allow the End Of Day process to proceed with no input from the user.</td>
</tr>
<tr>
<td>End Of Day: Settle Batch</td>
<td>Settle the credit card batch as part of the end of day process.</td>
</tr>
<tr>
<td>End Of Day: Settle Till</td>
<td>Settle the till as a part of the end of day process.</td>
</tr>
<tr>
<td>End Of Day: TillSettle</td>
<td>Settle the till as a part of the end of day process.</td>
</tr>
<tr>
<td>End Of Shift: Perform Till Count</td>
<td>Perform a till count as part of the end of shift process.</td>
</tr>
<tr>
<td>End Of Shift: Print Receipt</td>
<td>Prints an end of shift receipt during the end of shift process.</td>
</tr>
<tr>
<td>End Of Shift: Print Reports</td>
<td>Prints reports found in the end of shift: Report List setting during the end</td>
</tr>
<tr>
<td></td>
<td>of shift process.</td>
</tr>
<tr>
<td>End of Shift: Process Unattended</td>
<td>Allow the End Of Shift process to proceed with no input from the user.</td>
</tr>
<tr>
<td>End Of Shift: Settle Batch</td>
<td>Settle the credit card batch as part of the end of shift process.</td>
</tr>
<tr>
<td>End Of Shift: TillSettle</td>
<td>Settle the till as a part of the end of shift process.</td>
</tr>
<tr>
<td>EndOfDayPrintReport</td>
<td>Print the End Of Day Report.</td>
</tr>
<tr>
<td>EndOfDaySettleBatch</td>
<td>Settle Credit Card Batch as a part of the End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfDaySuspendedCancel</td>
<td>Cancels Suspended Transactions when EndOfDay is run</td>
</tr>
<tr>
<td>EndOfDaySuspendedPrevent</td>
<td>Suspended Transactions will Prevent End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfDayTillCount</td>
<td>Count the Till as a part of the End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfDayTillSettle</td>
<td>Settle the till as a part of the end of day process.</td>
</tr>
<tr>
<td>EndOfDayUnattended</td>
<td>Suppress Confirmation Dialogs in the End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfShiftSettleBatch</td>
<td>Settle Credit Card Batch as a part of the End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfShiftSuspendedCancel</td>
<td>Cancels Suspended Transactions when EndOfDay is run</td>
</tr>
<tr>
<td>EndOfShiftSuspendedPrevent</td>
<td>Suspended Transactions will Prevent End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfShiftTillCount</td>
<td>Count the Till as a part of the End Of Day Processing.</td>
</tr>
<tr>
<td>EndOfShiftTillSettle</td>
<td>Settle the till as a part of the end of shift process.</td>
</tr>
<tr>
<td>EndOfShiftUnattended</td>
<td>Suppress Confirmation Dialogs in the End Of Day Processing.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EpsonPrinter</td>
<td>Specifies that the attached printer uses ESC/POS codes versus OPOS formatting codes.</td>
</tr>
<tr>
<td>Express: Allow Local Express Files</td>
<td>Allow express files to be run from the local file system.</td>
</tr>
<tr>
<td>Find Item: Disallow Expired Items</td>
<td>Prevent expired items from being used in the Point of Sale.</td>
</tr>
<tr>
<td>Find Item: Hide Expired Items</td>
<td>Do not display expired items when searching the catalog. (Global/Store only).</td>
</tr>
<tr>
<td>Find Item: Use Alternate Layout</td>
<td>Items will be displayed using the alternate Find style.</td>
</tr>
<tr>
<td>FindInDescription</td>
<td>Indicates Find Anywhere will include description in the searchable fields.</td>
</tr>
<tr>
<td>FindNotOnFile</td>
<td>Causes a Find Item Window to open with the entry text when the entry text does not correspond to a SKU or Barcode.</td>
</tr>
<tr>
<td>FullPageReceiptDuplicate</td>
<td>Receipts should be printed using both an attached OPOS receipt printer and a full size Windows based printer.</td>
</tr>
<tr>
<td>FullPageReceipts</td>
<td>Receipts will be printed using a full size Windows based printer rather than an OPOS receipt printer.</td>
</tr>
<tr>
<td>FullPageWorksheets</td>
<td>Prints Till Management worksheets on a full size Windows based printer.</td>
</tr>
<tr>
<td>FullScreen</td>
<td>Display the main form maximized and without a border.</td>
</tr>
<tr>
<td>FundsReceipt: GetCustomer</td>
<td>Requires a customer for a funds receipt.</td>
</tr>
<tr>
<td>GiftCertificateChecksum</td>
<td>Allows the Gift Certificate checksum to be ignored.</td>
</tr>
<tr>
<td>GiftPrompt</td>
<td>After a retail transaction, the option to print a Gift Receipt is to be presented.</td>
</tr>
<tr>
<td>Hide Transaction Complete</td>
<td>Do not show the Transaction Complete window after certain transactions.</td>
</tr>
<tr>
<td>HideDefaultFindImage</td>
<td>Hide the red pin image for Find Results with no image specified.</td>
</tr>
<tr>
<td>IgnoreCustomerLocation</td>
<td>Removes Store ID filter from Customer selection windows.</td>
</tr>
<tr>
<td>ImprintHandKeyedCreditCard</td>
<td>Causes a popup to occur saying “Please make an imprint of the credit card” when processing a credit card.</td>
</tr>
<tr>
<td>Interface: Display Tooltips for Buttons</td>
<td>Display tool tips when pointing the mouse cursor at a button.</td>
</tr>
<tr>
<td>Interface: Entry Overlay</td>
<td>Display the entry window as needed in an overlay window.</td>
</tr>
<tr>
<td>Interface: Fade Windows</td>
<td>When displaying or hiding a window, fade the window into or out of view gradually.</td>
</tr>
<tr>
<td>Interface: Low Latency Mode</td>
<td>User interface elements are drawn using fewer colors to lower the latency.</td>
</tr>
<tr>
<td>Interface: Remain Enabled During Entry</td>
<td>Buttons and other interface elements should stay visually enabled during entry.</td>
</tr>
<tr>
<td>Interface: Simple Splash Screen</td>
<td>Disable various graphical effects used by the Splash Screen for high demand environments .</td>
</tr>
<tr>
<td>Interface: Suppress Alert Tips</td>
<td>Do not show Alert Tip popup windows unless the user clicks the status bar icon.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>International</td>
<td>Removes region specific validation from Phone number on Customer Add and Edit forms.</td>
</tr>
<tr>
<td>Inventory: Track Quantity on Hand</td>
<td>Track the number of items sold and received.</td>
</tr>
<tr>
<td>Item: Disable Weighted Barcode</td>
<td>Process barcodes that begin with 2 as normal item codes instead of weight or price data. The default is Yes, disable weighted barcode.</td>
</tr>
<tr>
<td>Item Find: Full Width Layout</td>
<td>Display items using the Full Width layout in the Find Results window.</td>
</tr>
<tr>
<td>Item Find: Show Extended Categories</td>
<td>Shows categories that provide extra search functionality for items.</td>
</tr>
<tr>
<td>ItemSellingRule InStock</td>
<td>Require that the item be in stock to be sold.</td>
</tr>
<tr>
<td>Keep Report Find Window Open</td>
<td>When using the Find Report function, keep the Find window open until the user presses cancel, even if a report is run.</td>
</tr>
<tr>
<td>LoanBeginningCashAmount</td>
<td>Prompt for beginning cash amount when a new till is created.</td>
</tr>
<tr>
<td>MSR: Decode Data</td>
<td>Forces the DecodeData property to be true for the OPOS MSR.</td>
</tr>
<tr>
<td>NetSuite: Prepend Gift Certificates</td>
<td>Prepends a gift certificate code with zeroes to pass through gift card logic.</td>
</tr>
<tr>
<td>Network: Allow Remote Authorization</td>
<td>Allow manager credentials to be requested and provided remotely.</td>
</tr>
<tr>
<td>Network: Enable Network Messaging</td>
<td>When enabled, messages can be sent and received over the network.</td>
</tr>
<tr>
<td>NonValidatedReturnsReqCust</td>
<td>When set, non validated returns require a customer.</td>
</tr>
<tr>
<td>On Screen Keyboard: Show on Startup</td>
<td>Show the Windows On Screen Keyboard when the application is started.</td>
</tr>
<tr>
<td>OneCashTender</td>
<td>Limits the Cash Tender to only one per transaction.</td>
</tr>
<tr>
<td>Open Item: Add Comment</td>
<td>Adds a comment line to store the new sku and description for an open item.</td>
</tr>
<tr>
<td>Operator Edit: Always Show Select Customer</td>
<td>Allow the customer to be changed for an existing Operator.</td>
</tr>
<tr>
<td>Operator Edit: Default to All Locations</td>
<td>When creating a new operator, the location will be set to All Locations.</td>
</tr>
<tr>
<td>Operator Edit: Restrict Access Based on Level</td>
<td>Do not allow operator to edit other operators with a higher permission level.</td>
</tr>
<tr>
<td>Operator Edit: Return to Find After Edit</td>
<td>After editing an operator, return the Operator Find window. Cancel to exit.</td>
</tr>
<tr>
<td>Payment on Account: Allow Zero Payment</td>
<td>Allow zero payment on sales transaction or sales order. Permits POS to accept $0.00 sales or cancel the payment when needed.</td>
</tr>
<tr>
<td>Payment on Account: Hide Balance Due Prompt</td>
<td>This will hide the balance due on the prompt when fulfilling an order.</td>
</tr>
<tr>
<td>Payment: Use Lane ID</td>
<td>Provide the unique Lane ID value to payment processors.</td>
</tr>
<tr>
<td>Pole Display: Display in Caps</td>
<td>Displays text on the Pole Display in all capital letters.</td>
</tr>
<tr>
<td>PreSign</td>
<td>Indicates that the customer may sign for a credit card transaction before it has completed.</td>
</tr>
<tr>
<td>Print Consignment Payout Agreement</td>
<td>Print a paper agreement form when paying a consignor for goods sold.</td>
</tr>
<tr>
<td>PrintCheckSlip</td>
<td>Prints a check slip on a OPOS check printer.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printer: Encode Barcode</td>
<td>Encodes the barcode before sending to the printer.</td>
</tr>
<tr>
<td>Product Feedback: Enable Email Feedback</td>
<td>Allow the application to send an email message with information about the system if a critical error occurs.</td>
</tr>
<tr>
<td>Product Feedback: Include Server in Subject</td>
<td>Include the server name in the email subject.</td>
</tr>
<tr>
<td>Product Feedback: Log to Database</td>
<td>Logs product feedback to the RA_ProductFeedback table.</td>
</tr>
</tbody>
</table>
| Promotions: Use Old Promotion Engine      | Use this flag to determine the promotion options available at the register. If checked (true), your promotions are limited to the NetSuite ERP fields available on the Classic Promotions Form. If the box is clear (false), the register can use the additional fields included on the Advanced Promotions Form.  
  If NetSuite ERP is set for Advanced Promotions, but Use Old Promotions Engine is checked on a register, NSPOS ignores the advanced fields not found on the Classic Promotion Form. If you currently use the Classic Promotions form, the default is checked (true).  
  —  
  We do not recommend changing this flag without contacting NetSuite Customer Support first. Changing the flag can create issues with your current setups. For example, sales orders created under a Classic Promotions setup may not provide the correct discount if you clear the register flag. You also might lose the ability to edit those sales orders.  
  We recommend changing all registers and the NetSuite ERP Classic to Advanced Promotion Form at the same time or doing it as part of an upgrade. Change the NetSuite ERP form first and set up an advanced promotion to use for testing.  
  —  
  If you want to test the change without performing full user acceptance testing (UAT), you can check or clear the flag on a single register. Making a test change to multiple registers can make it difficult to pinpoint issues.  
  Warning: We strongly recommend contacting NetSuite Customer Support before checking or clearing the Use Old Promotions Engine flag. Changing the flag setting without proper preparation can and will create issues with your current setup. |
<p>| PromptForAmountDue                         | Set this to force the user to enter a value when tendering a sale rather than default to the Amount Due.                                                                                                  |
| RebateReceipts                            | Print an additional receipt for any rebates included in the sale.                                                                                                                                       |
| Receipts: Ask for Receipt                 | Asks whether or not the customer wants to receive a printed receipt.                                                                                                                                     |
| Receipts: Print in Caps                   | Capitalizes all text on receipts.                                                                                                                                                                         |
| Receipts: Allow cashier to disable receipt prompts | When prompted to print a customer receipt, the cashier has an option to save a preference. If they select to not print a receipt and save that preference, future receipt prompts are disabled. |</p>
<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipts: Select Gift Occasion</td>
<td>Prompt for the occasion to print on the receipt.</td>
</tr>
<tr>
<td>Receiving: Start With Zero Quantity</td>
<td>Starts with 0 quantity when receiving lines.</td>
</tr>
<tr>
<td>RecordNotOnFile</td>
<td>Records when an item is found to be not on file.</td>
</tr>
<tr>
<td>Reports: Use Default Printer</td>
<td>Print reports directly to the default printer when the print command is used from the viewer.</td>
</tr>
<tr>
<td>RequireCustomer</td>
<td>A Customer must be selected before any Tenders can be received.</td>
</tr>
<tr>
<td>RequireCustomerInfo</td>
<td>Includes more fields in the requirement list for Customer Add and Edit forms.</td>
</tr>
<tr>
<td>Returns: Allow cross subsidiary returns</td>
<td>Allow customers to return items between stores in different subsidiaries. The default is clear (false).</td>
</tr>
<tr>
<td>Returns: Disable Original Card</td>
<td>For use on registers where credit card payments over Vantiv Integrated Payments (formerly Mercury Payment Systems MPS) displays Visa return Error Invalid Field - Account Number, and the payment fails to complete. Default is False. Set flag to True to correct issue. In the case of multiple payment providers, enable the flag only for registers using Vantiv.</td>
</tr>
<tr>
<td>Returns: Do not Require Signature</td>
<td>Do not require the customer signature to return merchandise.</td>
</tr>
<tr>
<td>Returns: Include all stores default value</td>
<td>Default value for search return transaction in all locations.</td>
</tr>
<tr>
<td>Returns: Include all stores enabled</td>
<td>Enable option to search transaction in other locations.</td>
</tr>
<tr>
<td>Returns: Include NetSuite sales default value</td>
<td>Default value for search return transaction in NetSuite.</td>
</tr>
<tr>
<td>Returns: Include NetSuite sales enabled</td>
<td>Enable option to search transaction also in NetSuite.</td>
</tr>
<tr>
<td>Returns: Refunds Require Original Tender</td>
<td>Refunds issued for validated merchandise returns require the original tender or it’s refund tender.</td>
</tr>
</tbody>
</table>

**Warning:** Enabling this **Returns** flag without the required prerequisites will cause:
- Transactions to become stuck on the server.
- Incorrect transaction processing that affects price calculations.
- Major synchronization issues leading to data inconsistencies between NS ERP and your POS terminals.

**Do not enable this flag without working with NetSuite Customer Support.**
<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Returns: Refunds Use Original Tender Thresholds</td>
<td>Refunds issued for validated merchandise returns use the original transaction’s tender refund thresholds.</td>
</tr>
<tr>
<td>Returns: Require Disposition</td>
<td>Makes it so a disposition reason is required when returning something.</td>
</tr>
<tr>
<td>Returns: Suppress Tag Printing</td>
<td>Do not print a tag when returning an item.</td>
</tr>
<tr>
<td>Sales Order: Advanced Shipping</td>
<td>This setting is not valid for NSPOS 2016.1 or later. It has no effect.</td>
</tr>
<tr>
<td>Sales Order: Disable Edit</td>
<td>To restrict editing from the register, check the Sales Order flag option: Disable Edit, making it true. The flag is set to false by default. If checked, sales associates can create sales orders and take payment, but all edits must be performed in NetSuite. This is useful for when sales order item-handling is performed away from the store, such as in a warehouse.</td>
</tr>
<tr>
<td>Sales Order: Invoice Unfulfilled Items</td>
<td>Use to control whether sales associates can invoice (take full payment) for Sales Orders prior to fulfillment of all items. Default is enabled (true).</td>
</tr>
<tr>
<td>Sales Order: No Auto Complete When Fulfilling</td>
<td>Prevents automatically finalizing a transaction when fulfilling.</td>
</tr>
<tr>
<td>Sales Order: Offline Mode</td>
<td>Turn off the real-time connection to NetSuite ERP that communicates sales order updates. If offline mode is checked, sales order updates wait for the next synchronization (upsync) cycle. It can be used as a workaround for bandwidth issues by maintaining all sales orders local to the register. The default is clear (false). Note that this setting can lead to synchronization issues and other errors.</td>
</tr>
<tr>
<td>Sales Test: Customer Per Workstation</td>
<td>Look up a specific customer for the current workstation.</td>
</tr>
<tr>
<td>Shift4: UTG PinPad line item display enabled</td>
<td>Show line item display on PinPad via UTG.</td>
</tr>
<tr>
<td>Shipping: Adjust Tax</td>
<td>Determines if tax should be adjusted to use the shipping postal code when a transaction includes a shipping destination. Default is disabled (false).</td>
</tr>
<tr>
<td>Show Transaction Complete</td>
<td>Displays a message box indicating a retail transaction has completed.</td>
</tr>
<tr>
<td>ShowTotal</td>
<td>Indicates the customer terminal will be used to display the total.</td>
</tr>
<tr>
<td>ShowTrxCompleteImage</td>
<td>Display an image on the Transaction Journal object when the Transaction is complete.</td>
</tr>
</tbody>
</table>

**Warning:** Enabling this Sales Order: Offline Mode flag without the required prerequisites will cause:
- Transactions to become stuck on the server.
- Incorrect transaction processing that affects price calculations.
- Major synchronization issues leading to data inconsistencies between NS ERP and your POS terminals.

**Do not enable this flag without working with NetSuite Customer Support.**
<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signatures: No Employee Signature</td>
<td>Employees are not required to sign when purchasing.</td>
</tr>
<tr>
<td>SignOnEntry</td>
<td>Causes a SignOn to use the Entry Window rather than the Elevate dialog.</td>
</tr>
<tr>
<td>SimpleCustomerInfo</td>
<td>The required fields on the Customer Add and Edit form are reduced to First and Last Names only.</td>
</tr>
<tr>
<td>Status Display: Show Operator Name</td>
<td>Display the Operator Name in the Status Bar instead of their ID.</td>
</tr>
<tr>
<td>SuppressPrintCanceled</td>
<td>Suppress Canceled Transaction Receipts.</td>
</tr>
<tr>
<td>SuppressPrintCONTRL</td>
<td>Suppress all Control Transactions from printing.</td>
</tr>
<tr>
<td>SuppressPrintCONTRLSNOF</td>
<td>Suppress Sign Off Transactions from printing.</td>
</tr>
<tr>
<td>SuppressPrintCONTRLSNON</td>
<td>Suppress Sign On Transactions from printing.</td>
</tr>
<tr>
<td>SuppressPrintCONTRLTPNC</td>
<td>Suppress Time Punch Transactions from printing.</td>
</tr>
<tr>
<td>SuppressPrintCONTRLVOID</td>
<td>Suppress Cancel Transaction Receipts.</td>
</tr>
<tr>
<td>SuppressPrintCONTRLVRSN</td>
<td>Suppress Version Transactions from printing.</td>
</tr>
<tr>
<td>SuppressPrintSuspended</td>
<td>Suppress printing customer and cashier receipts for suspended transactions.</td>
</tr>
<tr>
<td>SuppressPrintTraining</td>
<td>Suppress Training Transaction Receipts.</td>
</tr>
<tr>
<td>SuppressPrintVoided</td>
<td>Suppress Voided Transaction Receipts.</td>
</tr>
<tr>
<td>SuppressTag:Merchandise Return</td>
<td>Suppress the Merchandise Return Receipt.</td>
</tr>
<tr>
<td>System: Use On Screen Keyboard</td>
<td>Show the on screen keyboard throughout the application.</td>
</tr>
<tr>
<td>Tax Engine: Do Not Use</td>
<td>Disables the tax engine.</td>
</tr>
<tr>
<td>Tax Exemption: Certificate ID</td>
<td>Allows an operator to enter a tax exemption certificate ID that is recorded when a transaction is exempted from tax.</td>
</tr>
<tr>
<td>Tax Exemption: Require Customer</td>
<td>When set, requires a customer to make a transaction tax exempt.</td>
</tr>
<tr>
<td>Tax: Authority Override</td>
<td>Exempts tax when outside the jurisdiction of the current store.</td>
</tr>
<tr>
<td>Tax: Exempt Outside Jurisdiction</td>
<td>Determines how taxes are calculated if no tax schedule is available. Default is disabled (false).</td>
</tr>
<tr>
<td></td>
<td>▪ If false, and no schedule for the shipping postal code is available, NSPOS alerts the sales associate that no tax is defined for the postal code. The store location or other default tax is used.</td>
</tr>
<tr>
<td></td>
<td>▪ If true, and no schedule for the shipping postal code is available, the transaction will become <strong>tax exempt</strong>.</td>
</tr>
<tr>
<td>Tender Control: Allow Comments</td>
<td>Allows a clerk to enter comments when doing a disbursement or funds receipt.</td>
</tr>
<tr>
<td>Tender: Calculate Promotions on Demand</td>
<td>Promotions normally calculate or recalculate automatically with every change in the register Journal. Changes include adding or voiding items and changing quantities. If the list of items is very long and multiple promotions are in effect to calculate against, automatic calculations can lead to performance issues.</td>
</tr>
<tr>
<td>Flag</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Flag</td>
<td>If this flag is enabled (checked), only calculate promotions when the sales associate clicks <strong>Amt Due</strong> or another button that is customized to calculate promotions on demand. Default is clear (disabled).</td>
</tr>
<tr>
<td>Tender: Change Due Maximum - No Manager Override</td>
<td>Do not allow a manager to override the maximum change amount due for a tender.</td>
</tr>
<tr>
<td>Tender: Zero Change Max - No Manager Override</td>
<td>Do not allow a manager to override change due when the max is zero.</td>
</tr>
<tr>
<td>Till Count: Open Drawer for Initial Count</td>
<td>Display an itemized cash count worksheet when receiving a Tender Loan.</td>
</tr>
<tr>
<td>Till Count: Show Cash Denominations</td>
<td>Display a breakdown of cash denominations when counting a till. The final amount will be calculated.</td>
</tr>
<tr>
<td>Till Count: Show Form for Initial Count</td>
<td>Display a breakdown of cash denominations when counting a till for the first time, as part of a tender loan.</td>
</tr>
<tr>
<td>Till Processing: No Prompt for Till Action</td>
<td>Do not prompt the user to receive to release tills. The action will proceed without input.</td>
</tr>
<tr>
<td>Till: Enforce Limits</td>
<td>Enforces till limits.</td>
</tr>
<tr>
<td>Till: Non-Blind Count</td>
<td>Will display expected amounts on till worksheets.</td>
</tr>
<tr>
<td>Till: Operator Accountability</td>
<td>Set till accountability to operators rather than workstation.</td>
</tr>
<tr>
<td>Till: Prompt for Recount</td>
<td>Prompts the clerk if they want to recount the till after printing the actual counts.</td>
</tr>
<tr>
<td>Transaction: Clear on Page Change</td>
<td>Clear the completed transaction when a button bar is used.</td>
</tr>
<tr>
<td>Transaction: Customer Lookup on Entry</td>
<td>Always handle pre-entered text as a customer search until a customer has been chosen.</td>
</tr>
<tr>
<td>Transaction: Enable Item Cache</td>
<td>Cache items for up to two minutes, or the value specified in Transaction: Item Cache Duration.</td>
</tr>
<tr>
<td>Transactions: Continuous Sequence</td>
<td>Sequence number is continuous and not reset each day.</td>
</tr>
<tr>
<td>Transfer: Allow Consigned</td>
<td>Allows consigned items to be transferred.</td>
</tr>
<tr>
<td>Transfer: Allow Marked Down</td>
<td>Allow the transfer of items that have been marked down.</td>
</tr>
<tr>
<td>TransferGiftCardBalance</td>
<td>An option to transfer gift card balances to an internal gift card is presented to the user.</td>
</tr>
<tr>
<td>Transfers: Allow Transfer to Source</td>
<td>Allow to select same destination as source for transfer out.</td>
</tr>
<tr>
<td>Transfers: Confirm Finalize</td>
<td>Confirm that the user wishes to complete the transfer.</td>
</tr>
<tr>
<td>Transfers: Print Tags From Warehouse</td>
<td>Print item labels when receiving from a warehouse.</td>
</tr>
<tr>
<td>Transfers: Skip Find On First Item</td>
<td>When beginning a transfer, do not display an item find.</td>
</tr>
<tr>
<td>Transfers: Use Small Find Results</td>
<td>Display locations using the smaller result layout.</td>
</tr>
<tr>
<td>UseExchangeRate</td>
<td>Sales and tenders take foreign currency exchange rates into account.</td>
</tr>
</tbody>
</table>
Setting List

A setting in NSPOS is any customizable field value, such as a default amount, a maximum limit, or a default behavior. Settings shown with a colon(:) list the setting group and then the setting name. For example, Application Startup: Announcement is the group and setting that determines what displays when NSPOS starts.

- **Setting** – The setting name.
- **Description** – What the setting does.
- **Default Value** – The standard setting prior to any customization.
- **Setting Type** – The format of the setting value.
  - **String** – Any set of characters.
  - **Integer** – Whole numbers only, without a decimal place.
  - **Decimal** – Numbers with an optional decimal place.
  - **Check box** – Check or leave blank to enable or disable.
- **Customer can configure?** – Lists whether customer administrators can make the change. If no, configuring the setting requires assistance by Customer Support or Professional Services.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default Value</th>
<th>Setting Type</th>
<th>Customer can configure?</th>
</tr>
</thead>
<tbody>
<tr>
<td>AcceptedCardTypes</td>
<td>The list of credit card types accepted for payment. Authorization providers recommend a null value to let their software determine if the card type is accepted. Example: AX,VS,MC,NS,DC,CB,J. Unknown card types are two spaces.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>AddItemStart Department</td>
<td>The department ID to use as the parent for all items created through AddItem.</td>
<td></td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Adjustment: Reports</td>
<td>A comma-delimited list of report IDs to print when an adjustment is completed</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Application Startup: Announcement</td>
<td>An announcement to display when the application is started.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Application Startup: Startup Function</td>
<td>A function to run when the application has loaded.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Application Startup: Startup Script</td>
<td>An express file to run when the application has loaded.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Audio Alerts: Get Entry Sound</td>
<td>The sound file to play when the user's attention is requested by Get Entry.</td>
<td>notify</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Audio Alerts: Item Price Entry Sound</td>
<td>The sound file to play when an item requires price entry.</td>
<td>chimes</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Audio Alerts: User Input Sound</td>
<td>The sound file to play when user input is requested.</td>
<td>chimes</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Bank Deposit: Survey ID</td>
<td>The ID of the survey to collect info for a bank deposit.</td>
<td>1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Buy/Trade: Cash Out Limit</td>
<td>The limit of cash allowed as a payout before a manager approval is required.</td>
<td>100</td>
<td>Decimal</td>
<td>No</td>
</tr>
<tr>
<td>CAT: Max Display Lines</td>
<td>Override the default of 10 lines.</td>
<td>1</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>CompleteMessage</td>
<td>Text to display when a retail transaction completes. The text will be displayed as an alert tip.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Consignment: Base Credit Reduction</td>
<td>&quot;The amount to reduce the base price (pre-credit calculation), of an item being credit to a consignor.</td>
<td>1</td>
<td>Decimal</td>
<td>No</td>
</tr>
<tr>
<td>Consignment: Pickup Fee</td>
<td>The fee amount when an item priced equal to or more than the threshold is picked up. May be a % or a dollar amount. Enter XX % for percent, and XX for dollar amount.</td>
<td>5</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Consignment: Pickup Fee Threshold</td>
<td>The amount an item must be under in order to not incur a pickup fee.</td>
<td>25</td>
<td>Decimal</td>
<td>No</td>
</tr>
<tr>
<td>Consumer Charge: Default Account Type</td>
<td>The customer account type to use for the tender class HC.</td>
<td>HC</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Cost Centers Enabled</td>
<td>Cost center (department) information should be included in integration.</td>
<td>False</td>
<td>Script</td>
<td>No</td>
</tr>
<tr>
<td>Customer Edit: Default Country</td>
<td>Default Country to select for new customers.</td>
<td>AU</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Customer Edit: First Name Prompt</td>
<td>Prompt to display in customer edit dialog.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Edit: Last Name Prompt</td>
<td>Prompt to display in customer edit dialog.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Edit: Lock Names</td>
<td>Locks customer name from being edited.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Edit: Lock Phone</td>
<td>Locks customer phone numbers from being edited.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Edit: Nationality Prompt Text</td>
<td>The caption to display in Customer Edit for the Nationality field.</td>
<td>Country</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Customer Find: Custom Filter</td>
<td>Custom Item Filter for Customer Search.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Groups: Dealer</td>
<td>Customers that are dealers.</td>
<td>Dealer</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Groups: Employee</td>
<td>Customers who are employees.</td>
<td>110</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Customer Groups: Good Standing</td>
<td>Customers in good standing.</td>
<td>&quot;101, 150&quot;</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Groups: Police</td>
<td>Customers we should call the police if we encounter.</td>
<td>109</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Groups: Probation</td>
<td>Customers temporarily allowed to sell.</td>
<td>&quot;103, 104&quot;</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer Groups: Warning</td>
<td>Customers from whom we should avoid purchasing.</td>
<td>102</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer History: Excluded Customers</td>
<td>Customer IDs to exclude from the Sales and Purchase History lookup process.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Customer: Inhibit Sales Groups</td>
<td>A comma-delimited list of customer groups that cannot make purchases.</td>
<td>130</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Customer: Manager Required Groups</td>
<td>A comma-delimited list of customer groups that require a manager to make a purchase.</td>
<td>120</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Dates: First Day Of Week</td>
<td>Defines the start of the numbered week. Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday.</td>
<td>Sunday</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Dates: Week Rule</td>
<td>Defines the start of the numbered week. Valid options are FirstFullWeek, FirstDay, FirstFourDayWeek.</td>
<td>FirstFullWeek</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Default SMTP Support Server</td>
<td>SMTP server used to sending error reports to Customer Support.</td>
<td></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>DefaultDiscountPercent</td>
<td>The default percentage to display in the Entry Window when applying a percent discount.</td>
<td>0</td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td>DefaultTaxExemption Code</td>
<td>When set to a non-null value, transactions will start in Tax Exempt mode using this value as the reason code.</td>
<td>OC</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Disbursement: Manager Required Amount</td>
<td>The amount of a disbursement at which a manager's approval is required.</td>
<td>100</td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td>Disbursement: Maximum Amount</td>
<td>The most amount of money a for which a disbursement can be made.</td>
<td>299.99</td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td>eBayImageSize</td>
<td>The maximum height and width of an image uploaded to eBay.</td>
<td>640x480</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>EComm Payment: CyberSource Provider ID</td>
<td>EComm Payment: CyberSource Provider ID.</td>
<td>14</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>EComm Payment: Google Checkout Provider ID</td>
<td>EComm Payment: Google Checkout Provider ID.</td>
<td>16</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>EComm Payment: PayPal Provider ID</td>
<td>EComm Payment: PayPal Provider ID.</td>
<td>15</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>EComm Payment: SVS Provider ID</td>
<td>EComm Payment: SVS Provider ID.</td>
<td>17</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>End Of Day: Report List</td>
<td>A list of reports to print during the end of day process.</td>
<td>10</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Find Item: Hide Departments By Name</td>
<td>Do not display specific departments any time an Item Find is called for.</td>
<td>Supplies</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Gift Certificate: Type code required for returns</td>
<td>Gift Certificate: Type code required for returns.</td>
<td>MR</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Image Import: Item Image Output Folder</td>
<td>The folder to copy images to after they have been assigned to an item.</td>
<td>C:\Test\Output</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Image Import: Item Image Source Folder</td>
<td>The folder to search for images that correspond to items.</td>
<td>C:\Test\Images</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Inventory: Top Level Department</td>
<td>The top level department in the department hierarchy for this particular organizational unit.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Journal: Background Text</td>
<td>Text to display in the Journal when the Journal contains no items.</td>
<td></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Language: Preferred Language Code</td>
<td>The 4 letter (xx-xx), language code in which the system should attempt to run.</td>
<td>ja</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Layaway: Minimum Order Amount</td>
<td>The minimum layaway order total amount.</td>
<td>50</td>
<td>Decimal</td>
<td>No</td>
</tr>
<tr>
<td>Layaway: Minimum Order Down Payment Percent</td>
<td>The minimum layaway order down payment required as a percentage of the total.</td>
<td>50</td>
<td>Decimal</td>
<td>No</td>
</tr>
<tr>
<td>LineDisplayMessage</td>
<td>The text to display on an external customer display. Multiple lines should be separated by the pipe character</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>MaxDiscountAmount</td>
<td>Applies to amount-off discounts and price overrides. Maximum discount amount that cashier can apply manually at the register without manager's approval. For example, setting the maximum at 10.00 means that manual discounts of $10.01 or greater require approval. The following discount types are compared with the maximum discount amount to verify that calculated discount is not higher than this maximum:</td>
<td></td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>■ Item $</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Sale $ Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Item % Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Sale % Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Price Override (New Price)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Also see Maximum Discount Limits and Manager Approvals.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MaxDiscountPercent</td>
<td>Applies to percent-off discounts. Maximum discount percent that cashier can apply manually at the register without manager's approval. For example, setting the maximum at 10 means that manual discounts greater than 10% require approval. The following discount types are compared with the maximum discount percent to verify that calculated discount is not higher than this maximum:</td>
<td></td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>■ Item % Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Sale % Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Also see Maximum Discount Limits and Manager Approvals.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>MinimumPriceMessage</td>
<td>Message to display when item price tries to sell below the minimum price.</td>
<td>&quot;Item {@ItemID} cannot be sold for {@ActualUnitPrice as Decimal,0:c}. Minimum price for this item is {@MinimumPrice as Decimal,0:c}.&quot;</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>MinimumPriceResourceId</td>
<td>ResourceID required to override and sell below MinimumPrice.</td>
<td>9090</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>No Tags for Items in Department</td>
<td>Do not display specific departments in the Reprint Tags window.</td>
<td>False</td>
<td>Check box</td>
<td>No</td>
</tr>
<tr>
<td>No Tags for Items Named</td>
<td>Do not print tags for items whose exact name is in this list. Separate names with commas.</td>
<td>String</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>No Tags for Items With ID</td>
<td>Do not print tags for items whose ID is in this list. Separate IDs with commas.</td>
<td>6003</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>NumberReturnDays</td>
<td>The number of days worth of transactions to display in the Find Window for Returns.</td>
<td>5</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>NumberReturnDays Threshold</td>
<td>The maximum number of days of transaction history allowed to be display in the Find Window for Returns. Enter 999 for unlimited.</td>
<td>1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>On Screen Keyboard: Height</td>
<td>The preferred height of the Windows on screen keyboard.</td>
<td>300</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>On Screen Keyboard: Width</td>
<td>The preferred width of the Windows on screen keyboard.</td>
<td>660</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Online Orders: Transaction Reports</td>
<td>A comma-delimited list of report IDs to print when fulfilling an online order.</td>
<td>21910</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Payment: Service Phone</td>
<td>The Voice Approval Phone Number to use for the RA Payment Service.</td>
<td>800-257-2734</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Payment: Service URL</td>
<td>The URL to the RA Payment Service.</td>
<td><a href="https://PM01.retailanywhere.com/RAService/RAService.svc">https://PM01.retailanywhere.com/RAService/RAService.svc</a></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Physical Count: Executable Path</td>
<td>The path to the Physical Count application.</td>
<td>C:\MCL3\LINK_Lite-MT2000\mclLink.exe</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>PinPad: EFT Transaction Host</td>
<td>Override the default key index number of 0. Nova uses 1.</td>
<td>1</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Printer: Default Printer</td>
<td>The printer name and server (optional), to use when printing reports and other items.</td>
<td>String</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Printer: Form Printer</td>
<td>The printer to use when printing forms.</td>
<td>String</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Printer: Tag Printer Server</td>
<td>The server that hosts a Barcode Blaster printer to use for tag printing.</td>
<td>set at Store or Workstation level</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Printer: Tag Printer ServerL</td>
<td>The server that hosts a Barcode Blaster printer to use for tag printing.</td>
<td>DVF12R02</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Product Feedback: Support Address</td>
<td>An additional email address where automatic error reports should be directed.</td>
<td>String</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Receipt Text: Bottom Message</td>
<td>The text to add to the base of each retail receipt.</td>
<td>No cash or credit card refunds. Sales receipt required for all returns. Only merchandise that has not been worn, altered or had tags removed will be accepted. All sale items, fine jewelry and bathing suits are final sale. Gift cards are treated as cash and cannot be replaced if lost or stolen. Thank you for shopping at DVF! Follow Diane on Twitter @InsideDVF Join us on facebook facebook.com/dvf.</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Receipts: Customer Opt-Out Message</td>
<td>The message to display to the user when a customer has chosen to opt-out of printed receipts.</td>
<td>The customer has chosen not to receive printed receipts.</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Receipts: Suspended Receipt Count</td>
<td>The number of receipts to print for a suspended transaction.</td>
<td>2</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>ReportPath</td>
<td>The path to the reports on the server, relative to the root path.</td>
<td>/RA/</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Reports: Alternate User Domain</td>
<td>The domain to use when connecting to the alternate server.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Reports: Server</td>
<td>The server hosting reports</td>
<td><a href="http://localhost/ReportServer">http://localhost/ReportServer</a></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Reports: User Domain</td>
<td>The domain to use when connecting to the standard server.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Resale: Tax Group</td>
<td>The tax group to use for resale</td>
<td>2</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Returns: Maximum Days Since Purchase</td>
<td>The time frame in which returns are allowed.</td>
<td>1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Returns: Service Login</td>
<td>The login for the centralized returns service</td>
<td>BsMdBzCrlZPlUiaAnoHOnsQ==</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Returns: Service URL</td>
<td>The URL of the centralized returns service</td>
<td><a href="https://PM01.retailanywhere.com">https://PM01.retailanywhere.com</a></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Sales Associate: Title</td>
<td>Title for the sales associate find. Default is Sales Associate.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Sales Test: Default Customer</td>
<td>The customer to use for sales tests.</td>
<td>1300000000</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Sales Test: Iterations</td>
<td>Total number of sales tests to run.</td>
<td>200</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Sales Test: SKU Count</td>
<td>Total number of items to use for the sales pool.</td>
<td>20</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Transactions: Item ID</td>
<td>The item to use when creating a service transaction</td>
<td>SERVICE</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Transactions: Service Item Department</td>
<td>The department ID of the service items</td>
<td>9999999</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Transactions: Survey ID</td>
<td>The ID of the survey required when starting a service transaction</td>
<td>4</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>SettleBatchProvider</td>
<td>The Credit Card Provider to Settle Batch.</td>
<td>0</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: Default card type</td>
<td>Default card type for cards processed by Shift4 UTG.</td>
<td>NULL</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: Response timeout</td>
<td>Response timeout in milliseconds for packets sent to Shift4 UTG.</td>
<td>120000</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: UTG PIN pad refresh interval</td>
<td>Interval to prevent getting PinPad to idle state. Set 0 to disable the feature.</td>
<td>10000</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: UTG PIN pad update changes interval</td>
<td>Periodically check for journal changes and update PIN pad display. Set 0 to disable the feature.</td>
<td>1000</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: UTG PinPad Line Item width</td>
<td>Width in chars for Shift4 UTG PinPad to show items.</td>
<td>30</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shift4: UTG PinPad max lines</td>
<td>Maximum number of lines supported by Shift4 UTG pin pad.</td>
<td>10</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Shipping: Disbursement Reason Code</td>
<td>The disbursement reason code used when shipping internally.</td>
<td>CKMR</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Shipping: Disbursement Tender</td>
<td>The tender used when shipping internally.</td>
<td></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Shipping: Serial Number</td>
<td>The serial number for the shipping application.</td>
<td>I\WZmGicG8mncG5usvEgL\JQ\9OA4PDQ6\ThorjQWdmGKdAGqK\y35XZU</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Shipping: SKU</td>
<td>The SKU used for shipping.</td>
<td>6004</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>SlipAlignSpaces</td>
<td>The number of spaces to align lines printed on the slip printer.</td>
<td></td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Special Order: Minimum Order Amount</td>
<td>The minimum order total amount.</td>
<td>25</td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td>Special Order: Minimum Order Down Payment Percent</td>
<td>The minimum order down payment required as a percentage of the total.</td>
<td>25</td>
<td>Decimal</td>
<td>Yes</td>
</tr>
<tr>
<td>Style Matrix: Color Label</td>
<td>The text to display on the Style Matrix form along the Color axis.</td>
<td>Colors</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Support Email Address</td>
<td>Email address where error reports will be sent in an error case.</td>
<td><a href="mailto:no-reply@netsuite.com">no-reply@netsuite.com</a></td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Suspended Transactions: Cancel after days</td>
<td>Cancel Suspended Transactions after they are this many days old.</td>
<td>4</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>System Alerts: Alert Tip Duration</td>
<td>The amount of time, in seconds, that Alert notification persist in the notification area.</td>
<td>120</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>System Alerts: Error Tip Duration</td>
<td>The amount of time, in seconds, that Error notification persist in the notification area.</td>
<td>300</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>System Alerts: Minor Alert Tip Duration</td>
<td>The amount of time, in seconds, that minor Alert notification persist in the notification area.</td>
<td>5</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>SystemColor</td>
<td>Primary background color.</td>
<td>&quot;$#255,255,255&quot;</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Tag Printing: Print Server</td>
<td>The server for tag printing.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Default Value</td>
<td>Setting Type</td>
<td>Customer can configure?</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Tag Printing: Printer Name</td>
<td>The name of the printer for tag printing.</td>
<td>ZDesigner GK420d</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>TaxExemptChar</td>
<td>The character that will appear after &quot;T&quot; in the journal when items are tax exempt.</td>
<td>E</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Tcp Printer Address</td>
<td>Address of a mobile printer</td>
<td>10.0.0.200</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Tender Pickup: Survey ID</td>
<td>The ID of the survey to collect info for a tender pickup.</td>
<td>1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>TenderClassLower BoundResourceCA</td>
<td>The resource ID to be used instead of 9070 when tendering a credit card beyond the LALO.</td>
<td>9090</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>TenderClassLower BoundResourceCC</td>
<td>The resource ID to be used instead of 9070 when tendering a credit card beyond the LALO.</td>
<td>9090</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Terminology: Seller Term</td>
<td>The word to use in place of &quot;seller&quot; when referring to a customer that provides items through the intake process.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Till: Auto End Of Day Operator</td>
<td>The operator to use when automatically settling a till.</td>
<td>9999</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Till: Auto End Of Day Reason</td>
<td>The reason code to use when canceling a transaction while automatically settling a till.</td>
<td>A5</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Till: Auto End Of Day Time</td>
<td>The time at which an active till is automatically settled.</td>
<td>9:00 PM</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Timeclock: Minimum Lunch Break</td>
<td>The minimum number of minutes an employee is required to take for lunch.</td>
<td>30</td>
<td>Integer</td>
<td>No</td>
</tr>
<tr>
<td>Transaction: Item Cache Duration</td>
<td>The amount of time in seconds to cache items when the item cache is enabled.</td>
<td>120</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>TransactionComplete Image</td>
<td>The filename of the image to display on the Transaction Journal object when the ShowTrxCompleteImage flag is set.</td>
<td></td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>Transfer: In Reports</td>
<td>The report IDs you want to print when a Transfer In transaction is completed.</td>
<td>36</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Transfer: Pre-Receiver Reports</td>
<td>Reports to print before receiving a transfer.</td>
<td>10100</td>
<td>String</td>
<td>Yes</td>
</tr>
<tr>
<td>Transfers: Default Transfer Days</td>
<td>The default number of days estimated for transfers.</td>
<td>-1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>WindowSize</td>
<td>The size of the Main Window when not in Full Screen mode.</td>
<td>800x600</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>YesPay: Host</td>
<td>YesPay EasyVTerminal Host Computer Name.</td>
<td>localhost</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>YesPay: Port</td>
<td>YesPay Server Port.</td>
<td>10001</td>
<td>Integer</td>
<td>Yes</td>
</tr>
</tbody>
</table>
ITEMS and PRICES

Applies to: NetSuite Point of Sale (NSPOS)

Review the contents of this NetSuite Point of Sale (NSPOS) chapter for detailed steps on working with the items that you sell. It includes basic item and price setup procedures, as well as specialized setups such as limiting where items appear and requiring manual price entry at the register.

This chapter also provides a section on setting up and using gift cards and gift certificates.

- Items
  - Working with Inventory Items
  - Setting up a Services for Sale Item
  - Gift Cards and Gift Certificates in NSPOS
  - Specialized setups
    - Disable Item from Searches on the POS
    - Do Not Download Item to POS
    - Item Restrictions by Subsidiary or Location
    - Multiple Barcodes for Single Items
    - Weighted Barcodes – Enabling Scans
    - Bin Management

- Prices
  - Add a Price or Price Levels to an Item
  - Price Filtering for Currency by Location
  - Require Price Entry at Register

Items

Use this NetSuite Point of Sale (NSPOS) section for working with the items you sell, including gift cards, gift certificates, and specialized setups.

- Working with Inventory Items
- Setting up a Services for Sale Item
  - Gift Cards and Gift Certificates in NSPOS
- Specialized setups
  - Disable Item from Searches on the POS
  - Do Not Download Item to POS
  - Item Restrictions by Subsidiary or Location
  - Multiple Barcodes for Single Items
  - Weighted Barcodes – Enabling Scans
  - Bin Management

Working with Inventory Items

Inventory items are the physical products you sell online or in your stores. This section lists the steps to create basic inventory items. You set up your items in NetSuite ERP using Item records. When you add or
update an item, it downloads to your server for synchronization with your NetSuite Point of Sale (NSPOS) registers.

This topic includes only the basic fields used for NSPOS. For information about different item types and fields not listed, review the NetSuite ERP help topic Creating Item Records.

---

**Important:** NetSuite Assistant (not recommended) – Items created through the NetSuite Assistant do not contain all fields required for NSPOS, such as the Tax Schedule. Also, items created or updated through the Assistant do not trigger automatic synchronization with your registers.

We recommend adding items through the following RA Inventory Part Form procedure or through imports such as CSV uploads.

---

**To add a new inventory item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Review the current list to ensure the item was not previously added.
4. Click New Item.
5. For Item Type, click Inventory Item. Most items that you sell in your stores will be inventory items.
6. Under Custom Form, select RA Inventory Part Form. This recommended form includes custom fields for use with NSPOS.
7. Complete the fields used in NSPOS transactions.
   - **Item Name/Number** – Enter the name of the item or your internal item number, up to 60 characters. You can enter both a name and a number if desired.
   - **UPC Code** (optional) – Enter the Universal Product Code (UPC) or Global Trade Item Number (GTIN) associated with the item's barcode. A stock keeping unit (SKU) is also acceptable.
   - **Display Name/Code** (optional) – This name appears in the Journal, in item searches, and on receipts. If you do not enter a display name, NSPOS uses the Item Name/Number.

---

- **Basic** subtab > Tax Schedule – Select the tax schedule for the tax rate to be applied when selling the item.
All other fields are optional, but you might want to consider a field if it will benefit your business process. All fields are available to include in searches and reports.

**Note:** Most fields have pop up help. You can also click Help to display the NetSuite ERP item help topic.

8. You add prices for an item under the Sales / Pricing subtab. See Add a Price or Price Levels to an Item.

9. Click Save.

   The new item will replicate to your registers during the next synchronization download.

**Restricting where an item is offered for sale:**

1. See Item Restrictions by Subsidiary or Location.

**Editing an existing item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. Make changes as needed.
5. Click Save.

   The change will replicate to your registers during the next synchronization download.

**Making an item inactive:**

You can mark an item Inactive to prevent it from synchronizing with your registers and appearing in item searches. You cannot delete an item that is part of any past transaction.

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. Check the Inactive box.

   The box location depends on the Custom Form choice:
   - If RA Inventory Part Form, Inactive is near the top.
If **Standard Inventory Part Form**, go to the **System Information** tab.

**Note:** Other forms customized for your business might have the **Inactive** box in a different location.

5. Click **Save**.
   The change will replicate to your registers during the next synchronization download.

**Reactivating an inactive item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the inactive item.

   **Tip:** You might need to check the **Show Inactives** box at the top of the list.

4. Click **Edit** and clear the **Inactive** box.
1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. Click Actions > Delete.
5. Click OK.

Setting up a Services for Sale Item

Services for Sale items are a way to charge for services that your business performs for customers, such as installing an item in a home or business. You set up service items in NetSuite ERP using Item records. When you add or update a service item, it downloads to your server for synchronization with your NetSuite Point of Sale (NSPOS) registers.

NetSuite ERP offers three service-item types:

- **Services for Purchase** – Services your business buys, but doesn't sell to customers
- **Services for Resale** – Services your business buys and then sells to customers
- **Services for Sale** – Services your business sells, but doesn't buy

This topic covers Services for Sale items, and includes only the basic fields used for NSPOS. For information about other service item types or fields not listed here, review the NetSuite ERP help topic Creating Item Records.
Important: NetSuite Assistant (not recommended) – Items created through the NetSuite Assistant do not contain all fields required for NSPOS, such as the Tax Schedule. Also, items created or updated through the Assistant do not trigger automatic synchronization with your registers.

We recommend adding items through the following RA Inventory Part Form procedure or through imports such as CSV uploads.

To add a new service for sale item:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Review the current list to ensure the item was not previously added.
4. Click New Item.
5. Under Item Type, click Service > For Sale.
6. Complete the fields used in NSPOS transactions.
   - **Item Name/Number** – Enter the name of the service or your internal service-type number, up to 60 characters. You can enter both a name and a number if desired.
   - **UPC Code** (optional) – Enter the Universal Product Code (UPC) or Global Trade Item Number (GTIN) associated with the service item. A stock keeping unit (SKU) is also acceptable.
   - **Display Name/Code** (optional) – This name appears in the Journal, in item searches, and on receipts. If you do not enter a display name, NSPOS uses the Item Name/Number.
   - Accounting subtab > Tax Schedule – Select the tax schedule for the tax rate to be applied when selling the service.
All other fields are optional, but you might want to consider a field if it will benefit your business process. All fields are available to include in searches and reports.

**Note:** Most fields have pop up help. You can also click Help to display the standard NetSuite ERP help topic.

7. You add prices for an item under the **Sales / Pricing** subtab. See Add a Price or Price Levels to an Item.

8. Click **Save**.
   
The new service item will replicate to your registers during the next synchronization download.

**Editing, marking inactive, and other Service Item tasks**

See the steps under Working with Inventory Items.

**Gift Cards and Gift Certificates in NSPOS**

Use this topic as a guide to setting up and using gift cards and certificates on your NetSuite Point of Sale (NSPOS) registers. NSPOS provides tools for selling and accepting internal NetSuite-based gift cards/certificates and for working with external gift cards issued by an authorized third-party.

In general, the cashier hands plastic gift cards to the customer after activation and payment, while gift certificates are available online for purchases from your store’s website or by providing the authorization code at the register. NSPOS can sell both gift cards and gift certificates, but the same funds can only be used for one type or another. For example, a sales associate can sell a $50 gift entity, but it must be either a card or a certificate – not both.

- Set up NSPOS Gift Cards/Certificates in NetSuite ERP
  - What happens when a Type or Prefix is inactivated or deleted
- Gift Card Track Data Specifications
- Sell NetSuite Gift Card/Certificate
- Check Balance of NetSuite Gift Card/Certificate
- Use a NetSuite Gift Card/Certificate
- Sell an External Authorized Gift Card
- Check External Authorized Gift Card Balance
Set up NSPOS Gift Cards/Certificates in NetSuite ERP

NetSuite uses the term gift certificate exclusively instead of gift card. Each gift card issued in NetSuite Point of Sale (NSPOS) – whether as a physical gift card or email gift certificate – creates a corresponding gift certificate record in your NetSuite account. A gift certificate record is a type of item record that holds all key information about the gift card/certificate, including the beginning amount, remaining amount, and the authorization code.

To set up gift cards or gift certificates using NSPOS 2018.1.x or earlier:

1. Configure your account preferences for NSPOS gift certificates. This is a one-time setup.
2. Set up the Gift Certificate Master Template Record in 2018.1.x
3. Contact Professional Services to set up the type and type prefix.
4. Ensure Locations selling gift card or certificates are set to use the correct currency type.

**Important:** After you create the gift certificate master record under NSPOS release 2018.1.x or earlier, NetSuite Professional Services or Customer Support must configure NSPOS to use the record.

To set up gift cards or gift certificates using NSPOS 2018.2.x or later:

1. Configure your account preferences for NSPOS gift certificates. This is a one-time setup.
2. Set up the Gift Certificate Master Template, Type, and Type Prefix in 2018.2.x or later
3. Ensure Locations selling gift card or certificates are set to use the correct currency type.

Configure your account preferences for NSPOS gift certificates

Before creating and updating gift certificates, first perform the following procedure to ensure your NetSuite account is correctly configured. Unless you change your preferences, this is a one-time setup.

To set NetSuite preferences for NSPOS gift certificates:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Enable Features.
3. On the Items & Inventory subtab, select Gift Certificates.
4. Click Save.
5. Go to Setup > Accounting > Accounting Preferences.
6. Under Items/Transactions > Other Item Preferences, set the Gift Certificate Auth Code Generation field to Enter on Order.
7. Click Save.

**Note:** Generating the Authorization Code by Enter on Order means that, when a customer purchases a card or certificate, NSPOS will either generate the code automatically or read the code from the card. The transaction upsync to NetSuite ERP will not override this code.

Set up the Gift Certificate Master Template Record in 2018.1.x

Follow these steps to set up your master template if you are on NSPOS 2018.1.x or earlier. You can set up most of the template, but you must contact Professional Support to complete the process. They will configure NSPOS to use the master record.
To create a gift certificate master template record:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items > New and select Gift Certificate in the Item Type column.
3. In the New Gift Certificate window, enter a name in the Item Name/Number field. This name should describe its function, such as NSPOS Gift Certificate Template.
4. In the Subsidiary list, select Parent Company and check Include Children.
5. On the Accounting subtab, select an Income Account and Liability Account.
   Each gift certificate generated from this master record posts its corresponding gift card value to these accounts in the general ledger. Consult your company accountant if you are not certain which accounts to select.
6. For Tax Schedule, select Non-Taxable.
   In most tax jurisdictions, gift card purchases are non-taxable events. Sales tax is applied only to item purchases made using funds loaded to the card. Your jurisdiction requirements may vary.
7. Click Save.
8. Go to Lists > Accounting > Items and select Gift Certificate from the Type filter.
9. Locate the gift certificate record you created in the steps above and record the Internal ID field value.
   If you cannot see the Internal ID column, see the help topic Enabling the Show Internal IDs Preference online in NetSuite or notify Customer Support.
10. Contact NetSuite Professional Services or Customer Support and provide them with the gift certificate Item Name and Internal ID. They will configure NSPOS to use this master record.

Note: Professional Services or Customer Support might request other information from you as needed to implement your card and certificate functionality.

Set up the Gift Certificate Master Template, Type, and Type Prefix in 2018.2.x or later

Follow these steps to set up a gift certificate if you are on NSPOS 2018.2.x or later.

1. Create the template record
2. Assign a gift certificate type (RA-GC Type)
3. Assign a gift certificate type prefix (RA-GC Type Prefix)
4. Ensure currency set for your Locations

Tip: You can also use these steps to edit existing records and types.

To create a gift certificate master template record:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items > New and select Gift Certificate in the Item Type column.
3. In the New Gift Certificate window, enter a name in the Item Name/Number field. This name should describe its function, such as NSPOS Gift Certificate Template.
4. In the Subsidiary list, select Parent Company and check Include Children.
5. On the Accounting subtab, select an Income Account and Liability Account.
Each gift certificate generated from this master record posts its corresponding gift card value to these accounts in the general ledger. Consult your company accountant if you are not certain which accounts to select.

6. For Tax Schedule, select Non-Taxable.
   In most tax jurisdictions, gift card purchases are non-taxable events. Sales tax is applied only to item purchases made using funds loaded to the card. Your jurisdiction requirements may vary.

7. Click Save.

8. Go to Lists > Accounting > Items and select Gift Certificate from the Type filter.

9. Go to the next steps to assign the gift certificate type (RA-GC Type).

To assign a gift certificate type (RA-GC Type)

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate RA-GC Type and click List.
4. Click New RA-GC Type.

![RA-GC Type](image)

5. Leave Custom Form at the default Custom RA-GC Type Form.
6. For Gift Card Item Name, select the template you set up.
   The Internal ID populates from your selection.
7. Optionally enter a Display/Print Card Name. This information is for internal use only; it does not appear at the register.
8. The Description does not appear in the Journal. Enter text that is helpful for understanding how the gift certificate will be used. For example, Use this certificate for customer loyalty rewards.
9. Click Save.

```
Note: Use the Inactive box when you will no longer sell this gift certificate. For example, you can mark a seasonal certificate as Inactive when the season ends. See What happens when a Type or Prefix is inactivated or deleted.
```

10. Before proceeding, note the Internal ID on the RA-GC Type List for the type you set up.

```
Important: You will select the type's Internal ID for the RA-GC Type in the next procedure.
```

To assign a gift certificate type prefix (RA-GC Type Prefix)

In general, all gift cards issued by a single retailer will use the same prefix. However, you can set up additional prefixes if needed.
1. If not already done, log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate RA-GC Type Prefix and click List.
4. Click New RA-GC Type Prefix.

5. Enter a Name for the prefix using any combination of alpha or numeric characters. The name is for your internal use only; it does not appear on the register.
6. Select the RA-GC Type used when setting up the type.
7. Enter a Prefix of your choice using the following rules:
   - Numeric values 0 – 9 only. The prefix must not include alphabetic characters.
   - Enter 1 digit minimum, 3 or more digits recommended.

   **Warning:** After saving the RA-GC Type Prefix record, you cannot change the Prefix number. Be certain to enter the number you desire.
8. Click Save.

   **Note:** Use the Inactive box when you will no longer sell gift certificates or cards that use this prefix. You can also check Inactive if you entered an incorrect prefix number by mistake.

   What happens when a Type or Prefix is inactivated or deleted

   If you decide to no longer use a type or prefix (type prefix) for your gift certificates and cards, you can edit the record and Inactive or Delete it. However, any items already issued to customers must remain redeemable.

   The following rules apply if you inactivate or delete a RA-GC Type or RA-GC Type Prefix record:
   - You should stop selling certificates or cards that use the type or prefix.
   - You can continue checking the balance of certificates or cards that were previously sold.
   - You can continue redeeming certificates or cards that were previously sold.
   - If you reactivate a type, all prefixes that were not inactivated separately are made available for full use on NSPOS.
   - If you reactivate a prefix associated with an active type in NetSuite ERP, the prefix is made available for full use on NSPOS.
Ensure currency set for your Locations

Each retail location selling a NetSuite gift card or certificate must have the currency associated with the card assigned correctly.

For example, for cards configured in United States dollars, you must set the Location record > RA-Currency field to US Dollar. By default, the Location > RA-Currency field is blank.

This action binds gift cards or certificates sold in each updated Location to use that currency only.

Warning: NSPOS registers will not accept gift cards loaded with a currency that is different from the currency assigned to the register’s Location.

To ensure Locations selling gift cards or certificates are set to use the correct currency:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Locations.
3. Find the Location Name to verify and click View.
4. Verify that the RA-Currency field is set to the desired currency.
5. If the currency is not correct, click Edit.
6. Click the down-arrow beside RA-Currency and select the currency.
7. Click Save.
8. Verify the next Location.

Gift Card Track Data Specifications

Gift card track data must be formatted in a specific way for it to be readable in NetSuite Point of Sale (NSPOS). This formatting follows ISO standards (ISO/IEC_7813) for cards with magnetic stripes. The following are the requirements and options for using gift cards in NSPOS retail operations.

Gift Card Numbering

Gift card numbers must meet these requirements:

- Card number prefix is a fixed series of digits with a length of 1 digit minimum, 3 or more digits recommended.
In general, all gift cards issued by a single retailer will use the same prefix. However, Professional Services can set up additional prefixes if needed.

- Total length, including the prefix, must be between 9 and 32 digits.
- Numeric values 0 – 9 only. The number cannot contain alphabetic characters.
- Gift card number must be present on Track 2.

**Important:** Avoid using numbering schemes from which it is possible to determine future numbers by reviewing numbers previously issued. For example, do not use sequential numbers. Gift Cards numbers should be generated using a cryptographically-secure random number generator and of sufficient length. These security requirements apply to all gift cards issued through NSPOS.

Gift Card numbering example

- Prefix = **909**
- Length = 13 digits
- Examples: 9099419256070, 9091243227492, 9096638643072

**Authorization Codes – Printed or NSPOS Generated**

NSPOS provides two options for handling authorization codes – Printed on the gift card by the card provider or generated by NSPOS at the point of sale.

**Authorization Code Printed on Gift Card**

Card providers can print an authorization code on a gift card and embed it in the track information, such as in the magnetic stripe. With this method, the card's code is used to create the gift card in NetSuite.

Authorization codes must follow these rules:

- 9 characters or less
- Can include both numeric and alpha characters
- Cannot include the letter B
- Track 1 must include the gift card number and authorization code
- Track 2 must include the gift card number

Example printed information:

GIFT CARD

Your Card number: 9092017012001
Your Authorization code: ACD123EFG
Example track information:

%B9092017012001^1216IACD123EFG?!; 9092017012001=1216?

Track 1  Track 2

Example track details:

%B9092017012001^1216IACD123EFG?!; 9092017012001=1216?

Gift Card Number  Generic Expiration Date  Authorization Code

Special characters included in track information:

- %B – Ignored, indicates Track 1 start
- ^ – Separates gift card number and authorization code sections
- 1216I – Ignored, generic expiration date
- ?| ; – Separates Track 1 and Track 2
- = – Separates gift card number and expiration date
- 1216 – Ignored, generic expiration date
- ? – Ignored, indicates Track 2 end

**Note:** The percent-sign % character used to start Track 1 is optional. The question mark ? character ending Track 2 is optional.

**Note:** The pipe character | separating Track 1 and Track 2 is optional. If you cannot use a pipe, the separator becomes ?; only.

Example Printed Gift Card Tracks:

- %B9092017012001^1216IACD123EFG?!; 9092017012001=1216?
Authorization Code Generated by NSPOS, not printed on gift card

With this method, gift cards do not contain an authorization code. Instead, NetSuite generates the code at the point of sale.

Example track information:

%BA GIFTRECIPIENT?|;01234567890123=1216?

Track 1
Track 2

Example track details:

%BA GIFTRECIPIENT?|;01234567890123=1216?

Generic name on card
Card Number

Special characters included in track information:

- `%B` - Ignored, indicates Track 1 start
- `?|;` - Separates Track 1 and Track 2
- `=` - Separates gift card number and expiration date
- `1216` - Ignored, generic expiration date
- `?` - Ignored, indicates Track 2 end
Sell NetSuite Gift Card/Certificate

NetSuite supports issuing in-store gift cards and certificates to be used by the purchasing customer or a gift recipient. These sellable items are added to a transaction in NetSuite Point of Sale (NSPOS), similar to how regular items are purchased. They are activated automatically after payment is received and the transaction has synced with NetSuite, usually within 15 minutes.

Note: You cannot add funds to an existing gift card.

To sell a NetSuite gift card/certificate:

1. Tap Sell Gift Card or Issue Gift Card.
2. If prompted with Make card available as online certificate?, this selects whether to sell a hard plastic gift card or make the gift amount available via email only.
   - Tap Yes to email a certificate version of the gift card to the recipient.
   - Tap No to sell a plastic gift card.
3. If you tapped Yes for an online certificate:
   a. Complete the Recipient Email Address, Sender Name and Recipient Name fields.

   ![Issue Gift Card](image)

   **Important:** Confirm spelling of the email address with the customer. Entering an incorrect email address results in undeliverable email or the gift certificate being sent to someone else.

   b. Tap Done.
4. Enter the Issue Gift Card Amount and tap Enter or the green check mark.
5. If prompted to Please slide Gift card, swipe the card or enter the card number.
6. Tap Enter or the green check mark.
7. If gift card, hand it to the customer. It is activated and ready to use.
8. If they requested a gift certificate by email, tell them the certificate email will go out shortly.
**Warning:** Gift cards or certificates should not be used for payment in the same transaction in which it was issued.

**Warning:** Customers must wait 15 minutes before using or the checking balance of a new gift card or certificate. The issuing transaction must upsync to NetSuite ERP before first use.

Check Balance of NetSuite Gift Card/Certificate

Follow these steps to get the balance of an internal gift card/certificate in NetSuite Point of Sale (NSPOS).

**To find the balance on a NetSuite gift card/certificate:**

1. Tap **Gift Card Balance**.
2. Select whether to find the balance as a gift **Certificate** or **Card**.
   - If **Certificate**, enter the **Authorization Code** and tap the green check mark.
   - If **Card**, swipe the card or enter the card **Number** and tap the green check mark.
   
   NSPOS displays the available balance.

Use a NetSuite Gift Card/Certificate

Follow these steps to use a NetSuite gift card or certificate as full or split-tender payment for NetSuite Point of Sale (NSPOS) transactions. Funds applied to a card or certificate remain available for transactions until the funds are depleted. You cannot add funds to an existing gift card or certificate.

**To use a NetSuite gift card/certificate for full payment:**

Follow these steps when the balance on a gift card or certificate is sufficient to cover the amount due in full.

1. Scan or search for items and add them to the journal.
2. Tap **Amt Due**.
3. Tap **Gift Card** as the tender.
4. Enter the amount to pay from the card or certificate.

**Note:** Gift cards and certificates support partial redemption. If the amount due is lower than the card or certificate balance, the customer can use the remaining balance in a later transaction.

5. Receive the customer's payment.
   - If gift card, have the customer swipe it or you can enter the card number.
   - If gift certificate, enter the authorization code.

6. If the card or certificate balance is not enough to pay the transaction in full, accept another form of payment.
**Warning:** Do not accept a gift card or gift certificate as deposit for a **sales order**. These tenders are not supported by NetSuite ERP for a sales order deposit. If taken as a deposit, any remaining card or certificate balance will become unusable on NSPOS registers.

**To use a NetSuite gift card/certificate in a split-tender payment:**

Split tender is when the customer provides more than one payment type, such as a gift card and a credit card or cash. Normally split tender is used when the gift card or certificate balance is not enough to pay the full amount due.

1. Scan or search for items and add them to the journal.
2. Tap **Amt Due**.
   The amount due should be larger than the gift card or certificate balance in these steps.
3. Tap **Gift Card** as the tender.
4. Enter the amount to pay from the card or certificate.
5. Receive the customer's payment.
   - If gift card, have the customer swipe it in the PIN pad or you can enter the card number.
   - If gift certificate, enter the authorization code.
6. Tap the additional tender, such as **Cash**.
7. Enter the amount to pay.
8. Receive the customer's payment.
9. Continue as needed until the amount paid is equal to or greater than the amount due.

**Warning:** Do not accept a gift card or gift certificate as deposit for a **sales order**. These tenders are not supported by NetSuite ERP for a sales order deposit. If taken as a deposit, any remaining card or certificate balance will become unusable on NSPOS registers.

**Note:** Customers can use two different gift cards or certificates to pay in a split-tender transaction. However, they cannot use the same gift card or certificate twice in a transaction.

**Important:** You cannot add funds to an existing NetSuite gift card or certificate. If a customer makes a return for a transaction paid by card or certificate, the cashier can return the funds either in a new card or certificate, or as cash.

**Sell an External Authorized Gift Card**

Follow these steps in NetSuite Point of Sale (NSPOS) to sell a gift card issued by an authorized third-party. These are regular inventory items that you add to a transaction similar to physical items purchased at your register.

**To sell an external gift card:**

1. Tap **Sell Authorized Gift Card** or **Issue Authorized Gift Card**.
2. At the **Issue Gift Card Amount** prompt, enter the value of the gift card.
3. If prompted **Does this Gift Card need to be activated?**, tap **Yes**.
4. At the **Please slide Gift card** prompt, swipe the card or enter the card **Number**.
5. Tap **Enter** or tap the green check mark.
6. Hand the gift card to the customer; it is activated and ready to use.

Check External Authorized Gift Card Balance

Follow these steps to get the balance of a external gift card in NetSuite Point of Sale (NSPOS).

To find the balance on an external gift card:

1. Tap Authorized Gift Card Balance.
2. At the Please Slide Gift Card prompt, swipe the gift card or enter the card Number.
3. Tap Enter or tap the green check mark.
   NSPOS displays the available balance.

Cash out a Gift Card

Depending on your store's policy, customers can receive cash for their gift card balance. Generally the balance must be more than $10.00, but your store's policy may vary.

To cash out a gift card.

1. Tap Cash out Gift Card.
2. Swipe the card or enter the gift card Number.
3. Tap Enter or tap the green check mark.
   The gift card balance appears as change due.

Disable Item from Searches on the POS

If you want an item to be included in your NetSuite Point of Sale (NSPOS) register database, but to not appear when performing a search from a register, check the Disable in NetSuite POS Search box under Items in NetSuite ERP. Cashiers/Sales Associates can still ring up these items with a bar code scanner.

To disable items from searches:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. Under the Custom subtab, check the Disable in NetSuite POS Search box.
5. Click Save.
   The change will replicate to your registers during the Synchronization Periods.

Do Not Download Item to POS

If your business operations include items that you do not want to appear on your NetSuite Point of Sale (NSPOS) registers – either for sale or as searchable items – check the Do not download to POS box under Items in NetSuite ERP.

To prevent an item from downloading to NSPOS registers:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. Under the Custom subtab, check the Do not download to POS box.
5. Click Save.
   The change will replicate to your registers during the next synchronization download.

Item Restrictions by Subsidiary or Location

With NetSuite Point of Sale (NSPOS) 2018.1 or greater, you can set restrictions on where an item can be sold. By selecting one or more subsidiaries or a single location on an NetSuite ERP Item record, you can limit the stores that are authorized to handle an item. If a store is not included in a subsidiary or location chosen for an item, the item is not authorized to the store and is not visible to the cashier at the store.

If the cashier searches for or scans an unauthorized item, NSPOS returns a prompt stating “No results found.” This prompt also appears if the cashier attempts to process a return for an unauthorized item.

You can set restrictions one item at a time, or you can perform a mass update of Item records through an upload. Note that for mass updates, we recommend the following:

- Do not perform mass item updates during business hours, when transactions are occurring on your registers.
- Limit mass updates to 60,000 records per 24-hour period. Exceeding this limit can impact synchronization between your server and your registers.

Note: To keep an item available without restrictions, leave the Subsidiary set to Parent Company. This subsidiary choice is the default.

To restrict a single item to subsidiaries or a location:

Restricting an item means that it will only be visible to the cashier and available for sale at the selected subsidiary's locations or optionally, a single location. For information about complex setups for assigning subsidiaries and locations, see the help topic Creating Item Records in the NetSuite ERP Help Center. Look under Item Record Header Fields > Classification > Subsidiary > Advanced Item Location Configuration.

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Locate the desired item and click Edit.
4. To restrict the item to all locations within a subsidiary, select the Subsidiary.
   You can select more than one subsidiary. Check Include Children if you want to include all child entities that belong to the selected subsidiaries.
5. To restrict the item to a single location within the chosen subsidiary, select the **Location**.
6. Click **Save**.

### Review Current Item Restrictions

Before utilizing item restrictions, we recommend that you create a search and review all items for their current assigned subsidiaries and locations. Settings applied in the past might not be desirable for your current needs.

**To perform an item search for restrictions:**

These steps display an item list customized to include the Subsidiary and Location fields.

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click **Customize View** or **Edit View**.
4. Scroll to the bottom of the **Field** list.
5. Enter **Subsidiary** and click **Add**.
6. Enter **Location** and click **Add**.
7. Select **Subsidiary** and click **Move To Top**.
8. Select **Location** and click **Move To Top**.
9. Click **Preview**.
10. Sort the list by clicking a column heading as desired.
11. Click an export option to save the list for review.
Multiple Barcodes for Single Items

Adding a barcode to an item is part of the normal NetSuite Point of Sale (NSPOS) item setup in NetSuite ERP. However, depending on your business operations, your item configurations may sometimes require more than one barcode for a single item. Any additional barcodes assigned to an item, unless deactivated, are detected by NSPOS when ringing up a transaction.

- Item Types and Multiple Barcodes
- Adding Multiple Barcodes
- Editing Assigned Barcodes
- Using Multiple Barcodes on your Registers

Only certain item types allow multiple barcodes. Use the table below as a guide. Item types marked N/A are not available in NSPOS.

### Item Types and Multiple Barcodes

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Allows Multiple Barcodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly/Bill of Materials</td>
<td>Yes</td>
</tr>
<tr>
<td>Lot Numbered</td>
<td>N/A</td>
</tr>
<tr>
<td>Serialized</td>
<td>N/A</td>
</tr>
<tr>
<td>Description</td>
<td>N/A</td>
</tr>
<tr>
<td>Discount</td>
<td>No</td>
</tr>
<tr>
<td>Gift Certificate</td>
<td>No</td>
</tr>
<tr>
<td>Inventory Item</td>
<td>Yes</td>
</tr>
<tr>
<td>Lot Numbered</td>
<td>N/A</td>
</tr>
<tr>
<td>Serialized</td>
<td>N/A</td>
</tr>
<tr>
<td>Item Group</td>
<td>N/A</td>
</tr>
<tr>
<td>Kit/Package</td>
<td>Yes</td>
</tr>
<tr>
<td>Markup</td>
<td>N/A</td>
</tr>
<tr>
<td>Non-inventory Item</td>
<td>Yes</td>
</tr>
<tr>
<td>For Purchase</td>
<td>N/A</td>
</tr>
<tr>
<td>For Resale</td>
<td>Yes</td>
</tr>
<tr>
<td>For Sale</td>
<td>Yes</td>
</tr>
<tr>
<td>Item Type</td>
<td>Allows Multiple Barcodes</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Other Charge</td>
<td>Yes</td>
</tr>
<tr>
<td>For Purchase</td>
<td>N/A</td>
</tr>
<tr>
<td>For Resale</td>
<td>Yes</td>
</tr>
<tr>
<td>For Sale</td>
<td>Yes</td>
</tr>
<tr>
<td>Payment</td>
<td>N/A</td>
</tr>
<tr>
<td>Service</td>
<td>Yes</td>
</tr>
<tr>
<td>For Purchase</td>
<td>N/A</td>
</tr>
<tr>
<td>For Resale</td>
<td>Yes</td>
</tr>
<tr>
<td>For Sale</td>
<td>Yes</td>
</tr>
<tr>
<td>Subtotal</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Adding Multiple Barcodes

If only one barcode is needed, enter its value in the UPC field when creating or editing the item record. The UPC field is the primary field for barcode information and assigned by default to transactions and receipts.

**Note:** When printing price tags, the information printed on these tags in barcode format is the Item Name/Number field. If you need any other fields such as the UPC field to print in barcode format, contact NetSuite Customer Support. Additional barcode fields are not currently available for price tag printing.

Additional barcodes can only be added after a new item has been created and saved. These additional barcodes have a maximum length of 32 characters and are stored as text.

There are three methods you can use to add barcodes to an item:

- Create an RA-Barcode record linking the item to a barcode. After the RA-Barcode is created, check the item record to ensure the barcode was correctly assigned.
- Open the item record and assign an existing barcode or create a new one.
- Use the Import CSV Records Import Assistant to assign barcodes to multiple records at the same time. This saves you time by allowing you to upload one spreadsheet as a batch operation.

**Warning:** We do not recommend doing mass record updates during business hours. Creating or importing large numbers of barcodes or other records at once can impact the synchronization process at your registers. See Benchmarks for Data Transfers and System Limits.

Steps for each method follow below.

**To add barcodes to an existing item:**

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records & Fields > Record Types.
3. Locate **RA-Barcode** and click **New Record**
4. In the RA-Barcode window, in the **Item** field, select the item you want to add a new barcode to.
5. In the **Barcode** field, enter its corresponding barcode.

![RA-Barcode](image)

6. Click **Save** or position your cursor over the **Save** menu arrow and click **Save & New** to create a new RA-Barcode record.
7. When you have finished adding additional barcodes to items, open the item records and click the **Custom** subtab.
   Verify the assigned barcodes are displayed on the **RA-Barcode** subtab.

![RA-Barcode window](image)

**To assign existing barcode records to an existing item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click **View** for the desired item.
4. Click the **Custom** subtab.
5. On the **RA-Barcode** subtab, in the **RA-Barcode** field, select the barcode you want to assign to this item.
6. Click **Attach**. The barcode is now listed in the **Barcode** column.
7. Repeat steps 3–4 for any additional barcodes you want to assign.

If you have several items to which you want to assign additional barcodes, you can use the Import Assistant. For complete information of how to use this feature, see the help topic Importing CSV Files with the Import Assistant.

**To use the Import Assistant to assign barcodes to multiple records at one time:**

*Warning:* We do not recommend doing mass record updates during business hours. Creating or importing large numbers of barcodes or other records at once can impact the synchronization process at your registers.

1. To create the source file used to match items with additional barcodes, go to Lists > Accounting > Items.
2. On the Items page, click the MS Excel icon to export the list to your computer in .xls format.

3. Use the windows file dialog box to open the file with Microsoft Excel or another compatible application.
4. Edit the file so that only the **Name** column remains.
5. Rename this column to **Item**.
6. Delete any rows for items you do not want to add barcodes to. Do not leave blank rows in between item rows.
7. Add a new column called **Barcode**.
8. Enter each barcode value in the **Barcode** column for the corresponding item.

**Note:** If you want to add more than one barcode for an item, create a new row with the exact same name of the item and add a new barcode value in each corresponding column.

9. Save the file to your computer as a **CSV** (comma delimited) type file.
10. Go to Setup > Import/Export > Import CSV Records.
11. On the Import Assistant Page, under Step 1 Scan & Upload CSV File:
   a. In the **Import Type** field, select Custom Records.
   b. In the **Record Type** field, select RA-Barcode.
   c. Click **Select...**
d. A Windows Explorer directory window appears. Locate and select the .csv file you created in step 9 and click Open.

e. When the file appears next to the Select... button, click Next >

12. On the Step 2 Import Options page:
   a. Under Data Handling, select Add.
   b. Click Next >.

13. The Step 3 File Mapping step is performed without required input. On the Step 4 Field Mapping page:
   a. Ensure that the Item and Barcode fields correctly map to their NetSuite counterparts.

   ![Import Assistant with Field Mapping](image)

   b. Click Next >

14. On the Step 5 Save Mapping & Start Import page:
   a. Enter a unique name for this import process in the Import Map Name field, for example Import Extra Barcodes. You can then use this map name to quickly perform another barcodes import.
   b. Click Save & Run. A confirmation message appears and you will be notified by email when the operation has completed.

15. To check that the import worked as expected, open any item record found on your .csv file. Ensure that the barcode is displayed on the RA-Barcode subtab.

![RA-Barcode](image)

Editing Assigned Barcodes

**Important:** Barcodes, after being created, cannot be deleted. If you no longer want a barcode to be assigned to a specific item, you must deactivate the barcode in the RA-Barcode record. If you entered and saved a barcode incorrectly, deactivate the existing barcode and create and assign a new one.

To remove an existing additional barcode from an item:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click View for the desired item.
4. Click the Custom subtab. On the RA-Barcode subtab, click Edit next to the barcode you want to deactivate.

![RA-Barcode subtab](image)

5. In the Edit RA-Barcode window, check the Inactive box.

![Edit RA-Barcode window](image)

6. Click Save.

The barcode now shows as Inactive on the RA-Barcode subtab.

**Important:** Allow at least 15 minutes for the barcode update to synchronize and replicate across your registers.

**Warning:** We do not recommend doing mass record updates during business hours. Creating or importing large numbers of barcodes or other records at once can impact the synchronization process at your registers.

### Using Multiple Barcodes on your Registers

The following table lists how NSPOS registers handle multiple barcodes.

<table>
<thead>
<tr>
<th>Action in NetSuite ERP</th>
<th>Result when performing a transaction on an NSPOS register</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign one unique barcode to an item.</td>
<td>If the price tag's barcode matches the assigned barcode, the item rings up in the Journal.</td>
</tr>
<tr>
<td>Assign more than one unique barcode to an item.</td>
<td>If the price tag's barcode matches one of the assigned barcodes, the item rings up in the Journal.</td>
</tr>
<tr>
<td>Assign the same barcode to more than one item.</td>
<td>If the price tag's barcode matches the assigned barcode, a list of items is displayed for the operator to select from.</td>
</tr>
<tr>
<td>Assign the same barcode to more than one item and mark one as inactive.</td>
<td>If the price tag's barcode matches the assigned barcode, only those items marked as active are displayed for the operator to select from.</td>
</tr>
<tr>
<td>Mark a barcode as inactive.</td>
<td>Even if the price tag's barcode matches the assigned barcode, the item does not ring up in the Journal.</td>
</tr>
</tbody>
</table>
Weighted Barcodes – Enabling Scans

NetSuite Point of Sale (NSPOS) includes an option to use weighted barcodes for tagging random-weight items. These products are usually sold by weight rather than by the unit. Before being offered for sale, the store will weigh the item and apply a unique barcode that includes the item ID and price. When scanned, the item description and price for the weight display in the Journal.

**Note:** NetSuite POS does **not** integrate with scales at the register. Items must be weighed prior to the actual sale.

Per Uniform Code Council (UCC) standards, weighted barcodes always begin with the number 2. These barcodes are 11 to 12 digits in the format: `2xxxxx*yyyy*`.

- **2** – Identifies the barcode as a weighted code.
- **xxxxx** – Item ID in NetSuite. The NetSuite item record includes the Item Name/Number, RA-Barcode and UPC.
- ***** – Not used by NetSuite POS.
- **yyyy** – Item price.
- ***** – Not used by NetSuite POS.

For example, barcode 255555016990 is weighted, with Item ID 55555 and a price of $16.99.

**By default, processing for weighted barcodes is disabled.** Without changing the setup using the following procedure, NetSuite POS will either process a code beginning with the number 2 as a regular barcode, or it will return an error.

**To enable Scanning of Weighted Barcodes:**

Set the flag for **Item: Disable Weighted Barcode** to **No** (blank).

1. Sign in to **any** NetSuite POS register as an administrator (9090 level operator).
2. Press **Ctrl+F10** to open the **Universal Settings** window.
3. Enter **weighted** in the search field.
4. If checked, tap the box to clear the option for **Disable Weighted Barcode**. Removing the check mark enables weighted code scanning.
5. Tap **Done**.
6. Tap **Sign Off** and then tap **Exit**.
7. Restart NetSuite POS on the register. Changes will synchronize to the other NetSuite POS registers on your network.
Bin Management

You can use bins in NetSuite Point of Sale (NSPOS) to identify places in your warehouse where you store inventory items. Bins are also useful for items that sell in bulk. Bins help you track on-hand quantities, assist with organizing receiving items and simplify picking items to fulfill orders.

Before you can use bins in transactions, you must associate all items with a corresponding **Bin Number**. You can use a default Bin Number for non-bin items. The bin feature in NetSuite POS does not allow using bins with serialized and lot numbered items.

⚠️ **Important:** If one or more items sold in a transaction do not have an assigned Bin Number, the entire NetSuite POS transaction will fail to post to NetSuite.

Requirements and Recommendations

- NetSuite POS locations must be mapped with a default Bin Number.
- All items must be assigned to Bin Numbers.
- You can assign Bin Numbers to items using saved searches or mass updates.
- Work with your account manager prior to implementing bins.
- If access to the options described in the links below is denied or does not appear in NetSuite, your account may not be set up to use bins. Your account manager can assist with gaining access.

For setup procedures and more information, sign into NetSuite and see the help topic **Bin Management**. Log into NetSuite first.

Prices

Use this NetSuite Point of Sale (NSPOS) section for configuring your price setup for the items you sell.

- Add a Price or Price Levels to an Item
- Using Price Levels to adjust Prices across Locations
- Price Filtering for Currency by Location
- Require Price Entry at Register

Add a Price or Price Levels to an Item

Follow these steps to add prices to an item for NetSuite Point of Sale (NSPOS). You can have a single base price for all stores or set up price levels assigned to store Location records. Price levels let you sell an item for different prices, and can be used for stores that you internally assign to different marketing areas or regions. For international retailers, you can set prices in the different currencies that you use.

These steps cover basic price setups. For detailed steps and explanations of various pricing options, review the NetSuite ERP help topic **Setting Up Item Pricing**.

ℹ️ **Note:** For information on how prices synchronize for different currencies, see **Price Filtering for Currency by Location**.

**To add Prices to an Item:**

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click **Edit** for the item to update.
4. Click the **Sales / Pricing** subtab.
5. Click the main currency in which the item will sell.

6. **Base Price:** Every item should have a **Base Price** that is the common selling price for an item in your stores.

   Enter this price under the **QTY 0** (Quantity 0) column. Do not use a currency symbol or comma.

   **Note:** NSPOS does not support pricing by purchase quantity (QTY).

   ![Base Price Example]

7. If desired, enter price levels (for example, **Alternate Price n**) that can be assigned to different locations.

   ![Price Levels Example]

   To assign a location to use a price level, such as **Alternate Price 1**, you select the level from the Location record using the field **POS - Price Level**. Each item sold in the location will use that level to determine the price.
See Work with Locations for information on completing the Location record. The POS - Price Level is an optional field. If a location does not have a price level assigned, or if an item does not have an amount in the location’s price level, then the item’s Base Price is used instead.

8. If you sell the item using different currencies, select the Currency, and then enter the Base Price and other prices.

9. Click Save.

Using Price Levels to adjust Prices across Locations

Your NetSuite ERP accounting setup for NetSuite Point of Sale (NSPOS) can include Price Levels. These levels let you set different pricing for the same item on based on store locations. Price Levels are usually set as discounts against an item’s base price.

An example is setting a Price Level to have a Markup/Discount % of -10%. Every item using the Price Level will have a 10% discount off the Base Price at Locations having that Price Level assigned. You can apply a positive percent (without a negative sign) to increase a price.

<table>
<thead>
<tr>
<th>Item</th>
<th>Base Price</th>
<th>Price Level A: -10%</th>
<th>Price Level B: 5%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gloves</td>
<td>$5.00</td>
<td>$4.50</td>
<td>$5.25</td>
</tr>
<tr>
<td>Hat</td>
<td>$10.00</td>
<td>$9.00</td>
<td>$10.50</td>
</tr>
<tr>
<td>Scarf</td>
<td>$7.00</td>
<td>$6.30</td>
<td>$7.35</td>
</tr>
</tbody>
</table>

Item Price at Locations

<table>
<thead>
<tr>
<th>Locations, Assigned Price Level</th>
<th>Gloves</th>
<th>Hat</th>
<th>Scarf</th>
</tr>
</thead>
</table>

NSPOS Administrator Guide
Prices

<table>
<thead>
<tr>
<th>Location 1, No Price Level</th>
<th>$5.00</th>
<th>$10.00</th>
<th>$7.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location 2, Price Level A</td>
<td>$4.50</td>
<td>$9.00</td>
<td>$6.30</td>
</tr>
<tr>
<td>Location 3, Price Level B</td>
<td>$5.25</td>
<td>$10.50</td>
<td>$7.35</td>
</tr>
</tbody>
</table>

You can edit a Price Level to change the Markup/Discount %. To adjust current prices of all items that use the level, check the Update Existing Prices box before saving. This action updates current prices of all items that use the level.

When you assign a Price Level to an item, the new item price is included in the downsync to all registers at the assigned stores. The downsync sets the item’s price on those registers. Updating a Price Level creates new downsync’d prices for all items whose price has changed.

⚠️ Important: Depending on the size of your inventory, it can take up to one hour to update all prices for all items included in a Price Level change. To ensure good performance at the register, you should avoid updating Price Levels during business hours if you know it will impact many items.

Viewing your Price Levels

1. Log in to NetSuite as an administrator.
2. Go to Setup > Accounting > Setup Tasks > Accounting Lists.
3. Expand the Filters and select Price Level.
4. Click View by the desired Price Level.

Creating or Editing Price Levels and Assignments

- To set up a new Price Level, see the help topic Creating Price Levels.
- To adjust a Price Level, see the help topic Editing Price Levels.
- To assign a Price Level to a store Location, see Work with Locations. The field is POS-Price Level.
- To assign Price Levels to an Item, see Add a Price or Price Levels to an Item.

Price Filtering for Currency by Location

NetSuite Point of Sale (NSPOS) release 2018.1 or greater includes replication filtering for price levels using the currency assigned to the location. In the past, all prices in all currencies handled by a retailer were downloaded to all registers. However, registers in Oklahoma City, OK USA do not need pricing in Euros and registers in Tokyo, Japan would not typically trade in US Dollars.

The price filtering feature only downloads item price levels that are applicable to a store’s business. For retailers handling multiple currencies, the feature can significantly lower the amount of data stored on each register’s database.

Before 2018.1, all price levels were downloaded everywhere:

Items x Price Levels x n Currencies = Number of lines downloaded to all registers, all locations

1000 x 2 x 3($) and ¥ and €) = 6000 lines
With 2018.1 or greater, locations only receive price levels for the currency used:

\[
\text{Items} \times \text{Price Levels} \times \text{1 Currency} = \text{Number of lines downloaded to registers at each currency location}
\]

\[
1000 \times 2 \times 1(\text{($) or ¥ or €}) = 2000 \text{ lines}
\]

During data downloads (down syncs), the server checks the currency set on the retailer’s NetSuite ERP Location records. If no currency is defined for a location, we use the currency set on the location’s parent Subsidiary record.

### Removing unneeded currencies from your registers

In previous releases, pricing for all the currencies you accept was loaded to all registers. Restaging a register after designating a currency on the Location record associated with the workstation removes any price data that is not valid for the register's store. This action frees valuable disk space on each register's database.

#### To set a Currency for a Location:

Perform these steps to set up a store currency different from the default set on your parent Subsidiary record. You must restage the registers assigned to the store location.

| Note: You must designate a currency for all locations that sell NetSuite Gift Cards or Gift Certificates. |
| 1. Log in to NetSuite as an administrator. |
| 2. Go to Setup > Company > Locations. |
| 3. Click Edit for the desired Location record. |
| 4. Select from the RA-Currency list. |
| 5. Click Save. |
| 6. Repeat for other Location records as needed. |
| 7. Restage the registers at each affected location. |
Important: Changing the currency field (RA-CURRENCY) on a Location record switches the price currency sent to all registers at the location. You must restage all registers at the location to activate the new currency. Otherwise, your registers will continue using the old currency, causing price discrepancies at the point of sale.

Important: Changing the currency field (RA-CURRENCY) on a Location record switches the price currency sent to all registers at the location. You must restage all registers at the location to activate the new currency. Otherwise, your registers will continue using the old currency, causing price discrepancies at the point of sale.

Note: To set up price levels in NetSuite ERP, go to Setup > Accounting > Setup Tasks > Accounting Lists > New > Price Level.

Require Price Entry at Register

You can allow a NetSuite POS operator the ability to enter a new price after ringing up an item at the sales terminal. When the item is rung up, a window appears prompting the operator to enter a price for the item. The original price that was set for the item is presented as the default price.

To require the price of an item to be entered during a sale:

1. Log in to NetSuite as an administrator.
2. Go to Lists > Accounting > Items.
3. Click Edit for the desired item.
4. Under the Custom subtab, check the Require Price Entry at Register box.
5. Click Save. Allow time for the updated record to sync to NetSuite Point of Sale registers.
6. Any time the item is rung up on a NetSuite Point of Sale register, the user is prompted for the Item Price.
TRANSACTION MANAGEMENT

(Appplies to: NetSuite Point of Sale (NSPOS))

Use this chapter to learn about using, creating and configuring transaction-related processes in NetSuite Point of Sale (NSPOS)

- Basic Sales Transactions
  - Enter a Sales Transaction
  - Discounts
  - Sales Taxes
  - Suspend, Resume, Cancel Transactions
  - Receipts
  - Select Sales Associate

- Sales Orders
- Promotions
- Returns

**Important:** NetSuite POS is highly customizable. Buttons, names and layouts on your screen may be different from those described here. Check with your manager for any instructions specific to your setup.

If you need to locate a button or task, press Ctrl+F12 to search the Function List.

Basic Sales Transactions

This chapter guides you through making sales transaction on a NetSuite Point of Sale (NSPOS) register.

- Enter a Sales Transaction
- Discounts
- Sales Taxes
- Suspend, Resume, Cancel Transactions
- Receipts
- Select Sales Associate

Also see the Returns section for the steps to make validated (with receipt) and non-validated (without receipt) item returns. The section includes settings that administrators can configure to handle returns using your preferred business processes.

Enter a Sales Transaction

Sales transactions are the primary function of NetSuite Point of Sale (NSPOS). The overall workflow for entering transactions is to first add a customer, then add items, optionally apply any discounts or special sales tax considerations, and finally accept payment.
Follow these steps to ring up a sales transaction your NetSuite POS register. Steps for applying Discounts and working with Sales Taxes are provided in the following sections.

- Add Customers to a Sales Transaction
- Work with Items in a Sales Transaction
- Accept Payments for Purchases

Add Customers to a Sales Transaction

Use these steps to locate a customer and include them in a NetSuite POS sales transaction. Note that you can start a transaction and temporarily assign it to a guest customer account, returning later to add actual customer information and reassign it. Unless your store has specific requirements, adding a customer to a sales transaction is optional. It is however, recommended.

**Note:** Only one customer can be assigned to a single sales transaction.

To add an existing customer to a transaction:

Always search to see if a customer already exists in NetSuite POS.

1. Tap Find Customer.
2. Search for the customer by drilling into alphabetized folders or by entering the first few letters of the customer's first or last name.
   
   Search results display after entering three characters. Searches do not require pressing any additional buttons, are not case sensitive, and match any part of a name. If you do not have a keyboard, tap the green Show Keyboard button.

   **Note:** NetSuite limits the search to customers in the same subsidiary as the store. Subsidiaries are different divisions or companies under a corporate parent.

3. Tap the customer name to select them for the transaction.

   **Tip:** To view the customer's past five transactions, tap the customer's name. Tap anywhere on-screen to return to the transaction.

To add a new customer to a transaction:

Do this if you are certain the customer is not in NetSuite POS.

1. Tap Find Customer.
2. Tap **Create Customer**.
3. Enter required and optional information.
   a. **Required** fields display an arrow 
   b. If the customer belongs to an **Organization** or **Customer Group** already set up in your system, select it. These are pre-defined by your system administrator. You cannot add an organization or group.
4. Tap **Done**.

**To remove a customer from a transaction:**

1. Tap **Find Customer**.
2. Tap **No Customer**.
3. If you need to assign a different customer, tap **Find Customer** again.

**Work with Items in a Sales Transaction**

After optionally selecting the customer, you must add items to the transaction. You can use a barcode scanner, find and select items from folders or from a search, or use item hotkeys. To remove an item, use the steps in this section to void it.

- **Add Items using a Barcode Scanner**
- **Add Items using Find Item**
- **Add Items using Item Hotkeys**
- **Void Items using a Barcode Scanner**
- **Void Items from the Journal**

**Add Items using a Barcode Scanner**

Scanning an item’s UPC or SKU is the fastest way to add items to a transaction.

**To add items by scan:**

1. Scan the item with your flat or hand-held barcode scanner.
2. If adding more than one of the same item, tap **Item Quantity** to enter the number being sold or scan each item individually.

**Add Items using Find Item**

Use this when an item cannot be scanned or to look through current inventory. You can search or browse through all available items.

**To add items from a Find Item list:**

1. Tap **Find Item**.
2. Locate the item using either method:
   - **Search** — Enter all or part of an item name or ID. Results display after you enter at least three characters. These include exact, likely and near matches.
Basic Sales Transactions

- **Browse** — Drill into the folder hierarchies by opening folders to view the items inside.
  To go back or move up to top level folders, tap **Item** at the top of the window.
  3. Tap the item to add it to the transaction.
  4. If adding more than one of the same item, tap **Change Quantity** to enter the number being sold.

**Add Items using Item Hotkeys**

Item hotkeys are buttons or groups of buttons that add items to the Journal when tapped. Use hotkeys as a quick method for ringing up store specials, common items or hard-to-scan items. Managers and system administrators can create and configure item hotkeys.

**To add items from hotkeys:**

1. Tap the **Item Hotkey** button assigned to the desired item.
   Often this is a single button on the Main bar that opens hotkeys on the Side bar. However, hotkeys can be located anywhere on the Journal, so you may want to ask your manager what keys are available and where.
2. If adding more than one of the same item, tap **Change Quantity** to enter the number being sold.

**Void Items using a Barcode Scanner**

Follow these steps to remove an item from a sales transaction using your barcode scanner.

**To void an item by scan:**

1. Tap **Voids / Returns**.
2. Tap **Void Scan**.
3. At the **Scan or enter barcode** prompt, scan the item or manually enter its barcode.
4. Tap **Enter**.
5. If prompted, select a **Reason** from the list and tap **Enter**.
6. The current line item is flagged as VOID. Voided items appear on the receipt with a translucent red watermark.

**Void Items from the Journal**

Follow these steps to remove an item by selecting its line item on-screen.

**Watch a Related Video**

**To void by Journal line item:**

1. Select the item to void in the Journal.
2. Tap **Voids / Returns**.
3. Tap **Void Line**.
4. If prompted, select a **Reason** from the list.
5. The current line item is flagged as VOID. Voided items appear on the receipt with a translucent red watermark.
Accept Payments for Purchases

In NetSuite POS, your customers can choose from a variety of methods to tender payment for their merchandise. The following are standard payment types. Your setup may not accept all types.

- Paying with Cash
- Paying with Cash using Preset Amounts
- Paying with a Check
- Paying with a Credit Card
- Paying with a Debit Card
- Paying with a Gift Card or Gift Certificate
- Split Tender – Taking more than one type of Payment
- No Sale (open the cash drawer)

**Note:** When the drawer opens for cash and other payments, portions of the screen are unavailable until you close the drawer.

Paying with Cash

Follow these steps to receive cash for a sales transaction.

**To accept a cash payment:**

1. When you have finished ringing up all items, tap Amt Due.
2. Tap Cash.
3. Use the keypad to enter the cash received.

   ![Tip: NetSuite POS uses decimal assumption to convert round entries into decimal numbers. For example, 350 converts to $3.50. To enter $350.00, enter the numbers 35000.]

4. Tap Enter or the green check mark.
   
   Each payment appears in the Journal and reduces the Amt Due. When the payment received meets or exceeds this amount, the Journal displays the Cash Change, the cash drawer opens and the receipt prints.
5. Give the customer their change and receipt.

Paying with Cash using Preset Amounts

Your system administrator can customize NetSuite POS to receive cash in preset amounts. For example, if a customer tenders $40, you can tap a $20 preset button twice to quickly enter the amount and calculate the change. Not all setups include preset amount buttons.

**To accept cash in preset amounts:**

1. When you have finished ringing up all items, tap Amt Due.
2. Tap the applicable preset cash amount button, such as $20 Cash.
3. Repeat based on the cash received from the customer.
Each payment appears in the Journal and reduces the Amt Due. When the payment received meets or exceeds this amount, the Journal displays the Cash Change, the cash drawer opens and the receipt prints.

4. Give the customer their change and receipt.

Paying with a Check

Follow these steps to receive a bank check as payment for a sales transaction.

To accept a check payment:

1. When you have finished ringing up all items, tap Amt Due.
2. Tap Check.
3. Enter the amount of the check.
4. Tap Enter or the green check mark.
5. Enter the check number when prompted.
6. Tap Enter or the green check mark.
   The cash drawer opens and the receipt prints.
7. Insert the check in the cash drawer and give the customer their receipt.

Paying with a Credit Card

Depending on the hardware setup at your store and your country location, you or your customer can slide or insert credit cards through an attached card swipe reader or a CAT/PIN Pad terminal. Credit card payments are automatically routed through the third-party processor selected by your company.

To accept a credit card payment:

1. When you have finished ringing up all items, tap Amt Due.
2. Tap Credit Card.
3. Enter the amount to pay with the card.
4. Tap Enter or the green check mark.
5. When prompted, ask the customer to swipe their card or swipe it for them.
   - You can manually enter the 16-digit card number and tap Enter. Follow the prompts to enter additional required information.
   - A signature may be required. If there is no customer facing terminal, a receipt prints with a signature line.
   When all information is entered, NetSuite POS processes the charge through your credit card payment provider. The payment appears in the Journal when processing completes.
6. The receipt prints. If a signature receipt also prints, ask the customer to sign and then place it in the cash drawer.
7. Give the customer their receipt.

About Prepaid Credit Cards. A prepaid credit card is any card pre-loaded with currency from a major credit card provider such as Visa® or MasterCard®. These cards should be processed as credit cards, not gift cards.
Prepaid credit cards can have two important attributes that may vary by card issuer:

- Some cards support a feature called partial authorization. This is used when the total amount due is greater than the total remaining balance on the card. Instead of declining, NetSuite POS applies whatever balance it can to the transaction.
- Most cards have a delayed transaction-return time where a previously used card balance is not available for reuse. If a credit card payment line is voided or a return is performed to the card, that money may not be available for 24 hours. Advise the customer to contact the card issuer if they need more information.

**Paying with a Debit Card**

Debit cards are handled similar to credit cards except that they require the customer to enter their PIN (personal identification number). These generally require a customer-facing swipe device with a PIN pad.

If no device is available, you can process a debit card payment on-screen as a credit card.

**To accept a debit card payment:**

1. When you have finished ringing up all items, tap **Amt Due**.
2. Tap **Debit Card**.
3. Enter the amount to debit.
4. Tap **Enter** or the green check mark.
5. At the **Please Slide Debit Card** prompt, advise customer to swipe their debit card and follow the card reader prompts.
   - NetSuite POS processes the debit through your credit card payment provider. The payment appears in the Journal and the receipt prints when processing completes.
6. Give the customer their receipt.

**Paying with a Gift Card or Gift Certificate**

Follow these steps to accept a gift card or certificate as payment for a sales transaction. Gift cards are usually physical cards, while gift certificates are sent via email and use an Authorization Code.

- A single gift card or certificate can be used only one time per transaction.
- You can accept gift cards with balances greater than the amount due. The balance will remain on the card.
- If a customer pays with a gift certificate having a balance greater than the amount due, you must give customer the balance in cash.

**To accept a gift card payment:**

1. When you have finished ringing up all items, tap **Amt Due**.
2. Tap **Gift Card**.
3. Tap **Card**.
4. Enter the **Gift Card Amount** to subtract.
5. Tap **Enter** or the green check mark.
6. At the **Please Slide Gift Card** prompt, advise customer to swipe their gift card. You can enter the card number manually if needed.
7. If the **Amount Due** (for example, $60.00) is greater than the **Gift Card Amount** you entered (for example, $50.00):
   - Tap **Yes** to apply the full gift card amount. You must enter an additional payment, also called split tender.
   - Tap **No** to cancel, and then select a different payment type.

8. The receipt prints. Give the customer their receipt.

**To accept a gift certificate payment:**

*Warning:* If a customer pays with a gift certificate that has a balance greater than the total amount due, you must return the remaining balance to the customer in cash. Otherwise the balance will become unavailable. This limitation affects gift certificate balances only, it does not apply to gift cards.

1. When you have finished ringing up all items, tap **Amt Due**.
2. Tap **Gift Card**.
3. Tap **Certificate**.
4. Enter the **Gift Certificate Amount** to subtract.
5. Tap **Enter** or the green check mark.
6. Enter the certificate **Authorization Code**.

   **Note:** This may appear as **Gift Certificate/Card Serial Number**.

7. Tap **Enter** or the green check mark.
8. If the **Amount Due** (for example, $60.00) is greater than the **Gift Card Amount** you entered (for example, $50.00):
   - Tap **Yes** to apply the full gift certificate amount. You must enter an additional payment, also called split tender.
   - Tap **No** to cancel, and then select a different payment type.

9. The receipt prints. Give the customer their receipt.

**Split Tender – Taking more than one type of Payment**

When a customer uses more than one type of payment, such as a gift card and cash, we call that a split tender payment. No specific task is required to make a split tender; just tap the next payment type. If a customer wants to change a payment method already made, you can select the payment line in the Journal and tap **Void Line**.

*Important:* A single credit or debit card can only be used *once* per transaction.

**To accept multiple payment types:**

1. When you have finished ringing up all items, tap **Amt Due**.
2. Select the first payment type.
3. Enter an amount less than the total amount due. The tendered amount is added to the transaction in the Journal and subtracted from the **Amt Due**.
4. Tap the next payment type button.
5. Enter the next amount. When the payments meet or exceed the Amt Due, the Journal displays any Cash Change. The receipt prints and the cash drawer opens if change is due or to insert a check.

6. Give the customer any change and receipt.

In the example below, a transaction is split into two payment types.

![Transaction example]

**No Sale (open the cash drawer)**

Follow these steps to open the cash drawer without performing a sale. You must select a Reason Code describing why you performed this action.

**To open the cash drawer without a sale:**

1. Tap No Sale.
2. Choose the Reason Code and tap Select.
3. The cash drawer opens. Complete your task and close the drawer.

**Discounts**

Based on your permission settings, you can manually reduce the price of an item or apply a discount to an entire sales transaction. NetSuite POS offers many different discount functions. However, they are all based on the same five methods:

- **Item % Off** — An item discount you enter as a percentage off the original item price. For example, reduce the price of an item by 25%.
- **Item $ Off** — An item discount you enter in units of currency subtracted from the original price. For example, take $5.00 off an item's price.
- **Sale % Off** — A sales transaction discount you enter as a percentage off the total sale. For example, 25% off the entire transaction.
- **Sale $ Off** — A sales transaction discount you enter in units of currency subtracted from the total sale. For example, a $10.00 discount off the entire transaction.
- **Price Override** — Depending on permissions granted for your setup, you can override the price of an item by entering a lower price. For example, a sales associate might lower the price of an item from $59.99 to $49.99 to match a competitor's price. A manager's approval may be required. **Do not use Price Override to increase a price.**

- Also see Maximum Discount Limits and Manager Approvals.

Your system administrator can define Reason Codes to track price changes. This provides visibility to discounts provided for specific promotions or for things such as sales of damaged merchandise. Discounts can also be removed at the item and sale total levels.
This section details the five main discount types. Also see Other Discounts and Actions for steps to apply other discount types and to void discounts from the current transaction.

**Note:** Active promotions apply discounts automatically. When applied to an item, the promotion name appears in the item's Journal line.

### Item % Off

Follow these steps to discount an item by a percentage.

**To apply an item % off discount:**

1. Start a sales transaction.
2. Scan or select the item to discount.
3. Tap Discounts.
4. Tap Item % Off.
5. Enter the Discount % as a number, without the percent sign. For example, enter 10 for 10%.
6. Tap Enter or tap the green check mark.
7. Choose a Percent Discount Reason Code and tap Select.
8. Confirm the discount percentage and Reason Code appear for the item and that the discount has been applied to the Subtotal.

### Item $ Off

Follow these steps to apply a discount to an item by a fixed amount.

**To apply an item $ off discount:**

1. Start a sales transaction.
2. Scan or select the item to discount.
3. Tap Discounts.
4. Tap Item $ Off.
5. Enter the Discount $ as a number, without a currency symbol. For example, enter 1.00 (or 100 with decimal assumption on) to apply a $1.00 discount.
6. Tap Enter or tap the green check mark.
7. Choose a Price Reduction Reason Code and tap Select.
8. Confirm the discount amount and Reason Code appear for the item and that the discount has been applied to the Subtotal.

### Sale % Off

Follow these steps to discount an entire sales transaction by a percentage.

**To apply a sale % off discount:**

1. Start a sales transaction.
2. Tap Discounts.
3. Tap Sale % Off.
4. Enter the % Sale Discount as a number, without the percent sign. For example, enter 10 for 10%.
5. Tap Enter or tap the green check mark.
6. Choose a Percent Discount Reason Code and tap Select.
7. Confirm the discount percentage and Reason Code appear and that the discount has been applied to the Subtotal.

NetSuite POS spreads the discount equally among all items on the transaction. The discount is applied to the total – including sales tax – by reducing each item’s price and tax in equal proportions.

**Sale $ Off**

Follow these steps to discount an entire sales transaction by a fixed amount.

**To apply a sale $ off discount:**

1. Start a sales transaction.
2. Tap Discounts.
3. Tap Sale $ Off.
4. Enter the Discount Amount as a number, without a currency symbol. For example, enter 1.00 (or 100 with decimal assumption on) to apply a $1.00 discount.
5. Tap Enter or tap the green check mark.
7. Confirm the discount amount and Reason Code appear and that the discount has been applied to the Subtotal.

NetSuite POS spreads the discount equally among all items on the transaction. The discount is applied to the total – including sales tax – by reducing each item’s price and tax in equal proportions.

**Price Override**

You can choose this discount type to lower an item’s price. The override applies to the current transaction only, and may require your manager’s approval.

**Important:** Use Price Override to lower a price only. Do not use it to increase a price.

**To override a price:**

1. Start a sales transaction.
2. Scan or select the item to override.
3. Tap Discounts.
4. Tap Price Override. A numeric keypad appears showing the original price for the item less any applied discounts or previous overrides.
5. Enter the New Price as a number, without a currency symbol. For example, enter 49.99 (or 4999 with decimal assumption on).
6. Tap Enter or tap the green check mark.
7. Choose a Price Override Reason Code and tap Select.
8. Confirm the new price and Reason Code appear for the item and that the new price has been applied to the Subtotal.

Maximum Discount Limits and Manager Approvals

To prevent excessive discounts from being applied manually, NSPOS includes settings to limit the maximum amount or percent off available to be given at the cashier’s discretion. An amount or percentage exceeding that limit requires a manager’s approval.

For example, with a maximum amount off limit of $10.00:

- If a discount added by the cashier is $10.00 or less, manager approval is not required.
- If a discount added is $10.01 or greater, the cashier must get a manager to approve the discount.

The amount–off limit includes price overrides. The discount amount for overrides is the difference between the override price and the price shown in the journal.

Performing a Manager Approval

If a cashier attempts to add a discount greater than the maximum discount limit, they receive a prompt as follows. The prompt includes the discount requested and informs the cashier of the need to get approval.

The manager logs in using the fields included in the prompt and taps Confirm to make the approval.

Approvals can be made by any user with a role higher than Specialist (Resource ID 2). Typically, cashiers have a Specialist role. Higher roles include Manager (Resource ID 9070) and System Administrator (Resource ID 9090). See Roles and Permissions.

Note: Manager–role access ends when the approval is complete. The manager is automatically logged out after tapping Confirm. The cashier does not receive enhanced access from the manager having logged in to make the approval.

If a Manager adds a Discount greater than the Maximum

If a manager is logged in and working the transaction, that manager receives a different prompt when attempting to exceed a maximum discount limit. The prompt includes information about the discount limit and a Yes or No option to proceed.
If the manager taps Yes, the discount is applied. If the manager taps No, they receive a prompt listing that the discount exceeded the maximum and was not applied.

Setting Discount Limits

Administrators configure maximum discount limits through NSPOS settings. The two settings for discount limits are:

- **MaxDiscountAmount** – Applies to amount-off item or sale discounts and item price overrides.
- **MaxDiscountPercent** – Applies to percent-off item or sale discounts.

For both maximums, cashiers can apply discounts up to and including a setting’s value. For example, with MaxDiscountPercent limit of 10, an approval is required for discounts of 10.01% or greater.

These limits are reviewed as follows when a sales associate applies a discount to a transaction:

- **Discount Amount** (Item $ Off, Sale $ Off) — When applied, NSPOS verifies that the calculated discount is not higher than the set MaxDiscountAmount.
- **Discount Percent Item** (Item % Off, Sale % Off) — When applied, NSPOS verifies that the calculated discount is not higher than the set MaxDiscountPercent and MaxDiscountAmount.
- **Price Override** (New Price) — When applied, NSPOS verifies that the calculated discount is not higher than the set MaxDiscountAmount.

See Flags and Settings for the steps to configure a setting. Enter maximum values as a number, without a currency symbol or percent sign.

Other Discounts and Actions

NetSuite POS includes options for other discount types.

- **Manufacturer Coupon**
- **Discounts for Damaged Items**
- **Employee Discount**

You can remove discounts applied to a transaction.
Basic Sales Transactions

- Remove Item Discount
- Remove All Discounts

Manufacturer Coupon

A coupon is a form of discount. Coupons can be a set amount off an item's price, or they can be redeemed for free items. Sales associates typically scan coupons directly after scanning or selecting the item referenced in the coupon. Scanning a coupon usually means no further steps are necessary.

Follow these steps only if you need to manually redeem a coupon by entering the coupon details.

To manually redeem a manufacturer coupon:

1. Start a sales transaction.
2. Scan or select the item or items eligible for the coupon.
3. Receive the coupon from the customer.
4. Tap Discounts.
5. Tap Manufacturer Coupon.
6. Enter the Manufacturer Coupon Amount as a number, without a currency symbol. For example, if the coupon is $0.50 off, enter 0.5 (or 50 with decimal assumption on).
   - If the coupon can be redeemed for a free item, enter the value of the free item, subject to the maximum value shown on the coupon.
7. Tap Enter or tap the green check mark.
8. Confirm the coupon value is applied to the Subtotal.

Discounts for Damaged Items

You can apply a discount to the price of an item that is damaged.

To apply discount for damaged items:

1. Apply any of the discount types listed previously, such as Item $ Off.
2. Choose a Reason Code of Damaged.
3. Tap Select.

Important: Damaged Items - If you have more than one of the same item on a sales transaction, and you apply a damaged item discount, that discount is applied to each item. For example, a $5.00 discount for one damaged item that is part of a quantity of three results in a total discount of $15.00.

To apply a damage discount to one item only, either apply a Sale $ Off discount to the entire sales transaction or enter the transaction with the damaged item appearing in a separate line.

Employee Discount

You can apply an employee percent off discount to all items in a sales transaction. Your system administrator has set the discount percent based on your store's policy.
To apply an employee discount:

1. Start a sales transaction.
2. Tap Discounts.
3. Tap Employee Discount.
4. Tap Enter or tap the green check mark.
5. Continue as a normal sales transaction.

Remove Item Discount

You can remove discounts manually applied to single items.

To remove an item discount:

1. Select a discounted item.
2. Tap Discounts.
3. Tap Remove Item Discount(s).
4. At the How would you like to remove discounts? prompt:
   - Tap Last One to remove only the most recent discount applied to that item.
   - Tap All to remove every discount applied to that single item. This function only removes discounts for the line item that you selected. It does not remove discounts applied to other items in the transaction.

Remove All Discounts

You can remove all discounts manually applied to the sales transaction.

To remove all discounts:

1. Tap Discounts.
2. Tap Remove Sale Discounts or Remove All Discounts.
3. At the Are you sure you want to remove all discounts? prompt, tap Yes.

Sales Taxes

NetSuite POS defaults the sales tax charged to customers to the rate in your location's tax jurisdiction. The application chooses the tax jurisdiction from the zip code or other postal code at your store. However, you can set the transaction tax rate to zero for tax-exempt organizations such as non-profit charities.

Make a Transaction Tax Exempt

Follow these steps to specify that a customer is legally tax exempt and should have no sales tax applied. This requires that the customer show proof of their organization's exempt status by providing their tax exemption certificate or number.
To make a transaction tax exempt:

1. Begin the sales transaction.
2. Under Other Functions, tap Tax Exempt.
3. If not already done, find and select the Customer.
   This is required for tax exempt transactions. See Add Customers to a Sales Transaction.
4. At the Enter the tax exemption certificate ID prompt, enter the authorized state or local sales tax exemption number and tap the green check mark.
5. Choose a Tax Exemption Reason Code and tap Select. For example, choose Non-Profit.
6. In the transaction summary area, verify that no tax ($0.00) is applied to the transaction.

Tax by Zip Code — Apply a Different Jurisdiction’s Tax Rate

**Warning:** The ability to apply a different tax rate requires configuration by NetSuite | Oracle Professional Services. Attempting to apply a different rate without the correct setup could result in incorrect taxes being calculated.

Follow these steps to apply the tax rate for another jurisdiction to the current sales transaction. A tax jurisdiction is a city, county or other region with distinct tax regulations. For example, each city usually has its own sales tax rate.

Do this if the customer’s business pays taxes outside of your store’s jurisdiction. For example, branch offices operating locally may pay taxes through a corporate office found in a different state.

This feature requires that your system administrator maintain up-to-date tax tables arranged by U.S. zip code or other applicable postal codes. The following is written for U.S. setups.

To apply a different tax rate:

1. Begin the sales transaction.
2. Under Other Functions, tap Tax by Zip Code.
3. At the Enter the 5-digit zip code to use for tax calculations prompt, enter the zip code for the applicable tax jurisdiction and tap Enter.
4. If not already done, optionally find and select the Customer.
5. In the transaction summary area, verify the correct tax jurisdiction is applied to the transaction.

Suspend, Resume, Cancel Transactions

If a customer is not ready to complete a purchase, but wants to keep the item list and return to complete it later, you can suspend the NetSuite POS sales transaction. This saves all details about the potential purchase and lets you start a new transaction with the next person in line. You can quickly resume the transaction when the customer is ready.
You can cancel current transactions in progress and cancel suspended transactions if the customer declines to return to complete the purchase. After your store's time limit on holding transactions has expired, suspended transactions cancel automatically. You cannot resume a canceled transaction.

- **Suspend a Transaction**
- **Resume a Suspended Transaction**
- **Cancel a Suspended Transaction**
- **Cancel a Current Transaction**

### Suspend a Transaction

**Watch a Related Video**

Follow these steps to suspend and save all details about a transaction, including the customer's name, items, and any applied discounts.

⚠️ **Important:** After any form of payment is applied, in full or in part, you can no longer suspend a transaction.

NSPOS includes an option to print a set of suspended transaction receipts for the cashier and customer. The cashier can scan this receipt to quickly locate and resume a transaction. Administrators can enable this option by clearing the SupressPrintSuspended flag. See Flags and Settings in the NSPOS Administrator Guide.

**To suspend a transaction:**

1. Start a sales transaction.
2. Tap **Suspend**.
   
   This button might appear in the **Other Functions** menu.

### Resume a Suspended Transaction

Use these steps to resume a transaction and continue processing the sale. You can do this from any register connected to your NetSuite POS network. If the transaction does not appear in the **Resume** list, it was manually canceled or the time limit has expired.

Suspended transactions take about five minutes to be available from other registers. This means a transaction suspended on one register may not be immediately eligible for resuming on another register.

**To resume a suspended transaction:**

1. Verify that you have no transactions open in the Journal.
2. Verify that a green circle appears on the **Resume** button showing at least one suspended transaction. This may appear under **Other Functions**.
3. Tap **Resume**.
4. When the **Resume Transaction** window displays, either:
   - Locate the transaction by drilling into the transaction day's folder.
   - Search for the suspended transaction by customer name.
If printed, scan your or the customer’s suspend transaction receipt.

5. Select the transaction.

6. Complete the sale by adding items or taking payment.

Cancel a Suspended Transaction

If a customer will not resume a suspended transaction, follow these steps to remove it from the list.

To cancel a suspended transaction:

1. Verify that you have no transactions open in the Journal.

2. Verify that a green circle appears on the Resume button showing at least one suspended transaction. This may appear under Other Functions.

3. Tap Resume.

4. When the Resume Transaction window displays, either:
   - Locate the transaction by drilling into the transaction day’s folder.
   - Search for the suspended transaction by customer name.
   - If printed, scan your or the customer’s suspend transaction receipt.

5. Select the transaction and tap Enter.

6. Tap Voids / Returns.

7. Tap Cancel Transaction.

8. Choose a Reason from the list and tap Select.

Cancel a Current Transaction

Watch a Related Video

Follow these steps if the customer decides to cancel their transaction while it is in progress.

To cancel a current transaction:

1. Tap Voids / Returns.

2. Tap Cancel Transaction.

3. Choose a Reason from the list and tap Select.
   All line items are voided and a new transaction can begin.

Receipts

You can assist customers in NetSuite POS by reprinting a receipt from a previous transaction. Typically customers request this for their record keeping or for submitting an expense report or purchase order. Also helpful is printing gift receipts that provide gift recipients with a method to return items without immediately knowing the value of the gift.

- Reprint Receipt NSPOS 2018.2 and Earlier
- Print Gift Receipt
Reprint Receipt NSPOS 2018.2 and Earlier

Follow these steps to reprint a transaction receipt if the purchase was made prior to an upgrade to NSPOS 2019.1.

**Note:** You can only reprint a receipt from the NSPOS register on which the purchase was made.

To reprint a receipt:

1. Tap **Reprint Receipt**.
2. At the **Would you like to print the last receipt?** prompt:
   - Tap **Yes** to print the receipt for the last transaction.
   - Tap **No** to search for a transaction in the **Past Retail Transactions** list. Tap a transaction to print the receipt.

The receipt prints.

Print Gift Receipt

To ease making returns for a gift recipient, you can print a gift receipt for an entire transaction or only selected items from the transaction.

To print a gift receipt:

1. Tap **Print Gift Receipt**. This may appear under **Other Functions**.
2. At the **Would you like to print the last receipt?** prompt:
   - Tap **Yes** to print the receipt for the last transaction.
   - Tap **No** to search for a transaction in the **Past Retail Transactions** list. Tap a transaction to print the receipt.
3. You have the option to print **All Items** from a transaction on the gift receipt or specific items only. After selecting items, tap **Done** to print.

The gift receipt prints.

About the Receipt Transaction Barcode

Each receipt includes a transaction barcode at the bottom. This barcode can be scanned to resume suspended transactions and return items. The details are included here for informational purposes only.

This 32-character code is divided into the following sections:

- 1 — 8 is the Store ID
- 9 — 16 is the Workstation ID
Select Sales Associate

Some business processes require selecting a sales associate for each transaction. This is in addition to signing on to the register to start the business day. Assigning a person to a NetSuite POS transaction is helpful for things like tracking commissions or performing customer-satisfaction surveys. Sales associates are also known as sales representatives in NetSuite.

To select a sales associate for a transaction:

1. Start a sales transaction.
2. Tap **Add Sales Associate**.
3. Search for the sales associate or browse through the list.
4. Select the associate to add. Tap **Done** if the window does not close automatically.
   
   The sales associate displays in the transaction summary at the bottom.

To remove a sales associate from a transaction:

With a sales transaction started and a sales associate assigned:

1. Tap **Remove Sales Associate**.

Sales Orders

This section describes the NetSuite Point of Sale (POS) sales order process and customization options.

NetSuite POS sales orders are a method for helping customers purchase items that are handled differently from your regular shelf items. You can use sales orders to process items held in your warehouse instead of your stores, or sell services such as installations, construction or cleaning. Some retailers use sales orders to provide custom items that are assembled on demand, such as shirts with personalized lettering.

If your store policy allows it, sales orders provide a way for customers to purchase items using one or more partial payments. The total amount due must be received when the order is fulfilled.
Workflow – Open, Select, Order, Pay, Fulfill

Sales Orders in NetSuite ERP

Workflow – Open, Select, Order, Pay, Fulfill

The NetSuite POS sales process occurs over five or more steps, depending on if the customer makes more than one payment.

1. Open Sales Order mode.
2. Select the Customer.
3. Add one or more Items.
4. Accept partial or full payment.
5. Fulfill the order when items are ready.

Sales Orders in NetSuite ERP

NetSuite ERP includes sales order functionality. In standard online mode, orders made at the register upload to NetSuite ERP immediately. Your company can use NetSuite ERP to manage orders received
over the phone, by email or through your website. Changes made in NetSuite ERP replicate down to the registers in your network.

![Sales Order](image)

For information on handling sales orders in NetSuite ERP, see the help topic Sales Orders in the NetSuite Help Center. Log into NetSuite before clicking the link.

**Important:** When working with sales orders in NetSuite ERP, ensure that the Location field is set for the customer's store. In some sales order forms, Location is called the Store field.

### Deleting vs. Closing Sales Orders in ERP

NSPOS does not support deleting a sales order in NetSuite ERP. If you delete a sales order online, it will not synchronize correctly to remove the sales order record from your NSPOS registers. The sales order status that appears on your registers might not be the correct status.

We recommend placing sales orders that should be deleted in **Closed** status. This status will synchronize without issues.

**Important:** Do not delete sales orders in NetSuite ERP. Use a **Closed** status instead.

### “Do not download” sales order option

Applicable to NSPOS 2018.2.x and greater.

You can mark a NetSuite ERP sales order to prevent it from being downloaded to your registers. This option is useful for separating two sides of your business – one for products sold in stores and one for product sales managed online only.

Note that NetSuite ERP-created sales orders normally synchronize to your registers within 15 minutes of saving the form.

### Usage notes:

- To prevent a NetSuite ERP sales order from syncing any of its information to the register, check the **Do Not Download to POS** option before saving the order for the first time.
- If you save a sales order without checking the **Do Not Download to POS** option in NetSuite ERP, and you check the option later, the sales order will show a **Closed** status on your registers.
  
  Having the NetSuite ERP sales order appear as closed prevents a cashier from making changes.
- If a sales order is created on the register, but the option is checked later in NetSuite ERP, the order changes to appear closed on the register.

**To prevent a new sales order from downsyncing to your registers:**

You can select the **Do Not Download to POS** option while creating a sales order to prevent syncing any of the order’s information to your registers.
Important: To prevent a sales order from syncing any of its information to the register, check the option before saving the order for the first time.

1. Log in to NetSuite as an administrator.
2. Go to Transactions > Sales > Enter Sales Orders.
3. Complete the required fields.
4. Click the Custom subtab.
5. Check the Do not download to POS box.

6. Click Save.

Note: For information on the fields required to complete a sales order in NetSuite ERP, see the help topic Creating Sales Orders.

To prevent a cashier from updating an existing sales order on a register:

Follow these steps to prevent any changes to a sales order from the register. The sales order will show a Closed status on your registers. You can continue working the sales order in NetSuite ERP.

1. Log in to NetSuite as an administrator.
2. Go to Transactions > Sales > Enter Sales Orders > List.
3. Locate the desired sales order and click Edit.
4. Click the Custom subtab.
5. Check the Do not download to POS box.

6. Click Save.
“Do not download” customer info option and sales orders

The Customer record in NetSuite ERP includes a **Do not download to POS** option. Checking this box prevents a customer’s information from synchronizing to your registers. All transactions for those customers must be performed online in NetSuite ERP.

Be aware that sales orders automatically download to registers during the regular synchronization process (downsync). Creating a sales order for a customer marked “do not download” could cause the sales order to downsync without the required customer information. The result could be a downsync in error.

Before creating a sales order in NetSuite ERP, you should verify that the “do not download” option is clear on the Customer record.

**Important:** Do not create sales orders in NetSuite ERP for Customer records marked **Do not download to POS**.

For the steps to view and update Customer records, see [Work with Customer Records](#).

**From the Customer record:**

![Customer record screenshot]

About creating custom sales order forms in ERP

NetSuite ERP includes options to create unique sales order record forms that fit your business model. However, changes can affect the functioning of your sales order information on the NSPOS register. For example, invoices and sales order statuses could stop downloading, causing the updates to fall into an undefined condition.

To prevent error conditions, be certain any custom sales order form includes the column **Invoiced** for the Items subtab. For form customization, this field is called **Total to Date**.

The **Total to Date** (Invoiced) field is missing from the **Standard Sales Order – Progress Billing** form. If you use this form, be certain to add the field. Otherwise the orders will not synchronize with NSPOS.

**Offline Mode**

NetSuite POS supports offline mode for managing sales orders. Offline mode ensures that sales associates can manage new orders, make changes to existing orders and receive payments even if the
NetSuite POS/NetSuite ERP connection is temporarily down. After the connection is restored, changes made in offline mode upload to NetSuite ERP with the next synchronization cycle.

Tip: If you do not see an existing sales order, tap Show Offline in the Find window.

Sales Order Processes

The following are common tasks for managing sales order transactions in NetSuite POS. Note that many retailers have button layouts unique to their business, so your Sales Order button may be in a different location on your registers.

- Create a Sales Order
- Add Partial Payment for an existing Sales Order
- Edit Items in a Sales Order
- Fulfill and Invoice some Items in a Sales Order
- Fulfill and Invoice all Items in a Sales Order
- Cancel a Sales Order

Note: Before opening sales order mode, you must complete or suspend any open sales transactions displayed in the journal.

Warning: Do not perform an item Return while creating or updating a sales order. Making Returns during a sales order can result in an error that requires restarting NetSuite POS on the register.

Create a Sales Order

Follow these steps to set up the order. Note that your sales order buttons may be in a different location.

Warning: Do not accept a Gift Card or Gift Certificate as deposit for a sales order. These deposit tenders are not supported by NetSuite ERP. If taken as a deposit, any remaining card or certificate balance will become unusable on NSPOS registers.

To create a sales order:

1. Complete any open sales transactions.
2. Tap Sales Orders.
Your Sales Orders button may be under **Other Functions** or in a custom location.

3. Tap **Sales Order Mode**.

4. Search for the **Customer** by entering any part of their name in the search field.
   - If needed, tap the [ ] icon to open a keyboard.
   - Tap **Create Customer** to add a new customer.

5. Tap the customer **Name**.

6. Tap **Create New** sales order.

7. Locate the **Item** to order. You can scan a barcode or search using **Find Item**.
   
   To search for the item:
   1. Tap **Find Item**.
2. Enter any portion of the item name or ID, or drill into a category.
3. Tap the item **Name**.

![Image of Sales Order Mode](image)

- **Tip:** To go back while drilling into an item list, tap the **Item** icon at the top left.

8. For more than one of the item, tap **Change Quantity**.
9. To add another item, scan a barcode or tap **Find Item**.
10. Shipping orders use the customer address on file. To verify or change the address, tap **Modify Order Ship to Address**.
11. Tap **Amt Due** or **Accept Payment**. This can be the initial deposit or payment in full.

![Image of Sales Order Mode with transaction](image)

12. Tap the payment method.
13. Enter the amount to pay.
   The initial deposit displays in the payment window. You can increase this as needed, up to the full amount due.

14. Tap Done.
15. Enter the payment amount and tap Enter or the green check mark.

16. Accept the payment. If credit or debit card, ask the customer to swipe their card.
17. Give customer their receipt.

Split Tender Payments and Sales Orders

Split tender payments are when a customer uses more than one payment type to tender-out a single transaction. Customers can use any combination of cash, credit cards and debit cards as payment, but it is important that you do not make any changes to the order between accepting payment types.
**Important:** Making changes between accepting the first and subsequent forms of payment can cause the sales order to error. Changes to avoid during payment include adding items, adjusting a price or adding a discount. All changes to the order should occur before taking payment or after the payment is complete.

To accept Split Tender Payments for Sales Order Deposits:

1. Create the sales order.
2. Tap **Amt Due** or **Accept Payment**.
3. Tap the first tender type, such as **Cash**.
4. For **Amount received**, adjust the total amount to be paid (if needed) and tap **Done**. The total payment should be at least the minimum deposit shown, up to the full amount.
5. Enter the first tender amount and tap **Enter** or the green check mark.
6. Tap the second tender method.
7. Enter the second tender amount.
8. Tap and enter additional tenders as needed to complete the deposit.
9. NSPOS prints a receipt when the deposit is paid in full.

Add Partial Payment for an existing Sales Order

If you store allows partial payments, follow these steps to accept a payment that reduces the total amount owed.

**To accept partial payment for a sales order:**

1. Complete any open sales transactions.
2. Tap **Sales Orders**.
   
   Your Sales Orders button may be under **Other Functions** or in a custom location.
3. Tap **Sales Order Mode**.
4. Search for the **Customer** by entering any part of their name in the search field.
5. Tap the customer **Name**. Existing sales orders display.
6. Tap the sales order to pay.
7. Tap **Edit**.
8. Tap **Amt Due** or **Accept Payment**
9. Tap the payment method.
10. Enter the amount to pay.
11. Accept the payment. If credit or debit card, ask the customer to swipe their card.
12. Give customer their receipt.

Edit Items in a Sales Order

Follow these steps to adjust the items in an existing order. You can add items, remove items or change item quantities.

**Warning:** Changing a sales order in the main NetSuite online application while also changing it at a register that is currently offline will cause the order to error.

**To edit items in a sales order:**

1. Complete any open sales transactions.
2. Tap **Sales Orders**.
   
   Your Sales Orders button may be under **Other Functions** or in a custom location.
3. Tap **Sales Order Mode**.
4. Search for the **Customer** by entering any part of their name in the search field.
5. Tap the customer **Name**. Existing sales orders display.

**Note:** You cannot **exchange** one item through a return for another item until the entire sales order is fulfilled.
6. Tap the sales order to edit.
7. Tap **Edit**.
8. Edit the order:
   - To add an item, scan a barcode or tap **Find Item**.
   - To remove an item, tap the item to expand it. Tap **Void Line**.
   - To change the amount of an item, tap the item to expand it. Tap **Change Quantity**.
9. Tap **Save and Exit**.

**Note:** If prompted for additional payment, tap **Amt Due** or **Accept Payment** and process the payment. The minimum amount required displays in the payment window.

Any refund due to the customer displays in parenthesis ( ).

### Fulfill and Invoice some Items in a Sales Order

If some items are ready for pickup before others, you can fulfill and invoice just the available items. The sales order remains open for fulfillment of the remaining items later. Fulfilling includes invoicing for the amount due.

**To fulfill some items:**

1. Complete any open sales transactions.
2. Tap **Sales Orders**.
   
   Your Sales Orders button may be under **Other Functions** or in a custom location.
3. Tap **Sales Order Mode**.
4. Search for the **Customer** by entering any part of their name in the search field.
5. Tap the customer **Name**. Existing sales orders display.
6. Tap the sales order to partially fulfill.
7. Tap **Fulfill**.

**Note:** Your setup might show **Edit** or **Invoice** instead of **Fulfill**. If your business requires fulfillment before you can accept full payment, see **Fulfillment and Invoicing as Separate Tasks**.

8. Tap the first item you do **not** want to fulfill now.
9. Tap **Void Line**.
10. Enter the quantity of the item to temporarily void.
11. Tap **Fulfill Later**.
12. Repeat for any other items to fulfill later.
13. Tap **Amt Due** or **Accept Payment**.
14. Tap the payment method. The minimum amount required displays in the payment window.
15. Enter the amount to pay.
16. Accept the payment. If credit or debit card, ask the customer to swipe their card.
17. Give customer their receipt.
18. Provide fulfilled items to the customer.
**Fulfill and Invoice all Items in a Sales Order**

When the items arrive and the customer is ready to receive the merchandise, follow these steps to fulfill and invoice the order. Fulfilling includes invoicing for the amount due.

**To fulfill all items:**

1. Complete any open sales transactions.
2. Tap **Sales Orders**.
   
   Your Sales Orders button may be under **Other Functions** or in a custom location.
3. Tap **Sales Order Mode**.
4. Search for the **Customer** by entering any part of their name in the search field.
5. Tap the customer **Name**. Existing sales orders display.
6. Tap the sales order to fulfill.
7. Tap **Fulfill**. The payment amount required displays under **Amt Due**.

   **Note:** Your setup might show **Edit or Invoice** instead of **Fulfill**. If your business requires fulfillment before you can accept full payment, see **Fulfillment and Invoicing as Separate Tasks**.

8. Tap **Amt Due** or **Accept Payment**.
9. Tap the payment method.
10. Enter the full amount needed to complete the order.
11. Accept the payment. If credit or debit card, ask the customer to swipe their card.
12. Give customer their receipt.
13. Provide items to the customer.

**Cancel a Sales Order**

You can cancel an entire order if the customer requests the cancellation and the request meets your store policy. This is done by opening the order and voiding each item. The process typically requires refunding money the customer has paid towards the order.

**To cancel a sales order:**

1. Complete any open sales transactions.
2. Tap **Sales Orders**.
   
   Your Sales Orders button may be under **Other Functions** or in a custom location.
3. Tap **Sales Order Mode**.
4. Search for the **Customer** by entering any part of their name in the search field.
5. Tap the customer **Name**. Existing sales orders display.
6. Tap the sales order to cancel.
7. Tap **Edit**.

**Note:** You cannot exchange one item through a return for another item until the entire sales order is fulfilled.
8. Tap to expand the first item to void.
9. Tap **Void Line**.
10. Enter the item quantity to void.
11. Tap **Cancel**.
12. Tap the next item, click **Void Line** and **Cancel**.
13. If the **Amt Due** shows an amount in parenthesis, refund the customer their deposit. For example, $(9.99).

Customize Sales Order Processes – Setting Flags

This topic lists options to control the actions a sales associate (cashier) can take at the register for NSPOS sales orders.

- **Disable Editing Sales Orders from the Register**
- **Disable or restrict Sales Order Invoicing from the Register**
- **Require Fulfillment before Invoicing and split the two tasks**
- **Other Sales Order Flags**
- **How Sales Order Flags interact**

**Disable Editing Sales Orders from the Register**

Flag: **Disable Edit**

NSPOS includes the option to disable editing sales order items from the register. If checked, sales associates can create sales orders and take payment, but all edits must be performed in NetSuite. This is useful for when sales order item-handling is performed away from the store, such as in a warehouse.

To restrict editing from the register, check the sales order flag option: **Disable Edit**, making it true. The flag is set to false by default.

⚠️ **Important:** Disabling Edit will also disable the ability for customers to pay additional deposits.

To restrict **Sales Order Editing**

1. Sign in to any NetSuite POS register as an administrator.
2. Press **Ctrl+F10** to open **Universal Settings**.
3. Enter **Sales Order** in the search field.
4. Check the Sales Order box **Disable Edit**.
5. Tap Done.
6. Tap Sign Off and then tap Exit.
7. Restart NetSuite POS. Changes will replicate to the other registers on your network.

To set up the fulfillment button, see Customize the User Interface and Security in NSPOS.

Disable or restrict Sales Order Invoicing from the Register

Flag: Disable Invoice

You can control whether sales associates and other personnel can invoice sales orders at the register. This is helpful for special processes, such as when:

- Your customers have a number of days to cancel without penalty. When during fulfillment, orders move to a vendor or third party for supplies or completion. It is important that sales associates do not accidentally invoice orders as fulfilled too early.
  - Although NetSuite POS does not offer automated time-based fulfillment, the restriction limits invoicing to authorized users.
- Policy requires verifying on-hand or warehouse inventory before fulfilling and invoicing sales orders.

Restricting the ability to invoice a sales order is generally used in combination with setups that Require Fulfillment before Invoicing and split the two tasks.

You set sales order invoice control by checking the Sales Order flag: Disable Invoice. For sales associates attempting to invoice an order at the register:

- If checked, associates see a message that invoicing is not allowed. Associate can exit the message or click OK to make edits to the sales order as needed.
- If not checked, associates can invoice sales orders as usual. This is the default behavior.

For your internal procedures, enabling the flag means authorized users can invoice sales orders through NetSuite ERP only. However, we can optionally set up customizations that allow managers with Operator 700 (Resource ID 9070) roles or greater to invoice orders at the register.

To restrict Sales Order Invoicing:

1. Sign in to any NetSuite POS register as an administrator.
2. Press Ctrl+F10 to open Universal Settings.
3. Enter Sales Order in the search field.
4. Check the Sales Order box Disable Invoice.
5. Tap Done.
6. Tap Sign Off and then tap Exit.
7. Restart NetSuite POS. Changes will replicate to the other registers on your network.
Require Fulfillment before Invoicing and split the two tasks

Flag: Invoice Unfulfilled Items

Traditionally, cashiers can invoice and take payment for all items in a sales order, even if some items are not immediately available for fulfillment. However, NSPOS includes the option to restrict invoicing to fulfilled items only. In sales orders with multiple items, the cashier can invoice the fulfilled items, but the order remains open until all items are fulfilled. An initial deposit is still required to open the order.

Requiring fulfillment before invoicing is useful for deliveries, where some localities prohibit invoicing until the order has shipped. It also reduces the chance of having to refund an invoice because the materials required to fulfill the order are not on hand.

In addition, you can use the flag and create a custom button to split fulfillment and invoicing into separate tasks. This option can meet the needs of large-volume retailers that need this separation for their accounting practices. It assists with off-site fulfillment, where the order is placed in the store but fulfilled at the warehouse.

If you restrict fulfillment to your managers or back office, you can prevent cashiers from fulfilling and invoicing items too soon. For example, if a shopper has three days to cancel an order for a custom-built item, you might wait to fulfill the order until the cancellation period has passed.

To require Fulfillment before Invoicing

To require that each item be fulfilled before the cashier can invoice it, clear the Sales Order flag check box: Invoice Unfulfilled Items, making it false. The flag is set to checked or true by default.

Create a Button to separate Fulfillment and Invoicing at the Register

To separate fulfillment and invoicing at the register, you can set up a new button dedicated to Sales Order Fulfillment. Tapping the button places the journal in Fulfillment Mode.

- Sales associates (cashiers) will tap Sales Orders > Sales Order Fulfillment to open an existing sales order and fulfill the items.
- Then the cashier goes to Sales Orders > Sales Order Mode for invoicing.
- When invoicing for payment, the journal will only display the fulfilled items.
- To fulfill a subset of items (partial fulfillment), the cashier can tap Void Line for items not ready to fulfill and then fulfill the remaining items. Any items removed will display the next time the cashier taps the fulfillment button.

Note: If all fulfillment occurs at a warehouse or other facility using NetSuite ERP only, it is not necessary to set up a fulfillment button on NSPOS registers.

Map the button to the Message: SalesOrderFulfillment.Mode.
If desired, use the **Resource ID** to limit the roles that can perform fulfillment. For example, you can limit fulfillment at the register to the manager role by entering the number *9070*.

<table>
<thead>
<tr>
<th>Operator Role / Group</th>
<th>Operator Role / Group ID</th>
<th>Resource ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Associate, Cashier, xPOS Access</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>Specialist</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>Opener / Closer</td>
<td>500</td>
<td>9050</td>
</tr>
<tr>
<td>Manager</td>
<td>700</td>
<td>9070</td>
</tr>
<tr>
<td>System Administrator</td>
<td>900</td>
<td>9090</td>
</tr>
</tbody>
</table>

**Other Sales Order Flags**

- **Advanced Shipping** – This setting is not valid for NSPOS 2016.1 or later. It has no effect.

NSPOS includes other sales order flags that are not common or are no longer valid.
No Auto Complete When Fulfilling – Prevents automatically finalizing a transaction when fulfilling.

Offline Mode – Turn off the real-time connection to NetSuite ERP that communicates sales order updates. If offline mode is checked, sales order updates wait for the next synchronization (upsync) cycle. Can be used as a workaround for bandwidth issues by maintaining all sales orders local to the register. However, this setting can lead to synchronization issues and other errors. **We do not recommend using this setting.**

How Sales Order Flags interact

The different customization flags for sales orders can interact in different ways depending on what flags are enabled or disabled. The following tables list the results from different combinations of these three flags. They list what actions the cashier can perform from the register and what the cashier sees when opening a sales order.

<table>
<thead>
<tr>
<th>Flags Checked and Results</th>
<th>Journal display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Edit</td>
<td>These settings are the default.</td>
</tr>
<tr>
<td>Disable Invoice</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>Invoice Unfulfilled Items</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>Cashier can:</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>■ Edit sales orders</td>
<td>Cashier can invoice both fulfilled and unfilled items.</td>
</tr>
<tr>
<td>■ Invoice sales orders</td>
<td>Editing cannot be performed from the register. Disabling Edit will also disable the ability for customers to pay additional deposits.</td>
</tr>
<tr>
<td>■ Invoice unfilled items</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Cashier can:
- Invoice sales orders
- Invoice unfilled items

Cashier cannot:
- Edit sales orders

Cashier can only edit sales orders. No invoicing can be performed from the register.

Cashier can:
- Edit sales orders

Cashier cannot:
- Invoice sales orders
- Invoice unfilled items

Because both editing and invoicing are disabled, cashier cannot perform any actions on sales orders from the register except for fulfilling items.

Fulfill items if a Sales Order Fulfillment button is set up for split fulfillment and invoicing.
- Invoice fulfilled or unfulfilled items

- Disable Edit
- Disable Invoice
- Invoice Unfulfilled Items

---

Cashier can:
- Edit sales orders
- Invoice fulfilled items

Cashier cannot:
- Invoice unfilled items

---

Cashier can edit, but only invoice fulfilled items.

If cashier taps **Invoice** on a sales order that does not contain unfilled items, NSPOS displays:
Cashier can invoice fulfilled items only. No editing can be performed from the register. Disabling Edit will also disable the ability for customers to pay additional deposits.

If cashier taps Yes on a sales order that does not contain unfilled items, NSPOS displays:

You do not have permissions to edit Sales Orders. Do you want to invoice?
Sales Orders

- Disable Edit
- Disable Invoice
- Invoice Unfulfilled Items

Cashier can:
- No cashier actions on open sales orders except fulfill items.

Cashier cannot:
- Edit sales orders
- Invoice sales orders
- Invoice unfilled items

Because both editing and invoicing are disabled, cashier cannot update the order or take payments perform actions on sales orders from the register. However, if the custom fulfillment button was set up, the cashier can fulfill sales order items.

Using Customized Sales Order Processes

Your company policies might set restrictions or have procedures on what actions can be performed at the register.

- Restrict Editing
- Require Fulfillment before Invoicing
- Fulfillment and Invoicing as Separate Tasks

Restrict Editing

Your company can disable the register option to edit which items are included in a sales order. If disabled, associates can create sales orders and take payment, but all edits must be performed in NetSuite ERP. This is useful for when sales order item-handling is performed away from the store, such as in a warehouse.

Require Fulfillment before Invoicing

Traditionally, cashiers can invoice and take payment for all items in a sales order, even if some items are not immediately available for fulfillment. However, NSPOS includes the option to restrict invoicing to fulfilled items only. In sales orders with multiple items, the cashier can invoice the fulfilled items, but the order remains open until all items are fulfilled. An initial deposit is still required to open the order.

Requiring fulfillment before invoicing is useful for deliveries, where some localities prohibit invoicing until the order has shipped. It also reduces the chance of having to refund an invoice because the materials required to fulfill the order are not on hand.
Fulfillment and Invoicing as Separate Tasks

In addition to requiring fulfillment before invoicing, retailers can split the fulfillment and invoicing process into separate tasks. Fulfillment is performed using a custom button called Sales Order Fulfillment or something similar. This method is typically used when orders are placed in the store but fulfilled at a warehouse, requiring confirmation that the item is ready before fulfilling it. Often, the fulfillment button will be restricted to manager roles and above.

Some businesses might restrict the fulfillment button to headquarters or the back office. This prevents fulfilling items too soon, such as when a shopper has three days to cancel an order for a custom-built item. Your business will wait to fulfill the order until the cancellation period has passed.

One option is to not set up a button on an NSPOS register. Instead, fulfillment happens by logging in to NetSuite ERP and going to Transactions > Sales > Enter Sales Orders > List > View.

For information on handling sales orders in NetSuite ERP, see the help topic Sales Orders in the NetSuite Help Center. Log into NetSuite before clicking the link.

**Note:** If all fulfillment is performed at a warehouse or other facility using NetSuite ERP only, it is not necessary for the administrator to set up a fulfillment button on NSPOS registers.

Using the Sales Order Fulfillment button requires different processes for completing sales orders. These tasks are described in the following steps.

Considerations when Fulfillment is separate from Invoicing

- Fulfillment mode does not display prices.
- You cannot edit fulfillment items at the register. Editing must be performed in NetSuite ERP.
- You can change fulfillment quantities at the register by tapping the Change Quantity button.
- You can only Invoice full payment for fulfilled items.
- To accept additional deposit payments, tap Edit, not Invoice. Your customers have the option to pay the full amount when requesting a new sales order.

**To fulfill all items using Sales Order Fulfillment:**

1. Complete any open sales transactions.
2. Tap Sales Orders.
   - Your Sales Orders button may be under Other Functions or in a custom location.
3. Tap the custom button **Sales Order Fulfillment**. Your setup might use a different name for this button.

4. Search for the **Customer** by entering any part of their name in the search field.

5. Tap the customer **Name**. Existing sales orders display.

6. Tap the **Sales Order** to fulfill.

7. Tap **Amt Due** or **Accept Payment**.

   **Important:** The amount will show $0.00 due. No money will be taken during fulfillment. No payment record will be created in NetSuite ERP.

8. Tap **Cash**.

9. Leave the amount as $0.00 and tap **Enter**.

   The order is fulfilled and can be invoiced using the next set of steps. A confirmation receipt prints.

**To invoice a sales order after fulfillment:**

1. Complete any open sales transactions.

2. Tap **Sales Orders**.

   Your Sales Orders button may be under **Other Functions** or in a custom location.

3. Tap **Sales Order Mode**.

4. Search for the **Customer** by entering any part of their name in the search field.

5. Tap the customer **Name**. Existing sales orders display.

6. Tap the **Sales Order** to invoice.

7. Tap the payment method.

8. Enter the full amount needed to complete the order.

9. Accept the payment. If credit or debit card, ask the customer to swipe their card.

10. Give customer their receipt.

**To partially fulfill and invoice:**

You can fulfill and take payment for a subset of items in a sales order. First fulfill the desired items and then invoice them.

1. Complete any open sales transactions.

   **Fulfill Partial Items**

2. Tap **Sales Orders**.

   Your Sales Orders button may be under **Other Functions** or in a custom location.

3. Tap the custom button **Sales Order Fulfillment**. Your setup might use a different name for this button.

4. Search for the **Customer** by entering any part of their name in the search field.

5. Tap the customer **Name**. Existing sales orders display.

6. Tap the **Sales Order** to fulfill.

7. Select the items that are not ready to be fulfilled and tap **Void Line**.
Voided items will display the next time you open the order. They are not deleted. In this example we are fulfilling the **Hat – Winter** item only.

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Unit Price</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gloves – Driving</td>
<td>0</td>
<td>$25.99</td>
<td>$0.00</td>
</tr>
<tr>
<td>SCARF</td>
<td>0</td>
<td>$15.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

8. Tap **Amt Due** or **Accept Payment**.

![Important: The amount will show $0.00 due. No money will be taken during fulfillment. No payment record will be created in NetSuite ERP.]

9. Tap **Cash**.
10. Leave the amount as $0.00 and tap **Enter**.

The subset of items are fulfilled and can be invoiced.

### Invoice Partial Items

11. Tap **Sales Orders**.
12. Tap **Sales Order Mode**.
13. Search for the **Customer** by entering any part of their name in the search field.
14. Tap the customer **Name**. Existing sales orders display.
15. Tap the **Sales Order** to invoice.
16. You are prompted to invoice the partial fulfillment. Tap **Yes**.

17. Tap **Amt Due** or **Accept Payment**.
18. Tap the payment method.
19. Enter the amount paid.
20. Accept the payment. If credit or debit card, ask the customer to swipe their card.

### Promotions

Use this chapter to learn about and work with NetSuite Point of Sale (NSPOS) promotions.
Overview

Retailers use promotions to increase in-store visits, improve customer awareness and loyalty, and to move merchandise out of the warehouse and off the shelves, usually in collaboration with item vendors. With NetSuite POS, you can quickly create various types of promotions using NetSuite discount item and promotion records.

Promotions range from basic price markdowns, discounts on transaction totals, and complex buy one, get one or mix and match offers. You can analyze the sales generated from promotions in NetSuite, both while the promotion is running and when it has finished.

Promotion Parameters

Promotions use the following parameters:

- Effective and expiration dates
- Specific locations, all locations or excluded locations
- Specific customers, all customers, excluded customers, customer categories
- Specific items, all items, excluded items or item classes
- Type and amount of discount
- Purchase conditions required to receive the discount

Optional parameters you can use are:

- Repeatability options that let customers receive discounts multiple times or once per customer
- First only promotions for new customers where they receive the discount one time on their first NSPOS purchase transaction.
- Amount spend minimum to qualify for a discount
- Stacking rules that group promotions to manage how they interact with other promotions
- Multiple-use or single-use coupon codes

**Discount Types**

Each promotion is based on at least one the following discount types:

- **Percent Off** – A basic discount, where you specify what percent of the original price will be discounted.
- **Amount Off** – A basic discount, where you specify by how much the original price will be discounted.
- **New Price** – A basic discount based on repricing, where you specify a temporary reduced item price.
- **Transaction Discount** – A discount that takes an amount or percent off the transaction total, before taxes. The discount is calculated by applying the amount or percent off to each item. For example, a 10% transaction discount applies 10% off of each item’s price.
- **Buy One, Get One (BOGO)** – A complex discount, where a customer buys a specific quantity of an item to receive another of that item or a different item – either free or at a reduced price.
- **Mix and Match** – A complex discount where you specify how many units from a set of items the customer must purchase to activate the promotion. The customer can choose exactly which of the specified items and in what proportions they will buy. For example, if you specify that 5 units from a set of items A, B and C must be purchased, then the customer can purchase 5 of item A, or 3 from item A and 2 from item B, and so on.

**Creating a Promotion**

Use this topic to create a promotion in NetSuite Point of Sale (NSPOS). You can also use the topic as a guide to updating an existing promotion.

Creating a promotion involves the following steps:

1. **Determine the conditions** you want your promotion to have, including type of discount, dates when it will be effective, which locations will offer it, and what items will be included. Ensure that all items included in your promotion are added to NetSuite as NetSuite item records before continuing.

2. **Verify a Discount Item is in place** to use with the promotion. A Discount Item selection is required for setting up a promotion. It is used to track sales generated for a promotion.

3. **Create the Promotion Record**. NetSuite POS promotion records are called RA-Promotion custom records. In this record you assign all the conditions and items you want to include.

4. **Allow time for the Promotion Record to synchronize** with NetSuite POS registers. This takes approximately 15 minutes. After syncing, your promotion becomes available to all POS registers at the locations you specified.
Warning: We do not recommend doing mass record updates during business hours. Creating or importing large numbers of promotions or other records at once can impact the synchronization process at your registers. See Benchmarks for Data Transfers and System Limits.

- Review or Create a Discount Item
- Create an Advanced Promotion Record

Review or Create a Discount Item

Discount items in NetSuite Point of Sale (NSPOS) are used to map promotion discounts for accounting purposes. They provide methods for managing your accounting and tracking needs, including:

- How the discount affects sales tax.
- Where the discount line item should post.

For example, a Discount Item named Percent Off 20% is set up and selected for a promotion. If the promotion using this Discount Item is Promotion Type % Off and the % Off is set to 20, an item marked at $50 will sell for $40 during the promotion period. The promotion sales invoice flows into NetSuite as two line items – the original price of $50 and a discount line showing $10. Your Accounting team can determine how to apply each of these line items.

You must select a Discount Item when you create a promotion. Discount Items typically match the discount offered in a promotion, such as:

- Amount Off
- Percent Off
- Price Override
- Transaction Amount Off
- Transaction Percent Off

Discount items are reusable, and include:

- An Item Name/Number that is easily identified for adding to new promotions, filtering in reports and using in searches.
- A Reduction Type, such as Amount Off, listing how the discount is applied.
- The Rate or discount amount to be applied, such as $2.00 off. When used with RA-Promotion custom records for NetSuite POS, the discount item Rate is informational only.

It is not necessary to set a Discount Item for each amount off or percent off amount you may need. If your Accounting team does not require detailed naming for discount line items, you can use one of the default Discount Items with a rate of 0.00. The promotion parameters set the actual discount amount.

**Note:** Discount Item records are not inventory Item records. Note also that the Do not allow discount choice on inventory Item records has no effect on NSPOS promotions.

To review current Discount Item records:

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Accounting > Items.
3. Review the list for a Discount Item that meets your needs, such as Amount Off or Percent Off.
4. If a Discount Item matching the discount type needed for your promotion does not exist, follow the next steps to create it.
You can reuse Discount Items in other promotions.

**To create a new Discount Item record:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Accounting > Items > New.
3. Click Discount.
4. In the Item Name/Number field, enter a descriptive name. You will see this name as a discount line in transaction records generated from the discount in NetSuite. You will also select this when creating the promotion record.
   
   For example, if you are creating a summer promotion with a 10% off discount, you can name the discount **Summer Sale 10% Off**.
5. Enter the discount Rate to be applied. The rate can be either a percentage or dollar amount. A percentage discount must be followed by a % sign. A dollar amount should be entered as a positive number.
   
   For example, enter 10% for a Percent Off the regular price, **5.00** for an Amount Off. For a Price Override, set the Rate at **0.00**.

   ![Discount Item Record](image)

6. Under RA Custom Fields, for Reduction Type, select the type of discount to apply:
   - **Amount Off** to apply a flat discount.
   - **Percent Off** to discount the item price by a percent.
   - **Price Override** to replace a current price with a new price.

   **Note:** If you are creating a complex promotion (BOGO or Mix and Match), select the discount type to apply to the bonus item.

   **Example 1:** If the promotion is buy one, get one at 50% off, then select **Percent Off** because the bonus item is discounted by a percent.

   **Example 2:** If the promotion is buy two and receive a third at a reduced price of $10, select **Price Override** because the bonus item will be set to $10.00 no matter what its current price is.

   - **Transaction Amount Off** to apply a flat discount to the transaction total.
   - **Transaction Percent Off** to discount the transaction total by a percent.
7. On the Accounting subtab, under Accounts, select Non-posting if you want this discount to be non-posting.

Or, select Account and choose the account to which you want the discount to post.

Note: Accounting settings for discounts triggered by a promotion may be very important to your company. If you are unsure how to proceed, see the help topic Discount Items online in NetSuite and consult your accounting department before assigning these values.

8. Select the Tax Schedule to apply to this discount. Check the Apply Before Sales Tax option if applicable.

Important: How discounts modify the calculation of sales tax collected is very important. If you are not sure how to proceed, see the help topic Applying Sales Tax or VAT to Discount Items in the NetSuite Help and consult your accounting department before assigning these values.

9. Click Save.

The steps above describe setting up Discount Items for use with NetSuite POS Promotions. For more information about Discount Items and their impact on transactions – including the other optional fields on this screen – see the help topic Discount Items in the NetSuite Help.

Create an Advanced Promotion Record

To create a promotion in NetSuite Point of Sale (NSPOS), you must first have the Discount Item in place. Then you can set up the actual promotion.

NSPOS can apply multiple promotions to a single sales transaction. Promotions are stackable both on the transaction and the item level. The ability to stack means you can have more than one promotion applied to a single item and multiple promotions applied to the whole transaction. See Use Stacking Rules for Promotion Interactions.

The register actively analyzes items and quantities while the cashier rings up the customer’s purchase. As the transaction progresses, NSPOS may replace one promotion already applied with a different promotion that brings the customer a larger discount.

You can set up basic item, transaction discount, amount spend and BOGO or Mix and Match promotions.
Basic item promotions apply a discount directly to the quantity and item being purchased.
Transaction discount promotions apply the discount to the transaction total.
Amount spend promotions where a minimum purchase is required to receive the discount.
Buy one, get one (BOGO) or mix and match promotions provide discounts by purchasing a combination of items.

It is important to understand how NetSuite designates which items must be purchased by the customer and which items are then discounted or provided to the customer for fulfilling the promotion conditions.

- Items used to fulfill promotion requirements are **Trigger** items.
- Discounted or free items are **Reward** items.
- When an item is purchased and then a second of the same item is discounted, the item is flagged as both a **Trigger** and **Reward** item.

Go to the following for steps on creating each type of promotion.

- **Basic Item Promotions – Advanced Form**
- **Transaction Discount Promotions – Advanced Form**
- **Amount Spend Promotions – Advanced Form**
- **BOGO or Mix and Match Promotions – Advanced Form**

### Promotion Item Records

NetSuite creates a custom RA-PromotionItem record each time an item is added to an RA-Promotion record. Each record contains the Trigger, Reward, and override price settings you assigned to that item when adding it to the promotion record. When adding items to a new promotion, you can use these existing records or add an item and create its settings manually.

RA-PromotionItem custom records are available at Customization > Lists, Records & Fields > Record Types.

### Basic Item Promotions – Advanced Form

Follow these steps to create a basic promotion where a discount applies to one or more items.

**To create a Basic Item Promotion Record:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the **RA-Promotion** record row and click **List**.
4. Open the promotion record.
   - For a new promotion, click **New RA-Promotion**.
   - To update an existing promotion, locate the promotion and click **Edit**.
5. For **Custom Form**, select **Advanced Promotion Form**.
6. Enter a descriptive **Name**. This name appears in the NetSuite POS Journal line entry and on customer receipts.

   **Note:** Leave the **Inactive** box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

7. Select the **Discount Item** to use with the promotion.
8. Enter the **Effective Date** for the promotion to begin. The promotion starts at 00:00 on the selected date.
9. Enter the **Expiration Date** for the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active on that day.

**Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location's time zone.

**Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

10. In the **Promotion Type** field, select the discount type that will apply to the promoted items.
    - % Off – To discount by a percent.
    - $ Off – To apply a flat discount.
    - New Price – To replace the Reward item price with a new price.

**Note:** When you select a **Promotion Type**, some fields are dimmed. This is because they are no longer applicable to the promotion.

11. Leave the **Mix and Match** check box empty for these basic steps.
    For the steps to use these fields, see BOGO or Mix and Match Promotions – Advanced Form.

12. In the **Buy** field, enter the item quantity that must be purchased as a minimum condition to receive the discount.
    Because this is a basic promotion, you will normally enter 1.

13. If you want to limit the discounts to receive, enter the number in the **Get** field.
    For example, if the discount is on hats, and you only want them to receive the Reward discount on one item, enter 1.

14. Enter the discount amount. Fields not applicable to your discount type are dimmed.
    - % Off – Enter the percent amount that the item will be discounted. NetSuite adds the percent sign automatically.
    - $ Off – Enter a flat amount the item will be discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.
    - New Price – Enter the sale price at which the item will be sold. Do not enter a currency symbol.
    The price is universally applied to all items selected for the promotion unless a different override price is entered on the **Specific Items** subtab in a later step.

15. Leave **Apply to Transaction** empty for basic item promotions. The option applies the discount to the transaction total instead of individual items.
16. For a basic item promotion, leave the **Amount Spend** empty. This is the minimum purchase amount required to receive the discount. It will remove the **Buy quantity** requirement set for the items. See [Amount Spend Promotions – Advanced Form](#) if you want to include this requirement.

17. Select whether the promotion can **Repeat** for customers during the promotion period.
   - **Once** – Each customer can receive the discount one time.
   - **Multiple** – Each customer can receive the discount as often as desired.
   - **First** – New customer incentive. Customers can receive the discount one time only on the first transaction they make through an NSPOS register.
     
     Cashiers can add the customer at the time of purchase or you can preload your customers through an import. The trigger is whether a transaction attached to that customer exists in the NetSuite ERP database.

   ![Note:](#) Purchases made through other applications that log transactions to NetSuite ERP will cause a customer to be ineligible for a “first” NSPOS promotion.

18. Click the **Locations** subtab and select the locations.

   ![Locations](#)

   - **To select specific locations:** Select from the **Location** list.
   - **To include all locations:** Check the **All Locations** box.
   - **To exclude specific locations:** Check **Exclude Locations** and choose which to exclude from the **Locations** list.

19. Click the **Customers** subtab and select the customers to include.

   - **To include specific customers:**
     1. In the **Customer** field, select **List** or **Search**, or begin entering the first Customer you want to add to this promotion.
     2. If using a list or search, select the customer.
     3. Click **Add**.
     4. Repeat as desired.
   - **To include all customers:** Check the **All Customers** box.
   - **To include specific customer categories:** Select from the **Customer Category** list.
   - **To exclude specific customers:**
     1. Check the **Exclude Customers** box.
     2. In the **Customer** field, select **List** or **Search**, or begin entering the first customer you want to exclude from this promotion.
3. If using search or a list, select the customer.
4. Click Add.
5. Repeat as desired.

■ To exclude a customer category:
1. Check the Exclude Customers box.
2. Select one or more from the Customer Category list.

20. Click the Specific Items subtab and select the items. You can select specific items, include the discount on all items, or exclude items by their item class.

To include specific items:
1. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

   ![Specific Items screenshot]

   **Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

2. For a basic item promotion, leave Trigger and Reward fields set to Yes.
3. If this is a New Price promotion, and you want this item to have a different override price than the default new price set above, enter it in the Override Price field. This item-specific override price can be higher or lower than the promotion's default New Price value.
4. Click Add.
5. Repeat the Specific Items steps for each item you want to include in the promotion.

To include all items: Check the All Items box.

To exclude specific items:
1. Check the Exclude Items box.
2. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

   ![Specific Items screenshot]

   **Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

3. Ignore the Trigger and Reward and other fields.
4. Click Add.

To exclude items by item class:
1. Check the **Exclude Items** box.
2. Select one or more from the **Item Class** list to exclude from the promotion.

21. Optionally add coupon codes to the promotion from the **Coupons** subtab. See **Work with Coupon Codes**.

22. Optionally select a specific Stacking Rule from the **Stacking Rules** subtab.
   - Promotions are automatically assigned to the default Stacking Rule. Use the **Stacking Rule** list to select a different rule as desired. For more information, see **Use Stacking Rules for Promotion Interactions**.
   - Stacking Rules can include exclusions to prevent other promotions from combining to create too large of a discounts. However, you can override or add to the assigned rule for this specific promotion.
     - **Explicitly Excluded**: To exclude a promotion from combining with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.
     - **Explicitly Included**: To include a promotion with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.

23. Optionally select the **Notes** subtab and add comments about the promotion.

24. Optionally select the **Files** subtab and attach files to the promotion record. This is useful for keeping your advertising copy or planning documents with the promotion record.

25. The **Workflow** subtab is not used with NSPOS promotions.

26. **Click Save**.

### Transaction Discount Promotions – Advanced Form

Follow these steps to create a promotion where the discount is applied to the total transaction amount.

#### To create a Transaction Discount Promotion Record:

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the **RA-Promotion** record row and click **List**.
4. Open the promotion record.
   - For a new promotion, click **New RA-Promotion**.
   - To update an existing promotion, locate the promotion and click **Edit**.
5. For **Custom Form**, select **Advanced Promotion Form**.
6. Enter a descriptive **Name**. This name appears in the NetSuite POS Journal line entry and on customer receipts.

   **Note**: Leave the **Inactive** box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

7. Select the **Discount Item** to use with the promotion.
8. Enter the **Effective Date** for the promotion to begin. The promotion starts at 00:00 on the selected date.
9. Enter the **Expiration Date** for the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active on that day.

**Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location's time zone.

**Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

10. In the **Promotion Type** field, select the discount type apply to the transaction.
   - % Off – To discount by a percent.
   - $ Off – To apply a flat discount.
   - New Price – This option is not used with transaction discounts.

**Note:** When you select a **Promotion Type**, some fields are dimmed. This is because they are no longer applicable to the promotion.

11. Leave the **Mix and Match** check box empty for these basic steps. For the steps to use these fields, see BOGO or Mix and Match Promotions – Advanced Form.

12. In the **Buy** field, enter the item quantity that must be purchased as a minimum condition to receive the discount.

13. Leave the **Get** field empty.

14. Enter the discount amount. Fields not applicable to your discount type are dimmed.
   - % Off – Enter the percent amount that the transaction will be discounted. NetSuite adds the percent sign automatically.
   - $ Off – Enter a flat amount the transaction will be discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.
   - New Price – This option is not used with transaction discounts.

15. To apply the discount against the total transaction, check **Apply to Transaction**.

16. For a transaction discount item promotion, leave the **Amount Spend** empty. This is the minimum purchase amount required to receive a discount. It will remove the **Buy** quantity requirement set for the items. See Amount Spend Promotions – Advanced Form if you want to include this requirement.

17. Select whether the promotion can **Repeat** for customers during the promotion period.
- **Once** – Each customer can receive the discount one time.
- **Multiple** – Each customer can receive the discount as often as desired.
- **First** – New customer incentive. Customers can receive the discount one time only on the first transaction they make through an NSPOS register.

Cashiers can add the customer at the time of purchase or you can preload your customers through an import. The trigger is whether a transaction attached to that customer exists in the NetSuite ERP database.

**Note:** Purchases made through other applications that log transactions to NetSuite ERP will cause a customer to be ineligible for a “first” NSPOS promotion.

18. Click the **Locations** subtab and select the locations.

![Locations subtab](image)

- **To select specific locations:** Select from the **Location** list.
- **To include all locations:** Check the **All Locations** box.
- **To exclude specific locations:** Check **Exclude Locations** and choose which to exclude from the **Locations** list.

19. Click the **Customers** subtab and select the customers to include.

![Customers subtab](image)

- **To include specific customers:**
  1. In the **Customer** field, select **List** or **Search**, or begin entering the first Customer you want to add to this promotion.
2. If using a list or search, select the customer.
3. Click Add.
4. Repeat as desired.

- **To include all customers:** Check the All Customers box.
- **To include specific customer categories:** Select from the Customer Category list.
- **To exclude specific customers:**
  1. Check the Exclude Customers box.
  2. In the Customer field, select List or Search, or begin entering the first customer you want to exclude from this promotion.
  3. If using search or a list, select the customer.
  4. Click Add.
  5. Repeat as desired.
- **To exclude a customer category:**
  1. Check the Exclude Customers box.
  2. Select one or more from the Customer Category list.

20. If desired, click the Specific Items subtab and select the items. You can select specific items, include the discount on all items, or exclude items by their item class.

This subtab applies only if you want to make the purchase of specific items a requirement to receive the transaction discount.

**Note:** It is not necessary to require the purchase of specific items for a transaction discount promotion.

To include specific items:
1. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

**Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

2. To be included in a transaction discount promotion, individual items must be flagged as Yes in the Trigger field. The Reward setting is ignored because the reward is the transaction discount.
3. Click Add.
4. Repeat the Specific Items steps for each item you want to include in the promotion.

To include all items: Check the All Items box.

To exclude specific items:
1. Check the Exclude Items box.
2. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

**Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

3. Ignore the Trigger and Reward and other fields.
4. Click Add.
To exclude items by item class:

1. Check the Exclude Items box.
2. Select one or more from the Item Class list to exclude from the promotion.

1. Optionally add coupon codes to the promotion from the Coupons subtab. See Work with Coupon Codes.

**Note:** These coupon codes are specific to NSPOS. They are not the coupons available through NetSuite ERP.

22. Optionally select a specific Stacking Rule from the Stacking Rules subtab.

- Promotions are automatically assigned to the default Stacking Rule. Use the Stacking Rule list to select a different rule as desired. For more information, see Use Stacking Rules for Promotion Interactions.
- Stacking Rules can include exclusions to prevent other promotions from combining to create too large of a discounts. However, you can override or add to the assigned rule for this specific promotion.
  - **Explicitly Excluded:** To exclude a promotion from combining with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.
  - **Explicitly Included:** To include a promotion with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.

23. Optionally select the Notes subtab and add comments about the promotion.

24. Optionally select the Files subtab and attach files to the promotion record. This is useful for keeping your advertising copy or planning documents with the promotion record.

25. The Workflow subtab is not used with NSPOS promotions.

26. Click Save.

### Amount Spend Promotions – Advanced Form

Follow these steps to create a promotion where customers must spend a minimum amount to receive a discount. You can specify that the purchase applies to specific items or it can apply any item purchase.

#### To create a Amount Spend Promotion Record:

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Promotion record row and click List.
4. Open the promotion record.
   - For a new promotion, click New RA-Promotion.
   - To update an existing promotion, locate the promotion and click Edit.
5. For Custom Form, select Advanced Promotion Form.
6. Enter a descriptive Name. This name appears in the NetSuite POS Journal line entry and on customer receipts.

**Note:** Leave the Inactive box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

7. Select the Discount Item to use with the promotion.
8. Enter the **Effective Date** for the promotion to begin. The promotion starts at 00:00 on the selected date.

9. Enter the **Expiration Date** for the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active on that day.

   **Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location’s time zone.

   **Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

10. In the **Promotion Type** field, select the type of discount the customer will receive.
    - **% Off** – To discount by a percent.
    - **$ Off** – To apply a flat discount.
    - **New Price** – To replace a Reward item price with a new price.

    **Note:** When you select a **Promotion Type**, some fields are dimmed. This is because they are no longer applicable to the promotion.

11. Leave the **Mix and Match** check box empty for these basic steps.
    For the steps to use these fields, see **BOGO or Mix and Match Promotions – Advanced Form**.

12. Leave the **Buy** field at 0.
    Amount spend promotions do not require that the customer purchase a specific quantity of items.

13. If you want to limit the discounts to receive, enter the number in the **Get** field.
    For example, if the discount is on hats, and you only want them to receive the reward discount on one item, enter 1.

    **Important:** Leaving the **Get** field empty allows the discount to apply to multiples of the same Reward item. For example, spend $50.00 on hats and receive 50% off with the Get field empty means the customer can purchase an unlimited number of hats at the 50% discount, as long as they spend $50.00.

14. Enter the discount amount. Fields not applicable to your discount type are dimmed.
    - **% Off** – Enter the percent amount that the Reward item will be discounted. NetSuite adds the percent sign automatically.
    - **$ Off** – Enter a flat amount the Reward item will be discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.
    - **New Price** – Enter the sale price at which the item will be sold. Do not enter a currency symbol.
      The price is universally applied to all Reward items selected for the promotion unless a different override price is entered on the **Specific Items** subtab in a later step.

15. Leave the **Apply to Transaction** check box empty.

16. For **Amount Spend**, enter the minimum the customer must spend on specific items or in the total transaction.
17. Select whether the promotion can **Repeat** for customers during the promotion period.

   - **Once** – Each customer can receive the discount one time.
   - **Multiple** – Each customer can receive the discount as often as desired.
   - **First** – New customer incentive. Customers can receive the discount one time only on the first transaction they make through an NSPOS register.

   Cashiers can add the customer at the time of purchase or you can preload your customers through an import. The trigger is whether a transaction attached to that customer exists in the NetSuite ERP database.

   **Note:** Purchases made through other applications that log transactions to NetSuite ERP will cause a customer to be ineligible for a “first” NSPOS promotion.

18. Click the **Locations** subtab and select the locations.

   - **To select specific locations:** Select from the Location list.
   - **To include all locations:** Check the All Locations box.
   - **To exclude specific locations:** Check Exclude Locations and choose which to exclude from the Locations list.

19. Click the **Customers** subtab and select the customers to include.
To include specific customers:

1. In the Customer field, select List or Search, or begin entering the first Customer you want to add to this promotion.
2. If using a list or search, select the customer.
3. Click Add.
4. Repeat as desired.

To include all customers: Check the All Customers box.

To include specific customer categories: Select from the Customer Category list.

To exclude specific customers:

1. Check the Exclude Customers box.
2. In the Customer field, select List or Search, or begin entering the first customer you want to exclude from this promotion.
3. If using search or a list, select the customer.
4. Click Add.
5. Repeat as desired.

To exclude a customer category:

1. Check the Exclude Customers box.
2. Select one or more from the Customer Category list.
3. If desired, click the Specific Items subtab and select the items. You can select specific items, include the discount on all items, or exclude items by their item class.

This subtab applies if you want to make the purchase of specific Trigger items a requirement to receive the amount-spend discount. It also applies if you want to apply the discount to specific Reward items.

To include specific items:

1. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.
2. To make an item purchase a requirement for receiving the amount spend discount, select Yes in the Trigger field.
3. To make the discount apply to an item, select Yes in its Reward field.

**Important:** If you will have some items set as Trigger and some as Reward, you must check the Mix and Match box at the top.

**Warning:** Setting items as either Trigger or Reward without selecting Mix and Match will cause those items to be ignored in the promotion.
If you clear the Mix and Match box, items will not revert to both Trigger and Reward. Instead, those items will be excluded from the promotion.

4. Click Add.
5. Repeat the Specific Items steps for each item you want to include in the promotion.

**To include all items:** Check the All Items box.

**To exclude specific items:**
1. Check the Exclude Items box.
2. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

**Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

3. Ignore the Trigger and Reward and other fields.
4. Click Add.

**To exclude items by item class:**
1. Check the Exclude Items box.
2. Select one or more from the Item Class list to exclude from the promotion.

**Note:** These coupon codes are specific to NSPOS. They are not the coupons available through NetSuite ERP.

21. Optionally add coupon codes to the promotion from the Coupons subtab. See Work with Coupon Codes.

22. Optionally select a specific Stacking Rule from the Stacking Rules subtab.

- Promotions are automatically assigned to the default Stacking Rule. Use the Stacking Rule list to select a different rule as desired. For more information, see Use Stacking Rules for Promotion Interactions.
- Stacking Rules can include exclusions to prevent other promotions from combining to create large of a discounts. However, you can override or add to the assigned rule for this specific promotion.
- **Explicitly Excluded:** To exclude a promotion from combining with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.
Explicitly Included: To include a promotion with the current promotion, click the down arrows for a list or begin entering the promotion name and press the tab key. Select the promotion.

23. Optionally select the Notes subtab and add comments about the promotion.

24. Optionally select the Files subtab and attach files to the promotion record. This is useful for keeping your advertising copy or planning documents with the promotion record.

25. The Workflow subtab is not used with NSPOS promotions.

26. Click Save.

BOGO or Mix and Match Promotions – Advanced Form

Follow these steps to create buy one, get one (BOGO) or mix and match promotion.

It is important to understand how NetSuite designates which items must be purchased by the customer and which items are then discounted or provided to the customer for fulfilling the promotion conditions.

- Items used to fulfill promotion requirements are **Trigger** items.
- Discounted or free items are **Reward** items.
- When an item is purchased and then a second of the same item is discounted, the item is flagged as both a **Trigger** and **Reward** item.

**Important:** NSPOS does not automatically add Reward items to the Journal or prompt the sales associate to recommend it. If the promotion is buy 3, get 1 free, and the associate only scans 3 items, the customer will not receive the 4th item automatically. The associate must scan all 4 items.

**To create a BOGO or Mix and Match Promotion Record:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types
3. On the Record Types page, locate the RA-Promotion record, and click **New Record**.
4. For Custom Form, select **Advanced Promotion Form**.
5. In the Name field, enter a descriptive name. This name appears in the NetSuite POS Journal line entry and on customer receipts.

**Note:** Leave the Inactive box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

6. Select the Discount Item to use with the promotion.
7. In the Effective Date field, select the date you want the promotion to start. The promotion starts at 00:00 on the selected date.
8. In the Expiration Date field, select the date you want the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active that day.

**Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location’s time zone.

**Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

9. In the Promotion Type field, select the discount type that will apply to the Reward items.
   - $ Off – To apply a flat discount.
% Off – To discount the item price by a percent.

New Price – To replace the current item price with a new price.

**Example 1:** If the promotion is buy one, get one at 50% off, then select % Off because the Reward item that meets the buying amount condition is discounted by a percent.

**Example 2:** If the promotion is buy two and get one free, select % Off and set the amount to 100%.

**Example 3:** If the promotion is buy two and get a third for only $10.00, then select New Price because the Reward item price is $10.00, regardless of its current price.

**Note:** When you select a Promotion Type, some fields are dimmed. This is because they are no longer applicable to the promotion.

10. For Mix And Match promotions, check this box to let any combination of the Trigger items to apply the discount to any Reward item.

**Note:** You must check Mix And Match to use items set as either Trigger or Reward. Setting items as either Trigger or Reward without selecting Mix And Match will cause those items to be ignored in the promotion.

11. In the Buy field, enter the quantity of items that have to be bought as a minimum condition to activate the promotion.

For example, in a Buy 3, Get 1 Free promotion, enter 3 in this field.

If the Buy field has a value of 3 and the Get has a value of 1, buying six items activates a discount on two additional items when they are rung up.

12. In the Get field, enter the quantity of items that are discounted, provided to the customer or have a new price.

If the Get field is left empty, all Reward items will be discounted.

**Note:** NSPOS does not automatically add Reward items to the Journal or prompt the sales associate to recommend it. If the promotion is buy 3, get 1 free, and the associate only scans 3 items, the customer will not receive the 4th item automatically. The associate must scan all 4 items.

**Important:** As long as a value is assigned to the Get field, the promotion behaves as a BOGO promotion. If you do not want a BOGO style promotion, leave the Get field blank.

13. Enter the discount amount. Fields not applicable to your discount type are dimmed.
% Off – Enter the percent amount that the Reward item is discounted. NetSuite adds the percent sign automatically.

If the promotion is buy a quantity, get a quantity free, select % Off and set the amount to 100%.

$ Off – Enter a flat amount the Reward item is discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.

New Price – Enter the sale price at which the Reward item will be sold. Do not enter a currency symbol. The price is universally applied to all items selected for the promotion unless a different override price is entered on the Specific Items subtab in a later step.

14. Leave Apply to Transaction clear for BOGO or Mix and Match promotions. The option applies the discount to the transaction total instead of individual items.

15. For a BOGO or Mix and Match promotion, leave the Amount Spend empty.

This is the minimum purchase amount required to receive the discount. It will remove the Buy requirement set for the items. See Amount Spend Promotions – Advanced Form if you want to include this requirement.

16. Select whether the promotion can Repeat for customers during the promotion period.

   - Once – Each customer can receive the discount one time.
   - Multiple – Each customer can receive the discount as often as desired.
   - First – New customer incentive. Customers can receive the discount one time only on the first transaction they make through an NSPOS register.

   Cashiers can add the customer at the time of purchase or you can preload your customers through an import. The trigger is whether a transaction attached to that customer exists in the NetSuite ERP database.

   **Note:** Purchases made through other applications that log transactions to NetSuite ERP will cause a customer to be ineligible for a “first” NSPOS promotion.

17. Click the Locations subtab and select the locations.

   - **To select specific locations:** Select from the Location list.
   - **To include all locations:** Check the All Locations box.
   - **To exclude specific locations:** Check Exclude Locations and choose which to exclude from the Locations list.

18. Click the Customers subtab and select the customers to include.

   - **To include specific customers:**
     1. In the Customer field, select List or Search, or begin entering the first Customer you want to add to this promotion.
2. If using a list or search, select the customer.
3. Click Add.
4. Repeat as desired.

- **To include all customers:** Check the All Customers box.
- **To include specific customer categories:** Select from the Customer Category list.
- **To exclude specific customers:**
  1. Check the Exclude Customers box.
  2. In the Customer field, select List or Search, or begin entering the first customer you want to exclude from this promotion.
  3. If using search or a list, select the customer.
  4. Click Add.
  5. Repeat as desired.

- **To exclude a customer category:**
  1. Check the Exclude Customers box.
  2. Select one or more from the Customer Category list.

19. Click the Specific Items subtab and select the items. You can select specific items, include the discount on all items, or exclude items by their item class.

**To include specific items:**

1. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

**Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

2. Choose if the item will be a Trigger, Reward or both.
   
   If you checked the Mix And Match box, select whether you want the item to be a Trigger, Reward or both.

**Warning:** Setting items as either Trigger or Reward without selecting Mix and Match will cause those items to be ignored in the promotion.
   
   If you clear the Mix and Match box, items will not revert to both Trigger and Reward. Instead, those items will be excluded from the promotion.

3. If this is a New Price promotion, and you want the Reward item to have a different override price than the default price set above, enter it in the Override Price field. This item-specific override price can be higher or lower than the promotion's default New Price value.
4. Click Add.
5. Repeat the Specific Items steps for each item you want to include in the promotion.
To include all items: Check the All Items box.

To exclude items by item class:
1. Check the Exclude Items box.
2. Select one or more from the Item Class list to exclude from the promotion.

20. Click Save. The BOGO or Mix and Match promotion setup is complete.

Create a Classic Promotion Record

To create a promotion in NetSuite Point of Sale (NSPOS), you must first have the Discount Item in place. Then you can set up the actual promotion.

NetSuite POS (NSPOS) can apply multiple promotions to one sales transaction, but when an item that is included in multiple promotions is rung up at the terminal, NSPOS will only apply one promotion for that item to the sales transaction. The register actively analyzes the items and quantities as they are rung up. As the transaction progresses, NSPOS may remove one promotion that was applied for a different promotion that will bring the customer a larger discount.

You can set up basic item and BOGO or Mix and Match when using classic promotions.

- Basic item promotions apply a discount directly to the quantity and item being purchased.
- Buy one, get one (BOGO) or mix and match promotions provide discounts by purchasing a combination of items.

It is important to understand how NetSuite designates which items must be purchased by the customer and which items are then discounted or provided to the customer for fulfilling the promotion conditions.

- Items used to fulfill promotion requirements are Trigger items.
- Discounted or free items are Reward items.
- When an item is purchased and then a second of the same item is discounted, the item is flagged as both a Trigger and Reward item.

Go to the following for steps on creating each type of promotion.

- Basic Item Promotions – Classic Form
- BOGO or Mix and Match Promotions – Classic Form

Basic Item Promotions – Classic Form

Follow these steps to create a basic promotion in NetSuite Point of Sale (NSPOS) using the classic form where one or more items are discounted.
To create a Basic Item Promotion Record:

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Promotion record row and click List.
4. Open the promotion record:
   ■ For a new promotion, click New RA-Promotion.
   ■ To update an existing promotion, locate the promotion and click Edit.
5. For Custom Form, select Classic Promotion Form.
6. Enter a descriptive Name. This name appears in the NetSuite POS Journal line entry and on customer receipts.

   **Note:** Leave the Inactive box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

7. Select the Discount Item to use with the promotion.
8. Enter the Effective Date for the promotion to begin. The promotion starts at 00:00 on the selected date.
9. Enter the Expiration Date for the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active on that day.

   **Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location’s time zone.

   **Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

10. In the Promotion Type field, select the discount type that will apply to the promoted items.

   ■ % Off – To discount by a percent.
   ■ $ Off – To apply a flat discount.
   ■ New Price – To replace the Reward item price with a new price.

   **Note:** When you select a Promotion Type, some fields are dimmed. This is because they are no longer applicable to the promotion.

11. Leave the Mix and Match check box empty for these basic steps. For the steps to use these fields, see BOGO or Mix and Match Promotions – Classic Form.

12. In the Buy field, enter the item quantity that must be purchased as a minimum condition to receive the discount.

   Because this is a basic promotion, you will normally enter 1.

13. If you want to limit the discounts to receive, enter the number in the Get field.

   For example, if the discount is on hats, and you only want them to receive the Reward discount on one item, enter 1.

14. Enter the discount amount. Fields not applicable to your discount type are dimmed.

   ■ % Off – Enter the percent amount that the item will be discounted. NetSuite adds the percent sign automatically.
   ■ $ Off – Enter a flat amount the item will be discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.
- **New Price** – Enter the sale price at which the item will be sold. Do not enter a currency symbol. The price is universally applied to all items selected for the promotion unless a different override price is entered on the Specific Items subtab in a later step.

15. Click the Locations subtab and select the locations.

16. Click the Specific Items subtab and select the items.

1. In the **Item** field, select **List** or **Search**, or begin entering the first item you want to add to this promotion.

   **Note:** Items whose records are checked **Do not download to POS** are automatically excluded from promotions. They will not appear in your search.

2. For a basic item promotion, leave **Trigger** and **Reward** fields set to **Yes**.

3. If this is a **New Price** promotion, and you want this item to have a different override price than the default new price set above, enter it in the **Override Price** field. This item-specific override price can be higher or lower than the promotion's default **New Price** value.

4. Click **Add**.
5. Repeat the **Specific Items** steps for each item you want to include in the promotion.

17. Optionally select the **Notes** subtab and add comments about the promotion.

18. Optionally select the **Files** subtab and attach files to the promotion record. This is useful for keeping your advertising copy or planning documents with the promotion record.

19. Click **Save**.

**BOGO or Mix and Match Promotions – Classic Form**

Follow these steps to create buy one, get on (BOGO) or mix and match promotion using the classic form.

It is important to understand how NetSuite designates which items must be purchased by the customer and which items are then discounted or provided to the customer for fulfilling the promotion conditions.

- Items used to fulfill promotion requirements are **Trigger** items.
- Discounted or free items are **Reward** items.
- When an item is purchased and then a second of the same item is discounted, the item is flagged as both a **Trigger** and **Reward** item.

**Important:** NSPOS does not automatically add Reward items to the Journal or prompt the sales associate to recommend it. If the promotion is buy 3, get 1 free, and the associate only scans 3 items, the customer will not receive the 4th item automatically. The associate must scan all 4 items.

**To create a BOGO or Mix and Match Promotion Record:**

1. Log in to NetSuite ERP as an administrator.

2. Go to Customization > Lists, Records, & Fields > Record Types

3. On the Record Types page, locate the RA-Promotion record, and click **New Record**.

4. For **Custom Form**, select **Classic Promotion Form**.

5. In the **Name** field, enter a descriptive name. This name appears in the NetSuite POS Journal line entry and on customer receipts.

**Note:** Leave the **Inactive** box empty. This is used to inactivate an existing promotion. You can also delete the record to remove a promotion or end it early by changing the date.

6. Select the **Discount Item** to use with the promotion.

7. In the **Effective Date** field, select the date you want the promotion to start. The promotion starts at 00:00 on the selected date.

8. In the **Expiration Date** field, select the date you want the promotion to end. The promotion ends at 00:00 on the selected date, meaning it will not be active that day.

**Note:** Promotions must include at least two calendar days. Promotion dates sync to each workstation as fixed dates and times, regardless of the register location’s time zone.

**Note:** Effective and Expiration Dates must be between 1/1/1753 12:00:00 AM and 12/31/9999 11:59:59 PM.

9. In the **Promotion Type** field, select the discount type that will apply to the Reward items.
- **$ Off** – To apply a flat discount.
- **% Off** – To discount the item price by a percent.
- **New Price** – To replace the current item price with a new price.

**Example 1:** If the promotion is buy one, get one at 50% off, then select **% Off** because the Reward item that meets the buying amount condition is discounted by a percent.

**Example 2:** If the promotion is buy two and get one free, select **% Off** and set the amount to 100%.

**Example 3:** If the promotion is buy two and get a third for only $10.00, then select **New Price** because the Reward item price is $10.00, regardless of its current price.

**Note:** When you select a **Promotion Type**, some fields are dimmed. This is because they are no longer applicable to the promotion.

10. For **Mix And Match** promotions, check this box to let any combination of the Trigger items to apply the discount to any Reward item.

**Note:** You must check **Mix And Match** to use items set as either **Trigger** or **Reward**. Setting items as either Trigger or Reward without selecting Mix And Match will cause those items to be ignored in the promotion.

11. In the **Buy** field, enter the quantity of items that have to be bought as a minimum condition to activate the promotion.

For example, in a Buy 3, Get 1 Free promotion, enter **3** in this field.

If the **Buy** field has a value of **3** and the **Get** has a value of **1**, buying six items activates a discount on two additional items when they are rung up.

12. In the **Get** field, enter the quantity of items that are discounted, provided to the customer or have a new price.

If the **Get** field is left empty, all Reward items will be discounted.

**Note:** NSPOS does not automatically add Reward items to the Journal or prompt the sales associate to recommend it. If the promotion is buy 3, get 1 free, and the associate only scans 3 items, the customer will not receive the 4th item automatically. The associate must scan all 4 items.

**Important:** As long as a value is assigned to the **Get** field, the promotion behaves as a BOGO promotion. If you do not want a BOGO style promotion, leave the **Get** field blank.
13. Enter the discount amount. Fields not applicable to your discount type are dimmed.
   - **% Off** – Enter the percent amount that the Reward item is discounted. NetSuite adds the percent sign automatically.
     If the promotion is buy a quantity, get a quantity free, select % Off and set the amount to 100%.
   - **$ Off** – Enter a flat amount the Reward item is discounted. NetSuite formats and rounds this up or down to the nearest second decimal point. Do not enter a currency symbol.
   - **New Price** – Enter the sale price at which the Reward item will be sold. Do not enter a currency symbol. The price is universally applied to all items selected for the promotion unless a different override price is entered on the Specific Items subtab in a later step.

14. Click the Locations subtab and select the locations.

15. Click the Specific Items subtab and select the items.

1. In the Item field, select List or Search, or begin entering the first item you want to add to this promotion.

   **Note:** Items whose records are checked Do not download to POS are automatically excluded from promotions. They will not appear in your search.

2. Choose if the item will be a **Trigger**, **Reward** or both.

   If you checked the Mix And Match box, select whether you want the item to be a **Trigger**, **Reward** or both.

   **Warning:** Setting items as either **Trigger** or **Reward** without selecting Mix and Match will cause those items to be ignored in the promotion.

   If you clear the Mix and Match box, items will not revert to both **Trigger** and **Reward**. Instead, those items will be excluded from the promotion.

3. If this is a **New Price** promotion, and you want the Reward item to have a different override price than the default price set above, enter it in the Override Price field. This item-specific override price can be higher or lower than the promotion's default **New Price** value.
4. Click **Add**.

5. Repeat the **Specific Items** steps for each item you want to include in the promotion.

16. Click **Save**. The BOGO or Mix and Match promotion setup is complete.

---

### Work with Coupon Codes

This topic applies to NetSuite Point of Sale (NSPOS) **Advanced Promotions**.

NSPOS coupon codes provide a method for customers to use a promotion only if they have the code and meet the purchase conditions. You can add a coupon code to a promotion and then print the code on flyers, include the code in online advertisements or distribute your code by email. NSPOS coupon codes are only valid during the promotion’s effective period.

Codes are set up as a multiple use or single use type.

- **Multiple-use Codes** – One coupon code that can be used multiple times. Use this type of coupon when you will print the code on flyers or other mass advertising.

- **Single-use Codes** – One or more coupon codes that can each be used a single time only. Single-use codes are set up for a specific number of customers, with each customer receiving their own code.

**Important:** NSPOS promotions can only include one code type at a time – a multiple-use code or one or more single-use codes.

**Note:** You can use the **New RA-PromotionCoupon** button as an option to open a coupon form, but creating coupons directly within the promotion record using **Add** is the most efficient method.

**Note:** These coupon codes are specific to NSPOS. They are not the coupons available through NetSuite ERP.

---

### To add Coupon Codes to a Promotion:

1. Log in to NetSuite ERP as an administrator.
2. Create or edit a promotion.
3. Click the **Coupons** subtab.
4. Select if the coupon will be **Single Use Only** or available to use multiple times.
   - A single-use code can only be used once during the promotion effective period. This restriction means that only one customer can use the code a single time.
Promotions can have many single-use codes, but only one multiple-use code.
If one code in the list is Single Use Only, you cannot add another line with a multiple-use coupon code.

5. Enter the NSPOS Coupon Code. Only enter one code per line.
You can enter any number, letter or symbol, up to 40 characters. To ensure sales associates can enter the code during a transaction, you should limit the characters to those found on a standard keyboard.

6. Click Add.
7. Enter another code and click Add as desired.
8. Distribute or publish your coupon codes to your customers.

To view or edit a list of Coupon Codes:

Follow these steps to view all NSPOS coupon codes set up for your account. Each code record includes a link to its associated promotion. If a single-use coupon was used for a transaction, the coupon record displays the NSPOS Transaction ID and show a check in the Used check box.

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types
3. Locate the RA-PromotionCoupon row and click List.
4. Locate the desired NSPOS Coupon Code.
5. Click View to display details about the code.
6. Click Edit to:
   ■ Make the code Inactive.
   ■ Change the Promotion associated with the code.
   ■ Adjust whether the code is Single Use Only.
   ■ Change the NSPOS Coupon Code characters.

    **Note:** You should not change the NSPOS Transaction ID and Used fields.

7. If you made changes, click Save

You can click New RA-PromotionCoupon from the list to add a code to an existing promotion.
To Delete or Inactivate a Coupon Code:

You cannot delete or inactivate a coupon code directly from the promotion. Instead, go to the list of existing codes using the procedure below. Inactivating a code prevents it from being used again, but maintains any existing Transaction ID history. Deleting a code that was used removes it from the transaction history, and is not recommended.

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types
3. Locate the RA-PromotionCoupon row and click List.
4. Locate the desired NSPOS Coupon Code.
5. Click Edit.
6. Check the Inactive box or select Actions > Delete.
7. If you checked Inactive, click Save.

To use a Coupon Code at the Register:

1. Enter all items included in the transaction.
   We recommend entering the coupon at the end of the transaction, after scanning or entering all the items. That way you can ensure that all promotions requirements were met in the customer's purchase.
2. Enter the coupon code directly into the Journal.

If the customer's purchase does not meet the requirements, NSPOS displays a warning that the coupon was not applied and the coupon line in the journal is voided.

Use Stacking Rules for Promotion Interactions

This topic applies to NetSuite Point of Sale (NSPOS) Advanced Promotions.

When processing a sales transaction, NSPOS automatically applies the promotion discount that brings the most value to the customer. However, you may want to give your customers more than one discount at a time, or you may want to exclude one promotion when another is applicable to the same transaction.

Stacking Rules let you group promotions to manage how they interact with other promotions.
Using Stacking Rules, you can:

- Set a **Limit** on how many promotions within a rule can apply to a single transaction.
  - **Limit 1 or more** to permit only the best subset of promotions to combine and apply to qualifying purchases. For example, Limit 2 means use only the two promotions in the rule that provide the best discount to the customer.
  - **Limit 0** to permit all promotions within the rule to combine and apply to qualifying purchases.

- **Exclude** promotions in different Stacking Rules from being applied at the same time. This restricts promotions across rules from combining to permit too large of a discount.
  - Excluding one rule automatically applies the exclusion in reverse. For example, Rule B excluding Rule A means Rule A automatically excludes Rule B.
  - Rule C excluding Rule B as shown here means all three rules exclude the other.
### Stacking Rules Example

<table>
<thead>
<tr>
<th>Rule A</th>
<th>No Exclusion Rules Set</th>
<th>Limit: 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Buy 2 hats, get 10% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 3 hats, get 15% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 4 hats, get 20% off</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS only applies the **one promotion** that provides the largest discount.

<table>
<thead>
<tr>
<th>Rule B</th>
<th>Exclude Rule A</th>
<th>Limit: 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Buy winter clothing, get 10% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 winter hat, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 pair winter gloves, get 1 pair free</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS enables up to **two promotions** from the rule to apply.
- **Rule B** excludes the promotions in **Rule A** because winter hats are a subset of the **hat** category. The combined discounts are too large.
- Exclusion automatically applies from **Rule A** to **Rule B**.

<table>
<thead>
<tr>
<th>Rule C</th>
<th>Exclude Rule B</th>
<th>Limit: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Buy 1 winter scarf, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 winter coat, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy any clothing item, get 10% off</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS enables **all promotions** from the rule to apply.
- **Rule C** excludes the promotions in **Rule B** because winter scarfs and coats are a subset of the **winter clothing** category. Exclusion prevents and additional 10% off.
- **Rule B** exclusion of **Rule A** automatically extends the exclusion of **Rule A** to **Rule C**.
- All rules become exclusive without additional setup.

---

**Tip:** For PDF, zoom in to view this example. For the Help Center, click the image to enlarge it. Details are also listed below.

<table>
<thead>
<tr>
<th>Stacking Rules Example</th>
<th>Example Promos</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rule A</strong></td>
<td>No Exclusion Rules Set</td>
<td>Limit: 1</td>
</tr>
<tr>
<td></td>
<td>Buy 2 hats, get 10% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 3 hats, get 15% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 4 hats, get 20% off</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS only applies the **one promotion** that provides the largest discount.

<table>
<thead>
<tr>
<th>Rule B</th>
<th>Exclude Rule A</th>
<th>Limit: 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Buy winter clothing, get 10% off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 winter hat, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 pair winter gloves, get 1 pair free</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS enables up to **two promotions** from the rule to apply.
- **Rule B** excludes the promotions in **Rule A** because winter hats are a subset of the **hat** category. The combined discounts are too large.
- Exclusion automatically applies from **Rule A** to **Rule B**.

<table>
<thead>
<tr>
<th>Rule C</th>
<th>Exclude Rule B</th>
<th>Limit: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Buy 1 winter scarf, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy 1 winter coat, get 1 free</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Buy any clothing item, get 10% off</td>
<td></td>
</tr>
</tbody>
</table>

**Results:** NSPOS enables **all promotions** from the rule to apply.
- **Rule C** excludes the promotions in **Rule B** because winter scarfs and coats are a subset of the **winter clothing** category. Exclusion prevents and additional 10% off.
- **Rule B** exclusion of **Rule A** automatically extends the exclusion of **Rule A** to **Rule C**.
- All rules become exclusive without additional setup.

---

**To view an existing Stacking Rule:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types
3. Locate the **RA-PromotionStackingRule** row and click **List**.

---

**NSPOS Administrator Guide**
4. Click **View** for the desired Stacking Rule **Name**.
5. To update the Stacking Rule, click **Edit** while displaying the rule or from the list.
6. For details on each field, see the next procedure on creating a Stacking Rule.

To create a Stacking Rule:

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types
3. Locate the **RA-PromotionStackingRule** row and click **List**.
4. Review the list to ensure the Stacking Rule does not already exist.
5. Click **New RA-PromotionStackingRule**.
6. Set **Custom Form** to **Standard RA-PromotionStackingRule Form**.
7. Enter a **Name** for the Stacking Rule.
8. Leave the **Inactive** box blank. Use this box to inactivate a rule that is no longer needed.
9. Set a **Limit** for the number of promotions that can be applied to any single transaction.
   - **0** – No limit. NSPOS will apply all promotions that are applicable to the transaction.
   - **1** – Only apply the promotion that provides the largest discount.
   - **More than 1** – Apply all applicable promotions, up to the limit, that together provide the largest discount.

   **Note:** NSPOS will automatically select the one or more promotions that provide the best discounts to the customer.

10. Select any single **Exclusion Due to Stacking Rule**.

    Use the option to exclude promotions in different Stacking Rules from being applied at the same time. This restricts promotions across rules from combining to create too large of a discount.
Excluding one rule automatically applies the exclusion in reverse. For example, Rule B excluding Rule A means Rule A automatically excludes Rule B. If Rule C excludes Rule B, then all three rules exclude each other.

11. To make this Stacking Rule the default for all new promotions, select **Is Default**.

12. Optionally use the **Promotions** subtab to create and add promotions to the rule. **We do not recommend this approach.**

You can create simple promotions directly within the rule, or you can select the Stacking Rule from within RA-Promotion records. We recommend assigning a Stacking Rule directly from each promotion to be included.

**Warning:** To leave the **Promotions** list empty and assign from individual promotions, do not click the Promotions subtab.

13. Click **Save**.

Any promotions assigned outside of the Stacking Rule display as a list when viewing the rule later. The order of the list is not important. If multiple promotions are available, and the customer meets the requirements for more than one, the customer will always receive the promotions that provide the largest discounts.

**To Reassign a Promotion to a different Stacking Rule:**

Every promotion must be assigned to a Stacking Rule when the promotion is set up. Most commonly the promotion is assigned to the default rule. Use these steps to assign a promotion to a different Stacking Rule.

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Promotion record row and click **List**.
4. Locate the promotion and click **Edit**.
5. Click the **StackingRules** subtab.
6. Select the desired **Stacking Rule**.
7. Click **Save**.

**Promotions on NetSuite POS Terminals**

After your promotion is set up and has synced to NetSuite POS terminals/registers, the promotion begins automatically when the effective date arrives. No special steps are required to load the promotion to the terminal.

**Warning:** We do not recommend doing mass record updates during business hours. Creating or importing large numbers of promotions or other records at once can impact the synchronization process at your registers. See **Benchmarks for Data Transfers and System Limits**.

**Sales and Promotions**

Promotions valid for the location are applied automatically as the sales associate adds items to the Journal. NSPOS continuously reviews the items and available promotions throughout the transaction. This review ensures that the customer receives the largest discount on their purchases. A promotion applied at the beginning of the transaction might be replaced later in the transaction because trigger or reward items were added or removed.
A single promotion’s discount can be applied multiple times during the same sales transaction. For example, a customer can purchase and receive multiple items for a specific BOGO promotion in a single transaction.

Discounts are applied to Reward items that represent the smallest cost to the retailer.

Returns and Promotions

When a customer wants to return an item that was purchased as part of a promotion, the promotion is only recognized if the return is processed using the transaction number found on the customer receipt. Making a non-validated return by looking up the items without a receipt number will not include the promotion conditions that were applied to the original sale.

Analyze Promotion Results in NetSuite

When sales generated in NetSuite POS synchronize to your NetSuite account, any promotions included in those sales are processed and recorded using the NetSuite Discount Item set up or selected when creating the original promotion record.

NetSuite processes discounts by creating a separate transaction line on an invoice for the Discount Item that was used. This transaction line contains the name of the Discount Item and the financial result of the discount that was applied to the item immediately above it. To examine sales transactions that included a promotion, you can search for individual transactions or all transactions within the promotion.

To locate a specific transaction when you have a NetSuite POS transaction number:

1. Log in to NetSuite ERP as an administrator.
2. Go to Reports > New Search.
3. In the Search Type list, click Transaction.
4. On the Transaction Search page, click the Personalize Search button.
5. If desired, enter a different Search Title, such as Promotion Transactions by External ID.
6. In the Filters field, near the bottom, select External ID.
7. Click Add.
8. Click Save.
10. Click Submit.

Note: To use this saved search later, go to Reports > Saved Searches > All Saved Searches and click the search Title.

To create a search for all transactions in a promotion:

1. Log in to NetSuite ERP as an administrator.
2. Go to Reports > New Search.
3. In the Search Type list, click Transaction.
4. On the Transaction Search page, locate the Item field.
5. Select or enter the Discount Item name that you used to create the promotion.
6. Click Submit.

**Note:** Search results may include multiple listings of the same invoice or credit note. This is due to the fact that one sale in NetSuite POS can create multiple discount transaction lines in NetSuite.

If you created the promotion by using a Discount Item configured to post amounts to a specific custom account (set on the Accounting subtab of the Discount Item record), you can review the list of General Ledger entries created by each promotion at Reports > Financial > General Ledger.

**Promotion System Flags**

You can control certain aspects of how and when promotions calculate on a NetSuite Point of Sale (NSPOS) register during a sales transaction.

**Control Promotion Calculations on Demand**

As the sales associate adds items to the journal during checkout, NSPOS reviews promotions that include those items and automatically applies the promotions that bring the largest discounts to the customer. Adding items or changing quantities in the journal might qualify the customer for different promotions and larger discounts. Voiding an item or quantity might make the transaction ineligible for a promotion already applied, requiring another review to find the best discount.

Because the review and recalculate process occurs with each change, the customer and the sales associate can view the discounts being applied in real-time. However, if transaction includes many items and you have many promotions, the automatic process can lead to performance issues, delaying the time required to tender out the transaction.

To avoid performance issues, you can check (enable) the **Tender: Calculate Promotions on Demand** flag. If checked, NSPOS only applies promotions when the sales associate does one of the following:

- Taps Amt Due.
- Taps Calculate Best Promotion using a custom button that you set up.

When tapped, the applied promotions and discount amounts display in the journal for review. If a customer makes changes such as adding another item to qualify for a promotion, the sales associate can tap the button again to recalculate the results.

<table>
<thead>
<tr>
<th>Flag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tender: Calculate Promotions on Demand</td>
<td>If checked, only calculate promotions when the sales associate clicks Amt Due or another button that is customized to calculate promotions on demand. Default is cleared.</td>
</tr>
</tbody>
</table>

**To enable or disable Calculate Promotions on Demand:**

1. Sign in to any NetSuite POS register as an administrator.
2. Press Ctrl+F10 to open Universal Settings.
3. Enter Promotion in the search field.
4. Check or clear the box for the options.
5. Tap Done.

Changes are applied to the register immediately. Changes are applied to other registers in your network the next time they are restarted.
Control Manual Discounts on Promotion Items

You can set NSPOS flags to control the interaction of manual discounts and promotions on items purchased at the register. This can assist you in preventing too large of a discount to apply.

- **Discount: Discount promoted items** – This flag determines if the sales associate is alerted when applying a manual discount to an item that is already discounted through a promotion.
  - **If enabled** (checked), sales associates can apply manual discounts without an alert.
  - **If disabled** (clear), sales associates can apply a manual discount, but receive notification that the item is already on promotion. They are prompted to confirm that they want to proceed.

- **Discount: Promote discount items** – This flag determines if an item receiving a manual discount at the register can be included as a promotional item and receive the promotion discount.
  - **If enabled** (checked), manually discounted items can be included in promotion calculations.
  - **If disabled** (clear), items receiving a manual discount cannot be used to receive a promotional discount.

<table>
<thead>
<tr>
<th>Flag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discount: Discount promoted items</td>
<td>If checked, allow sales associates to manually discount an item included in a promotion without displaying an alert. If the box is clear, allow the manual discount but display an alert. A manager or administrator authorization may be required. Default is checked.</td>
</tr>
<tr>
<td>Discount: Promote discount items</td>
<td>If checked, allow an item that received a manual discount to be included in a promotion. If the box is clear, items receiving a manual discount cannot also receive a promotional discount. Default is clear.</td>
</tr>
</tbody>
</table>

**Important:** This flag is applicable to customers using the advanced promotion engine only. It has no effect for classic promotions.

To set Promotion Discount flags:

1. Sign in to any NetSuite POS register as an administrator.
2. Press **Ctrl+F10** to open **Universal Settings**.
3. Enter **Discount** or **Promo** in the search field.
4. Check or clear the box for the options.
5. Tap **Done**.

   Changes are applied to the register immediately. Changes are applied to other registers in your network the next time they are restarted.

Setting your default promotion form in NetSuite ERP

Our **advanced promotions** engine includes the ability to apply multiple discounts to the same item in a single transaction. You configure how and if promotions combine through Stacking Rules. NSPOS uses the rules to apply the one or more promotions that bring the largest discount to the shopper.

However, the option to provide multiple discounts may not fit all business models. Under our **classic promotions** engine, NSPOS reviews the promotions in effect and applies only the single best discount to
each item or combination of items. This best-discount only logic was in legacy NSPOS releases and is in line with the promotion strategy many retailers use now.

NSPOS includes the option to choose your default promotion form – **advanced** or **classic**. Updating a classic promotion using the advanced form will not cause issues, but it might be confusing. Advanced fields not supported by an existing promotion are ignored by the application.

**Note:** NSPOS registers use a flag to determine if your promotions are handled on the register as **classic** or **advanced**. The release team automatically sets the register flag appropriate for your setup during your upgrade. Do not change this flag without assistance from NetSuite Customer Support.

**Important:** If you are on the classic promotion engine and want to begin using advanced promotions, contact NetSuite Customer Support to request promotion flag changes on your NSPOS registers. They might need to review your current processes.

**To choose your default Promotion form:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Under the **Edit** column, click the **RA-Promotion** record.
4. Click the **Forms** subtab.
5. Choose your **Preferred** form:
   - Classic Promotion Form
   - Advanced Promotion Form

   ![Forms subtab](image)

   **Important:** If displayed, do **not** select Standard RA-Promotion Form.

6. Click **Save**.

   The form will update the next time you create a new promotion record or open an existing record.

   **Warning:** Do not change any other fields or settings on the RA-Promotion record. Doing so can have adverse effects on your promotion processes.

You can return to these steps later to choose a different default promotion form.

**Troubleshoot Promotions**

The following table highlights common operational problems that can occur for NetSuite Point of Sale (NSPOS) promotions.
<table>
<thead>
<tr>
<th>Environment</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| NSPOS device | Promotion does not appear when testing on the sales device. | Check the following:  
■ Allow enough time for the NetSuite records to sync to the NetSuite POS workstation.  
■ Make sure the time and date of sale falls within the date range on the promotion record in NetSuite.  
■ Make sure the testing location is included in the locations selected on the promotion record in NetSuite. |
| NetSuite POS device | Entering the correct amount of an item does not trigger the promotion at the time of sale. | If the promotion is a BOGO type, be sure to enter the buy and get quantities as two separate transaction lines. |
| NetSuite POS device | Some items included in the promotion record do not trigger the promotion at the time of sale. | Ensure that all items attached to the promotion record in NetSuite have both Trigger and Reward fields set to Yes unless Mix And Match is checked. |
| NetSuite | The amounts discounted do not correctly reflect in the General Ledger. | Check that the posting settings on the Accounting subtab of the Discount Item attached to the promotion are correctly set. |
| NetSuite | The amount of tax calculated by the promotion is incorrect. | Check that the taxation settings on the Accounting subtab of the Discount Item attached to the promotion are correctly set. |

### Downsynchronization of Promoted Items if missing from server

This topic applies to NSPOS 2018.1.2 or greater.

In early NSPOS releases, if an item included in a promotion did not exist on your replication server, the promotion downsyc to your registers would fail for that item. The correction was to manually Edit > Save the item in NetSuite ERP to trigger an item download to the server. Then the promotion could downsyc normally.

Today, if a promotion includes a missing item, the promotion downsyc automatically downloads the item to the server. A manual item update is not required.

**Note:** Items records marked as Do not download to POS are automatically excluded from promotions. They do not appear during promotion creation when searching for items to include.

### Other Discount Types

This topic covers other discount options available to NetSuite Point of Sale (NSPOS) implementations that use the Advanced Promotions Engine.

- Do Not Allow Discount on Item
- Grouping Transaction Discounts

Follow the links to review the details.

### Do Not Allow Discount on Item

The Advanced Promotions Engine in NetSuite Point of Sale (NSPOS) supports the Do Not Allow Discount option on the NetSuite ERP Item record. The option restricts an item from being included in manual
discounts and advanced promotions, including those that discount a transaction. Overriding the restriction requires store manager or administrator approval.

To mark an item with Do Not Allow Discount:

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Accounting > Items > Search.
3. Enter search criteria and click Submit.
4. Click Edit for the desired item.
5. In the Classification section, check the Do Not Allow Discount box.
6. Click Save.

**Important:** The promotion and transaction discount restrictions for Do Not Allow Discount apply to setups using the Advanced Promotions Engine.

For setups using the Classic Promotion Engine, the option only restricts item-based discounts applied manually. The option does not affect transaction discounts and is ignored in promotions.

Discount restriction summary for Advanced Promotions

The following rules apply when an item is marked Do Not Allow Discount and your implementation uses the Advanced Promotion Engine. Store manager and administrators can override restrictions against manual discounts at the register.

- Cashier – Cannot manually discount a restricted item at the register.
- Cashier – Cannot include a restricted item’s price in transaction discounts.
- Promotions – Cannot use a restricted Item as Reward for purchasing a Trigger item.
- Promotions – Restricted item prices are ignored in transaction discounts.

Manual Discounts

For manual discounts, the Do Not Allow Discount restriction includes both single item and total transaction discounts applied at the register. If a cashier wants to manually discount a restricted item, or discount a transaction and include a restricted item, they must get a store manager or administrator to log in and approve.
If the cashier taps **Yes**, they are prompted for authorized approval. If **No**, the transaction continues without discounting the restricted item. If a transaction discount includes one or more restricted items, the cashier is prompted for approval on each restricted item.

**Transaction discounts** work by taking an amount or percent off each item purchased. If an item included in the purchase is marked Do Not Allow Discount, and a manager does not approve the restricted item’s discount, that item's price is not included in the calculation. For example:

**Regular Price**

- Item A........... $100
- Item B........... $ 50
- Item C........... $ 85  \(<\text{Do Not Allow Discount}>\)

\[
\text{Amt Due} \; \ldots \ldots \; $235
\]

**Apply 10% Transaction Discount**

- Item A........... $100 - $10 = $90
- Item B........... $ 50 - $ 5 = $ 45
- Item C........... $ 85  \(<\text{Do Not Allow Discount}>\)

\[
\text{Amt Due} \; \ldots \ldots \; $220
\]

**Line item breakout for multiple quantities in Transaction Discounts**

In a transaction discount, if a cashier adds an item and then taps the quantity button for more of the same item, NSPOS might expand that item to individual lines in the journal. This breakout is due to rounding issues for prices that do not round well when discounted as a quantity. It occurs only when needed to correct rounding for the discounted price.

For example, the cashier scans one $0.99 pencil, changes the quantity to 10, and then adds a 5% transaction discount. The journal might show 10 individual $0.99 pencils discounted at 5%. 

**NSPOS Administrator Guide**
Promotion Discounts

Items restricted with Do Not Allow Discount cannot be used as Reward items. If included in a purchase discounted by a transaction promotion, the item's price is not included in the promotion calculations.

The restriction is ignored in Classic Promotions.

Grouping Transaction Discounts

With some set up, you can configure your NetSuite Point of Sale (NSPOS) registers to enable transaction discounts against a group or subset of items in a purchase. Some retailers call this a “Sale Discount.” The cashier scans or enters the items to discount and taps a discount button that you create. Only the items currently in the journal receive the discount. All items added after the discount is applied are excluded.

1. Cashier scans the items that will receive the discount, adding them to the journal.
2. Cashier taps the Sale Discount button. (You can choose your own button name.)
3. Cashier can manually enter the discount, or it can be a preset amount off or a percent off.
4. NSPOS reduces the price of items above the discount line in the journal.
5. Cashier scans additional items for purchase at their regular price or other promotional price.

Mapping a Button for the Grouping Transaction Discount

To prepare your registers to group transaction discounts, you must map one or more buttons in NSPOS. The number of buttons depends on the functionality desired. Note that NSPOS distributes transaction discounts evenly across all items affected. When applied, a 10% transaction discount deducts 10% from the price of each included item.

You can preset a default discount amount by adding a parameter to a button function, or you can leave the parameter empty to require the cashier to enter the discount each time. If a parameter is used, the cashier can override the preset discount if allowed. The parameter is the Discount ID assigned to a Discount Item in NetSuite ERP plus a value.

The available functions tied to NSPOS messages are:

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>MESSAGE</th>
<th>RESULT</th>
</tr>
</thead>
</table>
| Distribute Transaction Discount | DistributeTransactionDiscount | ■ Distributes a transaction discount to all items currently in the journal. The cashier taps the button after tapping a different button to add the discount.  
■ Use this function when you do not want NSPOS to automatically distribute the discount. |
| % Sale Discount and Distribute | Transaction.DiscountWithDistribution | ■ Adds and distributes a transaction discount to items currently in the journal. The default discount is a percent off. For example, Sale % Off.  
■ You can use the Parameter field to map the button to a different Discount Item ID, enabling a different discount type and a default value. |
| $ Sale And Distribute | Transaction.DiscountAmountOffWithDistribution | ■ Adds and distributes a transaction amount off discount to all items currently in the journal. For example, Sale $ Off. |
You can use the Parameter field to enter a default amount off. It is not necessary to include a Discount Item ID before the discount value.

You cannot set this function to percent off.

Important: If you have questions about any step or cannot locate the new functions, please open a case with Customer Support as soon as possible.

A. To open the Button Edit screen for Discounts:

1. Sign on to a NSPOS register as an administrator.
2. Tap Manager Functions > System Configuration > Button Edit.
   Or press Ctrl+F12, search for and tap Button Edit.
3. Tap the Side button bar option and tap Pages.
4. Tap Discounts.
5. Tap Activate so that you can see the changes immediately.
6. Tap Buttons.

B. Add the Button

1. Tap New.
2. In the top right-hand field, search for the desired message. You can copy and paste from this PDF or Help Center topic. Choose one:
   - DistributeTransactionDiscount
   - Transaction.DiscountWithDistribution
   - Transaction.DiscountAmountOffWithDistribution
3. Tap the function returned by the message search.
4. Enter a name for the button in the Caption field or leave it at the default.
5. Choose a color from the Style list.
6. Set the placement for your button by changing the Column and Row fields.
7. If you want to make your button smaller or larger, adjust the Width and Height.
8. If you do not want to add a Parameter, close the Button Edit form. Your task is complete.

9. For the function: % Sale Discount and Distribute, message: Transaction.DiscountWithDistribution, you can add a Parameter to map to a different Discount Item ID. This will provide a discount type and optional value that is different from the default.

You will need the ID of the Discount Item in NetSuite ERP.

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Accounting > Items.
3. Expand the Filters and select a Type of Discount.
4. Click View by the desired Discount Item.
5. With the Discount Item displayed, note the id= at the end of the URL in your browser’s address bar. For example:

   https://system-na2.netsuite.com/app/common/item/item.nwl?id=150

   This example Discount Item ID is 150. Record the ID shown in your address bar.
6. On the Function field, tap the Edit icon.
7. Enter the **Discount Item ID** in the NSPOS **Parameter** field.

10. Tap **Done**.

11. Close the **Button Edit** form when your setup is complete.

**Important:** Repeat all steps for one register in each Workstation Group.

---

**Returns**

A return is when a customer makes a purchase and then later decides the item is unwanted or does not meet their needs. They return the item to the retailer, requesting a refund or item exchange. Gift recipients who are not the original customer might also return an item. In NetSuite Point of Sale (NSPOS), customers or recipients can return items to any store or location that is using NSPOS within the retailer's NetSuite ERP subsidiary.

NSPOS provides two methods for accepting returns from a customer:

- **Return with Receipt** – A return that requires locating the original transaction. This can be done either through scanning the receipt or looking up the sales transaction by date, customer, or other criteria. Also called a validated return, this type of return can reduce fraud and mistakes.

- **Return without Receipt** – A return that does not require the customer to provide a receipt or the cashier to find the original transaction as proof of purchase. The cashier scans the item bar code or looks up the item on the register to determine the amount to refund.

Your customers can receive a refund in cash, as a gift card, or have it credited to a credit or debit card. If they want a refund to the credit or debit card originally used, they are not required to have that card on hand to swipe. Another refund option is to exchange the item by making a return and then purchasing a replacement.

NSPOS displays a **RETURN** watermark on the Journal line item. Unless the cashier adds items for purchase, the Journal shows the amount to be refunded as **Change**.
**Important:** If the customer purchased the returned items using a gift card, the cashier cannot put the refund on that card. The refund can be provided on a new gift card if desired.

**Warning:** If the return is an exchange, where the original item is replaced by a new item within the same transaction, any current promotions available for the new item will not be applied. To use a promotion, 1) refund the original item in one transaction and 2) purchase the new item in a separate transaction.

For detailed steps to making returns, see:
- Return with Receipt
- Return without Receipt
- Apply Refund to a new Gift Card

Also see:
- Considerations on Returning BOGO and other Promotional Items
- Validated Return Transaction Lookup
- Configure Return Settings
- Configure Refund Limits by Tender

### Return with Receipt

Also called a **validated return**, return with receipt is a feature that you can use to authenticate the original purchase before issuing a refund. The cashier validates the return against an NSPOS transaction by scanning the receipt or looking up the sale by date, customer information, or other criteria. Validated returns can reduce fraud and mistakes.

The cashier can find the original purchase regardless of whether it was done from an NSPOS register or through another application using a NetSuite ERP Invoice record or Cash Sale record.

**Note:** Some retailers require refunds to be in the same tender type as the original transaction. This means refunding credit cards purchases back to the original card and refunding cash with cash.

Other retailers prefer to avoid credit card payment-gateway transaction fees for a zero-sum sale by only providing refunds in cash or gift cards/certificates. Refunding as store credit is not an option in NSPOS.

Administrators can limit the defaults for a cashier’s transaction searches, such as search this store only vs. search all stores. NSPOS can also search for transactions posted to NetSuite ERP Invoice or Cash Sale records. See Configure Return Settings.
To find the transaction number needed to accept the return, the cashier can scan the barcode on the customer's receipt, enter the barcode numbers manually if the receipt is damaged, or search for the transaction at the register.

**Note:** Because sales transactions take about five minutes to replicate to other registers, a transaction made on one register may not be immediately eligible for return on another register.

Also see:
- Considerations on Returning BOGO and other Promotional Items
- Considerations for Returns after Tax Adjustments to Discounts

**To make a validated return in NSPOS:**

The cashier can scan the barcode on the customer's receipt, enter the barcode number manually if the receipt is damaged, or they can search for the transaction through the register.

1. In Sales Mode, tap **Voids/Returns**.

2. On the sidebar, tap **Return Receipt Search**.

3. If you have the receipt, scan it or enter it manually.

Otherwise, tap the red ✗ to search for the transaction.

See [Validated Return Transaction Lookup](#) for details on the different criteria available for searches.
4. Tap the items to return or tap Return All to refund the entire purchase.

The form displays the following for each item:

- **Quantity** – How many items were purchased.
- **Returned** – How many items from this transaction were previously returned.

**Important**: If an entire item quantity was previously returned, that item will not appear in the list.

- **Price** – Price at which each item was sold, after any discounts or promotions. See Considerations on Returning BOGO and other Promotional Items.
- **Price Total** – Total paid for the item quantity, after any discounts or promotions. The total is reduced by any items previously returned.
- **SKU** – The retailer stock keeping unit (SKU) identifier. This is your internal saleable item number or code.

5. Tap the item and enter the **Number to return** (quantity). NSPOS lists the maximum number of eligible items.
6. Repeat for other items to return as needed. Tap **Done**.

7. Select a **Reason Code** and tap **Done**. Select the code that most closely matches the customer's reason for the return.

8. Verify that the item appears in the Journal and you see:
   - The item line displays a RETURN watermark.
   - The transaction shows **Change** due to the customer instead of Amt Due.
9. Tap **Change** and select the payment option for the refund.

10. Refund the change due to the customer or the customer’s card.

11. Provide the return receipt to the customer.

   If the return receipt includes a copy with a signature line, ask the customer to complete all required information. Place the completed receipt in your cash drawer and hand the customer their copy.

**Note:** Searching for the transaction again will display any items still eligible for return, including the number of those items that were previously returned. If all quantities for an item were returned, that item will not appear in the list.

**Considerations on Returning BOGO and other Promotional Items**

The NSPOS **Returnable Items** form shows the price at which each item was purchased. It does not show any promotions or discounts that were applied to calculate that purchase price. Nor does it show if a promotion or discount is still valid for current purchases, such as exchanges.

Cashiers should watch for returns that might have been part of a Buy One, Get One (BOGO) promotion. BOGOs often include a free or heavily-discounted “reward” item for purchasing a “trigger” item at the regular price. A customer might attempt to return the regular-priced trigger item and keep the reward item. The Returnable Items form will show the purchase price for BOGO reward items as zero or a value lower than would be considered normal.

Returns for promotional or discounted items should be covered by company policies and watched for by the cashier. NSPOS does not monitor trigger and reward item pricing for returns.

**Important:** Watch for free or heavily-discounted items that might identify BOGO item returns.

**Considerations for Returns after Tax Adjustments to Discounts**

Usually the tax rate applied to a discount will be the same as the tax rate applied to the items sold. However, an administrator can make adjustments to tax rates associated with different parts of a transaction.

If a shopper returns an item purchased at a discount, and the tax for the discount was changed after the purchase, the refund amount will show the original taxes paid. This variance from the original and current discount tax rate could result in a difference between amounts logged for the transaction in NSPOS and the amount listed in NetSuite ERP.
Because NetSuite ERP does not prevent an administrator from making tax changes, the NetSuite customer is responsible for discrepancies in refund amounts caused by changing the tax rate applied to discounts.

**Important:** The NetSuite customer is responsible for discrepancies in refund amounts caused by changing the tax rate applied to discounts.

### Validated Return Transaction Lookup

If no receipt is available, use the transaction lookup form to search for transactions that will validate the return. By default, the search includes all stores in your subsidiary and all sales processed through NetSuite ERP.

Administrators can limit transaction searches to the original store or exclude sales made through NetSuite ERP. See [Configure Return Settings](#).

1. Tap **Voids/Returns** and then **Return Receipt Search**.
2. Tap the red 

3. Complete one or more search fields. Entering criteria in multiple fields will narrow your search.
4. Tap **Done** to perform the search.

- **Customer** - Enter a portion of the customer's name or tap **Look up customer**.
- **Item** – Enter a portion of the item name or tap **Look up item**.
- **Transaction amount** - Enter a **Minimum amount** or a **Maximum amount** to locate the transaction by how much the customer paid. For example, if the transaction is estimated to
have been over $30.00, enter 30.00 as the minimum amount. You can enter amounts in both fields to search within a range.

**Note:** This form does not use decimal assumption to automatically add decimal places to an amount.

- **Transaction date** – To locate the transaction by the purchase date, enter a **From** or **To** date and check the box to the left of that date.
  Enter and check both dates to search within a range.

- **Extended search > Include all stores in search** – Leave checked to search all stores within your subsidiary. Clear the box to limit the search to your store.

- **Optional Extended search criteria:** This criteria appears if enabled by your administrator. See [Set Extended Search defaults for Validated Return Transaction Lookups](#).

- **Extended search > Include NetSuite sales** – Leave checked to search for transactions from applications that post to NetSuite ERP Invoice or Cash Sale records. Clear the box to limit the search to store purchases.

- **Extended search > External ID** – The ID used in the transaction that is sent from NSPOS to NetSuite ERP. The External ID is a hidden field on the Invoice record.

- **Extended search > Invoice Document ID** – The Document Number shown on the NetSuite ERP Invoice record.

OR
Extended search > Sales Order Document ID – Similar to the Invoice Document ID, but because the ID is associated with a sales order, it will include all invoices linked to that order.

Return without Receipt

Also called a non-validated return, this return type does not require the cashier to locate the original transaction using a customer receipt or other criteria. Instead the cashier scans the returned item to determine the refund amount. This method is generally quicker than a validated return, but is also more prone to fraud.

It is the store’s responsibility to manage policies around non-validated returns. Because there is no proof of purchase, there is also no proof of the price for which the item sold. NSPOS will list the item at its current price.

Restricting non-validated returns

Administrators can require that cashiers receive approval before making non-validated returns by assigning a high Resource ID to the Return w/o Receipt button. The cashier is prompted that the return cannot proceed until a store manager or other role with that Resource ID or higher enters their credentials. See Set Button Security in the NetSuite POS Administrator Guide. Log into NetSuite before clicking the link.

To make a return without receipt in NSPOS:

The cashier scans or looks up the item and NSPOS provides the refund amount using the item’s current price.

1. In Sales Mode, tap Voids/Returns.
2. On the sidebar, tap Return w/o Receipt.

3. At the **Scan or enter the barcode** prompt, do one of the following:
   - Scan the returned item.
   - Enter the item bar code and tap the green check mark.
   - Tap the red to search for and tap the item. You can also drill through your item list to find a match.

4. Select a **Reason Code** and tap Done.
   Select the code that most closely matches the customer’s reason for the return.
5. Verify that the item appears in the Journal and you see:
   - The item line displays a RETURN watermark.
   - The transaction shows Change due to the customer instead of Amt Due.

6. Tap Change and select the payment option for the refund.
7. Refund the change due to the customer or the customer’s card.
8. Provide the return receipt to the customer.
   If the return receipt includes a copy with a signature line, ask the customer to complete all required information. Place the completed receipt in your cash drawer and hand the customer their copy.

Apply Refund to a new Gift Card

Follow these steps to apply a returned item refund to a gift card in NetSuite Point of Sale (NSPOS). Funds must go to a new gift card; you cannot add funds to an existing card, even if it was used to purchase the items originally.

**To apply a refund to a new gift card:**

1. From the Main (bottom) button bar, tap Voids/Returns.
2. Choose the type of return:
   - **With a Receipt**
     1. Tap Return Receipt Search.
     2. Scan the receipt barcode or enter the transaction number from the receipt.
     3. If prompted, find and select the Customer.
     4. Select the items to return. For all items, tap Return All.
     5. If prompted, select a Reason Code.
   - **Without a Receipt**
     1. Tap Return w/o Receipt.
     2. Scan the item barcodes or enter manually.

**Note:** Your administrator can create custom Reason Codes to fit your business processes. See Reason Codes in the NSPOS Administrator’s guide. Log into NetSuite before clicking the link.
3. If prompted, select a Reason Code.

3. When all return items appear in the journal, tap Sell Gift Card or Issue Gift Card from the right button bar.

4. Enter the amount to add to the new Gift Card. This should match the item return total, including taxes.

5. Swipe the Gift Card or enter the Gift Card number and authorization code printed on the card.

6. Tap AMT DUE. This should now be $0.00.

7. Select a payment method of Cash. This completes the transaction and prints the receipt.

8. Give customer the printed receipt. This provides the returned item list and details about the Gift Card.

Customer must wait 15 minutes before checking balance or using the Gift Card.

Configure Return Settings

Administrators can configure NSPOS return options to:

- Set the Maximum Days to make a Return
- Set Requirement for Refunds in Original Tender
- Set Extended Search defaults for Validated Return Transaction Lookups
- Require Cashier to enter Customer Name for Non-Validated Returns

**Note:** Because these are Universal Settings, you do not have to repeat these steps for each workstation group. Changes apply to all groups and locations.

**Important:** The Ctrl+F10 > Universal Settings > Returns search results will list several options for returns that are not covered in this guide. You should only adjust the settings described here and ignore the rest.

To update a setting:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F10 to open the Universal Settings form.
3. In the search field, enter either Returns or part of the flag check box name.
4. Check, clear, or enter a value as desired to configure returns.
5. Tap Done when complete.

Changes are applied immediately to the current register. Changes are applied to other registers the next time NSPOS is closed and restarted on those registers.

Set the Maximum Days to make a Return

Enter the maximum number of days in which your store will accept an item for a return. The number of days begins on the purchase transaction date. If the day limit has passed and a customer still wants to make a return, NSPOS prompts the cashier for manager approval. The cashier can tap Cancel to reject the return without seeking approval.
Set Requirement for Refunds in Original Tender

Use these options to set how the cashier can tender refunds based on the tenders used in the original transactions.

This topic applies to NSPOS 2018.2.0 and greater.

- **Disable Original Card Supported** – If your payment gateway automatically applies credit card purchase refunds back to the original credit card, this option disables that rule. The default is no (cleared).

- **Refunds Require Original Tender** – Requires all refunds to be made in the same tender as the original purchase. For example, refunds to credit card purchases must be refunded to a credit card. Cash purchases must be refunded in cash.

  Leave the box clear to enable credit card purchases to be refunded in cash or gift card. Allowing alternate refund tenders might help you avoid paying multiple gateway fees for what began as a single credit card purchase. The default is no (cleared).

- **Refunds Use Original Tender Thresholds** – If the original purchase was split-tender, such as 70% gift card and 30% cash, the refund must provided in the same tenders and amounts. (Note that you cannot refund to an original gift card; it must go to a new gift card.) The default is no (cleared).

The **Refunds Require Original Tender** feature requires cashiers to tender refund payments in the tender type used for the original purchase. This register option provides flexibility in configuring refund processes to be in line with your business needs. It applies to validated returns only. Validated returns use the receipt or transaction history to verify the purchase, price and tax rate charged.

If you set the requirement, purchases tendered in cash must be refunded in cash. Refunds for credit or debit card purchases go directly to the original card used. If the original purchase was split-tender, such as 70% gift card and 30% cash, the refund must provided 70% to a new gift card and 30% as cash.
The refund tender requirement applies to all stores within a single subsidiary. The default for this flag is no (cleared).

✅ Tip: NSPOS will not always provide a method for determining the original tender. The cashier might need to attempt the refund as cash tender first. If the tender is incorrect, NSPOS will prompt the cashier with the tender to use.

### Swipe-free Refunds

Most payment gateway integrations can make refunds to the purchase credit card without the need to swipe the card in the PIN pad. Swipe-free is only available for registers within the same subsidiary.

ℹ️ Note: For releases prior to 2018.2.0, swipe-free refunds can be processed from the register used to make the original purchase only.

### Set Extended Search defaults for Validated Return Transaction Lookups

If no receipt is available to validate a return, cashiers can use the lookup form to search for the original transaction. By default, in the **Extended search** section, the cashier only sees the option to include all stores in the search:

However, administrators can choose what areas are included in an extended search, and whether the cashier can adjust those areas. If you enable NetSuite Sales as criteria, the search can include the External ID, the Invoice Document ID or a Sales Order Document ID.

Use the following settings to adjust the cashier's default criteria for extended searches and control whether the cashier can change those defaults.

⚠️ Important: Including **all stores** and/or **NetSuite sales** can slow search performance at the register. Restricting lookups to a register’s current location can increase performance.

#### Extended Search: Include all stores in search

- **Include all stores default value** – Check the box to include the "all stores" criteria option in the lookup form. The criteria searches for NSPOS transactions across all locations within the store's subsidiary.
If the option is cleared, searches are restricted to only registers within the current location. The default is yes (checked) to include all stores.

- **Include all stores enabled** – Check this box to enable cashiers to check or clear the lookup form option to include all stores. The default is no (cleared).

Extended Search: Include NetSuite sales

- **Include NetSuite sales default value** – Check the box to include the “NetSuite sales” criteria option in the lookup form. The criteria searches for transactions from applications that post to NetSuite ERP Invoice or Cash Sale records.
  
  This setting also displays fields for an External ID and other ID-based criteria. The default is no (cleared).

- **Include NetSuite sales enabled** – Check this box to enable cashiers to check or clear the lookup form option to include NetSuite sales. The default is no (cleared).

**Require Cashier to enter Customer Name for Non-Validated Returns**

You can require the cashier to enter the customer’s name if the customer is making a non-validated (without receipt) return. The flag can be found in the General section of the Universal Settings, and is called **NonValidatedReturnsReqCust**.

- **Note:** Because validated returns use the transaction information from a look up or from the receipt, entering a customer name to be associated with the original purchase should not be required. Unless the Anonymous Customer was selected, the customer’s name will already be associated with the transaction.

**To require entering the customer’s name for non-validated returns:**

1. Sign in to any NSPOS register as an administrator (9090 level operator).
2. Press Ctrl+F10 to open the Universal Settings form.
3. In the search field, enter NonValidated.
4. Check the NonValidatedReturnsReqCust option.
5. Tap Done.
Changes are applied immediately to the current register. Changes are applied to other registers the next time NSPOS is closed and restarted on those registers.

Configure Refund Limits by Tender

You can enter maximum refund amounts for each tender type that you accept. For example, you can set a one limit for cash refunds and set a different limit for refunds posted to a credit card. Setting maximum refund amounts can limit the loss you might incur from a fraudulent refund.

In addition to every tender type having a different refund limit, you can set maximum amounts for Return with Receipt and Return without Receipt.

You can also set minimum refund amounts. Usually applicable to credit card tenders, setting a minimum can prevent giving refunds for amounts that are less than the processing fee charged by your payment gateway.

If a cashier attempts to provide a refund in a tender with limits that are less than the minimum or more than the maximum, the cashier must get a manager’s or administrator’s approval.

If a manager or an operator with an administrative role is handling the refund, they can tap Yes at the prompt and proceed with the transaction. Otherwise, the following appears:

Permission Required

Permission is required for the following action:
The Cash tender amount of ($86.11) is more than the maximum refund amount of ($50.00).

Please enter your credentials below to allow the process to continue:

User ID: [blank]
Password: [blank]
To set tender limits for returns:

1. Sign in to any NetSuite POS register as an administrator (9090 level operator).
2. Press Ctrl+F12 and search for Edit Tenders.
3. Tap Edit Tenders.
4. Tap a tender type, such as Cash. You will perform this task for each tender type desired.
5. Locate the Tender Minimum Refund and Tender Maximum Refund fields.

   ![Tip: Scroll to the right.]

6. Enter a Tender Maximum Refund amount without a currency sign. This is the maximum refund that can be given for the tender type without a manager's approval.
7. If desired, enter a Tender Minimum Refund. Usually applicable to credit card tenders, some retailers do not want to refund an amount that is less than the payment gateway fee required to process it.
8. If desired, enter a Tender Maximum Validated Refund to set a higher limit for a Return with Receipt refund.
9. Tap Done when complete.
10. Repeat for other tender types as desired. Changes are applied immediately to the current register. Changes are applied to other registers the next time NSPOS is closed and restarted on those registers.
COMPANY

Applies to: NetSuite Point of Sale (NSPOS)

Use this chapter to manage internal tasks related to your store personnel and to the reports that track business results in NetSuite Point of Sale (NSPOS).

- Employees in NSPOS
- Reports

Note that NSPOS has its own reports engine. Similar reports can be found in NetSuite ERP and saved searches from ERP data can be used as a method to create your own reports.

Employees in NSPOS

Applies to: NetSuite Point of Sale (NSPOS)

We call employees or users that perform NetSuite Point of Sale (NSPOS) register tasks or are responsible for maintaining the application operators. Operators include all positions below. The list of duties is not comprehensive. These are brief descriptions only and your business may use its own customized positions or roles.

- Sales Associates – Perform sales transactions and work with customer information.
- Specialists – Perform tasks that require training and responsibilities beyond a basic sales associate.
- Openers/Closers – Perform sales associate and specialized tasks plus can be delegated to perform beginning of day and end of day till tasks.
- Managers – Perform beginning of day and end of day till tasks, can sign in during transactions to authorize discounts or other overrides, run reports and assist employees with optional time clock issues.
- Administrators – Set up employees, customize NetSuite POS to fit business needs, perform other tasks described in this guide.

Roles and Permissions

In NetSuite POS, we grant permissions using roles / groups that are assigned to Resource IDs:

<table>
<thead>
<tr>
<th>Operator Role / Group</th>
<th>Operator Role / Group ID</th>
<th>Resource ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Associate, Cashier, xPOS Access</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>Specialist</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>Opener / Closer</td>
<td>500</td>
<td>9050</td>
</tr>
<tr>
<td>Manager</td>
<td>700</td>
<td>9070</td>
</tr>
<tr>
<td>System Administrator</td>
<td>900</td>
<td>9090</td>
</tr>
</tbody>
</table>

Each Resource ID provides a basic set of permissions that are typical for retail transactions, such as processing sales, taking returns, applying discounts and entering customer information. Managers are assigned roles with Resource IDs that have greater permissions, allowing overrides and other high-level functions not available to sales associates. Administrators have Resource IDs that include permissions to access and configure almost any area in the NetSuite POS application.
When an operator tries to access a function not available to their Resource ID, an authorization override window displays that may include manager steps for authorizing the operator to proceed.

As an administrator, you can adjust security by assigning roles to employees and adjusting the Resource IDs required to access function buttons and pages. This chapter lists steps to adjust security roles at the employee level only. To adjust the role required to access a function, see Set Button Security and Set Page Security. Most employee-setup tasks, including editing an existing operator or unlocking an account, require 9090 level access.

Passwords and Lockouts

Signing into NetSuite POS requires entering a User ID and Password. NetSuite POS uses the Payment Application Data Security Standards (PA-DSS) to determine requirements for setting and maintaining passwords.

NetSuite POS security requirements include the following standards for administrator accounts:

- Passwords must be at least 7 characters and include both letters and numbers.
- Passwords must change every 90 days.
- New passwords must be different than the previous 5 passwords.

For managers, sales associates and other employees, the administrator is responsible for setting up their passwords per your store or company's policies. Administrators are also responsible for updating operator passwords. Sales associate and other non-system administrator passwords do not expire. Follow PA-DSS guidelines on passwords to ensure your store is in compliance.

Accounts will lock after five sign-on attempts that fail due to entering an incorrect password. This will block access to the register for the operator. Administrators are responsible for unlocking accounts. See Unlock an Employee’s Account for NSPOS. Contact NetSuite Customer Support if you need more information or assistance.

Idle Time-Outs

It is important that an NSPOS register not be left unattended. The methods used to lock out a register if it is left idling depend on the cashier or other user’s role.

For users logged into NSPOS with an administrator role:

- If a register is left idle for 15 minutes, the administrator is logged off and the register switches to Closed Mode. Access to NSPOS from the register is denied until that user or another user signs on again.

For all other user roles:

- The register will not time out through NSPOS. Instead, Windows® screen-saver lock methods should be used to secure the register if left unattended.

Employee Setup and Admin Tasks

Use these tasks to work with your employee setups.

Employee Setup

- Set up a New Employee in NSPOS
- Unlock an Employee's Account for NSPOS
- Reset an Employee's Password for NSPOS
Employees in NSPOS

- Change an Employee's Security Role for NSPOS
- Disable an Employee's Access to NSPOS

General Administration

- Work with the optional Time Clock in NSPOS

Click a link to display the steps and details.

**Important:** Some customized setups do not display a Manager Functions button. To cover those scenarios, the steps in this chapter include locating functions using Ctrl+F12.

Set up a New Employee in NSPOS

As an administrator, you manage the NetSuite Point of Sale (NSPOS) employee setup for your business. This task takes place in the NetSuite online application and in the manager tools in NetSuite POS. Employees are called operators in NetSuite POS.

1. Create the NSPOS Employee record and RA-Operator ID in NetSuite
2. Complete the Operator setup in NSPOS 2018.2.x

**Warning:** Follow these steps to set up employees. Do NOT use the Create Operator button in NetSuite POS.

Create the NSPOS Employee record and RA-Operator ID in NetSuite

This task requires an administrator login to NetSuite. The RA-Operator ID becomes the User ID the employee will use to sign in at the register.

**To create an employee and assign an ID:**

1. Log in to NetSuite ERP as an administrator.
2. Go to Lists > Employees > Employees > New.

   **Note:** To update an existing employee, go to Lists > Employees > Employees > Search.

3. Under Custom Form, select RA-Employee Form.
4. For RA-Operator ID, enter the User ID the operator will use to sign on to NetSuite POS. Common choices are your internal employee number or the operator's first initial, last name. Do not include spaces.

   **Important:** The RA-Operator ID is also the user's temporary password. You will change this in the NetSuite POS steps.

   **Note:** The password fields under Access are for signing into the NetSuite online application. Because most employees will not need this access, you can leave these fields blank.

5. Enter the employee's Name. Other informational fields, such as Phone and Email, are optional.
6. On the Info subtab, select the employee's Subsidiary company. This is the company or division under which they will work. Select Parent Company to allow all subsidiaries.
7. Click Save.
8. Before beginning the next set of steps, allow at least 15 minutes for this information to synchronize with your NetSuite POS registers.

Complete the Operator setup in NSPOS 2018.2.x

Follow these steps to complete the operator setup for the employee in NSPOS 2018.2.x. This setup includes assigning a location and setting a security role.

About employee customer records: To simplify administration, and because employees often make purchases as customers, each operator is associated behind the scenes with a customer record. This customer record is automatically assigned to the Employee customer group and may be eligible for automated employee discounts your business may provide.

Note: By default, the Manager Functions button is located on the main (bottom) button bar in the Journal window. Your company's custom setup may have the button in a different location or under a different name.

To complete the operator setup using Manager Functions:

1. Log into NSPOS as an administrator.
2. Tap Manager Functions.
3. Tap Team Mgt.
4. Tap Associates.
5. Search for the new operator by last name or open an operator group.
6. Tap the operator record to open.
7. Adjust the Operator Role and Location as desired.
   - Operator Role – By default, the Operator Role is set to Specialist or Cashier (sales associate). You can change this to Manager or another role by tapping the browse icon. The ability to quickly change roles is helpful for when you need to temporarily assign a sales associate/cashier to a manager role to cover a shift. You can reverse this later.
   - Location – By default, new operators are authorized to work at any Location, but you can limit this by tapping the browse icon and choosing locations.
8. Tap Set Password to set the new operator's password. Tap Change to save.
9. Tap Done when your setup is complete.

To complete the operator setup using Edit Operator:

1. Press Ctrl+F12.
2. Search for edit operator.
3. Tap Edit Operator.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Adjust the Operator Role and Location as desired.
   - Operator Role – By default, the Operator Role is set to Specialist or Cashier (sales associate). You can change this to Manager or another role by tapping the browse icon. The ability to quickly change roles is helpful for when you need to temporarily assign a sales associate/cashier to a manager role to cover a shift. You can reverse this later.
Location – By default, new operators are authorized to work at any Location, but you can limit this by tapping the browse icon and choosing locations.

7. Tap Set Password to set the new operator’s password. Tap Change to save.
8. Tap Done when your setup is complete.

Unlock an Employee’s Account for NSPOS

Follow these steps to unlock a NetSuite Point of Sale (NSPOS) account that is locked due to five or more incorrect sign on attempts.

Note: By default, the Manager Functions button is located on the main (bottom) button bar in the Journal window. Your company’s custom setup may have the button in a different location or under a different name.

To unlock an account using Manager Functions:

1. Tap Manager Functions.
2. Tap Team Mgt.
3. Tap Associates.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap Unlock User.
7. At the prompt, tap Yes.
8. Tap Done.

To unlock an account using Edit Operator:

1. Press Ctrl+F12.
2. Search for edit operator.
3. Tap Edit Operator.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap Unlock User.
7. At the prompt, tap Yes.
8. Tap Done.

Reset an Employee’s Password for NSPOS

Follow these steps to reset a NetSuite Point of Sale (NSPOS) password. This procedure can be used when they have forgotten their password, believe it has been compromised, or as part of a standard security task.

Note: By default, the Manager Functions button is located on the main (bottom) button bar in the Journal window. Your company’s custom setup may have the button in a different location or under a different name.

To reset a password using Manager Functions:

1. Tap Manager Functions.
2. Tap Team Mgt.
3. Tap Associates.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap Set Password.
7. Enter the new Password.
8. Enter the password again to Confirm.

To reset a password using Edit Operator:
1. Press Ctrl+F12.
2. Search for edit operator.
3. Tap Edit Operator.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap Set Password.
7. Enter the new Password.
8. Enter the password again to Confirm.

Change an Employee’s Security Role for NSPOS

Follow these steps to adjust a NetSuite Point of Sale (NSPOS) security role assignment. This can be used for permanent assignments or to temporarily assign a sales associate/cashier to a manager role to cover a shift. You can reverse temporary assignments later by following these same steps.

**Note:** By default, the Manager Functions button is located on the main (bottom) button bar in the Journal window. Your company’s custom setup may have the button in a different location or under a different name.

To change a role assignment using Manager Functions:
1. Tap Manager Functions.
2. Tap Team Mgt.
3. Tap Associates.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap the Operator Role browse icon and select the new role.
7. Tap Done.

To change a role assignment using Edit Operator:
1. Press Ctrl+F12.
2. Search for edit operator.
3. Tap **Edit Operator**.
4. Search for the new operator by last name or open an operator group.
5. Tap the operator record to open.
6. Tap the **Operator Role** browse icon and select the new role.
7. Tap **Done**.

**Disable an Employee’s Access to NSPOS**

You can remove an employee’s access to sign into NetSuite Point of Sale (NSPOS) by setting their role to Disabled. This role change does not remove the employee from the system, but it does lock them out. Keeping the employee in the system is important in the event you must research their NSPOS history.

**To disable an employee’s access by changing their role:**

1. Sign in to any NSPOS register as an administrator (9090 level operator).
2. Press **Ctrl+F12** on the keyboard to open the Function List.
3. Enter **edit operator** in the search field.
4. Tap **Edit Operator**.
5. Search for and tap the operator’s name.
6. Tap the **Operator Role** browse icon.
7. Select **Disabled**.
8. Tap **Done**.

**Work with the optional Time Clock in NSPOS**

NetSuite Point of Sale (NSPOS) includes optional time clock features to allow employees to log the beginning and end of their work shift. Because it is optional, it may not be installed for your business. If it is installed, any employee set up in NSPOS can clock in and out at any register. The time clock is separate from the register sign on / sign off required to perform sales transactions. Employees temporarily taking over the screen to clock in or clock out do not affect the status of a signed on operator.

**Note:** We do not integrate the POS time clock with NetSuite or any third-party software.

You or a manager can use the **Time Punch Report** to review time clock entries and provide them to your human resources department.

**To clock in or clock out:**

1. In **Sales Mode** or **Closed Mode**, tap the **Clock In** or **Clock Out** button.

   **Note:** If the register is in **Sales Mode** and has a sales transaction on screen, the sales associate must complete or cancel the transaction. The time clock is not available during a transaction.

2. Enter your **User ID** and **Password**.
3. Tap **Confirm**.
4. Tap the **Time clock operation successful** prompt to close it.
Edit Time Clock Punch

Use Edit Time Punch when an employee has already clocked in or out, but the time logged is incorrect. For example, you can edit a time punch when an employee clocked out but continued to work when they realized their help was still needed.

**Note:** By default, the Manager Functions button is located on the main (bottom) button bar in the Journal window. Your company’s custom setup may have the button in a different location or under a different name.

**To edit a time clock punch:**
1. Tap Manager Functions.
2. Tap Team Mgt.
3. Tap Edit Time Punch.
4. Search for and select the Worker (employee).
5. Search for the existing Time Punch Entry.
6. Select a Reason for the edit.
7. For Correct Time field, select the desired time punch date and enter the time.
8. Tap Done.

Create Time Clock Punch

Use Create Time Punch when an employee forgot to clock in and/or out.

**To create a new time clock punch:**
1. Tap Manager Functions.
2. Tap Team Mgt.
3. Tap Create Time Punch.
4. Select the Punch Direction. Clocking in and out each requires a separate time punch.
5. Search for and select the Worker (employee).
6. For Time field, select the time punch date and enter the time.
7. Tap Done.
8. Repeat if needed to show both clock in and clock out for a shift.

Reports

**Applies to:** NetSuite Point of Sale (NSPOS)

NetSuite Point of Sale (NSPOS) includes a variety of reports. Each report appears in a separate window where you can preview results and refine your criteria before saving or printing. In the report viewer tool bar, tap Export to save any report as XML, CSV, PDF, HTML, Excel, TIFF, or Word. Tap Print to send the report to your printer.

The following are core reports supported in NetSuite POS as standard functionality. Most reports have alternates you can run online in NetSuite.

This guide covers the NetSuite POS reports only. To find information on NetSuite reports, including how to run each report, search the NetSuite Help Center using the report name.

Select Reports from a List

If you do not have a NetSuite Point of Sale (NSPOS) report assigned to a button, you can select from the list of all NSPOS reports.

To run a report from the report list:

2. Tap Reports on the main button bar.
3. Tap Reports on the side button bar.
4. Find and tap desired report.

Custom Reports

You can set up saved searches in NetSuite ERP to create custom reports. See Custom Reports using Saved Searches.

Customer Profile Report

This report lists all transaction activities for a customer starting from the date they were first added to NetSuite Point of Sale (NSPOS). You will usually run it after selecting a customer, but you can run it outside of a transaction if you want to manually enter a Customer ID.

Use the report options to run it for a specific date range, print the results, or save and export it in CSV, HTML or other file format.

To run a Customer Profile Report:

1. Use Find Customer to select the customer. You can optionally skip this step to enter a Customer ID from the report window.
2. From the Main button bar, tap Reports.
3. Tap Customer Profile. The customer's report displays.
4. To view details, tap the + sign by the Items Purchased and the year.
5. To show transactions within a date range:
   a. For Start Date, clear the Null check box and select a date.
   b. For End Date, clear the Null check box and select a date.
   c. Tap View Report.
6. To print or save and export the report, choose from the options at the top.
7. Tap X in the upper right to return to the Journal window.

### Customer Profile Report fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Customer Info</strong></td>
<td>Basic customer information, first / last visit dates on which they made a transaction, and the sales associate (operator) ID logged into the register for those transactions.</td>
</tr>
<tr>
<td><strong>Sales</strong></td>
<td>Total customer sales for periods over the last year and over the customer lifetime (since they were added to the system).</td>
</tr>
<tr>
<td><strong>Top 3 Associates</strong></td>
<td>Sales associates that performed the highest-value sales transactions for the customer over a month and the number of units (items) included.</td>
</tr>
<tr>
<td><strong>Items Purchased</strong></td>
<td>Date, location, transaction number (Trx#), sales associate and items purchased, grouped by year and month. Tap + to expand a section.</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Type of transaction: Sale or Return.</td>
</tr>
</tbody>
</table>
Inventory On Hand Report

Use this NetSuite Point of Sale (NSPOS) report to view the quantity available of an item at each location by its item ID or stock keeping unit (SKU).

**To run an Inventory On Hand Report:**

1. **In Sales Mode,** complete all sales transactions.
2. From the Main button bar, tap **Manager Functions** and/or tap **Reports**.

   **Note:** In some setups, this report is located under the **Inventory** menu and is called **Inventory – All Stores**.

3. Tap **Inventory On Hand**.
4. Enter the Item ID or SKU in the **Auto|SKU** field.
5. Tap **View Report**.
6. To print or save and export the report, choose from the options at the top.
7. Tap **X** in the upper right to return to the Journal window.

### Inventory On Hand Report fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Retail</td>
<td>Item's every day retail price.</td>
</tr>
<tr>
<td>Unit Discount</td>
<td>Any discount amount applied to the retail price.</td>
</tr>
<tr>
<td>Net Sales</td>
<td>Unit Price minus Unit Discount.</td>
</tr>
<tr>
<td>Units</td>
<td>Number of items in each transaction, sub-totaled by year and month.</td>
</tr>
<tr>
<td>Period Total</td>
<td>Total value of all sales transactions over the reporting period Start and End Dates. If Null is checked for dates, this is the customer's lifetime net sales total.</td>
</tr>
</tbody>
</table>

### Item Inventory

<table>
<thead>
<tr>
<th>Location ID</th>
<th>Location Name</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>UK Distribution Center</td>
<td>14,000</td>
</tr>
<tr>
<td>13</td>
<td>AU Retail Store 1</td>
<td>1,000</td>
</tr>
</tbody>
</table>

4/22/2016 6:14:32 AM
Items Sold Report

Use this NetSuite Point of Sale (NSPOS) report to view net sales over a specific period for any or all tills, operators, workstations, or stores. The report displays the quantity sold and the number of items returned.

To run an Items Sold Report:

1. In Sales Mode, complete all sales transactions.
2. From the Main button bar, tap Manager Functions and/or tap Reports.
3. Tap Items Sold. The report displays.
4. Tap the + sign by the Total to view details that include specific item numbers, descriptions, sizes, colors, and quantities sold/returned.
5. To adjust criteria, choose from the fields at the top and tap View Report.
6. To print or save and export the report, choose from the options at the top.
7. Tap X in the upper right to return to the Journal window.

### Items Sold

**Demo Retailer**  
**Activity For:** Tuesday 9/19/2016

```
<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Color</th>
<th>Size</th>
<th>Sold</th>
<th>Return</th>
<th>Net Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>25</td>
<td>3</td>
<td>$88.00</td>
</tr>
<tr>
<td>Demo Folder 1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>0</td>
<td>$4.00</td>
</tr>
<tr>
<td>ITM121</td>
<td>Demo_Item_001</td>
<td></td>
<td></td>
<td>1</td>
<td>0</td>
<td>$4.00</td>
</tr>
<tr>
<td>Demo Folder 2</td>
<td></td>
<td></td>
<td></td>
<td>24</td>
<td>3</td>
<td>$84.00</td>
</tr>
<tr>
<td>ITM122</td>
<td>Demo_Item_002</td>
<td></td>
<td></td>
<td>1</td>
<td>0</td>
<td>$4.00</td>
</tr>
<tr>
<td>ITM123</td>
<td>Demo_Item_003</td>
<td></td>
<td></td>
<td>21</td>
<td>3</td>
<td>$72.00</td>
</tr>
<tr>
<td>ITM124</td>
<td>Demo_Item_004</td>
<td></td>
<td></td>
<td>2</td>
<td>0</td>
<td>$8.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>25</td>
<td>3</td>
<td>$88.00</td>
</tr>
</tbody>
</table>
```

### Items Sold Report fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item ID</td>
<td>Item identifier.</td>
</tr>
<tr>
<td>Description</td>
<td>Item description.</td>
</tr>
<tr>
<td>Color</td>
<td>Color assigned as part of Style for matrix items. Most items will not include a color.</td>
</tr>
<tr>
<td>Size</td>
<td>Size assigned as part of Style for matrix items. Most items will not include a size.</td>
</tr>
<tr>
<td>Sold</td>
<td>Number of items sold.</td>
</tr>
<tr>
<td>Return</td>
<td>Number of items returned.</td>
</tr>
<tr>
<td>Net Sales</td>
<td>Net value of items sold. Net Sales = (Sold – Return) x item price</td>
</tr>
<tr>
<td>Folder</td>
<td>Name of NetSuite POS folder or group to which the item is assigned.</td>
</tr>
<tr>
<td>Total</td>
<td>Total</td>
</tr>
</tbody>
</table>
Sales Audit Report

Sometimes called the Daily Sales Report (DSR), the NetSuite Point of Sale (NSPOS) Sales Audit Report is part of the End of Day process. The report runs automatically after counting a till/cash drawer. You can run this manually by following the steps below.

Use this report to review key sales-performance indicators, totals by payment type, and counts for each type of transaction performed. The standard report lists your current location and business day, but you can choose to run it for a different location, specific registers/workstations, operators and tills, and choose a range of business days.

To manually run a Sales Audit Report:

1. In Sales Mode, complete all sales transactions.
2. From the Main button bar, tap Manager Functions and/or tap Reports.
3. Tap Sales Audit. The audit report displays.
4. To show transactions for different locations, workstations, and so on:
   a. Choose from a list or clear a Null check box and enter an ID or select dates.
   b. Tap View Report.
5. To print or save and export the report, choose from the options at the top.
6. Tap X in the upper right to return to the Journal window.
# POS Sales Audit

**Location 3**  
Activity For: Wednesday 1/6/2016

## Key Performance Indicators

<table>
<thead>
<tr>
<th>Field</th>
<th>Count</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail Transaction Count</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Net Units Sold / Net Sales</td>
<td>4</td>
<td>$100.00</td>
</tr>
<tr>
<td>Average Units per Tx / Average Sale Amount</td>
<td>2</td>
<td>$50.00</td>
</tr>
<tr>
<td>Sales Area Square Footage / Net Sales per Sq Ft</td>
<td>500</td>
<td>$0.20</td>
</tr>
</tbody>
</table>

## Retail Transactions

<table>
<thead>
<tr>
<th>Field</th>
<th>Qty</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Sales</td>
<td>2</td>
<td>$100.00</td>
</tr>
<tr>
<td>Returns</td>
<td>0</td>
<td>$0.00</td>
</tr>
<tr>
<td>Gross Sales Less Returns</td>
<td></td>
<td>$100.00</td>
</tr>
<tr>
<td>Discounts</td>
<td></td>
<td>$0.00</td>
</tr>
<tr>
<td>Net Sales</td>
<td></td>
<td>$100.00</td>
</tr>
<tr>
<td>Tax Collected</td>
<td></td>
<td>$8.75</td>
</tr>
</tbody>
</table>

## Retail Tenders

<table>
<thead>
<tr>
<th>Field</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>$50.00</td>
</tr>
<tr>
<td>Credit Card (EMV)</td>
<td>$50.00</td>
</tr>
<tr>
<td>GIFT Card</td>
<td>$0.00</td>
</tr>
<tr>
<td>Layaway</td>
<td>$0.00</td>
</tr>
<tr>
<td>Personal Check</td>
<td>$0.00</td>
</tr>
<tr>
<td>Special Order</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total Tendered</td>
<td>$100.00</td>
</tr>
</tbody>
</table>

## Tender Control Transactions

<table>
<thead>
<tr>
<th>Field</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disbursement</td>
<td>$10.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Actual Count</th>
<th>POS Count</th>
<th>Over/(Short)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>$94.38</td>
<td>$94.38</td>
<td>$0.00</td>
</tr>
<tr>
<td>Personal Check</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Totals</td>
<td>$94.38</td>
<td>$94.38</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

## Credit Card by Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>MasterCard</td>
<td>$54.37</td>
</tr>
<tr>
<td>Total Credit Cards</td>
<td>$54.37</td>
</tr>
</tbody>
</table>

## Other Statistics

<table>
<thead>
<tr>
<th>Field</th>
<th>Count</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancelled Transactions</td>
<td>1</td>
<td>$75.00</td>
</tr>
<tr>
<td>Line Item Void</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Suspended Transactions</td>
<td>1</td>
<td>$25.00</td>
</tr>
<tr>
<td>Resumed Transactions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Sale Transactions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Override</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Discounts</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

## Sales Audit Report fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Key Performance Indicators</strong></td>
<td>Key indicators that measure store performance by the transactions and units sold based on the size of the sales area.</td>
</tr>
<tr>
<td>Retail Transaction Count</td>
<td>The number of sales or other transactions.</td>
</tr>
<tr>
<td>Net Units Sold / Net Sales</td>
<td>Number of net units sold divided by the net total sales.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Units per Trx / Average Sales Amount</td>
<td>Average units sold per transaction divided by the average sales transaction amounts. Calculations do not include returns. Average Sale Amount = (Gross Sales – Discounts) / Retail Transaction Count</td>
</tr>
<tr>
<td>Sales Area Square Footage / Net Sales per Sq Ft</td>
<td>If available, the square footage of the store area dedicated to merchandise sales divided by net total sales.</td>
</tr>
<tr>
<td>Count</td>
<td>Number of transactions, units sold, average units sold and sales area size.</td>
</tr>
<tr>
<td>Amount</td>
<td>Total amounts and average amounts for each key performance indicator.</td>
</tr>
<tr>
<td>Retail Transactions</td>
<td>Totals from transactions performed at the register during the shift.</td>
</tr>
<tr>
<td>Gross Sales</td>
<td>Gross sales calculated as the total items sold from transactions that were completed. The sum does not include canceled or suspended transactions.</td>
</tr>
<tr>
<td>Returns</td>
<td>The portion of gross sales that were returned.</td>
</tr>
<tr>
<td>Gross Sales Less Returns</td>
<td>Quantity of gross sales remaining after subtracting returns.</td>
</tr>
<tr>
<td>Discounts</td>
<td>Total discounts applied to gross sales without returns.</td>
</tr>
<tr>
<td>Net Sales</td>
<td>Gross sales – (returns + discounts)</td>
</tr>
<tr>
<td>Tax Collected</td>
<td>Total taxes collected.</td>
</tr>
<tr>
<td>Other Credits</td>
<td>Miscellaneous credits applied to transactions during the reporting period.</td>
</tr>
<tr>
<td>Total Net Retail Transactions</td>
<td>Total net sales and tax collected.</td>
</tr>
<tr>
<td>Qty</td>
<td>Number of transaction components.</td>
</tr>
<tr>
<td>Amount</td>
<td>Total value of each transaction component.</td>
</tr>
<tr>
<td>Retail Tenders</td>
<td>Payment types tendered, such as cash or credit card.</td>
</tr>
<tr>
<td>Qty</td>
<td>Number of transactions for each tender type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Total value of transactions by each tender type.</td>
</tr>
<tr>
<td>Tender Control Transactions</td>
<td>Transactions such as disbursements and tender loans that adjust the till totals.</td>
</tr>
<tr>
<td>Amount</td>
<td>Total of each tender control transaction.</td>
</tr>
<tr>
<td>Calculated Over/(Short)</td>
<td>Actual cash and personal check amounts counted versus the amounts processed as transactions in the POS. Used to determine overages or shortages in the till.</td>
</tr>
<tr>
<td>Actual Count</td>
<td>Manual total count from till. In this example, till began the day with $40 cash.</td>
</tr>
<tr>
<td>POS Count</td>
<td>Calculated total till count as determined from the start of day count and all cash or check transactions. This is the expected total. Includes the number of transactions using cash or personal check as the payment method.</td>
</tr>
<tr>
<td>Over/(Short)</td>
<td>The difference between the Actual Count and the POS Count.</td>
</tr>
<tr>
<td>Credit Card by Type</td>
<td>Number of transactions by credit card type, such as MasterCard or Visa.</td>
</tr>
<tr>
<td>Amount</td>
<td>Total transactions for each card type.</td>
</tr>
<tr>
<td>Other Statistics</td>
<td>Counts and totals of events such as canceled or suspended transactions.</td>
</tr>
<tr>
<td>Count</td>
<td>Number of occurrences for each event type.</td>
</tr>
</tbody>
</table>
### Stuck Transactions Report

The NetSuite Point of Sale (NSPOS) Stuck Transactions Report displays POS transactions that did not successfully import to NetSuite ERP during a synchronization cycle. These transactions are held (stuck) on your server. Stuck transactions can result in entries missing from your NetSuite accounting records.

The report provides the warning or error message for each transaction held. Details include line-item information grouped by store, workstation and date. The text used are from standard NetSuite ERP messages, with the same message used for more than one issue type.

**Tip:** Run this report regularly to ensure your transactions are being successfully imported to your NetSuite ERP accounting records.

### Correcting Stuck Transactions

Most transaction errors are handled by an NSPOS corrective script called **IS123**. Those corrected transactions do not become "stuck." The transactions that do become stuck usually require assistance from NetSuite Customer Support. Only a small percentage are correctable by your administrator.

As noted, the same NetSuite ERP error message can be used for more than one issue type, so the cause might need research to discover. Also, Support can clear transactions that are no longer needed by marking them as “sent.”

### Inactive Items in Stuck Transactions

One thing for which customers can check are item records set to **Inactive** in NetSuite ERP. An item that is no longer active, but included in a promotion or other transaction, can cause a transaction to become stuck. Reactivating the item will push the item to your server automatically and often allow the transaction import to complete. You can inactivate the item again later, after allowing time for processing. Waiting a few hours should be enough.

See the procedure called **Making an item inactive** under Working with Inventory Items.

### To run a Stuck Transactions Report:

This report does not come pre-mapped to a button. Instead, you can select it from the Reports list. The report is named as the **RA-ErrorReport**.

2. Tap **Reports** on the main button bar.
3. Tap **Reports** on the side button bar (submenu).
4. Find and tap **RA-ErrorReport** from the list.
Time Punch Report

Your NetSuite Point of Sale (NSPOS) setup might include a time clock feature. Clocking in and out is separate from signing on and off the register and, if available, can be used by all employees, not just sales associates. It can be used even if no one is signed on to the register. However, employees cannot clock in or out while a sales transaction is in progress.

Use this report to list the hours logged through the time clock and the employees that worked them. The default settings are for today's date, all locations and all operators (employees). However, you can run it for different date ranges and specific locations and operators. The first page is a summary; details for each operator list on separate pages.

The time clock includes the ability for a manager to create or edit a time punch on behalf of an employee. This is found under Manager Functions > Team Mgt > Edit Time Punch or Create Time Punch. Manual entries display on the report in red text.

To run a Time Punch Report:

1. In Sales Mode, complete all sales transactions.
2. From the Main button bar, tap Manager Functions and/or tap Reports. You can also run this from the Edit/Create Time Punch sidebar.
3. Tap **Time Punch**. The report displays.
4. To view different dates, locations or operators, select from the calendars and lists at the top and tap **View Report**.
5. To print or save and export the report, choose from the options at the top.
6. Tap **X** in the upper right to return to the Journal window.

---

**Time Punch Report**

for the period 3/6/2016 to 3/12/2016

Edited and created entries are noted in red text

<table>
<thead>
<tr>
<th>Operator Summary</th>
<th>Time</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boston West Location #3</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operator 11</td>
<td>John Doe</td>
<td>18:37</td>
</tr>
<tr>
<td>Operator 22</td>
<td>Jane Smith</td>
<td>45:20</td>
</tr>
<tr>
<td>Operator 23</td>
<td>Bob Brown</td>
<td>40:00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td><strong>103:57</strong></td>
</tr>
</tbody>
</table>

| **Boston East Location #4** |      |       |
| Operator 21          | Steve Smith | 20:00  | 20.00 |
| **Total**            |       | **20:00** | **20.00** |

**Grand Total**

<table>
<thead>
<tr>
<th>Time</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>123:57</strong></td>
<td><strong>123.95</strong></td>
</tr>
</tbody>
</table>

Breakdown by operator on subsequent pages.

---

<table>
<thead>
<tr>
<th>Operator: 11 – John Doe</th>
<th>IN</th>
<th>OUT</th>
<th>Time</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 3/6/2016</td>
<td>Tuesday</td>
<td>08:30:00</td>
<td>12:30:00</td>
<td>4:00</td>
</tr>
<tr>
<td>11 3/8/2016</td>
<td>Tuesday</td>
<td>01:00:00</td>
<td>05:00:00</td>
<td>4:00</td>
</tr>
<tr>
<td><strong>Tuesday Total</strong></td>
<td></td>
<td></td>
<td><strong>8:00</strong></td>
<td><strong>8.0</strong></td>
</tr>
<tr>
<td>11 3/10/2016</td>
<td>Thursday</td>
<td>08:30:00</td>
<td>12:30:00</td>
<td>4:00</td>
</tr>
<tr>
<td>11 3/10/2016</td>
<td>Thursday</td>
<td>01:00:00</td>
<td>05:00:00</td>
<td>4:00</td>
</tr>
<tr>
<td><strong>Thursday Total</strong></td>
<td></td>
<td></td>
<td><strong>8:00</strong></td>
<td><strong>8.0</strong></td>
</tr>
<tr>
<td>11 3/11/2016</td>
<td>Friday</td>
<td>03:00:00</td>
<td>05:37:00</td>
<td>2:37</td>
</tr>
<tr>
<td><strong>Friday Total</strong></td>
<td></td>
<td></td>
<td><strong>2:37</strong></td>
<td><strong>2.61</strong></td>
</tr>
</tbody>
</table>

**Grand Total for Operator 11**

<table>
<thead>
<tr>
<th>Time</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>18:37</strong></td>
<td><strong>18.61</strong></td>
</tr>
</tbody>
</table>

---

**Time Punch Report fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary page</td>
<td>Lists the period reported and totals by operator and location.</td>
</tr>
<tr>
<td>Operator Summary</td>
<td>Total amounts and average amounts for each key performance indicator.</td>
</tr>
<tr>
<td>Time</td>
<td>Hours and minutes worked.</td>
</tr>
<tr>
<td>Hours</td>
<td>Hours and minutes converted to decimal numbers.</td>
</tr>
<tr>
<td>Detail pages</td>
<td>Detailed time clock entries for each operator.</td>
</tr>
<tr>
<td>Operator number and name</td>
<td>Operator number and name in NetSuite POS.</td>
</tr>
</tbody>
</table>
Transaction Detail Report

Use the NetSuite Point of Sale (NSPOS) Transaction Detail report to find a transaction number and look up complete details for any transaction. It includes the price of each item sold and the tax paid, adding up to a total transaction amount.

To run a Transaction Detail Report:

1. In Sales Mode, complete all sales transactions.
2. From the Main button bar, tap Manager Functions and/or tap Reports.
3. Tap Transaction Detail. The report displays.
4. To adjust criteria, choose from the fields at the top and tap View Report. If the transaction number is known, enter it in the TransactionID field and select Null by all other fields.
5. To print or save and export the report, choose from the options at the top.
6. Tap X in the upper right to return to the Journal window.

Note: For locations where item prices include taxes, the report lists the tax paid on a separate line but does not include that separate tax line in the transaction total. Instead, the total uses the sum of the combined prices/taxes for each item in the transaction. This setup is most common in the United Kingdom and Australia.

Custom Reports using Saved Searches

You can set up saved searches in NetSuite ERP to create a custom report. Any field held in NetSuite can be used in a search, including fields in NetSuite Point of Sale (NSPOS) custom “RA-” records. By saving a search, you can run it again manually or set it to run automatically on a schedule. Scheduled reports can be sent to specific recipients within your company.

For more information, see the help topic Saved Searches.

Example: Workstation Monitoring search for Offline Registers

These example saved-search procedures use workstation monitoring fields based on each workstation’s Synchronization – Last Connection Date. The search looks for the last time a register connected to the server and received a replication download.

To ensure we have an overview of all registers, we will configure the search to query and list details about each workstation. The results will show workstations with connection dates older than one week and
workstations with no connection date. We will also include each workstation’s location to determine if a connection problem is specific to a store.

Use these steps as a guide to creating your own saved searches. Also see the help topic Defining a Saved Search.

To create, run and save a search for offline registers:

1. Log in to NetSuite as an administrator.
2. Go to Reports > Saved Searches > All Saved Searches.
3. Click New Saved Search.
   This page lists all records that are available to you for a saved search. It includes standard NetSuite records and custom NSPOS records.
4. For a workstation status report, select RA-Workstation.

5. Enter a **Search Title**, such as Workstation Last Connection Date. NetSuite will assign an **ID** when you click **Save** later.
6. If you want to allow other users from your business to run the search, check the **Public** box.
7. The **Available as ____ View** options determine where you can access and view the search results. Check all three **View** options if desired. See the help topic Using a Saved Search as a View.

8. Set the search parameters in the **Criteria** subtab.
   You can configure the report to show only workstations that did not connect in a specified date range or for a specific amount of time. In this example we will look for workstations that did not connect in the past week.
   1. Scroll in the **Standard Filter** to select Synchronization — Last Connected to server.
2. In the criteria form that appears, select **not within** and **last week to date**. (The **From / To** date fields are dynamic, and reset each time you run the search. No need to change a date here.)

3. Click **Set**.

9. Open the **Results** subtab.
   You can use this subtab to choose the details to report, set the sort order, and choose the output type (layout).

10. Select from the **Sort By** and **Then By** lists to choose how to sort the results. Check the **Descending** box if you want to sort from highest to lowest values.

11. Choose the **Output Type**, such as **Normal** for a list view.
    See the help topic **Defining a Saved Search** for other output options.

12. For the **Columns** to show, you can:
Add a column. Click in the empty field, select a field from the list, then click Add.

Remove a column. Select a field and click Remove.

Move a column. Select the field and click Move Up or Move Down.

13. To call attention to problem registers, we can open the Highlighting subtab to flag workstations that have no connection history at all. This field might already appear in the highlight list. If so, you can remove other fields pre-selected for highlighting.

**Note:** NetSuite typically pre-selects fields that are historically important to a business.

14. Click Preview to view the results.

You can download or email the results by clicking an export method icon.

15. Click Return to Criteria.

16. If you want to email the results now or later, open the Email subtab. Click the Recipient field, choose the user and click Add.

The recipient must have a NetSuite userid associated with your account.

17. Make adjustments as desired, and then click Save when complete.

You can also click Save & Run or Save & Email.

**To run and export a saved search:**

Follow these steps to manually run an existing search.

1. Log in to NetSuite as an administrator.
2. Go to Reports > Saved Searches > All Saved Searches.
3. Locate the search to run.

**Tip:** Click a column to sort the saved search list by that column’s criteria.

4. Click View. The latest results display.
5. You can download or email the results by clicking an export method icon.

6. If you want to adjust the basis for the search, such as changing “is not within last week to date,” click Return to Criteria. To update all search parameters, click Edit this Search.

7. Otherwise, use the main NetSuite menu bar at the top to perform another task as desired.

To run and email the report on a schedule:

NetSuite can automatically run and email a report, without the need to run it manually. For more information, see the help topics Defining a Saved Search and Defining Audiences for Saved Searches.

1. Log in to NetSuite as an administrator.
2. Go to Reports > Saved Searches > All Saved Searches.
3. Locate the search to run.
4. Click Edit.
5. Open the Email subtab.
6. Check the Send emails according to schedule box.

7. Click in the Recipient field and choose a user. Click Add. The recipient must have a NetSuite userid associated with your account.

8. Add additional recipients as desired.
9. Open the Schedule section subtab and choose how often to run the report.
10. If desired, open the **Customize Message** section subtab and enter text to be included in the report emails.

11. Click **Save**.
This chapter provides procedures for monitoring your NetSuite Point of Sale (NSPOS) environment and solving many common problems that might occur.

- Workstation Monitoring
- Normal State Monitoring
- Troubleshooting

### Workstation Monitoring

Use the workstation monitoring tab to view statistics about registers in your NetSuite Point of Sale (NSPOS) network. Use the tab to monitor the last terminal connection date, the terminal application version, component versions and the size of each register's database.

You can also use saved-search options in NetSuite ERP to customize reports for different aspects of your workstation and server networks. See Custom Reports using Saved Searches > Example: Workstation Monitoring search for Offline Registers.

**Tip:** Many workstation issues arise from connection problems. Use the monitoring tools here or build a saved search using the example to determine a register's Synchronization – Last Connection Date. This date is the last time the register exchanged information with the server.

### Monitoring Periods

Statistics for each workstation are refreshed every 24 hours. If a refresh fails because a register is offline or has a connectivity issue, the monitoring uses a recovery mechanism to trying resending the data later. Once a send is successful, the tab resets the monitoring time-point to be 24 hours after the last successful refresh. This reset means that statistical updates might not occur at the same times when measured over a long period.

NetSuite ERP rejects updates if no changes have occurred. If a register has gone offline, the replication server will continue trying to send updates to NetSuite ERP. However, only the last successful update will appear in the monitoring tab. The system notes available for the monitoring tab will not reflect the rejected transmissions from the server.

**To view monitoring for a workstation:**

1. Log in to NetSuite as an administrator.
2. Go to Customization > Lists, Records, & Fields > Record Types.
3. Locate the RA-Workstation row and click List.
4. Click View for the desired workstation.
5. Under Monitoring, view the Last Connected to Server timestamp and the Offline status. These values can verify if a register is running and synchronizing to receive database updates from your server.
6. Open the Workstation Monitoring subtab and review the statistics.
Monitoring Statistics

Workstation monitoring provides the following statistics about each register.

### Monitoring

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Connected to Server</td>
<td>Last date / time register connected with the cloud server for synchronization.</td>
</tr>
<tr>
<td>Offline</td>
<td>Register network connection status. Selected means register is offline.</td>
</tr>
</tbody>
</table>

### Provisioning Workstation Monitoring

<table>
<thead>
<tr>
<th>Name</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoUpdater</td>
<td>Version</td>
<td>AutoUpdater version installed on register. AutoUpdater provides automatic upgrades of major NetSuite POS components.</td>
</tr>
<tr>
<td>Database</td>
<td>DatabaseOwnerId</td>
<td>ID of database used for the NSPOS register. For standalone or Server with POS registers, the database ID of the register. For POSClient registers, the database ID of the connected Server with POS register database.</td>
</tr>
<tr>
<td>NetSuite Point of Sale</td>
<td>Version</td>
<td>Application release installed on register. Important for implementations, upgrades and support troubleshooting.</td>
</tr>
<tr>
<td>RaposDb</td>
<td>RowSize</td>
<td>See RowSize and DbSize.</td>
</tr>
<tr>
<td>RaposDb</td>
<td>Version</td>
<td>Database version on register.</td>
</tr>
</tbody>
</table>
Monitoring Statistics

For release 2018.1 or greater, workstation monitoring provides the following statistics about each register.

Tip: Note the AutoUpdater last connection date. Use this date prior to a new release to ensure the AutoUpdater application is functioning and can load new releases and fixes to your registers. The date should be the current date or, if reviewed early in the morning, yesterday’s date.

<table>
<thead>
<tr>
<th>Name</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Connected to Server</td>
<td>Last date / time register connected with the cloud server for synchronization.</td>
<td></td>
</tr>
<tr>
<td>Offline</td>
<td>Offline network connection status. Selected means register is offline.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoUpdater</td>
<td>Version</td>
<td>AutoUpdater version installed on the register.</td>
</tr>
<tr>
<td>AutoUpdater</td>
<td>LastTimeConnection</td>
<td>Last time AutoUpdater connected to the server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Can be used prior to a new release to ensure AutoUpdater is running and can load the upgrade to the register.</td>
</tr>
<tr>
<td>Component</td>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ComputerSystem</td>
<td>Name</td>
<td>The date displayed should be the current date or, if reviewed early in the morning, yesterday's date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Should match the register terminal's Computer Name that can be seen in the system information.</td>
</tr>
<tr>
<td>ComputerSystem</td>
<td>TotalPhysicalMemory</td>
<td>Size of physical memory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Should meet or exceed the minimum hardware specifications listed in the NSPOS Administrator Guide &gt; NSPOS System Requirements.</td>
</tr>
<tr>
<td>ComputerSystem</td>
<td>SystemType</td>
<td>Terminal hardware type, such as x64-based PC or x86-based PC.</td>
</tr>
<tr>
<td>Database</td>
<td>DatabaseOwnerId</td>
<td>ID of database used by the NSPOS register.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For standalone or Server with POS registers, value is the database ID of the register.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For POSClient registers, value is the database ID of the connected Server with POS register database.</td>
</tr>
<tr>
<td>Database</td>
<td>LocationId</td>
<td>ID of the location in which the register is running.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use to verify that the register is assigned to the correct location.</td>
</tr>
<tr>
<td>NetSuite Point of Sale</td>
<td>Version</td>
<td>NSPOS release installed on register.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Important for customizing registers, making upgrades and performing troubleshooting.</td>
</tr>
<tr>
<td>OperatingSystem</td>
<td>LastBootUpTime</td>
<td>Date and time the operating system was last restarted.</td>
</tr>
<tr>
<td>OperatingSystem</td>
<td>Caption</td>
<td>Name of the system, such as Microsoft Windows 8.1 Enterprise.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Should match one of the systems supported in the PA-DSS guide corresponding to the register's NSPOS release.</td>
</tr>
<tr>
<td>OperatingSystem</td>
<td>Version</td>
<td>Version number of the register's operating system.</td>
</tr>
<tr>
<td>OperatingSystem</td>
<td>CurrentTimeZone</td>
<td>The time zone used by the register, displayed as an offset in minutes from Greenwich Mean Time (GMT). GMT is also called Coordinated Universal Time (UTC). The number can be positive, negative, or zero.</td>
</tr>
<tr>
<td>Processor</td>
<td>Name</td>
<td>Register's processor type.</td>
</tr>
<tr>
<td>Database</td>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RaposDb</td>
<td>RowSize</td>
<td>Current space reserved for the application using this database. Should not exceed 10 GB. See RowSize and DbSize.</td>
</tr>
<tr>
<td>RaposDb</td>
<td>Version</td>
<td>Rapos database application version on register.</td>
</tr>
<tr>
<td>RaposDb</td>
<td>DbSize</td>
<td>Amount of data saved to the database. Should be monitored to ensure value is below 10 GB maximum. See RowSize and DbSize.</td>
</tr>
<tr>
<td>RaposInventoryDb</td>
<td>RowSize</td>
<td>Current space reserved for the application using this database. Should not exceed 10 GB.</td>
</tr>
<tr>
<td>RaposInventoryDb</td>
<td>Version</td>
<td>RaposInventory database application version on register.</td>
</tr>
<tr>
<td>RaposInventoryDb</td>
<td>DbSize</td>
<td>Amount of data saved to the database. Should be monitored to ensure value is below 10 GB maximum.</td>
</tr>
<tr>
<td>RaposReplicationDb</td>
<td>DbSize</td>
<td>Amount of data saved to the item database. Should be monitored to ensure value stays below the 10 GB maximum.</td>
</tr>
<tr>
<td>Replication Push Agent</td>
<td>Version</td>
<td>Version of push agent used to perform synchronization tasks.</td>
</tr>
<tr>
<td>ReplicationStatistics</td>
<td>XmlFilterToProcess</td>
<td>Amount of data to be processed from or to the register. Should be zero.</td>
</tr>
<tr>
<td>ReplicationStatistics</td>
<td>XmlInboxConflicts</td>
<td>Number of conflicts on the register. For example, if a price update for an item fails, it will show as a conflict. Should be zero, but a certain number of conflicts can be expected due to</td>
</tr>
</tbody>
</table>
RowSize and DbSize

You should review the RowSize and DbSize values for each database type to ensure volumes stay below the maximum limit of 10 GB.

- **RowSize** – The space reserved by the database application to manage saved information. For example, an empty database might be allocated 1 GB (gigabyte) to start. When data exceeds 1 GB, it allocates another GB of space, changing the RowSize to 2 GB.

  A database might contain 9.1 GB of data (DbSize), but the RowSize will show the reserved space as 10 GB. Because RowSize is a space-allocation indicator only, it should not be flagged as an immediate problem if it shows 10 GB.

- **DbSize** – Represents the actual volume of data saved to the database. It should be monitored to ensure it stays below the 10 GB maximum. Problems **can occur** when data is close to 10 GB, and **will occur** if data requirements exceed the 10 GB maximum reserved by the RowSize.

**Warning:** Ensure each DbSize value stays below 10 GB.

Normal State Monitoring

For NetSuite Point of Sale (NSPOS) 2019.1.0 and later, we include Normal State Monitoring. This feature can alert you in the event that NSPOS components installed on a register are not functioning within their “normal state” parameters. It also lists the Operating System (OS) and SQL Server versions in use, and whether NSPOS supports those versions.

An icon at the top left provides the Normal State status:

- **Green** (OK) — All components are functioning normally.
- **Amber** (Alert/warning) — Minor errors are occurring in one or more components, but the cashier can continue using the register. Assistance from NSPOS Customer Support is advised.
Red (Error) — Major errors are occurring in one or more components. The administrator must contact NSPOS Customer Support.

Tapping the Normal State icon displays a list of NSPOS components and their status.

To provide NetSuite Customer Support with information about an error state, the NSPOS Workstation Status page includes an option to Export and save logs. This option is described in the topic Pack and Download Register Logs for Support.

NSPOS Workstation Status Saved Search

To give you an overview of all registers in your network, we've added a saved search to your NetSuite ERP account for NSPOS. The search returns information about all registers that are in an Error or Warning state. Results include the:

- Workstation Name
- Location
- Lane Number
- State (status)
- Details about the workstation state

You can export the results in .csv or other formats.

Running a Workstation Status Search

1. Log in to NetSuite as an administrator.
2. Go to Reports > Saved Searches > All Saved Searches.
3. Locate the NSPOS Workstation Status row.
4. Click View. The results display.
5. To save and share the results, click an export icon.

Pack and Download Register Logs for Support

NSPOS Normal State Monitoring for includes a download feature you can use to send Customer Support the logs used for troubleshooting. To simplify gathering the information, NSPOS packs logged events into a .zip file that is saved to your replication server. Automatically saving log files to the server ensures that logs are available regardless of the state of a register’s file system.

The log package contains logs from these register components:

- NSPOS
- ReplicationPushAgent
- AutoUpdater
- MonitoringAgent

In general, the faster Support receives a log package containing information about an issue, the faster they can resolve it. For this reason, downloading of the log package is available to both you and Support. If you want to send a downloaded log package to Support, but your email policies prohibit sending .zip files, you can attach the .zip to a Support Issue.

To Pack and Download a Register Log Package:

1. Sign in to an NSPOS register as an administrator.
2. Tap the Normal State icon in the upper left. The appearance will vary depending on what issues, if any, are affecting the register.
3. Tap Export and save logs.
4. Tap Save.
Log Package Refresh Frequency

- NSPOS sends register log packages to the server one time per day.
- NSPOS removes log packages from the server after 30 days.

Troubleshooting

This section provides helpful procedures and tips designed to solve system issues and ensure optimal NetSuite Point of Sale (NSPOS) performance. To summit a case to NetSuite Customer Support, sign on to NetSuite ERP and go to Support > SuiteAnswers.

Also see Workstation Monitoring.

- General Advice
- Using Saved Searches to Identify Problems
- Windows Updates and Performance
- Restrictions on Changing a Workstation Location
- Syncing Register Time with Server Network Time
- Hardware
  - General Hardware Steps
  - Receipt Printer
  - Cash Drawer
  - Tag Printer
- Software
  - User unable to Sign On
  - Register does not Respond
  - Unable to Sell Gift Card or Certificate
  - Error loading CashDrawer Unit1 device for .NET v1.14
  - Other Software Errors
- Replication Issues
  - Sales/Transactions are missing in Sales Audit or Transaction Detail Reports
  - Sales/Transactions are missing in NetSuite ERP
  - New or Updated Items do not appear on a Register
  - New or Updated Tax settings do not appear on a Register
- Security Notifications for ERP Sandbox Integration

General Advice

These are general recommendations for when a register freezes or does not allow completion of a command or task.

- See if a different user with greater permissions can complete the task. For example, try signing on as a manager or administrator.
Try turning the register and other hardware off, and then turn it back on.
Try unplugging the affected hardware and then plug it back in.

Prior to contacting NetSuite Customer Support, gather the following information:

- Does the problem occur on other registers in the store?
- Does the issue always happen, or does it only occur occasionally?
- Is there a pattern to the problem, such as it only occurs with certain credit card types or individual items?
- Take a screen shot or notes of any errors that appear. Include them when you open the Support case.

Using Saved Searches to Identify Problems

You can create and save custom searches in NetSuite ERP to report on things such as last connection dates. Saved searches are good for getting an overall picture of your setups across locations and to view details about specific items of interest. See Custom Reports using Saved Searches > Example: Workstation Monitoring search for Offline Registers.

Tip: Many workstation issues arise from connection problems. Build a saved search using the example to determine a register’s Synchronization – Last Connection Date. This date is the last time the register exchanged information with the server.

Windows Updates and Performance

Applying a Windows® update to registers during business hours can significantly affect performance. NetSuite recommends applying updates only when the location is closed.

Restrictions on Changing a Workstation Location

To prevent system issues, administrators cannot change the Location setting on the RA-Workstation record after creating the workstation in NetSuite. If you must move a register to another store, first create a new RA-Workstation record with the desired Location and inactivate or delete the old workstation record. Then stage the register for the new Location.

Syncing Register Time with Server Network Time

If a register is set to use its internal clock, the register time can get out of sync with the network time used by your NSPOS replication server. The server network time comes from time-keeping sources on the internet.

Register variations of minus or plus five minutes (-5min > x < +5min) can cause data replication functions to fail. Gift card functionality and other POS services are also dependent on keeping the time synchronized.

Your administrator or NetSuite Customer Support can use the NSPOS Push Agent log to determine if replication errors were caused by times being out of sync.
To resynchronize a register’s clock using Windows 10:

1. Go to Settings > Time & Language > Date & Time.
2. Switch **Set time automatically** to **On**.
3. Close the window.

To resynchronize a register’s clock using Windows 7:

1. Tap the Windows **Start** button and search for **change time zone**.
   Or go to Control Panel > Date and Time.
2. Open the **Internet Time** tab.

   **Note:** Some businesses restrict access to the **Internet Time** tab.

3. Tap **Change Settings**.
4. Tap **Update now** and then **OK**.

Hardware

Use the NetSuite Point of Sale troubleshooting (NSPOS) guidelines here to identify and handle hardware issues.
Note: Some procedures use the application OLE for Retail Point of Sale (OPOS). OPOS is often used to manage peripheral hardware devices. It is commonly installed with NSPOS, but is considered optional if it is not required by a device manufacturer.

General Hardware Steps

1. Ensure that the register is turned on.
2. Turn off the register.
3. Turn on the register and wait for NSPOS to load.
4. Sign on.
5. Verify if the issue still exists.
6. If yes, take a screen shot or notes of any errors that appear.
7. See the procedures that follow to diagnose specific hardware.

Receipt Printer

1. Take a screen shot or notes of any errors that appear.
2. Try to reprint a previous receipt.
3. If reprinting fails, close NetSuite POS.
4. If possible, use the installed OPOS utility to verify that the printer is detected.

Cash Drawer

1. Take a screen shot or notes of any errors that appear.
2. Verify if you can open the cash drawer using the No Sale button.
3. If the drawer fails to open, close NSPOS.
4. If possible, use the installed OPOS utility to verify that the drawer is detected.

Tag Printer

1. Take a screen shot or notes of any errors that appear.
2. Try to print one or more different tags.
3. If printing fails, close NSPOS.
4. If possible, use the installed OPOS utility to verify that the printer is detected.

Software

Use the NetSuite Point of Sale troubleshooting (NSPOS) guidelines here to identify and handle software issues.
User unable to Sign On

1. Verify whether the user can sign on to a different register. If not, contact your administrator or NetSuite Customer Support to unlock the user’s account.
2. Have another user try to sign on to the register.
3. Restart the register and wait 10 to 15 minutes.
4. Have the user try to sign on again.
5. Take a screen shot or notes of any errors that appear.

Register does not Respond

1. Note what actions were performed prior to the screen freezing.
2. Note the local time. Include it if you open a Support case.
3. Press the Windows Logo key. This helps determine if the issue is limited to NetSuite POS or if it is a Windows issue.
4. If the Start menu does not appear, it is most likely a Windows issue. Restart the register.
5. Take a screen shot or notes of any errors that appear.

Unable to Sell Gift Card or Certificate

Attempting to sell a gift card results in Error Code: Gift Card 50.

NSPOS requires that the RA-Currency field on the Location record be set to the currency used for the gift card. The steps below must be performed for every retail location selling the card. By default, the Location > RA-Currency field is blank.

⚠️ Important: This procedure binds gift cards sold in each updated Location to use that currency only.

To set a Location to use the correct currency type for a gift card or certificate:

1. Log in to NetSuite as an administrator.
2. Go to Setup > Company > Locations.
3. Find the Location Name to verify and click View.
4. Verify that the RA-Currency field is set to the desired currency.
5. If the currency must be set, click Edit.
6. Click the down arrow beside RA-Currency and select the currency.
7. Click **Save**.
8. Verify the next Location.

---

**Error loading CashDrawer Unit1 device for .NET v1.14**

“Error loading CashDrawer Unit1 device. Another application has exclusive access to the device and did not relinquish control before timeout milliseconds expired.”

This is a known issue for which Microsoft® has provided an update – KB2959943. See the following websites:


---

**Other Software Errors**

1. Note what actions were preformed prior to the error appearing.
2. Note the local time. Include it if you open a Support case.
3. Restart the register, perform the same actions and verify that the error appears again.
4. Take a screen shot or notes of the error.

---

**Replication Issues**

Replication issues occur when data synchronization fails to exchange information between NetSuite and your registers. Use the NetSuite Point of Sale troubleshooting (NSPOS) guidelines here to identify and handle issues with your server > register > server connections.

**Sales/Transactions are missing in Sales Audit or Transaction Detail Reports**

1. Run reports from other registers to verify if transactions are missing.
2. If missing from a single register only, restart the register, wait 10 to 15 minutes and run the report again.
3. Take a screen shot or notes of any errors that appear.

**Sales/Transactions are missing in NetSuite ERP**

1. Review the register where the transactions originated to see if an Unsent Transaction Report was created.
2. Use the report to identify missing transactions and error messages.
3. If possible, use the error messages to make adjustments in NetSuite.

**Note:** NetSuite recommends submitting separate Support cases for each error listed in the Unsent Transaction Report.

**New or Updated Items do not appear on a Register**

1. Verify if the new or updated items appear on other registers.
2. If missing from a single register only, restart the register, wait 10 to 15 minutes and try again.
3. Take a screen shot or notes of any errors that appear.

**Note:** If new or changed items are missing from all registers, it may mean that issues are occurring on the POS server.

**New or Updated Tax settings do not appear on a Register**

1. Verify if the settings appear on other registers.
2. If missing from a single register only, restart the register, wait 10 to 15 minutes and try again.
3. Take a screen shot or notes of any errors that appear.

**Note:** If new or updated tax settings are missing from all registers, it may mean that issues are occurring on the POS server.

**Security Notifications for ERP Sandbox Integration**

NetSuite Point of Sale (NSPOS) includes two notifications that alert you to possible server issues when creating a sandbox for for user acceptance testing (UAT). The notifications prompt you to take certain actions in the event a misconfiguration occurs with the NSPOS integration to your NetSuite ERP production or sandbox environment.

**What is covered in the notifications**

In NetSuite ERP, the NSPOS production server URL is stored as the NSPOS SERVER NAME. NetSuite ERP has implemented a change that duplicates the production URL and credentials in sandbox environments.
A sandbox refresh copies the NSPOS SERVER NAME value from the production environment to the sandbox. After the refresh, the sandbox contains the URL for the production server. Because the URL is duplicated, the sandbox and production integration between the server will not function correctly.

In the event of an issue, attempting to make the sandbox and NSPOS server integration function correctly without extensive knowledge of this area could have a negative impact on your business. The risks include the mixing of testing and production data.

The notifications warn you if a testing setup will create this type of integration error.

⚠️ **Important:** If you receive a notification, please contact Customer Support for assistance.